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eAn Introduction to Compressor

Compressor is an essential part of the video compression 
process. It makes compression fast, efficient, and convenient, 
giving you more options in your choices of compression 
settings and output formats. 

With the ability to view and experience media content in many different ways (such as 
on websites, Apple TV, an iPod, CD-ROM discs, and DVDs), content authors need a 
quick and easy means of converting their material so that it can be conveniently 
distributed to a variety of playback devices. 

Whether you want to create high-quality movie trailers that can be opened and viewed 
over the web within seconds, or you just want to transfer a video clip to a CD or DVD, 
you need to compress media files so that they fit into limited space and are readily 
available for viewing. Compressor is a high-speed video and audio encoding tool that 
provides an efficient way to convert content for any of these methods.

In addition to the variety of viewing delivery methods, there are also a variety of output 
formats to consider. You may need to compress the same media file into different 
output formats just to accommodate different media players and uses. With 
Compressor, you can select different output formats for use with the various 
distribution models.
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About the Compressor User Manual
This preface, “An Introduction to Compressor,” contains background information that 
introduces most of the basic concepts and terms related to using Compressor.

Other chapters in this user manual cover the following:
Â Chapter 1, “Getting Started Quickly,” will help you with basic steps in using 

Compressor for the first time. 
Â Chapter 2, “The Basic Transcoding Workflow,” offers more detailed Compressor 

setup procedures.
Â Chapter 3, “The Compressor Interface,” is a quick visual tour of Compressor windows 

and features.
Â Chapter 4, “Importing Source Media Files,” covers the file types that Compressor can 

accept and how to import them.
Â Chapter 5, “Creating, Previewing, and Modifying Settings,” covers settings, an 

essential part of the Compressor workflow.
Â Chapter 6, “Finalizing Jobs and Submitting Batches,” is a detailed explanation of basic 

Compressor workflow.
Â Chapters 7 through 18 explain each of the output file types in turn. See “Output 

Formats for Transcoding” on page 14 for more information on these chapters.
Â Chapters 19 through 22 will help you add settings and further adjust the visuals of 

your Compressor transcode jobs for better-looking and better-sounding output.
Â Chapter 23, “Using the Preview Window,” explains how to use the Compressor 

Preview window so you can have a look at source media files, as well as the effect of 
any Compressor settings you might apply to the files.

Â Chapter 24, “Creating and Changing Destinations,” covers how to set up and save 
frequently used destinations for transcoded output files.

Â Chapter 25, “Using Droplets,” covers the time-saving drag-and-drop applications you 
can create with Compressor.
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Typical Compressor Scenarios
The following are typical Compressor scenarios:
Â Converting source media to one or more different output formats:  You can use Compressor 

to convert one or more media files to one or more different media file output formats. 
See “Quick-and-Easy Compressor Workflow” on page 20 for more information.

Â Exporting sequences or clips to one or more formats directly from other applications:  You 
can use Compressor to convert sequences or clips to one or more file formats from 
within other applications, such as Final Cut Pro. This workflow is the same as 
described in detail in the section, “Submitting a Final Cut Pro Project for Transcoding” 
on page 117. 
This integration with Final Cut Pro and other applications makes transcoding (the 
process of converting files from their original format into output files ready for 
distribution in another format) faster and more convenient, and also saves hard disk 
space by eliminating the need to export intermediate media files before processing 
them. It also leverages the video processing technology of the other applications to 
do much of the work (therefore maximizing the quality of images that are encoded), 
and avoids degradation that can occur from multiple compression and 
decompression steps. 

CD-ROMDVD videoApple devices
Apple TV

iPod
iTunes

Compressor
application

H.264
MP3

MP3
MPEG-1
MPEG-4

QuickTime

AC-3
AIFF

H.264
MPEG-1
MPEG-2

AIFF
MP3

QuickTime

Source media or
Final Cut Pro project

To web

QuickTime
movie 

(for broadband
and lowband)
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Â Creating DVD compliant files for use with DVD Studio Pro:  Before you can convert your 
existing media files into DVD Studio Pro projects, you must convert the video into 
MPEG-1 (SD projects only), MPEG-2 (SD and HD projects), or H.264 (HD projects only) 
files. Before importing one or more media files into DVD Studio Pro, Compressor 
transcodes the files into the correct format. Compressor can encode audio in the 
Dolby Digital Professional format (also known as AC-3). Dolby Digital Professional is a 
very common compressed audio format for DVD-Video discs. Compressor also 
supports two specialized situations:
Â For those situations in which you are editing high definition (HD) sources in 

Final Cut Pro and want to create a standard definition (SD) DVD from them, 
Compressor includes a high-quality down-conversion capability. HD sources using 
1080i or 720p resolutions use a high-quality transcoding process to create 
SD MPEG-2 video output files.

Â For those situations in which you must fit the maximum video onto a DVD and do 
not require broadcast quality, Compressor includes the ability to export DVD-
Video–compatible MPEG-1 format files.

Compressor Features
Compressor can work as a standalone application or be integrated into the workflow of 
other applications, such as Final Cut Pro. To this end, Compressor accepts the same full 
range of source media file types that Final Cut Pro accepts. Compressor is targeted at 
video postproduction professionals and compressionists who require high performance 
and maximum control over the final digital content for DVD authoring, streaming 
media servers, and wireless devices. Compressor gives you resizing, cropping, image 
processing, encoding, and delivery options, and offers the following features:
Â Batch processing:  This streamlined process allows you to create multiple output files 

from single source media files. 
Â VBR options:  Using the MPEG-2 encoder, you can set either a single or dual-pass variable 

bit rate (VBR) for your output files, a setting that affects the video file image quality. 
Â H.264 encoding:  H.264 produces higher quality video at lower data rates for 

everything from mobile phones to High Definition (HD). H.264 works especially well 
with the Apple QuickTime 7 media player. Compressor includes H.264 formats that 
specifically target HD DVDs, iTunes, the iPod, and Apple TV.

Â Droplets:  These standalone applications can be used for drag-and-drop transcoding 
operations straight from your desktop. Once created, Droplets simplify and automate 
the transcoding process and can be used even without opening Compressor.

Â Settings:  Settings contain all necessary file format, filter, and geometry settings 
needed for transcoding. You can customize and modify the Apple-supplied settings 
or create new ones, making it possible to create a library of specialized settings that 
can be reused.
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Â Filters:  The selection of available Compressor filters gives you dynamic artistic control 
while you convert your source media to other formats, and allows you to create a 
final product to your precise specifications. A selection of the available filters includes 
fade in/fade out, timecode overlays, gamma correction, noise removal, letterbox, 
watermark, color adjustment, and others. Additionally, there are audio filters for 
controlling dynamic range, peak levels, equalization, and fade in/fade out.

Â Previewing:  You can preview your filter settings in real time using the Preview 
window as you adjust them in the Inspector window. This lets you tweak the settings 
to your satisfaction, before transcoding the source media file.

Â Destinations:  You can create and save destinations for your output files, which can 
then be assigned to each output file’s target. You can even include FTP and iDisk 
locations. A destination can also specify the filenaming convention to use.

Â Geometry:  You can adjust your frame size using the geometry Inspector window 
controls and graphical controls in the Preview window. These features allow you to 
crop unwanted image areas of your source media file and reduce file size. 
Compressor also allows you to resize your image to other aspect ratios such as 4:3, 
16:9, and 2.35:1 for delivery onto other platforms, such as DVD or iPod.

Â Publishing:  You can use Compressor to upload output files to a QuickTime Streaming 
Server or other locations for DVD authoring. 

Â AppleScript usage:  You can add specialized AppleScript information to any output file, 
which gives you the flexibility to automate and customize any post-encoding 
operations.

Â Interoperability:  Compressor is an integral component of other Apple professional 
video applications such as Final Cut Pro and DVD Studio Pro. You can export 
sequences directly from Final Cut Pro into Compressor for transcoding, and drag 
MPEG-2 files transcoded from Compressor into DVD Studio Pro to simplify the DVD 
authoring process.

Â Transcoding activity in the background:  Compressor lets you begin transcoding a 
batch and then continues processing in the background, allowing you to perform 
other tasks at the same time. 

Â Email notification:  You can set up Compressor to send an email notification to any 
location to notify you when the batch transcode is complete.
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Â Distributed processing:  Compressor offers distributed processing, distributing the 
work to multiple computers that have been chosen to provide more processing 
power. The distributed processing feature is limited to computers that have either 
Final Cut Studio or DVD Studio Pro installed. For more details, see the Distributed 
Processing Setup guide.

Â Command-Line Features:  Compressor has a number of command-line options for 
submitting jobs, enabling and disabling service node and cluster controlling services, 
and monitoring batches.

Output Formats for Transcoding 
Selecting the relevant playback platform (Apple Devices, DVD, web, CD, and kiosk) is 
the first choice you need to make before you compress a source media file into a 
different output format. Once you have decided on the platform, you can choose the 
appropriate output format for that platform. 

Whatever the digital video format of your source media file, you can transcode it using 
one of the following encoders supplied with Compressor:
Â AIFF:  Intended for audio use (DVD or CD authoring). For more details on the AIFF 

format, see Chapter 7, “Creating AIFF Files,” on page 125.
Â Digital Video (DV) Stream:  The DV format is extremely popular due to its low cost and 

wide availability when working with SD projects.
Â Dolby Digital Professional:  Also known as AC-3. Intended for DVD authoring. For more 

details on the AC-3 format, see “Creating Dolby Digital Professional Output Files” on 
page 129.

Â H.264:  The next-generation video compression technology in the MPEG-4 standard. 
Also known as MPEG-4 Part 10. Suitable for HD DVD and many other uses, H.264 can 
match the best possible MPEG-2 quality at up to half the data rate. H.264 is currently 
mandatory in both new high definition DVD specifications (HD DVD and Blu-ray). For 
more details on the H.264 format for use in your HD DVD projects, see “Creating 
H.264 for DVD Studio Pro Output Files” on page 153. For information on creating 
H.264 files for use in iTunes, on an iPod, or with Apple TV, see Chapter 10, “Creating 
H.264 for Apple Devices Output Files,” on page 147. For information on creating 
H.264 files for other uses (such as web video), see “Creating QuickTime Movie 
Output Files” on page 223.

Â Image Sequence:  Intended for use with other programs that import media as a series 
of still images in either the TIFF or TARGA format. For more details on the Image 
Sequence format, see Chapter 12, “Creating Image Sequence Files,” on page 159.
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Â MPEG-1:  Intended for Internet or specialized DVD use. For more details on the 
MPEG-1 format, see Chapter 14, “Creating MPEG-1 Output Files,” on page 167.

Â MPEG-2:  Intended for DVD use. For more details on the MPEG-2 format, see 
Chapter 15, “Creating MPEG-2 Output Files,” on page 181.

Â MPEG-4:  A very scalable specification, with a variety of uses, from web video or 
wireless devices to HD. For more details on the MPEG-4 format, see Chapter 16, 
“Creating MPEG-4 Output Files,” on page 211.

Â QuickTime Movie:  QuickTime is a cross-platform multimedia technology. It allows 
Mac OS and Windows applications to play back video, audio, and still-image files. For 
more details on the QuickTime format, see Chapter 17, “Creating QuickTime Movie 
Output Files,” on page 223.

Â QuickTime Export Components:  Leveraging the component plug-in architecture of 
QuickTime, Compressor can now output a variety of additional formats such as 
Windows Media, RealPlayer, 3G, and AVI. For more details on QuickTime Export 
Components, see “Creating QuickTime Export Component Output Files” on page 237.

Using the Compressor User Manual
The Compressor User Manual provides step-by-step instructions for using Compressor to 
compress source media files, as well as background and conceptual information about 
compression. It is designed to provide the information you need to get up to speed 
quickly, so that you can take full advantage of Compressor.

The Compressor User Manual allows you to access information directly on screen while 
you’re working in Compressor. To view this information, choose Help > Compressor 
User Manual. The Compressor User Manual is fully hyperlinked and enhanced with many 
features that make locating information quick and easy.
Â The home page provides quick access to various features, including the index and 

other relevant documents and websites.
Â A comprehensive bookmark list allows you to quickly choose what you want to see 

and takes you there as soon as you click the link.

In addition to these navigational tools, the Compressor User Manual gives you other 
means to locate information quickly:
Â All cross-references in the text are linked. You can click any cross-reference and jump 

immediately to that location. Then, you can use the Preview Back button to return to 
where you were before you clicked the cross-reference.

Â The table of contents and index are also linked. If you click an entry in either of these 
sections, you jump directly to that section of help. 

Â You can also use the Find dialog to search the text for specific words or a phrase.
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To access the onscreen help, do one of the following:
m Choose Help > Compressor User Manual.

m Press Command-, (comma).

In addition to accessing the Compressor User Manual, the Help menu also contains an 
item for creating a support profile. In certain support situations, AppleCare may require 
information about both your computer and how this particular application is 
configured. Choosing Help > Create Support Profile creates a file that contains the 
necessary information and can be emailed to AppleCare. You would not normally use 
this feature unless directed to by an AppleCare representative.

Apple Websites
There are a variety of Apple websites that you can visit to find additional information.

Compressor Website
Go here for general information and updates as well as the latest news on Compressor. 

To access the Compressor website, go to:
Â http://www.apple.com/finalcutpro/compressor.html

There are a variety of discussion boards, forums, and educational resources related to 
Compressor on the web. 

Apple Service and Support Website
Go here for software updates and answers to the most frequently asked questions for all 
Apple products, including Compressor. You’ll also have access to product specifications, 
reference documentation, and Apple and third-party product technical articles. 

To access the Apple Service and Support webpage, go to:
Â http://www.apple.com/support

To access the Compressor support page, go to:
Â http://www.apple.com/support/compressor

To access the Apple discussion pages, go to:
Â http://discussions.info.apple.com

http://www.apple.com/finalcutpro/compressor.html
http://www.apple.com/support
http://www.apple.com/support/compressor
http://discussions.info.apple.com
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Other Apple Websites
Start at the Apple main home page to find the latest information about Apple products:
Â http://www.apple.com

QuickTime is industry-standard technology for handling video, sound, animation, 
graphics, text, music, and 360-degree virtual reality (VR) scenes. QuickTime provides a 
high level of performance, compatibility, and quality for delivering digital video. Go to 
the QuickTime website for information on the types of media supported, a tour of the 
QuickTime interface, and specifications, and more:
Â http://www.apple.com/quicktime

FireWire is one of the fastest peripheral standards ever developed, which makes it great 
for use with multimedia peripherals, such as video camcorders and the latest high-
speed hard disk drives. Visit this website for facts and benefits about FireWire 
technology, FireWire software information, and available third-party FireWire products:
Â http://www.apple.com/firewire

For information about seminars, events, and third-party tools used in web publishing, 
design and print, music and audio, desktop movies, digital imaging, and the media arts, 
go to:
Â http://www.apple.com/pro

For resources, stories, and information about projects developed by users in education 
using Apple software, including Compressor, go to:
Â http://www.apple.com/education

Go to the Apple Store to buy software, hardware, and accessories direct from Apple. 
You can also find special promotions and deals that include third-party hardware and 
software products:
Â http://store.apple.com

http://www.apple.com
http://www.apple.com/quicktime
http://www.apple.com/firewire
http://www.apple.com/pro
http://www.apple.com/education
http://store.apple.com
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1 Getting Started Quickly

Compressor contains a number of preexisting settings 
that allow you to start transcoding immediately. 

You can begin transcoding media files as soon as you install Compressor, if you have 
one or more source media files and the preexisting Compressor settings and 
destinations suit your transcoding needs.

This chapter contains the following sections:
Â Terms Used by Compressor (p. 19)
Â Quick-and-Easy Compressor Workflow (p. 20)
Â Optional Tasks You Can Perform Before Submitting a Batch (p. 26)

Terms Used by Compressor
There are a few terms used by Compressor that you should feel comfortable with 
before you begin using it.

A batch is the heart of the transcode process. It contains one or more source media 
files, which are the files you want to convert, or transcode, to another format. Each 
source media file creates its own job. This means that a batch can contain multiple jobs, 
with each job based on its own source media file. 

Each job also has at least one target. The targets define what sort of output file should be 
created by the transcoding process. You can have multiple targets assigned to a job, 
which means that you can easily create multiple output files, each with a different format. 

Each target has three parts:
Â The setting:  The setting part of a target defines the encoder format that is used, as well 

as a number of other aspects, including a variety of filters and geometry attributes.
Â The destination:  The destination part of a target defines where the output file is saved. 

It also defines the rules that are used to create the output filename. Compressor 
includes a preference setting that allows you to specify a default destination.
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Â The output filename:  You can edit the output filename part of the target if for some 
reason you do not want to use the name generated based on the destination.

Note:  You can transcode a job only after it has at least one setting assigned to it.

If you need to create your own settings, or modify those that come with Compressor, 
see Chapter 2, “The Basic Transcoding Workflow,” on page 29, and Chapter 5, “Creating, 
Previewing, and Modifying Settings,” on page 87.

Quick-and-Easy Compressor Workflow
The following workflow shows you the easiest way to use Compressor:
Â Add source media files to Compressor (p. 20)
Â Assign settings and destinations to jobs (p. 22)
Â Submit the batch (p. 25)

Step 1:  Add source media files to Compressor
1 Double-click the Compressor icon in the Applications folder.

Compressor opens with an empty untitled batch with a placeholder job.

Note:  Select a Standard layout from the Window > Layouts menu to see the 
Compressor interface configured similarly to what is shown above. 

2 Drag source files from the Finder or the desktop to the Batch window.

Preview window

History window

Settings and
Destinations tabs

Untitled Batch window
with a placeholder job

Inspector window
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Note:  If you drag multiple files to the thumbnail area (with the arrow in this example) 
only the last file is added to this job and all other files are ignored.

New jobs are created for each source file you dragged to the batch.

See “About the Batch Window” on page 74 for more information about the controls in 
the Batch window.

The thumbnail area of
the job

Each source file creates a
job in the batch.

Target area (empty in this 
case) of a job
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Step 2:  Assign settings and destinations to jobs
You need to assign at least one setting to each source media file job before you can 
submit the batch for processing, but you can also add multiple settings to the same job 
to transcode multiple versions of the media file. Each setting-destination pair is known 
in Compressor as a target. 

1 Choose a setting for your source media file jobs in any of the following ways:

Â To assign different settings to different jobs:  Drag settings from the Settings tab to 
individual jobs in the Batch window.
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Â

 

To assign a single setting to multiple selected jobs:  

 

Select the jobs (source media files) 
in the Batch window and choose Target > New Target With Setting. This opens a 
settings selection dialog over the Batch window.

Choose one or more settings, using the disclosure triangles to reveal individual 
settings, and click Add. The chosen settings are assigned to all the selected jobs.

You can also choose Edit > Select All to select all the jobs before applying the settings. 
See Chapter 5, “Creating, Previewing, and Modifying Settings,” on page 87, for more 
information on settings, and Chapter 6, “Finalizing Jobs and Submitting Batches,” on 
page 101 for more information about working with jobs and targets.

The next step is to set the destination. By default, the destination is set to Source, 
which writes the output files to the same folder as the source files originated from. You 
can change the destination for organization purposes or to take advantage of larger 
and faster hard disks. 

 

Note:  

 

You can choose a default destination from the Compressor Preferences window. 
See “Setting Compressor Preferences” on page 38 for more information.

 Select the jobs in the
Batch window.

Select the settings to 
apply to the selected jobs.

Click Add to assign the 
settings to the selected 
jobs.

The chosen settings are
assigned as targets to the

selected jobs.
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You can set the destination for each individual target or for a selected group of targets. 

2 Choose a destination for your job’s targets in one of the following ways:

Â Do nothing. Accept the default destination Source (the same folder as the source 
media files originated from) specified in the Destination column.

Â Use the target’s shortcut menu to change one setting at a time. Control-click the target 
you want to change and then choose any of the pre-existing destinations available to 
you from the Destination submenu.

You can also choose Other from the shortcut menu to open a dialog to choose any 
location available to your computer as the destination.

Note:  Choosing Other allows you to choose any location currently accessible from 
your desktop, including a mounted open volume. However, this volume must remain 
open until the batch has been transcoded.

You can select multiple targets and change all their destinations at once using the 
same method. You can also use the Target > Destination menu to choose a 
destination, or drag a destination from the Destinations tab to the target.

See Chapter 24, “Creating and Changing Destinations,” on page 305, for more 
information on destinations.

3 You can name the batch, and save it, by choosing File > Save.

Use the target’s shortcut 
menu to change the 
destination for the 
selected targets.
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Step 3:  Submit the batch
Once each media file has at least one setting and destination associated with it, it 
becomes a job, and your batch is ready to be submitted. Click the Submit button to 
submit your batch. 

A dialog appears where you can name this submission, choose whether to use 
distributed processing, and set the priority of this submission. In most cases you can 
leave the settings as they are and just click Submit.

After you submit a batch, you can open the Batch Monitor so you can monitor the 
transcoding progress of your batch. You can also set the Batch Monitor to automatically 
open in the Compressor Preferences window.

Note:  You can always open Batch Monitor by double-clicking the Batch Monitor icon in 
the Utilities folder inside the Applications folder or by clicking its icon in the Batch window.
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You can also monitor the encoding progress in the History window.

See Chapter 6, “Finalizing Jobs and Submitting Batches,” on page 101, for more 
information on jobs and batches.

Optional Tasks You Can Perform Before Submitting a Batch
The three steps described in the previous section show you the fastest way to 
transcode media files. Although you can modify your pre-existing settings using this 
method, you can’t preview your files or fine-tune any settings.

The following chapters describe additional steps that can be performed on the setting 
of any job before it is submitted:
Â Chapter 5, “Creating, Previewing, and Modifying Settings,” on page 87 
Â Chapter 6, “Finalizing Jobs and Submitting Batches,” on page 101
Â Chapter 19, “Adding Filters to a Setting,” on page 241
Â Chapter 20, “Adding Frame Controls to a Setting,” on page 255
Â Chapter 21, “Adding Geometry Settings,” on page 267
Â Chapter 22, “Adding Actions to a Setting,” on page 277
Â Chapter 23, “Using the Preview Window,” on page 283
Â Chapter 24, “Creating and Changing Destinations,” on page 305 
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The following chapters give a more detailed look at output format settings and various 
transcoding options:
Â Chapter 7, “Creating AIFF Files,” on page 125
Â Chapter 8, “Creating Dolby Digital Professional Output Files,” on page 129
Â Chapter 9, “Creating DV Stream Output Files,” on page 145
Â Chapter 11, “Creating H.264 for DVD Studio Pro Output Files,” on page 153
Â Chapter 10, “Creating H.264 for Apple Devices Output Files,” on page 147
Â Chapter 12, “Creating Image Sequence Files,” on page 159
Â Chapter 13, “Creating MP3 Output Files,” on page 163
Â Chapter 14, “Creating MPEG-1 Output Files,” on page 167
Â Chapter 15, “Creating MPEG-2 Output Files,” on page 181
Â Chapter 16, “Creating MPEG-4 Output Files,” on page 211
Â Chapter 17, “Creating QuickTime Movie Output Files,” on page 223
Â Chapter 18, “Creating QuickTime Export Component Files,” on page 237
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2 The Basic Transcoding Workflow

Compressor makes it easy to transcode media into 
multiple formats.

In addition, Compressor is integrated into other applications, such as Final Cut Pro, and 
generates high-quality assets for use in DVD Studio Pro, providing seamless 
transcoding between media formats directly within one application. 

This chapter covers the following topics:
Â Compressor Concepts and Terms (p. 31)
Â Preparing Compressor for Transcoding (p. 32)
Â Creating a Compressor Batch (p. 34)
Â Viewing Transcoding Status (p. 36)
Â Optional Compressor Shortcuts (p. 37)
Â Setting Compressor Preferences (p. 38)

The following diagram illustrates how the Compressor transcoding process works. The 
largest transcoding component is a batch. The batch represents all the components 
needed to transcode your current media. It must contain one or more jobs. A job 
consists of at least one source media file with one or more targets, each with a setting 
and a destination associated with it. After completing the transcoding process, the 
resulting file is known as the output media file. One output media file is created for each 
setting assigned to a source media file. 
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In the illustration below, the batch contains two source media files, each of which is a 
job containing two targets (sets of a setting and destination). The total number of 
output files created by transcoding this batch will be four: Job 1 will create two output 
media files, as will Job 2.

A typical Compressor transcoding process consists of the following components:
Â Source media file:  The transcoding process always starts with a source media file, 

which is the file intended for transcoding in its original form. Source media files are 
always one of the following:
Â Movies:  Containing video, audio, and other data (such as markers)
Â Stills:  Used as part of a sequence of still images for certain video productions

Â Setting:  Once you have imported your source media file, you must assign one or 
more settings to it. A setting is a combination of transcode attributes, such as output 
format, filter, and geometry settings, that are applied to the source media file during 
the transcoding process. 
Â Output (file) format:  The encoder you choose to convert your source media file. 

Choose one of the following output formats based on the intended playback 
method and environment of your transcoded media files: AIFF, Dolby Digital 
Professional, DV Stream, H.264 for DVD Studio Pro, H.264 for Apple Devices (which 
contains settings for use with an iPod or Apple TV), Image Sequence (which 
supports TIFF and TARGA images), MPEG-1, MPEG-2, MPEG-4, QuickTime Movie, or 
QuickTime Export Components.

Â Filters:  Allow you to adjust different characteristics of your video such as color, 
brightness, and sharpness, to maximize your video quality as the file is compressed.

Â Geometry settings:  Allow you to crop the image and adjust its frame size.

Source
media file 

2

Batch

Job 2

Output media file
(Job 2, Target 2)

Target 2

Setting Destination

Output media file
(Job 2, Target 1)

Target 1

Setting Destination

Source
media file 

1

Job 1

Output media file
(Job 1, Target 2)

Target 2

Setting Destination

Output media file
(Job 1, Target 1)

Target 1

Setting Destination
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Â Actions settings:  Allow you to send email notifications and execute post-
transcoding tasks using AppleScripts.

Â Destination:  A destination also needs to be assigned to the source media file. This is 
the location where your transcoded media file is stored. You can either use the 
default destination called Source (the same folder the source media file is in), or you 
can designate any location to which you have full access. You can also change the 
default destination in Compressor Preferences. The destination also controls how the 
transcoded media file is named.

Â Target:  A blueprint for creating an output media file containing a setting, a 
destination, and an output filename.

Â Job:  Once you assign one or more targets to the source media file, it becomes a job, 
and is ready to be transcoded. 

Â Batch:  A batch consists of one or more jobs that are processed at one time. All jobs 
contained within the batch are submitted collectively when you click the Submit button.

Â Output media file:  The transcoded media files created after the batch is submitted 
and processed are called output media files. An output media file is the result of a 
successfully transcoded source media file (containing one setting and destination). 
You can create as many output media files as there are different settings applied to 
the various source media files in the batch. 

Compressor Concepts and Terms
Â Codec:  Short for COmpression/DECompression. A mathematical model for reducing 

the data of a source media file.
Â File Format:  The output format you use to transcode your source media file. 
Â Group:  Contains designated settings placed into a folder in the Settings tab. Groups 

help you organize your settings and can simplify the job creation process.
Â Transcoding:  The process of converting files from their original format into output files 

ready for distribution in another format. Closely related terms include compression, 
which specifically refers to data reduction, and encoding, a term which is essentially 
synonymous with transcoding, but does not emphasize the conversion aspect.
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Preparing Compressor for Transcoding
Compressor contains a number of preconfigured settings that allow you to start 
transcoding immediately. If you want to transcode your source media files immediately 
and don’t need to create your own settings, you can follow the steps described in 
“Quick-and-Easy Compressor Workflow” on page 20 instead. 

However, if you want to create your own settings and destinations, and customize 
other attributes such as filters, cropping, frame resizing, and actions settings, you need 
to follow the steps outlined below. If the custom settings you create here can be used 
for all your transcoding needs, you won’t need to go through these steps again. 
However, if you need to create new settings and destinations for each transcoding 
project, you’ll need to repeat these steps each time.

Step 1:  Create a setting
Unless you are using a pre-existing setting supplied with Compressor, you will need to 
create your own settings. This is done using the Settings tab, and begins with choosing 
an output format from the File Format menu that opens when you click the Add ( + ) 
button. See “Choosing an Output Format” on page 33 for more information. In 
addition, you also have the option of adding filters, geometry settings, and 
post-transcoding actions, and then previewing your setting to ensure satisfaction. 

See “Creating a Setting from Scratch” on page 94 for more information.

You can also streamline your workflow by putting your settings into groups. See 
“Creating Groups of Settings” on page 98 for more information.

After you have created a setting, you can further customize it with additional 
adjustments such as filters (to adjust image quality or add effects such as letterboxing), 
pixel size (geometry values), and post-transcoding actions. These additional 
adjustments are all managed in the Inspector window. See Chapter 19, “Adding Filters 
to a Setting,” on page 241, Chapter 20, “Adding Frame Controls to a Setting,” on 
page 255, Chapter 21, “Adding Geometry Settings,” on page 267, and Chapter 22, 
“Adding Actions to a Setting,” on page 277, for more information.

Step 2:  Preview the setting using the Preview window
It’s a good time-saving measure to preview your setting before submitting the batch. 
This can be done using the Preview window, and ensures that the quality of the output 
media file is acceptable. The Preview window consists of a split screen displaying the 
content of your source media file in its original form in one half, and the content of 
your output media file in the other half. 
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From the Preview window, you can do any of the following:
Â Play the media file.
Â Dynamically preview effects (in real time).
Â Modify the effects of the filters and geometry settings of your setting.
Â Compare source or output versions.
Â Crop the output file frame size.
Â Change the aspect ratio.
Â Add various (compression, chapter, or podcast) markers.

See “Previewing a Setting” on page 96 or Chapter 23, “Using the Preview Window,” on 
page 283, for more information.

Step 3:  Create a destination 
By default, your transcoded file is saved in the same folder as your source media file 
(Source). However, if you want to store your transcoded files in a different location, you 
can create a new destination in the Destinations tab. Using this tab, you can choose any 
folder, volume, or remote server for which you have permissions and access to be a 
destination, and add useful file identifiers for your transcoded output file. Once you 
have created sufficient destinations, you won’t need to open the Destinations tab again.

See Chapter 24, “Creating and Changing Destinations,” on page 305, for more information.

Choosing an Output Format
Choosing an output format is the first decision you need to make once you’ve decided 
to transcode a source media file. You choose an output format based on the intended 
playback method for the audience. Compressor gives you access to the following 
industry-standard formats, all of which have their own particular attributes:
Â QuickTime:  Intended for use with QuickTime in a variety of playback environments. 

Because QuickTime is cross-platform multimedia technology, it allows Mac OS and 
Windows applications to capture and play back video, audio, and still-image files. For 
more details on the QuickTime format, see Chapter 17, “Creating QuickTime Movie 
Output Files,” on page 223.

Â MPEG-1:  Intended for Internet, CD ROM,. and specialized DVD use. For more details 
on the MPEG-1 format, see Chapter 14, “Creating MPEG-1 Output Files,” on page 167.

Â MPEG-2:  Intended for standard and high definition DVD use. For more details on the 
MPEG-2 format, see Chapter 15, “Creating MPEG-2 Output Files,” on page 181.

Â MPEG-4, Part-2:  Intended for a variety of uses including the web or wireless devices. 
For more details on the MPEG-4 format, see Chapter 16, “Creating MPEG-4 Output 
Files,” on page 211.
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Â MP3:  Intended for audio compression. The MP3 format creates audio files that are 
compatible with a wide variety of playback devices. For more details on the MP3 
format, see Chapter 13, “Creating MP3 Output Files,” on page 163.

Â H.264 for DVD Studio Pro:  Intended for a variety of uses including HD-DVD. For more 
details on the H.264 format, particularly for authoring HD-based DVDs, see 
Chapter 11, “Creating H.264 for DVD Studio Pro Output Files,” on page 153.

Â H.264 for Apple Devices:  Intended for creating video files suitable for playback using 
iTunes, an iPod, and Apple TV. For more details on the H.264 for Apple Devices 
format, see Chapter 10, “Creating H.264 for Apple Devices Output Files,” on page 147.

Â Dolby Digital Professional. Also known as AC-3. Intended for DVD authoring. For more 
details on the AC-3 format, see Chapter 8, “Creating Dolby Digital Professional Output 
Files,” on page 129.

Â AIFF:  Intended for audio use (including DVD or CD authoring). For more details on 
the AIFF format, see Chapter 7, “Creating AIFF Files,” on page 125. 

Â Image Sequence:  Compatible with a wide range of compositing and image 
processing applications. For more details see Chapter 12, “Creating Image Sequence 
Files,” on page 159.

Â DV Stream:  Common format used for SD projects. See Chapter 9, “Creating DV 
Stream Output Files,” on page 145, for more information.

Note:  Compressor and QuickTime can also be extended to support additional codec 
options and third-party formats. The QuickTime Export Components feature allows you 
to control the third-party encoding engine without having to open another 
application. For more information, see “Creating QuickTime Export Component Output 
Files” on page 237.

Creating a Compressor Batch
Once you have the necessary settings and destinations available, you can begin to create 
your batch for transcoding. A batch contains one or more jobs. A job consists of one 
source media file with one or more targets, which contain the settings and destinations.

You can submit a batch for transcoding only after you have assigned at least one target 
(setting and destination) to each job (source media file) in the batch. All jobs in the 
batch are submitted together. Think of batches as documents that can be saved, closed, 
and opened again. And much like Final Cut Pro project tabs, each Compressor batch is 
contained in a separate tab that can be torn off.
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Step 1:  Import source media files into Compressor
You import source media files into a batch either by using the File Selection dialog or 
by dragging the files from the Finder to the Compressor Batch window. You can import 
source media files from any folder that you have access to. 

See Chapter 4, “Importing Source Media Files,” on page 73, for more information.

Step 2:  Assign a setting
Once you have imported your source media file into the Batch window, you need to 
assign one or more settings to it. This makes it a job. A source media file can be 
transcoded only after it has at least one setting assigned to it, and you can add a 
setting to a source media file only after you have either selected a pre-existing setting 
or created one. Your setting must have an output file format associated with it.
Â If you choose a pre-existing setting, the output file format has already been assigned. 
Â If you create your own setting, you must choose an output file format from the file 

format menu that opens when you click the Create a New Setting button ( + ) in the 
Settings tab.

You can add one setting to multiple jobs in one step by selecting the jobs in the Batch 
window and choosing a setting from the dialog that appears when you choose Target 
> New Target With Setting, or by Control-clicking one of the selected jobs and 
choosing a setting from the New Target With Setting submenu of the shortcut menu 
that appears. 

If you have a favorite setting (pre-existing or customized), you can streamline your 
workflow by creating a standalone application called a Droplet containing multiple 
settings, and use the Droplet to submit batches without opening Compressor. See 
“Creating a Droplet” on page 317 for more information.

Note:  You can also create groups of settings, which is a quick and convenient way to 
assign multiple settings to a source media file. See “Creating Groups of Settings” on 
page 98 for more information.

Step 3:  Preview the setting using the Preview window
You can either preview a source media file or the source media file with its assigned 
setting. From the Preview window, you can dynamically preview (in real time) and 
modify the effects of the filters and geometry adjustments of your setting, play back 
the media file, view source or output views, crop the output file frame size, change the 
aspect ratio, and add various markers relevant to the MPEG-1, MPEG-2, H.264 for 
DVD Studio Pro, and H.264 for Apple Devices formats.

See “Previewing a Setting” on page 96 or “Previewing a Clip” on page 289 for 
more information.
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Step 4:  Assign a destination 
You can choose the location to place your output media files by assigning a destination 
to each target. The destination also defines various aspects of how the output media 
file is named. There are several supplied destinations in the Destinations tab you can 
choose from, or you can create your own custom destinations. In addition to assigning 
a destination by dragging one from the Destinations tab to a job’s target, you can also 
use the Target > Destination menu or the shortcut menu that appears when you 
Control-click a target to assign an existing destination to a job. You also have the 
option of choosing a location that has not been defined as a destination by choosing 
Other in the above two menus.

See “Assigning Destinations to Source Media Files” on page 107 for more information.

Step 5:  Submit the batch for transcoding
Once you have created all the jobs you want in the batch and are satisfied with the 
settings and quality of your output files (having previewed them), you are ready to 
submit the batch. You do this by clicking the Submit button in the Batch window. 

Note:  If you are transcoding a large batch, you should turn off the screen saver 
application on your computer. This will improve the speed of your transcode because 
resources are not being diverted to the screen saver.

See “Submitting a Batch” on page 112 for more information.

Viewing Transcoding Status
You use the Batch Monitor and the History window to see the current status of a 
submitted batch and all the jobs contained within it. The Batch Monitor is a standalone 
application, so that it can work with both Compressor and Droplets, whether or not 
Compressor is open, and regardless of whether you have submitted anything. See 
“Creating a Droplet” on page 317 for more information about Droplets.

Step 1:  View the batch transcoding status
After you submit a batch, then you can open the Batch Monitor so you can view the 
transcoding status of your batch. This is a good way to monitor when your batch has 
finished transcoding and if any problems occurred during the transcode process. You 
can set the Batch Monitor to automatically open in the Compressor Preferences window.

See the Batch Monitor User Manual for more details.

Alternatively, you can look at the History window in Compressor. It contains a progress 
bar and, like the Batch Monitor, it can tell you if a submission was successfully transcoded.
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Step 2:  Confirm transcode completion
It’s a good idea to open the transcoded media file’s destination folder to ensure that 
the media file was transcoded successfully and saved to that location. 

Optional Compressor Shortcuts
Compressor was designed with workflow in mind. Depending on your needs, there are 
a number of ways to speed up the Compressor transcoding workflow. 

Using Pre-Existing Settings
Compressor contains a number of pre-existing settings that allow you to start 
transcoding immediately. If these pre-existing settings suit your needs, you can 
transcode your source media files immediately. 

See “Quick-and-Easy Compressor Workflow” on page 20 for more information. 

Even if you need to create custom settings, you can group them so that they can be 
easily applied to targets. See Chapter 5, “Creating, Previewing, and Modifying Settings,” 
on page 87, for more information.

Using Default Settings and Destinations
If you find that you are applying the same settings and destinations to each source media 
file, you can configure Compressor Preferences to automatically apply those settings and 
destinations. See “Setting Compressor Preferences” on page 38 for more information.

Working with Droplets
Droplets are a fast and convenient way to transcode material without even opening 
Compressor. You create a Droplet by saving a setting or a group of settings and 
destinations as an active icon. When you drag one or more source media files to it, the 
Droplet begins the transcoding process automatically.

See “Creating a Droplet” on page 317 for more information.
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Setting Compressor Preferences
You can use Compressor Preferences to configure several aspects of Compressor.

To open Compressor Preferences, do one of the following:
m Choose Compressor > Preferences.

m Press Command-, (comma).

The Preferences window appears.

To configure the email notification preference:
1 Enter the default email address to use when email notification is activated.

You can change this address in the Actions pane of the Inspector window.

2 Enter the mail server used by this computer for outgoing email.

For more information about email notification, see “Working with Post-Transcoding 
Actions” on page 277.

To set whether or not the Batch Monitor automatically opens, 
do one of the following:

m Select the “Auto launch Batch Monitor” checkbox to have the Batch Monitor 
automatically open when you submit a batch.

m Deselect the “Auto launch Batch Monitor” checkbox to prevent the Batch Monitor from 
automatically opening. You can still manually launch the Batch Monitor from the 
Batch window.

To control whether Content Agent automatically launches, do one of the following:
m Select the “Auto launch Content Agent” checkbox to have Content Agent open 

automatically when the computer is started.

m Deselect the “Auto launch Content Agent” checkbox to have Content Agent not open 
until Compressor is opened.
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Content Agent is a background process that Compressor uses to transfer source files to 
other nodes in an Apple Qmaster cluster and to receive the transcoded files back from 
those nodes. Generally, Content Agent is not needed until you are ready to submit a batch 
using distributed processing. There may be times, however, when having the Content 
Agent open automatically when the computer starts can help a transcode process. 

For example, if a computer loses power and automatically restarts while a large batch is 
being processed, having Content Agent restart can automatically get the transcode 
process to resume running. 

To control whether Compressor remains running after a batch has been submitted 
through it by another application (such as Final Cut Pro):

m Select “Quit upon submitting batches from other applications” to have Compressor quit 
once the batch has been submitted.

m Deselect “Quit upon submitting batches from other applications” to have Compressor 
continue running once the batch has been submitted.

To control cluster options (for distributed processing scratch storage settings):
1 Click the Cluster Options pop-up menu.

2 Choose one of the following:

Â “Copy Source to Cluster as Needed” to have Compressor copy source files to a 
cluster’s scratch storage location as needed.

Â “Never Copy Source to Cluster” to prevent Compressor from copying source files.
Â “Always Copy Source to Cluster” to require Compressor to always copy source files to 

a cluster’s scratch storage location.

Note:  This preference setting applies only to certain bundled copies of Compressor 
that have distributed processing enabled. The distributed processing feature is limited 
to computers that have either Final Cut Studio or DVD Studio Pro installed.

To control whether Compressor transfers Source files to the processing cluster 
immediately, do one of the following:

m Select “Copy at submission (high priority)” to have Compressor transfer source 
files immediately.

m Deselect “Copy at submission (high priority)” to prevent Compressor from transferring 
source files immediately.

Note:  This preference setting applies only to certain bundled copies of Compressor 
that have distributed processing enabled. The distributed processing feature is limited 
to computers that have either Final Cut Studio or DVD Studio Pro installed.
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To control the default setting:
m Use the Default Setting pop-up menu to choose from the list of existing settings.

The setting you choose appears as the default setting when you import a new source 
file in the Batch window.

To change the default destination:
m Use the Default Destination pop-up menu to choose from the list of existing destinations.

The destination you choose appears as the default destination when you import a new 
source file in the Batch window.

To control whether Compressor can browse clusters from a wide area network, do 
one of the following:

m Select Browse Wide Area Network to have Compressor use computers beyond the local 
subnet, and enter the DNS domain in the DNS Domain field. 

m Deselect Browse Wide Area Network to have Compressor limit itself to computers in 
the local subnet.

Note:  Any changes you make to the Compressor Preferences settings take effect only 
when you click Apply. If you make changes but decide not to use them, click Cancel.
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3 The Compressor Interface

The Compressor interface consists of a number of core 
windows in which you do most of your transcoding 
preparation work.

This chapter covers the following topics:
Â Compressor Windows and the Transcoding Workflow (p. 42)
Â Creating and Managing Compressor Layouts (p. 43)
Â Working with the Compressor Windows (p. 46)
Â Batch Window (p. 49)
Â Customizing the Toolbar (p. 50)
Â Settings Tab (p. 52)
Â Destinations Tab (p. 53)
Â Inspector Window (p. 54)
Â History Window (p. 65)
Â Preview Window (p. 66)
Â Batch Monitor (p. 67)
Â Droplet Windows (p. 68)
Â About Changing Values and Timecode Entries (p. 69)
Â General Compressor Keyboard Shortcuts (p. 71)
Â Preview Window Keyboard Shortcuts (p. 72)
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Compressor Windows and the Transcoding Workflow
Each Compressor window represents a part of the transcoding workflow.

Â Batch window:  Allows you to import source media files, add settings and 
destinations, and name the batch.

Â Settings and Destinations tabs:  The Settings tab allows you to centrally manage Apple 
and custom settings. The Destinations tab allows you to create, modify, or remove 
destination settings, set a default destination, and add file identifiers to your output 
media filename.

Â Inspector window:  Allows you easy access to common transcoding controls, and a full 
summary table containing all the details of each setting. You can also use the 
Inspector window to gather information on source clips, and to make dynamic 
changes interactively with the Preview window.

Â Preview window:  Allows you to play your source media file in its original format, or 
preview your source media file with settings that have been assigned to it. You can 
see the effects of settings—such as filters and frame resizing—and make 
adjustments to these attributes while previewing the media file in real time. You can 
also use the Preview window to add and view various kinds of markers.

Â History window:  The History window allows you to view a full log of all batches 
submitted from your computer, including progress bars of those still being 
transcoded, and pause or resubmit any batches listed in the log. 

Preview window

History window

Settings and
Destinations tabs

Untitled Batch window
with a placeholder job

Inspector window
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Â Droplet window (not pictured):  Allows you to save one or more settings or groups of 
settings into a Droplet, a standalone preset, packaged into a drag-and-drop 
application and saved as an icon. 

Â Batch Monitor (not pictured):  Allows you to view the status of all batches being 
processed. (See the Batch Monitor User Manual for more information.)

The Compressor toolbar, located along the top of the Batch window, makes it easy to 
navigate to the main Compressor windows and to the Batch Monitor. 

Creating and Managing Compressor Layouts
As you use Compressor you will find that, depending on the particular encoding task 
you are configuring, how the various Compressor windows are laid out can affect how 
easy it is to use. To help with this, Compressor includes the ability to configure and save 
layouts. Layouts define which windows are visible, their size, their position, and which 
icons are in the Batch window’s toolbar.

Compressor includes two layouts that you can use to get a starting point for creating 
your own custom layouts.

Note:  Each layout is available in several sizes, allowing you to choose the size that best 
fits your monitor. You can modify any of these layouts and save them as your own 
custom layouts.

Standard Layout
The standard layout shows all the Compressor windows, with the Settings and 
Destinations tabs sharing a window. This layout is optimized for those times when you 
are transcoding a single source media file.
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Batch Layout
The batch layout places the emphasis on the Batch window. This layout is optimized for 
those times when you are transcoding a number of similar source media files.

Choosing, Saving, and Managing Layouts
Compressor makes it easy to choose a layout.

To choose a layout:
m Choose Window > Layouts, and choose a layout from the list that appears.

Once you choose a layout, the Compressor interface changes to match it.

You can also create and save your own custom layouts.

To save a layout:
1 Configure the Compressor interface the way you want it to be saved. 

See “Working with the Compressor Windows” on page 46 for information on the ways 
you can work with the various windows. 

2 Choose Window > Save Layout.

3 In the dialog that appears, enter a name for the layout and click Save.

The layout is saved and appears in the Windows > Layouts list. 

You can manage the layouts list by removing or renaming existing layouts. 
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To manage your layouts:
1 Choose Window > Manage Layouts.

The layout manager dialog appears.

2 To rename a layout, double-click it and type the new name.

3 To remove a layout, select it and click the delete ( – ) button.

4 To save the current interface configuration as a new layout, click the add ( + ) button 
and enter a name for the layout.

5 To choose a layout and apply it to the current Compressor interface, choose the layout 
and click the Apply button. 

The layout manager closes and the Compressor interface changes to match the 
chosen layout.

6 Click Done when you have finished managing your layouts.

Note:  The layouts list is actually divided into two sections—the ones supplied by Apple 
and the ones that you create. The ones that you create are listed in alphabetical order. 
Use care when naming your layouts to ensure you can easily locate them in the list. 

About the Layout Files
If you have several workstations using Compressor, you might find that you want to be 
able to have the same layouts available on all of them.

You can accomplish this by copying the layout files from one system to another, 
ensuring you put them in the correct location. The layouts are stored in the following 
path: Users/username/Library/Application Support/Compressor/Layouts. The layouts all 
have a “.moduleLayout” extension.

Important:  Do not manually add or remove the layout files while Compressor is open. 
Compressor checks this location for available layouts as part of its startup process. You 
must restart Compressor to have it recognize any changes you have made to these files.
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Working with the Compressor Windows
While the standard and batch workflow layouts present the Compressor interface as a 
single large element, it is actually comprised of a number of individual windows that 
can be positioned and sized to best suit your needs. 

Why Are Some Windows Covered Up?
Because the Compressor interface is made up of individual windows, you may find that 
when you switch from Compressor to another application and then switch back to 
Compressor by clicking one of its windows, only that window appears, with the others 
remaining covered by other windows you might have open. 

There are three ways to avoid this situation or to get all the windows to appear:
Â When switching between applications, take advantage of the built-in application 

switching feature of Mac OS X. Press Command-Tab to have an application selection 
dialog appear. As you hold down the Command key, you can toggle the Tab key to 
cycle through the currently running applications, releasing the Command key once 
the Compressor icon is selected. This ensures that all the Compressor windows will 
be visible.

Â Choose Window > Bring All to Front.
Â Click the Compressor application icon in the Dock.

Resizing the Compressor Windows
All the Compressor windows can be resized with the exception of the Inspector 
window, which has a fixed size.

Each window has a minimum size limit, both horizontally and vertically, that affects 
how small you can make the window.

To resize a window:
m Drag the window’s lower-right corner to stretch or compress the window horizontally 

or vertically. 

Note:  As you reposition or resize a window, it will snap to a nearby window once you 
get close to it. This makes it easy to create a neat layout without gaps or overlaps.

Drag this corner to 
resize the window.
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About the Tabs
The Batch window and the Settings and Destinations tab window can have multiple tabs. 
Â The Batch window:  When you are working with a large monitor and have several 

batches open, you might want to be able to see each of them in its own window.
Â The Settings and Destinations tabs:  By default, the Settings tab and the Destinations 

tab are located in the same window. You can choose to have each in its own window 
or to close one of the tabs. You can even choose to add any of the other windows 
(except the Batch window) as an additional tab to the window.

In both cases, you can also control the order of the tabs.

To move a tab to its own window by dragging:
1 Drag the tab out of its current location.
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2 Release the tab to have it appear in its own window.

To move a tab to its own window using a shortcut menu:
m Control-click the tab and choose Tear Off Tab from the shortcut menu.

The tab opens in its own window.

To add a tab from one window to another window by dragging:
1 Drag the tab to the tab area of the window you want to add it to. 

A highlight appears around the tab area.
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2 Release the tab.

It snaps to the tab area and its original window closes. 

To add a tab from one window to another window by using a shortcut menu:
m Control-click the tab area where you want the window to appear, and choose the tab 

from the list that appears in the shortcut menu.

Note:  This is the only method that allows you to add the History, Preview, or Inspector 
tabs to the window.

To change the order of the tabs in their current window:
m Drag the tab left or right to its new position. 

The other tabs move to make room for it.

Once you have the Compressor interface configured as you like it, you can save it as a 
layout. That makes it easy to restore the layout or to switch between it and other layouts. 
See “Creating and Managing Compressor Layouts” on page 43 for more information.

Batch Window
When you first open Compressor, the Batch window appears. The Batch window allows 
you to import source media files for compressing, add settings and destinations, name 
the batch, and choose where you want to save it. The Batch window is where you place 
all source media files in preparation for transcoding. 

Note:  Generally the Batch window is always showing. If you close it, it will reopen when 
you create a new batch (File > New Batch) or open an existing batch (File > Open).

You can use the Compressor menu bar or the toolbar at the top of the Batch window 
to open all other windows. (If the toolbar isn’t visible when you open Compressor, click 
the button in the upper-right corner of the Batch window to open it.)

Job area

Toolbar

Batch tabs

Batch status Batch submission button

Show/hide toolbar 



 

50 Chapter 3   

 

 The Compressor Interface

 

 

In addition to the Compressor toolbar and the Submit button, the Batch window 
contains the tabs for the open batches and an area for showing and configuring a batch’s 
jobs. For information about adding source media files to a batch, see “Adding Source 
Media Files to a Batch to Create Jobs” on page 75. For information on working with jobs 
and targets, see Chapter 6, “Finalizing Jobs and Submitting Batches,” on page 101.

 

Customizing the Toolbar

 

The Batch window contains a toolbar that you can customize to better fit your needs. 

 

Note:  

 

If the toolbar isn’t visible when you open Compressor, click the button in the 
upper-right corner of the Batch window to open it.

 

To customize the Batch window toolbar:
1

 

Do one of the following to open the toolbar customization palette:

Â

 

Choose View > Customize Toolbar.
Â Control-click in the toolbar and choose Customize Toolbar from the shortcut menu.
Â Click the Customize icon in the toolbar (if present).
The toolbar palette opens.

2 To remove items currently in the toolbar, drag them off.

3 To add items to the toolbar, drag them from the toolbar palette to the toolbar, placing 
them where you want them to appear.
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4 To rearrange items in the toolbar, drag them from their current location to a new location.

5 To restore the toolbar to its default configuration, drag the default set (located on the 
bottom of the palette) to the toolbar.

6 To configure how items show in the toolbar, choose a setting from the Show pop-up menu.

You can choose to show the icon and text, the icon only, or the text only.

7 Click Done when you have finished.

Note:  The toolbar configuration is saved as part of a layout. See “Creating and 
Managing Compressor Layouts” on page 43 for more information about layouts.

About the Toolbar Items
Most of the items you can add to the toolbar can be added only once. There are a few 
that can be added multiple times, such as the separator, the space, and the flexible space.
Â New Batch:  Creates a new untitled batch.
Â Open Batch:  Opens a dialog for you to locate and select a saved batch to open.
Â Close:  Closes the currently selected batch.

Note:  You cannot close a batch if it is the only one open.

Â Add File:  Opens a dialog for you to locate and select one or more source media files 
to import into the current batch.

Â Add Surround Sound:  Opens the audio file assignment dialog that you can use to 
manually assign files to each audio channel in a surround sound configuration.

Â Submit with Previous Settings:  Submits the batch by using the settings used by 
previous batch submissions, bypassing the submission dialog.

Â History:  Opens the History window.
Â Inspector:  Opens the Inspector window.
Â Settings:  Opens the Settings tab.
Â Destinations:  Opens the Destinations tab.
Â Preview:  Opens the Preview window.
Â Batch Monitor:  Opens the Batch Monitor application.
Â Separator:  Adds a vertical line to the toolbar, allowing you to group items together.
Â Space:  Adds a fixed-width space to the toolbar.
Â Flexible Space:  Adds a flexible-width space to the toolbar. The space makes it 

possible to force items to the left and right edges of the toolbar, with it expanding to 
fill any unused area.

Â Customize:  Opens the toolbar customization palette.
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It
is
possible
to
add
more
items
to
the
toolbar
than
there
is
room
for.
When
that

happens,
the
right
edge
of
the
toolbar
shows
a
double
arrow
that
you
can
click
to
get

access
to
the
icons
that
do
not
fit.




Settings
Tab




Settings





allows
you
to
centrally
manage
Apple
and
custom
settings.
You
use
the

Settings
tab
together
with
the
Inspector
window
to
create
and
modify
settings,
decide

exactly
which
settings
you
want
to
use
to
transcode
your
source
media
file,
and
choose

which
output
format
you
want
the
transcoded
file
converted
to.





To
open
the
Settings
tab,
do
one
of
the
following:
m




Choose
Window
>
Settings.

m




Press
Command-3.

m




Click
the
Settings
icon
in
the
Batch
window
toolbar
(if
present).

m




Click
the
Settings
tab
(if
present).

Click
these
arrows
to

see
items
that
did
not

fit
in
the
toolbar.
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The
Settings
tab
contains
a
list
of
the
existing
settings
and
the
necessary
buttons
to

add,
remove,
or
duplicate
a
setting,
and
create
groups
and
Droplets.

See
Chapter
5,
“Creating,
Previewing,
and
Modifying
Settings,”
on
page
87,
for
details

on
using
the
Settings
tab
to
create,
manage,
and
choose
settings.




Destinations
Tab




The
Destinations
tab
allows
you
to
create,
modify,
or
remove
destination
settings,
set
a

default
destination,
and
add
file
identifiers
to
your
output
media
filename.





To
open
the
Destinations
tab,
do
one
of
the
following:
m




Choose
Window
>
Destinations.

m




Press
Command-4.

m




Click
the
Destinations
icon
in
the
Batch
window
toolbar
(if
present).
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Click
the
Destinations
tab
(if
present).

See
Chapter
24,
“Creating
and
Changing
Destinations,”
on
page
305,
for
details
on
how

to
configure
destinations
to
simplify
your
Compressor
workflow.




Inspector
Window




The
Inspector
window
has
easy
access
to
common
transcoding
controls
(for
creating

and
modifying
settings
and
destinations),
a
full
summary
table
containing
all
the

details
of
each
setting,
and
information
about
source
media
files,
including
A/V

attributes,
closed
caption
data,
and
other
annotations.





To
open
the
Inspector
window,
do
one
of
the
following:
m




Choose
Window
>
Show
Inspector.

m




Press
Command-Option-I.

m




Click
the
Inspector
icon
in
the
Batch
window
toolbar.




Note:






Unlike
the
other
Compressor
windows,
the
Inspector
window
cannot
be
resized.
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About the Automatic Settings
Several items in the settings panes have an optional automatic mode. When the 
automatic mode is enabled, Compressor determines the optimal value for the setting.

In general, when the automatic mode is active, its item is dimmed and cannot be changed. 
Â If the setting has not been assigned to a source media file, the item says “Automatic.” An 

exception is in the Frame Controls pane of the Inspector window, whose state is 
undetermined until you have applied the setting to a source media file.

Â If the setting has been assigned to a source media file, the item remains dimmed but 
shows the value that will be used.

When the automatic mode is inactive, its button is dimmed and you can choose values 
for an item as usual.

You can toggle the Automatic button to change from on (the button darkens) to off 
(the button lightens).

∏ Tip:  It is a good idea to verify the values in the Inspectors for those settings that are set 
to automatic. Compressor can usually correctly determine the appropriate values; 
however, there may be instances where there is not enough information in the source 
media file to determine the correct value. For example, some QuickTime clips might 
not have proper metadata or the metadata might be incorrect. Additionally, if the 
source media file uses nonstandard settings (such as the video frame size or frame 
rate), Compressor chooses the nearest standard value to use.

The automatic button is 
dark when active, and its 
item is dimmed.

The automatic button is 
dimmed when inactive, 
and its item is selectable.
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Media Source Files and the Inspector Window
When you select a batch’s job, the Inspector window shows you information about the 
job’s source media file.

The Inspector window contains two tabs: A/V Attributes and Additional Information.

A/V Attributes
The A/V Attributes tab contains general information about the source media file and is 
divided into three sections.
Â File information:  This section shows the filename, location and type of file.
Â Video information:  This section, when applicable, shows all video-related information 

about the file. This includes its frame size, frame rate, and timecode information.
Â Audio information:  This section, when applicable, shows all audio-related information 

about the file. This includes its sample size and sample rate.
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Additional Information
The Additional Information tab allows you to see and modify a variety of metadata 
items that might have been added in other applications such as Final Cut Pro, 
Soundtrack Pro, or QuickTime. You can also add metadata items to the output media 
file. It also includes the ability to associate a closed caption file with the file.

See “Using the Inspector with Source Media Files” on page 82 for more information on 
managing the closed caption files and annotations.
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About the Settings Panes
When you select a setting in the Settings tab or a target in a batch’s job, the Inspector 
shows one of six panes.

Summary Pane 
The Summary pane contains the Summary table, which describes all the settings (video 
and audio settings, geometry, and filter settings) associated with the setting selected in 
the Settings tab. Information in the Summary table is updated automatically whenever 
any setting is modified. 

The Summary table includes the following details:
Â Name:  The name of the setting selected in the Settings tab.
Â Description:  A description of the setting selected in the Settings tab.
Â File Extension:  The extension assigned to the transcoded media file. This identifies 

which format your source media file is being converted to.
Â Estimated file size:  When assigned to a source media file this shows the estimated 

total file size. When not assigned to a source media file, this shows an estimated size 
per hour of source media. 

Note:  The estimated total file size is not available for all output formats.
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Â Audio Encoder:  Details of the audio output file format and other transcoding settings, 
such as sample rate, channels, bits per sample, and codec type.

Â Video Encoder:  Details of the video output file format and other transcoding settings 
such as frame width and height, crop amount (in pixels), frame rate, aspect ratio, 
codec type, pixel depth, spatial quality, minimum spatial quality, key frame interval, 
temporal quality, minimum temporal quality, and data rate (in bits per second).

Â Filter:  Details of all, some, or none (depending on how many filters you selected in 
the Filters pane) of the available Compressor filters.

Encoder Pane
You use the Encoder pane to select and configure the output file format and other 
settings. The file format options and attributes are different for each format. 

Â File Format:  Use this pop-up menu to choose an output file format. See “Choosing an 
Output Format” on page 33 for more information on the available output formats.
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Â File Extension field:  The following file extensions automatically appear in this field 
based on the format you choose from the File Format pop-up menu, and if video and 
audio tracks are enabled. Don’t alter this field without good reason, because your file 
may not be recognized if you do.
Â aiff:  Represents AIFF.
Â ac3:  Represents Dolby Digital Professional.
Â dv:  Represents Digital Video (DV) format video.
Â mpg:  Represents MPEG-1 multiplexed (video and audio) stream.
Â m1v:  Represents MPEG-1 video elementary stream.
Â m1a:  Represents MPEG-1 audio elementary stream.
Â m2v:  Represents MPEG-2 video elementary stream.
Â m2t:  Represents MPEG-2 transport stream.
Â mpeg:  Represents MPEG-2 program stream.
Â m4v:  Represents H.264 for Apple Devices.
Â mp4:  Represents MPEG-4.
Â mov:  Represents QuickTime and H.264 for DVD Studio Pro.
Â tga:  Represents TARGA.
Â tiff:  Represents TIFF.

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. It is only 
relevant if you are using Compressor with distributed processing and with two pass or 
multi-pass encoding. (The Compressor distributed processing feature is limited to 
computers that have either Final Cut Studio or DVD Studio Pro installed.) For more 
information, see “Job Segmenting and Two-Pass (or Multi-Pass) Encoding” on page 61.
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Job Segmenting and Two-Pass (or Multi-Pass) Encoding
If you choose the two-pass or the multi-pass mode, and you have distributed 
processing enabled, you may have to make a choice between speedier processing 
and ensuring the highest possible quality. 

The Apple Qmaster distributed processing system speeds up processing by 
distributing work to multiple processing nodes (computers). One way it does this is 
by dividing up the total amount of frames in a job into smaller segments. Each of the 
processing computers then works on a different segment. Since the nodes are 
working in parallel, the job is finished sooner than it would have been on a single 
computer. But with two-pass VBR and multi-pass encoding, each segment is treated 
individually so the bit-rate allocation generated in the first pass for any one segment 
does not include information from the segments processed on other computers.

First, evaluate the encoding difficulty (complexity) of your source media. Then, decide 
whether or not to allow job segmenting (with the “Allow Job Segmenting” checkbox 
at the top of the Encoder pane). If the distribution of simple and complex areas of the 
media is similar throughout the whole source media file, then you can get the same 
quality whether segmenting is turned on or not. In that case, it makes sense to allow 
segmenting to speed up the processing time. 

However, you may have a source media file with an uneven distribution of complex 
scenes. For example, suppose you have a 2-hour sports program in which the first 
hour is the pregame show with relatively static talking heads, and the second hour is 
high-action sports footage. If this source media were evenly split into 2 segments, the 
bit rate allocation plan for the first segment would not be able to “donate” some of its 
bits to the second segment because the segments would be processed on separate 
computers. The quality of the more complex action footage in the second segment 
would suffer. In this case, if your goal were ensuring the highest possible quality over 
the entire 2-hour program, it would make sense to not allow job segmenting by de-
selecting the checkbox at the top of the Encoder pane. This forces the job (and 
therefore, the bit-rate allocation) to be processed on a single computer. 

Note:  The “Allow Job Segmenting” checkbox only affects the segmenting of 
individual jobs (source files). If you are submitting batches with multiple jobs, the 
distributed processing system will continue to speed up processing by distributing 
(unsegmented) jobs, even with job segmenting turned off.

For more information on variable bit rate encoding (VBR), see “Quality Tab” on 
page 190. For more information on the Apple Qmaster distributed processing system, 
see the Distributed Processing Setup guide.



62 Chapter 3    The Compressor Interface

 

Frame Controls Pane
This pane of the Inspector offers automatic and customized settings for advanced 
image analysis in frame resizing and frame retiming. 

Frame resizing would be necessary when transcoding between a high definition format 
such as 1080i and a standard definition format such as DV-NTSC. An example of frame 
retiming would be when transcoding between video formats with different frame rates 
such as NTSC (29.97 frames per second) and PAL (25 frames per second). For more 
information about the Frame Controls pane, see “About the Frame Controls Pane” on 
page 256.

Filters Pane
You use the Filters pane to add filters to your setting. You can perform such tasks as 
gamma correction and noise removal from here. 
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Select the checkbox next to any of the filters you want to include in a particular setting. 
Use each filter’s sliders or arrow controls to adjust your filter settings as necessary. 

Filters are applied to the source media file in the order you organize them in the Filters 
list. You can reorder filters by dragging them up or down in this list. 

For more information about the Filters pane, see “About the Filters Pane” on page 244.

Geometry Pane
You use the options in the Geometry pane to crop and size the media file being 
compressed and set its aspect ratio.

The Geometry pane has three sections:
Â Source inset (Cropping):  Use any of the four fields to enter the number of pixels by 

which you want to reduce the source media file size, or click the “Automatically 
detect crop settings for letter-box” checkbox to have Compressor enter crop values 
based on the source media file video content.

Â Dimensions (encoded pixels):  Use the Frame Size pop-up menu or these fields to 
create an appropriate output frame size and aspect ratio for your output media file. 
Use the Pixel aspect pop-up menu to set width and height values to conform to a 
designated pixel aspect ratio. 

Â Output image inset (Padding):  Use the Padding pop-up menu to calculate the output 
height or width values. With Custom selected, you can enter values in the fields.

For more information about the Geometry pane, see Chapter 21, “Adding Geometry 
Settings,” on page 267.
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Actions Pane
You use the Actions pane to activate transcode-completion notification emails and 
execute post-transcoding AppleScript actions.

Â “Email Notification to” checkbox and field:  Use to enter the address to which you want 
an email notification sent after the media file has been transcoded, or in the event of 
an error.

Â “Execute AppleScript on output” checkbox:  Select this checkbox to activate any 
AppleScript you have assigned to the setting after the media file has been transcoded.

Â Choose button:  Click to select the AppleScript you want to assign to the setting.
Â Default Destination:  Choose a destination from the pop-up menu that you want this 

setting to use as it default.

For more information about the Actions pane, see Chapter 22, “Adding Actions to a 
Setting,” on page 277.
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History Window
The History window gives you quick access to and some information about previously 
submitted batches. You can use it to pause a transcoding operation, resubmit batches by 
dragging them to the Batch window, or view submission details about particular batches. 
You can also use it to locate the output media files from previously submitted batches.

The History window also contains a progress bar that you can use to monitor the status 
of previously submitted batches.

To open and close the History window, do one of the following:
m Choose Window > History.

m Press Command-1.

m Click the History button in the Batch window toolbar.

Note:  The History window automatically opens if it is closed when you submit a batch 
for transcoding.

The History window contains entries that display information about the batch name 
and the date and time it was originally transcoded. The entries are ordered by date, 
with the oldest first. When you drag a batch into the Batch window for resubmission, a 
new untitled batch is created for it (any existing batches are unaffected).

For more information about the controls and settings in the History window, see 
“About the History Window” on page 115.
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Preview Window
The Preview window consists of a split screen that displays your selected source media 
file in its original form on the left side, and what your output media file will look like on 
the right side. This allows you to make a comparison between the original and 
transcoded versions and adjust your settings as necessary. Using the options in this 
window, you can crop the frame, add key frames, and change the aspect ratio. 

To open the Preview window, do one of the following:
m Choose Window > Preview.

m Click the Preview button in the Batch window toolbar.

m Press Command-2.

The Preview window has additional features, including a marker management pop-up 
menu. The marker management pop-up menu allows you to import chapter lists or 
manually add chapter (and podcast) markers and compression markers (to improve the 
compression quality of your media file). You can also view Edit/Cut compression 
markers that were generated in other applications such as Final Cut Pro. If you are 
exporting a Final Cut Pro project to Compressor, these settings or markers are 
transferred with your project. These markers are also exported to DVD Studio Pro. See 
“Working with MPEG-2 I-Frames” on page 208 and “About MPEG-2 Markers and 
DVD Studio Pro” on page 201 for more information.

For more information about the controls and settings in the Preview window, see 
“About the Preview Window” on page 284.

Marker pop-up menu button
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Batch Monitor
You use the Batch Monitor to monitor the progress of all transcoding batch activity, 
including estimates for the transcoding time remaining for all jobs. The Batch Monitor 
is a separate application that can be opened without opening Compressor. For more 
details on the Batch Monitor see the Batch Monitor User Manual.

To open the Batch Monitor, do one of the following:
m Click the Batch Monitor button in the Batch window toolbar.

m Double-click the Batch Monitor icon in the Utilities folder.

You can also set Compressor Preferences so that Batch Monitor launches automatically 
when you submit a batch. See “Setting Compressor Preferences” on page 38 for 
more information.

The Batch Monitor displays the status of all your submitted batches including each 
batch’s name and other details. You can view reports for both successful and failed jobs 
in the Batch Monitor as well as the History window. 

For more information about the controls and settings in the Batch Monitor, see the 
Batch Monitor User Manual.
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Droplet Windows
You can save one or more settings or groups of settings into a Droplet, a standalone 
preset, packaged into a drag-and-drop application and saved as an icon. Then you can 
transcode source media files (without even opening Compressor) by simply dragging 
them to a Droplet icon. See Chapter 25, “Using Droplets,” on page 315, for information 
on creating and using Droplets.

You can open any Droplet and view its window for full details about the Droplet. 

To open a Droplet window:
m Double-click a Droplet icon.

For more information about the controls and settings in the Droplet window, see 
“About the Droplet Window” on page 316.

Drag selected source
media files to a Droplet

to transcode them.
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About Changing Values and Timecode Entries
Compressor includes several types of value entry methods. Most of them have features 
that can make changing the values or timecode fields much easier.

Using Value Sliders
There are two methods used to enter general numeric values: traditional sliders with 
separate numeric entry fields and value sliders that combine the slider with the 
numeric entry field.

Value sliders allow you to enter a specific number in the value field or to drag in the 
value field to set a value. When using the value sliders, you can use a modifier key to 
make normal, small, or large value adjustments. Dragging in the middle area (where 
the number is) works the same as an ordinary slider; dragging to the right increases the 
value and dragging to the left decreases the value. Additionally, you can click the right 
or left arrow to change the value one step at a time. You can also double-click the 
number itself and type a new number to enter a specific number in the value field. 

To change values in normal increments, do one of the following:
m Drag left or right in the value field.

m Click the left arrow to decrease a value, or click the right arrow to increase a value.

m If you have a three-button mouse with a scroll wheel, click in the value field and use 
the scroll wheel on the mouse.

To change values in fine increments, do one of the following:
m Option-drag in the value field.

m Option-click the left arrow to decrease a value, or Option-click the right arrow to 
increase a value.

m If you have a mouse with a scroll wheel, Option-scroll in the value field.

To change values in coarse increments, do one of the following:
m Shift-drag in the value field.

m Shift-click the left arrow to decrease a value, or Shift-click the right arrow to increase a 
value.

m If you have a mouse with a scroll wheel, Shift-scroll in the value field.

When a value slider or value field is active (highlighted), press Tab to move to the next field.

Value slider with combined 
slider and numeric entry field

Separate slider and numeric 
entry field
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Using Timecode Value Sliders
Compressor uses timecode value sliders for all timecode entry fields. In addition to 
being able to enter timecode values directly, you are able to “scrub” the timecode value 
by dragging.

If you place the pointer over a segment of the timecode, small arrows appear above 
and below that segment. 

You can drag up or to the right to increase the value in that segment (values in 
segments to the left will also increment if your dragging causes the selected segment 
to roll over). Dragging to the left or down decreases the value. You can hold down the 
Option key to make the value changes slower, or the Shift key to make them faster.

Alternatively, you can click the up and down arrows on each side of the timecode value or 
press the keyboard’s Up and Down Arrow keys to increase or decrease the timecode value.

You can control which segment is affected by the up and down arrows by selecting a 
segment so that a caret appears below the segment. You can also use the keyboard’s 
Left and Right Arrow keys to select other segments.
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General Compressor Keyboard Shortcuts

Key command Function

Brings the Inspector window to the front.

Brings the History window to the front.

Brings the Preview window to the front.

Brings the Settings tab to the front.

Brings the Destinations tab to the front.

Saves the current batch.

Saves the current batch as a new batch.

Creates a new untitled batch.

Opens a saved batch.

Opens the Preferences window.

Imports a source asset to create a new job in the batch.

Creates a new surround sound group job in the batch.

Submits the current batch.

Submits a batch from an open Droplet.

Removes a selected item from the Batch, Preview, or Destinations 
window.

Navigates up list items in the Batch, Destinations, Settings, and 
Filters lists.

Navigates down list items in the Batch, Destinations, Settings, 
and Filters lists.

Navigates through text fields in all panes.

Opens the Mount Cluster Storage dialog.

Opens Compressor Help.

Ioption

1 

2 

3 

4

S

Sshift

N

O 

, 

l 

Ishift

Soption

return 

delete 

tab 

Mshift

shift ? 
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Preview Window Keyboard Shortcuts

Key command Function

 
Starts fast reverse motion. 

Starts fast forward motion.

Moves the clip backward frame by frame.

Moves the clip forward frame by frame.

Starts or stops clip playback.

Adds or removes a marker.

When the playhead is positioned on a marker, opens the Edit 
Marker dialog.

Sets an In point for the clip.

Sets an Out point for the clip.

J 

L 

space 

M 

E

l 

O 
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4 Importing Source Media Files

The first step in the Compressor transcoding process 
is to import at least one source media file into the 
Batch window. 

Importing one or more source media files into a batch creates jobs (one for each source 
media file). This is the first step toward being able to transcode the source media files 
into the desired output files.

You can import source media files to create jobs from any folder that you have access 
to. Compressor supports a wide variety of source media formats, from many popular 
QuickTime formats to Dolby Digital Professional (AC-3), MPEG-1, MPEG-2, and MPEG-4. 

See “Adding Source Media Files to a Batch to Create Jobs” on page 75 for 
further information.

This chapter covers the following topics:
Â About the Batch Window (p. 74)
Â Adding Source Media Files to a Batch to Create Jobs (p. 75)
Â Using the Inspector with Source Media Files (p. 82)
Â Tips on Importing Source Media Files (p. 85)
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About the Batch Window
The Batch window provides a central location for organizing your transcoding tasks and 
quickly assigning settings. When you first open Compressor, an untitled Batch window 
appears. Think of batches as documents that can be saved, closed, and opened again. 
You use the toolbar at the top of the Batch window to open all other task windows.

General Batch Window Information
Batches are the heart of your Compressor workflow, and the Batch window is where 
you work with the batches. The Batch window supports having multiple batches open 
at once, showing them as separate tabs. 

To create a new batch:
m Choose File > New Batch (or press Command-N).

A new untitled batch is added to the Batch window.

See “Saving and Opening a Batch File” on page 116 for more information about 
batch files.

You can even have multiple Batch windows open, with each containing a different 
batch, by dragging a batch’s tab to a new location. See “About the Tabs” on page 47 for 
information on dragging tabs to open or close additional Batch windows.

The Batch window has a Submit button, located in the lower-right corner, that you can use 
to begin transcoding the currently selected batch. The lower-left corner shows the status 
of the current batch (how many jobs it contains and whether it has been submitted).

Jobs area

Toolbar

Batch tabs

Batch status Batch submission button

Show/hide toolbar 

Currently selected 
batch name

Each tab is for a

different batch.

The new batch’s tab
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About the Batch Window Toolbar
The Batch window has a customizable toolbar along its top. You can choose whether to 
show or hide the toolbar by clicking the button in the window’s upper-right corner.

You can choose to have a variety of items in the toolbar, such as items to open, save, or 
close a batch. See “Customizing the Toolbar” on page 50 for details on the items you 
can add and how to add them.

Adding Source Media Files to a Batch to Create Jobs
You need to import the source media files into the batch in the Batch window before 
you can add any transcoding settings to them. Once they are imported into the batch, 
the source media files create a job, which is the first step to getting the files transcoded. 
There are special methods to use when importing surround sound source media files.

Show/hide toolbar 
button (with the toolbar 
hidden in this example)
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Adding Standard Source Media Files to Batches
Following are the details for adding standard (non–surround sound) source media files 
to a batch.

To add source media files to a batch:
1 Open Compressor.

The Batch window opens with an empty batch tab named Untitled.

2 Do one of the following:

Â Choose Job > New Job With File (or press Command-I), navigate to the relevant 
media file folder, select one or more source media files, and then click Open.

Note:  Choose Job > New Job With Surround Sound Files (or press Command-Shift-I) 
to create a new job using a set of audio files for surround sound output. See “Adding 
Surround Sound Source Media Files to Batches” on page 78 for more information.

Â Click the Add File button (in the Batch window toolbar, if visible), navigate to the 
relevant media file folder, select one or more source media files, and then click Open.

Â Control-click an empty area of the batch and choose New Job With File from the 
shortcut menu. You can then navigate to the relevant media file folder, select one or 
more source media files, and then click Open.

Â Open your source media file folder and drag one or more source media files into 
the batch. 

Untitled batch tab

Empty batch area with a
placeholder job
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Note:  You can combine the above steps by selecting all the source media files you 
want to transcode before opening Compressor and then dragging them to the 
Compressor application icon. This opens Compressor and adds the media files to the 
default untitled batch at the same time. 

3 Save the batch by doing one of the following:

Â Choose File > Save As.
Â Press Command-Shift-S.

4 Enter a name for the batch and choose the location where you want to save it in the 
dialog that appears. Click Save when done.

The tab in the Batch window changes to match the name of the file. 

Note:  If your Finder preferences are set to show the extensions, the extension 
“.compressor” appears in the tab along with the name.

You are not actually required to name and save your batches, and for quick jobs you 
might decide not to. However, naming and saving a batch makes it easy to go back and 
resubmit it later if you find that the output files were not as expected, or if your needs 
change. It also makes it easier to figure out what is in the History window and the 
Batch Monitor if you submit multiple batches in a short period of time.

The batch now contains your selected media files, each in its own job. Source media 
files with video content also include a thumbnail image and a scroller that you can use 
to scroll through the video.

You can change the source media file assigned to a job.

You can drag this to
scroll through video files.

Click anywhere in the job 
to see this file’s attributes 
in the Inspector window.

Each source media file
creates a job.

The targets for this job 
will appear in this area.
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To change the source media file assigned to a job:
1 Select the job for which you wan to change the source media file.

2 Do one of the following:

Â Choose Job > Source > File, navigate to the relevant media file folder, select one or 
more source media files, and then click Open.

Â Control-click the job and choose Source from the shortcut menu. You can then 
navigate to the relevant media file folder, select one or more source media files, and 
then click Open.

Â Drag a new source media file to the job.

Any targets you had already configured remain, and are now applied to the new source 
media file. You can also remove a source media file from a job if needed.

To remove a source media file from a job:
m Control-click the job and choose Clear Source from the shortcut menu.

To remove a job from a batch, do one of the following:
m Select the job and press Delete.

m Control-click in an empty part of the batch and choose Remove All Jobs from the 
shortcut menu.

These jobs are now ready to have a target added to them. Targets include the settings 
and destinations required to make this a job that you can submit for transcoding. See 
Chapter 6, “Finalizing Jobs and Submitting Batches,” on page 101 for information on 
adding targets to jobs. Also see Chapter 5, “Creating, Previewing, 
and Modifying Settings,” on page 87, for information on how to create your own settings.

Adding Surround Sound Source Media Files to Batches
There are two methods you can use to add audio files to a batch to create a surround 
sound job: an automatic method that relies on file naming to map the audio files to the 
proper channels and a manual method that allows you to manually assign the audio 
files to the channels.

Each method results in a job that you can add a setting to that supports surround 
sound audio outputs, such as Dolby Digital Professional, AIFF, and several audio codecs 
in the QuickTime Movie output format.

Important:  Some of the output formats have multiple configurations for the surround 
sound audio channels. Be sure you know which configuration your intended playback 
device requires. For example, the AIFF output format provides four different 
configurations for 5.1 (6-channel) audio outputs, with the difference being the order of 
the channels.
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Assigning Files to Surround Sound Channels (Automatic Method) 
Compressor offers some streamlined channel assignment techniques that can save 
you time.

To assign files to surround channels with channel identifier codes:
1 Append the channel identifier code of the target surround channel to the filename of 

each source audio file. (See the table below for a list of the appropriate channel 
identifier codes.)

For example, to assign an AIFF file to the left surround channel, rename the file as 
filename-Ls.aiff (where filename is the name of your file).

Note:  Mac OS X may add a file extension like .aiff. This will not interfere with this 
channel assignment method. 

This procedure only works when you drag and drop files into the Batch window. If you 
drag the files onto the Compressor application icon, they will appear as separate source 
files, each in its own job.

Note:  If you are creating Dolby Digital Professional (AC-3) surround sound streams, you 
will not use all the channels listed in the table at once. See “Audio Tab Settings” on 
page 131 for a diagram of the Dolby audio coding modes.

2 Drag the renamed source audio files to the Batch window.

If the following conditions are met, Compressor automatically collapses the entire group 
of files into what appears as a single surround source media file in the Batch window:

Â The files in the group must be named correctly. (See table above.)
Â The total number of files in the group must be fewer than seven.

Channel assignment Channel identifier code

Left front channel -L

Right front channel -R

Center front channel -C

Left surround channel -Ls

Right surround channel -Rs

Center surround channel -S

Low frequency channel 
(Subwoofer, LFE)

-LFE
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Assigning Files to Surround Sound Channels (Manual Method)
Follow these steps to use the manual method for assigning individual audio files to 
surround sound channels. 

To manually assign source audio files to channels of a surround sound stream:
1 Do one of the following to import the source audio files:

Â Click the Add Surround Sound button in the Batch window.
Â Choose Job > New Job With Surround Group (or press Command-Shift-I).
Â Control-click in the batch and choose New Job With Surround Group from the 

shortcut menu. 
The channel assignment interface opens.

2 Do one of the following to assign a source audio file to a particular channel. 

Â Drag the source audio file from the Finder to the icon for a specific channel (for 
example, “L”).

Â Click the icon for a specific channel (for example, “L”) and use the Open dialog to 
locate the source audio file intended for that channel. 

The file is now assigned to the “L” (Left Front) Channel.

3 Repeat Step 2 for each of the source audio files that you intend to include in the 
surround stream.

Note:  If you are creating Dolby Digital Professional (AC-3) surround sound streams, you 
will not use all the channels listed in the table at once. See “Audio Tab Settings” on 
page 131 for a diagram of the Dolby audio coding modes.

4 When you have finished adding source audio files to the channel assignment interface, 
click OK.

The group of surround files appears as a single surround source media file job in the 
Batch window.
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About Surround Sound Jobs
Once you have created a surround sound job, the batch window shows the surround 
sound icon in the source media file thumbnail and the Inspector window shows the 
channels and their assigned files.

You can change any of the file assignments in the Inspector window.

To change a surround sound file assignment:
1 Click the speaker icon of the channel you want to change.

A file selection dialog opens.

2 Locate the file to assign to that channel and click Open.

See Chapter 8, “Creating Dolby Digital Professional Output Files,” on page 129, for 
information on creating Dolby Digital Professional output files. See the Soundtrack Pro 
User Manual for comprehensive information about creating surround sound audio files. 
If you are planning to make DVDs using DVD Studio Pro, see the DVD Studio Pro User 
Manual for more information about the DVD authoring workflow.

Click a channel’s icon to 
change the file assigned 
to that channel.
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Using the Inspector with Source Media Files
When you select a batch’s job, the Inspector window shows you information about the 
job’s source media file.

The Inspector window contains two tabs: A/V Attributes and Additional Information.

A/V Attributes Tab
The A/V Attributes tab contains general information about the source media file and is 
divided into three sections.
Â File information:  This section shows the filename, location, and type of file.
Â Video information:  This section, when applicable, shows all video-related information 

about the file. This includes its frame size, frame rate, and timecode information.
Â Audio information:  This section, when applicable, shows all audio-related information 

about the file. This includes its sample size and sample rate.
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Additional Information Tab
The Additional Information tab allows you to see and modify a variety of metadata 
items that might have been added in other applications such as Final Cut Pro or 
QuickTime. It also includes the ability to associate a closed caption file with the file.

To associate a closed caption file with a job’s source media file:
1 Click the job to show the source media file’s attributes in the Inspector window.

2 Click the Additional Information tab.

3 Click Choose, locate the closed caption file (must be a Scenarist closed caption format 
file, usually with a “.scc” file extension), and click Open.

Note:  Closed caption data is supported by the H.264 for Apple Devices, MPEG-2, and 
QuickTime Movie output formats.

Depending on the output format of the job’s target, Compressor applies the closed 
caption file to the output media files.
Â For QuickTime outputs:  Compressor adds the closed caption file as a closed caption 

track to the QuickTime output file. You can view the closed captions using QuickTime 
Player (version 7.2 or later).

Â For MPEG-2 elementary stream outputs:  Compressor embeds the closed caption data 
in an elementary MPEG-2 video stream so that it can be used for DVD authoring. 
DVD Studio Pro will retain this closed caption data when the video stream is used in 
a track in a standard definition NTSC DVD project. You can use Apple DVD Player to 
play the DVD Studio Pro build files and verify that the closed caption data is present.

Â For MPEG-2 program and transport stream outputs:  Compressor embeds the closed 
caption data in program and transport MPEG-2 streams using the EIA-708 ATSC protocol.
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Important:  The timecode values in the closed caption file must directly relate to the 
timecode of the source media file. You can open a closed caption file in TextEdit to see 
the timecode values it contains (the actual text is encoded and cannot be read this way).

To add an annotation:
1 Click the job to show the source media file’s attributes in the Inspector window.

2 Click the Additional Information tab.

3 Use the Add Annotation pop-up menu to choose the type of annotation.

4 Double-click the corresponding Value field and enter the annotation text.

Note:  This Add Annotation feature is supported by the H.264 for DVD Studio Pro, H.264 
for Apple Devices, MP3, and QuickTime Movie output formats.
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Tips on Importing Source Media Files
Here are some additional tips on importing source media files.

Highly Compressed Source Files
It is strongly recommended that you do not use highly compressed source files, such as 
MPEG files, as your source files, because they can cause undesirable artifacts in the 
encoded video.

QuickTime Reference Movies and Distributed Processing
Strictly speaking, only actual QuickTime movies (not QuickTime reference movies) are 
supported for distributed processing. If you submit a reference movie for distributed 
processing, make sure media files specified in the reference movie are available to each 
node of the Apple Qmaster cluster. In other words, put the media on the shared 
(cluster storage) volume. For more details, see the Distributed Processing Setup guide.

Importing MPEG-2 Files
When you import an MPEG-2 file, Compressor must parse the file before you can play it 
in the Preview window. Parsing the file involves determining its frame structure and 
other necessary information about the file. Since the frame structure can change 
throughout the file, Compressor must scan through the entire file, which can take 
several minutes for longer files.

This does not happen with MPEG-2 elementary files encoded using Compressor that 
had the “Add DVD Studio Pro metadata” checkbox selected. See “Extras Tab” on 
page 197 for more information.

About Dolby Digital Professional Source Media Files
You can use Dolby Digital Professional AC-3 audio files as source media files for your 
jobs. There are two common reasons to want to do this:
Â To test a file you just encoded. Since you cannot preview the Dolby Digital Professional 

output settings, importing an encoded file into a job allows you to play it and verify 
the settings.

Â To convert a Dolby Digital audio file to another format. Since not all media players 
include Dolby Digital decoders, you may find that you need to transcode the file into 
another format.
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Compressor includes a Dolby Digital decoder that it uses whenever you play or 
transcode Dolby Digital audio files. This makes it possible to verify the Dolby Digital 
Professional output settings of a previously encoded file on your system without 
requiring you to have an external Dolby Digital decoder. To hear surround sound you 
must have an external surround sound device connected to your computer’s USB or 
FireWire output. The audio is mixed down to two channels if you play the audio using 
your system’s stereo speakers.

Important:  Since the audio output is already decoded and not in the Dolby Digital format, 
the optical output cannot be used when playing Dolby Digital files from Compressor.

∏ Tip:  Add an “.ac3” extension to the filename if Compressor does not allow you to add it 
to a job.

Automatic Values and Nonstandard QuickTime Files
Compressor uses a variety of tactics to determine the proper values for any settings that 
are set to Automatic. In most cases, QuickTime files contain metadata that specify the 
various attributes of the file, such as frame rate and frame size. In some cases, this 
metadata is not present, forcing Compressor to try to determine this information, or it is 
incorrect, causing Compressor to generate incorrect values for the Automatic settings. 

Additionally, some QuickTime files use nonstandard settings that require Compressor to 
choose an automatic value that may not be suitable.

For these reasons, it is a good idea to verify the values in the Inspectors for those 
settings that are set to automatic. See “About the Automatic Settings” on page 55 for 
more information.
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5 Creating, Previewing, 
and Modifying Settings

A setting is a combination of transcode attributes, such as 
output format, filter, and geometry settings, that you apply to 
the source media file as a part of the transcoding process.

You need to assign at least one setting to a source media file before you can transcode 
it. Once you have a source media file in the current batch in the Batch window, you can 
either select a pre-existing setting or create a customized one using the Settings tab. 

Once you have all the settings that you think you need, you won’t have to open the 
Settings tab again because you can select the settings directly from the Batch window.

This chapter covers the following:
Â About the Settings Tab (p. 88)
Â Using the Inspector with Settings (p. 92)
Â Duplicating Settings (p. 93)
Â Creating a Setting from Scratch (p. 94)
Â Previewing a Setting (p. 96)
Â Deleting Settings (p. 97)
Â Creating Groups of Settings (p. 98)
Â Distributing and Sharing Settings (p. 99)
Â Example:  Creating Custom Groups and Settings for DVD (p. 99)

Note:  A setting is just one kind of Compressor preset. You can also create, modify, save, 
or remove Destination presets. For more information on destinations, see “Creating and 
Changing Destinations” on page 305. 
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About the Settings Tab
The Settings tab allows you to manage your settings. In conjunction with the Inspector 
window, the Settings tab also provides details of all the settings with easy access to 
common transcoding controls.

You use the Settings tab (together with the Inspector window) to create, modify, or 
delete settings, as well as create group folders for multiple settings. You can also create 
Droplets from the Settings tab.

The Settings tab contains a list of the existing settings and the necessary buttons to 
add, remove, or duplicate a setting, and create groups and Droplets. 

Settings Tab Buttons
The following buttons are located along the top of the Settings tab.
Â Create a New Setting Group:  Click to create a folder where you can group existing 

settings. Use this button as a way to organize your settings into some sort of logical 
order, keeping the Settings tab easy to navigate. Once settings have been created, 
you can assign a whole group of settings to a source media file (by dragging it onto 
the source file in the Batch window) or you can create a Droplet containing multiple 
settings. See “Creating Groups of Settings” on page 98 for more information. 

Click the disclosure
triangles to show
or hide a setting

group’s contents.

Save Selection
as Droplet

Create a New
Setting Group

Duplicate Selected 
Setting button

Delete Selected 
Settings button

Settings list

Create a New 
Setting button

An example setting



Chapter 5    Creating, Previewing, and Modifying Settings 89

 

Â Save Selection as Droplet:  Click to create a Droplet from an existing setting or group 
of settings. Droplets allow you to transcode a media file by simply dragging one or 
more source media files over the Droplet icon. Once you have selected your setting 
or group and clicked the Save Selection as Droplet button, the Save dialog asks you 
to name your Droplet, choose a location for it, and choose a destination folder for 
the relevant output media files. Once you complete this dialog, your Droplet is ready 
and you can drag as many files as you want to its icon. See Chapter 25, “Using 
Droplets,” on page 315 for more information about Droplets.

Â Duplicate Selected Setting:  Click to duplicate a selected setting in the Settings tab. 
The Duplicate button copies the exact settings of the setting currently selected in 
the Settings tab. Using the Duplicate button allows you to create a new setting from 
a pre-existing one; you can then adjust that setting according to your needs, rather 
than creating a new setting from scratch.

Â Create a New Setting ( + ):  Click to add a new setting to the Settings tab. A dialog 
appears for you to choose an output file format (H.264 for Apple Devices, MPEG-2, 
MPEG-4, and so on) when you click this button.

Â Delete Selected Settings ( – ):  Click to remove a setting from the Settings tab. You are 
not asked for a confirmation, so be sure you want to remove the setting before 
clicking this button.

Note:  You cannot delete the Apple settings.

Settings List
When you first open the Settings tab it contains a set of pre-existing (Apple) settings 
supplied with Compressor. The Settings tab displays name and description details of all 
existing settings and groups stored on your computer.

The Apple setting group
with subgroups

New “Untitled” setting
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New settings appear in the Custom group folder with the default name “Untitled ___” 
with “___” being the file format you chose from the ( + ) pop-up menu. It’s a good idea 
to change the setting name to something meaningful, such as details of the settings or 
distribution method associated with the setting. Click the setting in the Settings tab to 
open it in the Inspector window. 

Use the Name field in the Inspector window to enter a name. Use the Description field 
to enter more information about each setting. This information only appears within the 
Settings tab and can help you keep track of your files when you have many settings. 

You can also organize your settings by putting them in group folders. Once you have 
created and named a group folder, you can drag any existing custom setting into it. 
When you drag a setting to a group, you remove it from its current location. You can 
also drag individual settings from a group to a source media file. See “Creating Groups 
of Settings” on page 98 for more information.

Click a setting to see it in
the Inspector window.

Enter the selected 
setting’s name and 
description in the 
Inspector window.
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Selecting a Target
Whenever you select a batch’s target, its setting immediately appears in the Inspector 
window with “Selected Target” in the Name field. This is a temporary copy of the 
setting and not the setting itself, so you can make temporary modifications to the 
setting for just that one batch submission. 

When you modify the target’s setting, the Save As button at the bottom of the 
Inspector window becomes active. Click Save As to save the modified setting with a 
new name. The saved copy appears in the Settings tab as Setting Name-Copy, and 
immediately becomes the selected setting in the Settings tab.

Select a target in the 
Batch window to see 
its settings in the 
Inspector window.

The setting’s 
name shows as 
“Selected Target”.

Click the Save As button 
to save this as a new 
setting with any 
changes you make.
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Using the Inspector with Settings
The Inspector window contains the following panes that let you create and modify all the 
settings related to your output media file, such as filters, geometry, and output format:
Â Summary pane:  Provides a detailed summary of a selected setting. See “Summary 

Pane” on page 58 for more information about this pane.
Â Encoder pane:  Allows you to select an output file format and other related video and 

audio settings. See the following specific sections for more information about the 
different encoder panes:
Â “About the AIFF Encoder Pane” on page 125
Â “About the Dolby Digital Professional Encoder Pane” on page 130
Â “About the DV Stream Encoder Pane” on page 145
Â “About the H.264 for Apple Devices Encoder Pane” on page 148
Â “About the H.264 for DVD Studio Pro Encoder Pane” on page 153
Â “About the Image Sequence Encoder Pane” on page 160
Â “About the MPEG-1 Encoder Pane” on page 169
Â “About the MPEG-2 Encoder Pane” on page 184
Â “About the MPEG-4 Encoder Pane” on page 212
Â “About the QuickTime Movie Encoder Pane” on page 224
Â “About the QuickTime Export Components Encoder Pane” on page 239

Â Frame Controls pane:  Allows you to customize changes to the frame size, frame rate, 
or field dominance. (See “Working with Frame Controls” on page 255 for 
more information.)

Â Filters pane:  Allows you to add filters to your setting to enhance the quality of the 
output files. (See “About the Filters Pane” on page 244 for more information.)

Â Geometry pane:  Allows you to crop and set the frame size for your output media file. 
(See “Adding Geometry Settings” on page 267 for more information.)

Â Actions pane:  Allows you to execute AppleScripts and send email notifications. (See 
“Adding Actions to a Setting” on page 277 for more information.)

The Inspector window is also where you name your settings, as well as add descriptions 
to make it easier to remember what you customized later. 
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Duplicating Settings
If there is a setting that contains some attributes that you want to use in another 
setting, you can duplicate the existing setting and make the necessary modifications to 
the duplicated one, rather than creating a new setting from scratch. Duplicating a stock 
Apple setting and then adjusting the duplicate to suit your needs is the most 
convenient way to create custom settings.

To duplicate a setting:
1 Select the setting that you want to duplicate in the Settings tab. 

2 Click the Duplicate Selected Setting button.

A new setting appears in the Custom folder with the word Untitled appended before 
the original name.

3 Select the new setting in the Custom folder.

4 Open the following Inspector panes to modify the following items:

Â The setting name and description:  Change the name and description to make it easy 
to remember why you created this custom setting.

Â Encoder pane:  Change the output format and video and audio codecs and their 
associated attributes here. 

Â Frame Controls pane:  Change any attribute in the Frame Controls pane. 
Â Filters pane:  Change any filter attributes here. Click the checkbox next to a filter to 

add it to the setting, or deselect it to remove it from the setting. 
Â Geometry pane:  Change any attribute in the Geometry pane. 
Â Actions pane:  Change any attribute in the Actions pane. 

Select the setting
to be duplicated.

Click the Duplicate Selected 
Setting button to duplicate 
the selected setting.
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5 If you have modified the setting in any way, you can do either of the following to save 
the changes:

Â Click the Save button at the bottom of the Inspector window to save the changes.
Â Attempt to select any other setting.

A dialog asks if you want to save the changed attributes.

Click OK to save the changes, or click Revert to cancel the changes and return to 
the Inspector.

See “Assigning Settings to Source Media Files” on page 102 for information about 
assigning settings. 

Creating a Setting from Scratch
If the pre-existing settings are not sufficient for your transcoding needs or if you simply 
want additional settings, you can create your own.

Note:  The recommended procedure for creating custom settings is to duplicate a stock 
Apple setting and then adjust the copy to suit your needs. For information on 
duplicating settings, see “Duplicating Settings” on page 93.

To create a setting:
1 Click the Add ( + ) button in the Settings tab and choose an output format from the 

pop-up menu.
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A new setting called Untitled appears in the Custom folder of the Settings tab, 
appended with the selected output file format (for example, Untitled MPEG-2). 

The Inspector window also changes to show this setting’s parameters.

Note:  You can always change the output file format for that setting in the Encoder pane 
of the Inspector, but be sure to change the setting name to reflect its output file format.

2 Enter a suitable name and description for the setting in the Name and Description 
fields in the Inspector window.

3 Configure the setting as needed in the Inspector window.

4 Click Save to Save the setting.

See “Assigning Settings to Source Media Files” on page 102 for information about 
assigning settings.

Note:  You can create groups of settings that can then be applied to a media file in one 
step. See “Creating Groups of Settings” on page 98 for more information. 

The new untitled setting
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3 Make any necessary adjustments to your setting while previewing the media file in the 
Preview window.

Note:  To preview the effect of the filters on your media file, you need to make sure that 
the checkbox for that particular filter is selected in the Filters list. Otherwise, the 
Preview window won’t recognize that filter, and it will not be part of the transcoding 
settings for that job. See Chapter 23, “Using the Preview Window,” on page 283, for 
more information about previewing your settings and “About the Filters Pane” on 
page 244 for more information on filters.

Deleting Settings
Use the Delete Selected Settings button to delete custom settings. 

Note:  You cannot delete Apple settings.

To delete a setting:
1 Select the setting that you want to delete.

2 Click the Delete Selected Settings ( – ) button or press the Delete key on your keyboard.

This half of the 
Preview window 
shows the effects 
of the Inspector 
window changes.

Make adjustments while
previewing the media file

in the Preview window.

Select the item you want
to change.

Warning:  There is no warning when you delete a setting, and you cannot undo the 
deletion to restore the setting.
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Creating Groups of Settings
Creating a group of settings allows you to quickly assign multiple settings to a source 
media file. 

To create a group of settings:
1 Click the Group button in the Settings tab.

A folder called Untitled appears in the Settings tab with 0 Settings in the Description 
column. You cannot modify this field. It displays the number of settings the group contains.

2 Enter a suitable group name in the Inspector Name field.

3 In the Settings tab, drag the relevant settings into the group folder.

Note:  You can also create hiearchies of groups (groups within groups). Just drag a 
group folder into another group folder.

Click the Group button.

A new untitled group
with 0 settings is created.

Enter a name for 
the new group.

This custom group
contains three other
custom groups, each
with its own settings.
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The Description field displays the number of settings your group contains. Once you 
have at least one setting inside the group folder, you can click the disclosure triangle 
next to the group folder to show or hide the setting group details. You can also see full 
details of the settings in any group by selecting the group and then looking at the 
Summary pane in the Inspector window.

Note:  You can also drag settings from one group to another group.

To add the same setting to more than one group:
1 Select the setting.

2 Click the Duplicate button to create a copy, and rename the duplicated setting.

3 Drag the duplicated setting to another group folder.

Distributing and Sharing Settings
Both pre-existing and newly created settings are stored in the home folder at /Users/
username/Library/Application Support/Compressor as XML files, with the file extension 
.setting. You can distribute and share any of these settings by placing them into the 
same location within the home folder of whatever computer you distributed the 
settings to. You can also transfer these files the same way that you would distribute any 
other file, by emailing them as an attachment or placing them on a server.

Example:  Creating Custom Groups and Settings for DVD
For this example, you are working on an HD project that will eventually end up on both 
an HD and an SD DVD. Before that happens, though, you also need to supply SD DVDs 
of the dailies.

An easy way to handle this is to create two groups of settings: 
Â Settings for the dailies:  These settings would include an AIFF audio encoder (since 

you want it done fast and disc space will not likely be an issue) and an MPEG-2 
encoder with an SD frame size using the fastest settings (since quality is not the 
highest concern). This could also be an HD encoder if you have an easy way to play 
an HD DVD.

Â Settings for the final disc:  These settings would include an AC-3 audio encode, an 
H.264 HD for DVD video encode, and an MPEG-2 encode using the Frame Controls to 
ensure a high-quality SD output video.

Â You would most likely create a third settings group that would be named after this 
project and would contain the above two groups.



100 Chapter 5    Creating, Previewing, and Modifying Settings

 

To create the groups for dailies and final outputs:
1 In the Settings tab, click the Group button three times to create three new 

untitled groups.

2 Select the first of the new groups and, using the Inspector window, name it after 
the project.

3 Select the second of the new groups and name it Dailies.

4 Select the third of the new groups and name it Final Discs.

5 In the Settings tab, drag the Dailies and Final Discs groups up until a black box 
surrounds the group named after the project, and then release them.

Note:  You can select multiple groups or settings by holding down Shift while 
selecting them.

This places both of these groups within the project’s group.

6 Locate settings in the Apple settings that come closest to matching what you need 
each setting to do in these new groups.

7 Make a copy of each setting by clicking the Duplicate Selected Setting button.

8 Select each copied setting, rename it, and then drag it to the proper folder.

You can then select each setting and make any necessary changes to it. 

When you have imported the source media files and created their jobs, you can just 
assign the appropriate group (Dailies or Final Disc) and all the proper settings are 
applied to the targets.

This custom group
contains the other

custom groups, each
with its own settings.

This custom group
contains the settings

used to create the dailies.

This custom group
contains the settings

used to create the
final disc.
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6 Finalizing Jobs 
and Submitting Batches

A job consists of a source media file with at least one target, 
comprised of a setting and a destination, assigned to it. You 
created the jobs by importing the source media files. Adding 
targets makes them ready to be submitted for transcoding. 

You created a job when you imported source media files into a batch. For the job to be 
complete, and thus ready to be submitted for transcoding, you need to add one or 
more targets to it. Each target contains a setting, which defines everything about what 
the file is to be transcoded into, and a destination, which defines where the transcoded 
file is saved and how its name is generated. Each target also allows you to manually 
enter the name for the output file.

Compressor gives you a number of different options for assigning settings and 
destinations to your targets and submitting and resubmitting batches.

Note:  See “About the Settings Tab” on page 88 and “About the Destinations Tab” on 
page 306 for more information about creating presets in these windows.

See the following sections for assigning settings and destinations and 
submitting batches:

Assigning settings
Â Assigning Settings to Source Media Files (p. 102)
Â Replacing an Assigned Setting with a Different Setting (p. 105)
Â Modifying an Assigned Setting (p. 105)

Assigning destinations
Â Assigning Destinations to Source Media Files (p. 107)
Â Setting the Output Filename (p. 108)
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General job and target information
Â About Targets (p. 109)
Â About Adding and Copying Jobs (p. 110)
Â About Chaining Jobs (p. 111)

Submitting batches
Â Submitting a Batch (p. 112)
Â Resubmitting a Batch (p. 116)
Â Submitting a Final Cut Pro Project for Transcoding (p. 117)
Â Transcoding Different Clips from One Source Media File (p. 122)

Saving and opening batches
Â Saving and Opening a Batch File (p. 116)

Assigning Settings to Source Media Files
You can use a variety of methods to assign settings to a job. Some are better suited to 
working with one job, such as dragging the setting from the Settings tab, while others are 
better for assigning the same settings to a group of jobs, such as using the shortcut menu.

Note:  The following steps assume you have already added source media files to a 
batch, creating the jobs to which you are adding the settings. See Chapter 4, 
“Importing Source Media Files,” on page 73, for details on importing source media files.

∏ Tip:  You can Option-click a setting group’s disclosure triangle to expand that group 
(and all subgroups) and show all settings it contains.



Chapter 6    Finalizing Jobs and Submitting Batches 103

 

To assign a setting to a job by dragging:
1 Select one or more settings or groups of settings in the Settings tab.

2 Drag the settings to the job in the Batch window.

A new target is created for each setting that you added to the batch’s job.

Note:  You can only apply the settings to a single job when you assign them by dragging.

A job with a source
media file in the

Batch window

Select one or more (two
in this case) settings to

apply to the job.

New targets are added 
for each setting you 
dragged to the job.
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To assign a setting to a job using the Target menu:
1 Select one or more jobs in the Batch window’s current batch.

2 Choose Target > Add Target With Setting.

The settings selection dialog appears over the batch window.

3 Choose one or more settings or groups of settings to assign to the jobs, and click Add.

The settings are assigned to each selected job. 

To assign a setting to a job using the shortcut menu:
1 Select one or more jobs in the Batch window’s current batch.

2 Control-click one of the selected jobs and choose Add Target With Setting from the 
shortcut menu. 

The shortcut menu lists the settings based on their groups. You cannot directly choose 
a group to be assigned, but each group contains an “All” item that selects all the 
group’s settings.

Note:  You cannot select multiple individual settings with this method.

3 Choose a setting or All to choose all settings in a group. 

The settings are applied to all selected jobs. 



Chapter 6    Finalizing Jobs and Submitting Batches 105

 

Replacing an Assigned Setting with a Different Setting
After you have assigned a setting to a job, you might find a more suitable setting and 
decide to change the target’s setting to the new one. You can use several methods to 
change a target’s setting. All of these methods leave the destination and output 
filename settings as they are.

To replace a setting already assigned to a target with a different setting, do one of 
the following:

m Choose Target > Change Setting. This opens the setting selection dialog where you can 
choose a new setting and click Add to assign it to the selected target.

m Control-click the target and choose Change Setting from the shortcut menu. This 
opens the setting selection dialog where you can choose a new setting and click Add 
to assign it to the selected target.

m Select the new setting in the Settings tab and drag it to the target.

Note:  With all the above methods, if you select multiple settings, only the top one is 
assigned to the target. 

Modifying an Assigned Setting
You can edit or change any component of a setting that has already been assigned 
to a source media file in the Batch window (identified as Selected Target in the 
Inspector window).
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To modify a setting already assigned to a source media file in the Batch window:
1 Select the target in the batch with the setting that you want to change.

The setting appears in the Inspector window with “Selected Target” in the Name field. 
This is a temporary copy of the setting and not the setting itself, so you can make 
temporary modifications to the setting for just that one batch submission. 

2 Make the changes to the setting.

When you modify the setting, the Save As button at the bottom of the Inspector 
window becomes active. 

3 Click Save As to save the modified setting with a new name. 

The saved copy appears in the Settings tab as Setting Name-Copy and immediately 
becomes the selected setting in the Settings tab.

Note:  You do not have to save the modified setting, but it is a good idea to save it in 
case you need to use it again later.

Select a target in the 
Batch window to see 
its settings in the 
Inspector window.

The setting’s 
name shows as 
“Selected Target”.

Click the Save As button 
to save this as a new 
setting with any 
changes you make.
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Assigning Destinations to Source Media Files
When you assign settings to your targets, the default destination is automatically also 
assigned. You can set the default destination with Compressor preferences. (Choose 
Compressor > Preferences.) This can be one of those supplied with Compressor or a 
custom destination you have created. See “Creating a Destination” on page 308 for 
details on working with destinations. 

You can replace the default destination with any other destination, or even manually 
choose a location to save the output file to. There are a number of different ways to 
assign a destination to a source file. As with assigning settings, different methods have 
different advantages.

To assign a destination by dragging:
1 Select a destination in the Destinations tab.

2 Drag the destination to the target in the Batch window.

The destination part of the target updates to the new destination.

Note:  You can only apply the settings to a single job when you assign them by 
dragging. Additionally, you cannot create a temporary destination using this method.

Using this dragging method, you can also create a new target (with an empty setting) 
by dragging the destination to an empty part of the job. 

Drag the destination to a
job with a target in the

Batch window.

Select a destination to
apply to the target.
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To assign a destination using the Target or shortcut menu:
1

 

Select all targets that you want to set the destination on.

 

2

 

Do one of the following:

Â

 

Choose Target > Destination > 

 

destination.

 

 
Â

 

Control-click one of the targets and choose Destination > 

 

destination

 

 from the 
shortcut menu. 

 

Note:  

 

You can also assign a temporary destination by choosing Other. This opens the 
File Selection dialog and allows you to create a new destination for just that batch 
submission. This destination is not saved and applies only to the submitted batch.

Once you have assigned the destinations, they appear in the target’s destination section.

 

Setting the Output Filename

 

In addition to defining where to save the output file, destinations also define how the 
output filename is created. Once you have assigned a destination, the output filename 
is complete. You can choose to use it as is or you can manually modify it or enter a 
new name.

 

To modify or enter a new output filename:
m

 

Click in the output filename area and edit the existing name, or triple-click the existing 
name to enter a new name.

Destination 
shortcut menu

The output filename
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About Targets

 

Targets contain three items:
Â

 

The setting
Â

 

The destination
Â

 

The output filename

You can use a variety of methods to add targets to a job. The most common is to add a 
setting or destination to the job. You can also use any of the following methods.

The setting The destination

The output filename

Drag the dividers to
expand a target’s section
and make it easier to see

the entry.
The target Add and 
Delete buttons
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Do one of the following to add an empty target to a job:
m Select one or more jobs and choose Target > Add Target. This adds an empty target to 

the jobs.

m Select one or more jobs and Control-click in an empty area of one of them, then 
choose Target > Add Target. This adds an empty target to the jobs.

m Click the Add ( + ) button of an existing target.

You can also copy one or more targets from one job to another:

To copy targets to another job by dragging:
1 Select the targets to copy.

2 Press the Option key and then drag the targets to the new job.

Do one of the following to delete targets:
m Select one or more targets and press Delete.

m Click the Delete ( – ) button in a target.

About Adding and Copying Jobs
Jobs are most often created by adding source media files to a batch. You can use 
several other methods to add jobs to a batch. Additionally, you can chain jobs in a 
batch to set the order in which the files are transcoded once they are submitted. 

To add an empty job to a batch:
m Choose Jobs > New Job.

To delete a job from a batch:
m Select the job and press the Delete key.

To copy jobs from one batch to another, do one of the following:
m Open each batch in its own window and drag the jobs from one window to the other. 

m Select the jobs to be copied, press Command-C, select the batch to copy them to, and 
then press Command-V.
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About Chaining Jobs
Chaining jobs is useful when you need to apply multiple settings to a source media file, 
but need to have each setting applied after the previous one has finished. This makes it 
possible to control the order in which the settings are able to modify the source media file.

To chain all targets in a job to new jobs:
1 Select the job whose targets you want to chain to new jobs.

2 Choose Jobs > New Job With Target Output.

New jobs are added to the batch with the chain thumbnail and the name of the output 
file of the targets they are chained to.

To chain selected targets to new jobs:
1 Select the targets whose outputs you want to chain to new jobs.

2 Control-click one of the targets and choose New Job With Target Output from the 
shortcut menu.

New jobs are added to the batch with the chain thumbnail and the name of the output 
file of the targets they are chained to.

You can chain multiple jobs if needed. See “Creating PAL Video During the Reverse 
Telecine Process” on page 264 for an example of chaining two jobs together.

The chained job’s source
name is the output

filename of the target it is
chained to.

The chained job’s
thumbnail is this chain

link logo.
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Submitting a Batch
Once you have configured the jobs and their targets within a batch, you are ready to 
submit the batch for processing. 

To submit a batch:
1 Make sure the batch to be submitted is selected in the Batch window.

2 Do one of the following:

Â Choose File > Submit (or press Command-Option-S).
Â Click the Batch window’s Submit button.
The submit dialog appears.

3 Check the Name field to confirm the batch name.

By default, this is the name of the first source media file in the batch. You can change 
this name to something more meaningful about this batch. This is the name that is 
used for this submission in both the Batch Monitor and the History window.

4 Use the Cluster pop-up menu to choose which computer or cluster will process the batch.

The default Cluster setting is “This Computer,” which means Compressor will not 
involve any other computers in completing the batch. You can choose from any other 
available clusters that appear in this list. See the Distributed Processing Setup guide for 
more details on setting up an Apple Qmaster distributed processing network.

5 Check the “Include unmanaged services on other computers” checkbox to create an ad 
hoc cluster including “This Computer” and any available service nodes.

This is part of the AutoCluster feature. See “About AutoCluster and Unmanaged 
Services” on page 113 for more information.
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6 Use the Priority pop-up menu to choose priority level for the batch.

7 Click Submit or press Enter to submit the batch for processing.

The History window shows the batch progress. See “About the History Window” on 
page 115 for more information.

Note:  The History window automatically opens if it is not already open.

You can also monitor the transcoding progress with the Batch Monitor by 
double-clicking the Batch Monitor icon in the Utilities folder inside the Applications 
folder or by clicking its icon in the Batch window. For more information on 
Batch Monitor, see the Batch Monitor User Manual, available from the Help menu.

You can set the Batch Monitor to automatically open in the Compressor Preferences 
window. See “Setting Compressor Preferences” on page 38 for more details. 

Note:  When submitting larger batches (for example, nine source media files with three 
settings assigned to each), there is about a 10-second delay after submitting the batch 
when nothing happens. Be patient. Compressor is preparing the large batch before it 
can be properly submitted for processing. If you are transcoding a large batch, you 
should turn off the screen saver application on your computer. This will improve the 
speed of your transcode because resources are not being diverted to the screen saver. 

About AutoCluster and Unmanaged Services
Compressor includes an AutoCluster feature that makes it easy to take advantage of 
the distributed processing capabilities offered by Apple Qmaster, without requiring a 
lot of knowledge about how clusters are configured, setting up file sharing, and so on.

Using AutoCluster is a two-step process:
Â Automatically creating Apple Qmaster service nodes as you install Final Cut Studio 

or Apple Qmaster. 
Â Selecting the “Include unmanaged services on other computers” checkbox when 

you submit a Compressor batch for processing.

These two steps let you harness the processing power of any number of computers 
on your network without any additional effort or knowledge on your part. 

See the Distributed Processing Setup Guide, available from the Compressor Help menu, 
for additional information.
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Once the batch has been submitted, a yellow triangle with an exclamation point 
appears in the batch.

These warning symbols are used by Compressor whenever an issue exists with a batch. 
You can place the pointer over the symbol to see a tooltip defining why it is there, or 
you can click the symbol to open a dialog about it. 

In the above case, since the batch has been submitted, this warning is to let you know 
that a file with that name now exists at that destination, and that if you submit again, 
that file will be overwritten.

You can bypass the submit dialog when submitting a batch. The submitted batch 
automatically uses the settings from the previously submitted batch.

To submit a batch using previous settings, do one of the following:
m Choose File > Submit with Previous Settings.

m Click the Submit with Previous Settings item in the Batch window toolbar (if present).

See “About the Batch Window” on page 74 for more information about using the 
Batch window.

Test Transcode Tip
Before committing to a long transcoding session, do a quick test with a small section of 
the source media file. If there is a problem (such as an incorrect setting or a reference 
file that can’t find the files it is referencing), you can make the correction without losing 
a lot of time. Such tests also allow you to preview Encoder pane and Frame Controls 
results that are not visible in the Preview window. For a quick way to select a small 
section of the source media file, see “Transcoding a Portion of the Clip with the Preview 
Window” on page 295.

Make sure the test section is specific to the type of settings you applied. For example, 
pick a high motion section if you’re doing frame rate or field order conversions with 
Frame Controls.

Click the warning 
symbol to see an 
explanation about why 
it is there.
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About the History Window
The History window provides quick access to all previously submitted batches, allowing 
you to conveniently resubmit batches by dragging them to the Batch window, and view 
submission details about when particular job batches were submitted from your computer. 

The History window organizes its contents by the submission date. You can change the 
order in which the contents are sorted by clicking the Reverse Sort Order button along 
the bottom of the History window. You can also clear the contents of the History 
window by clicking the Clear button, or remove selected items by selecting them and 
pressing the Delete key.

The History window can also show you the progress of a batch currently being transcoded.

Note:  If it is closed, the History window automatically opens when you submit a batch.

Once the transcode finishes, the History window adds a button to make finding the 
encoded files easy.

Click the disclosure
triangle to see the details
of that day’s submissions.

Click the disclosure
triangle to see the details

of each target of
this submission.

Click the Pause button 
to temporarily pause 
the transcode process. 
Click it again to resume 
transcoding.

The name of 
this submission

Click the Cancel
button to end the
transcode process.

A target from the
submitted batch

Click the Reveal in 
Finder button to show 
the encoded file in a 
Finder window.

Clicking this disclosure
triangle shows the
submission details.
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Resubmitting a Batch
All batch submission information is stored in the History window. This information 
includes the details about all of the batch’s jobs and targets, including which source media 
files were assigned to them. You can use this information to resubmit a batch simply by 
dragging a particular entry from the History window back to the Batch window.

To resubmit a batch submission from the History window:
1 Use the disclosure triangles to locate the batch submission to resubmit. 

Note:  This is where giving the submission a recognizable name can help.

2 Drag the submission from the History window to the Batch window.

When you drag a batch from the History window to the Batch window, Compressor 
creates a new untitled tab in the Batch window for that batch. The batch appears in the 
new tab with all its original details (source media files, targets, assigned settings, 
destinations, output format, and batch name). You can now make any changes to the 
batch and resubmit it.

Saving and Opening a Batch File
There may be times when you configure a batch but are not able to submit it right 
away. In those cases, you may find it useful to save the batch settings for later reference. 

To save a batch file:
1 Do one of the following:

Â Choose File > Save As.
Â Press Shift-Command-S.
A dialog opens to name the file and choose its destination. By default, the filename is 
the same as the first source media file.

2 Enter a name for the file if you do not want to use the default name.

3 Choose the destination for the file.

4 Click Save.

Batch filenames have a “.compressor” extension added to them.

Note:  The “.compressor” extension will appear in the batch window tabs if Finder 
preferences are set to show all file extensions.
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To open a batch file within Compressor:
1 Do one of the following:

Â Choose File > Open.
Â Press Command-O.
A dialog opens to select the batch file to open. 

2 Locate and choose the batch file to open.

3 Click Open.

You can also open a batch file by double-clicking it in the Finder, or by dragging the 
batch file to the Compressor application icon.

Note:  An error message appears if Compressor cannot locate any of the source files 
listed in the batch file, and only those sources it finds will appear.

Submitting a Final Cut Pro Project for Transcoding
You can use Compressor to improve the transcoding process for your Final Cut Pro 
projects. For example, you can transcode your Final Cut Pro project without rendering it. 
This avoids a potentially time-consuming step depending on how many transitions, 
filters, and video effects have been applied to your project, and also results in no 
generational loss of the content from your source media files. This process also eliminates 
one step from the earlier transcoding workflow which involved exporting from 
Final Cut Pro to QuickTime and then transcoding that QuickTime movie in Compressor.

Depending on its file size, a Final Cut Pro project that is transcoded only on your 
computer could significantly affect your computer’s performance. 

Note:  Transcoding a Final Cut Pro project doesn’t actually create a rendered project, 
although the transcoded output media file does have all the rendered effects applied. If 
you want to continue working on the project within Final Cut Pro, you need to render it 
in Final Cut Pro.

To transcode a Final Cut Pro project:
1 Open the project you want to transcode in Final Cut Pro.

2 Use one of the following methods to select the project for transcoding in Final Cut Pro:

Â In the Browser, select the sequence you want to transcode.
Â Make the Timeline the active window by clicking in it.

3 Save your Final Cut Pro project and give it an appropriate name.
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4 Choose File > Export > Using Compressor.

Compressor opens (if it was not already open) and the sequence appears as a job in a 
new untitled batch.

5 Assign settings and destinations to the job as necessary. 

See the following sections for more information:

Â “Assigning Settings to Source Media Files” on page 102
Â “Assigning Destinations to Source Media Files” on page 107

6 Click the Submit button in the Batch window.

Compressor begins transcoding the Final Cut Pro project and then closes. 

Note:  Final Cut Pro needs to remain open throughout this process, because much of 
the transcoding preparation of the frames occurs within Final Cut Pro rather than 
within Compressor. Also, you cannot continue working in Final Cut Pro until the 
transcode is completed.

See “Exporting from Final Cut Pro and Distributed Processing,” below, for information 
on how this process works if you are using distributed processing.

Resubmitting a Final Cut Pro Project
You can use the History window to resubmit a Final Cut Pro project, the same way as 
you resubmit any other batch. Compressor recognizes that this particular batch 
originated from Final Cut Pro, so when you drag the batch from the History window to 
the Batch window, it automatically opens Final Cut Pro. 

See “Resubmitting a Batch” on page 116 for details about the steps in this process.

The Final Cut Pro
sequence and project
names are combined

to create the new
job’s name.
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Exporting from Final Cut Pro and Distributed Processing
Compressor and Apple Qmaster can distribute video and audio compression tasks over 
multiple computers connected to a network. 

Note:  This Compressor distributed processing feature is limited to computers that have 
Final Cut Studio installed.

There are two methods you can use to avoid exporting self-contained media files from 
Final Cut Pro for Compressor distributed processing:
Â Export a sequence directly from Final Cut Pro to Compressor and then submit that 

job to a cluster in an Apple Qmaster distributed processing network. In this workflow, 
Final Cut Pro opens on each processing node in that cluster to complete the job. 

Â Export the Final Cut Pro sequence as a QuickTime reference movie and then submit 
the resulting movie to the cluster for processing. Although this method does not 
require that Final Cut Pro be installed on each computer in the distributed 
processing cluster, the media files specified in the reference movie must be available 
to each computer in the cluster.

To export a Final Cut Pro sequence directly to Compressor for distributed processing:
1 Make sure Final Cut Pro is installed on each computer in the cluster that you intend to 

use for distributed processing. 

Each installation of Final Cut Pro requires a product serial number. For information 
about volume licenses, go to http://www.apple.com/finalcutstudio.

2 Make sure all the source media files and render files for your Final Cut Pro project are 
on a hard disk that can be shared (mounted) by all the computers in the cluster that 
will process the job. (The following instructions use an example of a shared hard disk 
named Media1.) 

If you copy all the media files to another hard disk for this purpose, you may need to 
reconnect the media files in Final Cut Pro before proceeding.

Important:  The hard disk you use to store the media files may not be a startup disk for 
any computer in the cluster.

3 In Final Cut Pro, set the scratch disk to the same hard disk used for storing media files 
in step 2:

a Choose Final Cut Pro > System Settings, then click the Scratch Disks tab.
b Click Set. 
c In the dialog that appears, locate and select the disk you want to use (Media1 in 

this example).
d Click Choose. The specified disk (Media1) is listed next to the Set button, along with 

the amount of available disk space.
For more information about Final Cut Pro scratch disks, see the Final Cut Pro User Manual.

http://www.apple.com/finalcutstudio
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4 Enable file sharing on the computer where the scratch disk (Media1) is located (in the 
Sharing pane of System Preferences, click Services and then select Personal File Sharing).

5 On each computer in the intended cluster, mount the scratch disk you specified in 
step 3 (in the Finder sidebar, click Network, navigate to the computer that contains the 
Media1 disk, click Connect, and select Media1).

6 In Compressor preferences, specify cluster options settings:

a Choose Compressor > Preferences, or press Command-comma ( , ). The Preferences 
window appears.

b Choose Copy Source to Cluster as Needed from the Cluster Options pop-up menu.

7 In Final Cut Pro, choose File > Export > Using Compressor.

Compressor opens with the selected media file (the Final Cut Pro sequence) in the 
Batch window. 

8 In Compressor, double-click the selected file and play it in the Preview window to verify 
the integrity of the clip.

9 In the Batch window, assign settings and destinations to the selected file as necessary. 

10 Click the Submit button.

The submit dialog appears. 

11 Do one of the following:

Â Choose the intended cluster from the Cluster pop-up menu.
Â Select the “Include unmanaged services on other computers” checkbox to use the 

AutoCluster feature. See “About AutoCluster and Unmanaged Services” on page 113 
for more information.

12 Click Submit.

Important:  For best results, be sure Final Cut Pro is already open on the cluster’s 
computers. Apple Qmaster attempts to open Final Cut Pro if necessary; however, if the 
External A/V Device warning appears, Final Cut Pro will not open and cannot be used. 
Additionally, when using the AutoCluster feature, be aware that submitting a batch will 
cause Final Cut Pro to open on the computers providing the unmanaged services, 
which might surprise whoever is currently using the computer.
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To export a Final Cut Pro sequence as a QuickTime reference movie and submit it to 
Compressor for distributed processing:

1 Make sure all the source media files and render files for your Final Cut Pro project are 
on a hard disk that can be shared (mounted) by all the computers in the cluster that 
will process the job. (The following instructions use an example of a shared hard disk 
named Media1.) 

If you copy all the media files to another hard disk for this purpose, you may need to 
reconnect the media files in Final Cut Pro before proceeding.

Important:  The hard disk you use to store the media files may not be a startup disk for 
any computer in the cluster.

2 In Final Cut Pro, choose File > Export > QuickTime Movie.

3 In the Save dialog, make sure that the Make Movie Self-Contained checkbox is not selected.

4 Save the QuickTime reference movie to the same hard disk (Media1) used to store 
media files in step 1.

5 Enable file sharing on the computer where the scratch disk (Media1) is located (in the 
Sharing pane of System Preferences, click Services and then select Personal File Sharing).

6 On each computer in the intended cluster, mount the hard disk (Media1) where the 
media files and QuickTime reference movie are located (in the Finder sidebar, click 
Network, navigate to the computer that contains the Media1 disk, click Connect, and 
select Media1).

7 In Compressor preferences, specify cluster options settings:

a Choose Compressor > Preferences, or press Command-comma ( , ). The Preferences 
window appears.

b Choose Never Copy Source to Cluster from the Cluster Options pop-up menu. 

8 Import the QuickTime reference movie into Compressor. (Drag it from the desktop to 
the Compressor Batch window.)

9 Double-click the file in the Batch window and play it in the Preview window to verify 
the integrity of the clip.

10 In the Batch window, assign settings and destinations to the selected file as necessary. 

11 Click the Submit button.

The submit dialog appears. 

12 Do one of the following:

Â Choose the intended cluster from the Cluster pop-up menu.
Â Select the “Include unmanaged services on other computers” checkbox to use the 

AutoCluster feature. See “About AutoCluster and Unmanaged Services” on page 113 
for more information.

13 Click Submit.
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Transcoding Different Clips from One Source Media File
If you have a large source media file and you only want to transcode a few different 
sections of it, you can do this in one batch submission.

To transcode different clips from one source media file:
1 Open the Batch window.

2 Import the source media file into a batch as many times as the number of clips you 
want to make. 

A new job is created each time you import the source media file.

3 Add settings to each job.

A unique identifier is applied to the output filename, so that you can easily identify 
each clip after it is transcoded.

4 Do one of the following to open the Preview window:

Â Click the Preview button in the Batch window.
Â Click one of the targets.
The Preview window opens.

Unique file identifiers are 
automatically applied to 
each job.
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5 Use the Batch Item selection buttons or pop-up menu to navigate to each media file 
you want to transcode.

Drag the In and Out points to the first relevant section of the media file, and repeat for 
the next media file by dragging its In and Out points to the next relevant section of the 
media file. You can also use the I (In) and O (Out) keys to move the markers to the 
current location of the playhead.

6 Return to the Batch window and click Submit.

See “About the Preview Window” on page 284 for more information.

The In point The Out point
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7 Creating AIFF Files

You can use Compressor to output audio in the AIFF format. 

This chapter discusses outputting your audio in the AIFF file format:
Â Creating AIFF Output Files (p. 125)
Â About the AIFF Encoder Pane (p. 125)
Â About the Sound Settings Dialog (p. 126)
Â Configuring AIFF Settings (p. 128)

Creating AIFF Output Files
The AIFF (Audio Interchange File Format) file format was developed by Apple for 
storing high-quality audio. The format was intended for DVD or CD authoring and is 
now one of the most commonly used audio file formats for the Mac OS. 

About the AIFF Encoder Pane
The following options appear when you choose the AIFF output format from the File 
Format pop-up menu in the Encoder pane of the Inspector window:

File Extension field

QuickTime AIFF 
Summary table

Click to open the
Sound Settings dialog.

Choose AIFF.
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Â File Extension:  This field displays the AIFF file extension aiff automatically after the 
AIFF output format is selected from the File Format pop-up menu or the ( + ) pop-up 
menu in the Settings tab. Don’t alter this field.

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. Since 
job segmenting is not used for audio-only encodes, this checkbox is not active with 
the AIFF file format. For more information, see “Job Segmenting and Two-Pass (or 
Multi-Pass) Encoding” on page 61.

Â Settings:  This button opens the QuickTime Sound Settings dialog. Use this dialog to 
select suitable audio codecs and change other audio compression settings. See 
“About the Sound Settings Dialog” below for more information.

Â QuickTime AIFF Summary:  This table displays full details for this setting.

About the Sound Settings Dialog
You use the Sound Settings dialog to change your audio compression settings for both 
the QuickTime and AIFF output formats. To open this dialog, click the Audio Settings 
button in the AIFF or QuickTime Movie Encoder pane.

If a particular audio setting cannot be changed, it remains dimmed. Some audio codecs 
allow you to make additional settings, which appear in the lower half of the Sound 
Settings dialog. In some cases, an Options button becomes available. Click it to make 
additional settings. 

Choose the number 
of channels (the 
selection varies 
based on the 
codec).

Choose a rate that
provides the quality and

file size required.

Choose an audio 
codec.

Format-specific 
settings based on 
the codec
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The Sound Settings dialog contains the following items, with various choices for each, 
depending on the audio codec you choose in the Format pop-up menu.
Â Format:  Choose the audio codec you want to add to your setting.
Â Channels:  Choose the type of channel output, such as mono, stereo, or some type of 

multi-channel output, depending on the codec.
Â Rate:  Choose the sample rate you want to use for your media file. The higher the 

sample rate, the higher the audio quality, but the larger the file. Downloading a 
larger file takes longer and requires more bandwidth. 

Â Show Advanced Settings:  This button remains dimmed unless the codec you selected 
from the Format pop-up menu offers options. It is recommended that you contact 
the manufacturers of these codecs directly for more information about the additional 
options they offer.

QuickTime Audio Sample Sizes and Rates
If you have the disk space and bandwidth, it is best to leave your audio uncompressed. 
Uncompressed audio normally uses 8-bit (phone quality) or 16-bit (CD quality) samples. 
Compressor supports up to 64 bits per sample floating point and a maximum sample 
rate of 192 kHz. 

Choosing an Audio Codec
AAC is a good general-purpose audio delivery codec and it is compatible with a wide 
variety of playback devices. For low-bandwidth audio on faster computers, the 
QDesign Music codec (QDMC) is good for most material, while Qualcomm PureVoice is 
the best choice for speech-only material. For slower computers, CD-ROM, and kiosk 
situations, IMA is a better choice, because it is less computer intensive, thus allowing 
the computer to focus on the more challenging video stream. 
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Configuring AIFF Settings
When you choose the AIFF output file format as your output format, you can only 
create audio settings (because it is an audio-only format). If you want to add an audio 
codec to your AIFF preset, you need to open the Sound Settings dialog and choose 
your audio codec settings from there. 

To create an AIFF audio codec setting:
1 In the Settings tab, do one of the following:

Â Make sure that the correct setting is selected.
Â Create a new setting by choosing AIFF from the “Create a new setting” ( + ) 

pop-up menu.

2 Click the Settings button in the AIFF Encoder pane.

The Sound Settings dialog opens.

3 Choose an audio codec from the Format pop-up menu and either accept its defaults or 
customize the other audio codec settings (Format, Channels, Rate, and Options, if 
available). See “About the Sound Settings Dialog” on page 126 for more details.

Note:  You can see full details of the current contents of your preset by viewing the 
QuickTime AIFF Summary table in the Encoder pane.

4 Click OK to save your settings and close this dialog.

Choose an audio codec from 
the Format pop-up menu.
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8 Creating Dolby Digital 
Professional Output Files

Compressor provides the tools you need to encode, and 
batch-encode, Dolby Digital Professional (AC-3) audio files.

Dolby Digital Professional format (also known as AC-3) is a very common compressed 
audio format for DVD-Video discs. Compressor accepts multichannel sound files in a 
variety of formats and gives you complete control over the AC-3 encoding process. 
Dolby Digital programs can deliver 5.1-channel surround sound with five discrete 
full-range channels (left, center, right, left surround, and right surround) plus a sixth 
channel for low-frequency effects (LFE), sometimes known as “the subwoofer.” Another 
surround option is Dolby Surround, with four channels (left, center, right, surround). But 
not all AC-3 audio is 5.1 surround sound. Dolby Digital Professional is commonly used 
to encode stereo files to greatly reduce their file size. 

This chapter covers the following:
Â About the Dolby Digital Professional Encoder Pane (p. 130)
Â General Information About Creating Dolby Digital Professional Files (p. 136)
Â Converting Stereo Audio Files to Dolby Digital Professional Format (p. 138)
Â Assigning Files to Surround Sound Channels (Manual Method) (p. 139)
Â Assigning Files to Surround Sound Channels (Automatic Methods) (p. 141)
Â Assigning Files to Surround Sound Channels with Droplets (p. 143)
Â Options for Spatial Mixing (p. 143)

Note:  Dolby Digital Professional encoding with Compressor is available only on 
computers that also have Final Cut Studio installed. If you are using Compressor with 
distributed processing, Final Cut Studio must be installed on each node that will be 
doing Dolby Digital Professional encoding.
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See the Soundtrack Pro User Manual for comprehensive information about creating 
surround sound audio files. If you are planning to make DVDs using DVD Studio Pro, see 
the DVD Studio Pro User Manual for more information about the DVD authoring 
workflow. See “Adding Surround Sound Source Media Files to Batches” on page 78 for 
more information about creating surround sound audio files using other output formats.

Note:  It’s important to understand that Compressor cannot take stereo audio files and 
create 5.1 surround sound from them. If you want to create a 5.1 surround sound AC-3 
audio file, you must first create the six channels of audio it requires. This must be done 
using other applications, such as Soundtrack Pro, outside Compressor. 

About the Dolby Digital Professional Encoder Pane
This section contains detailed information about the various tabs within the Dolby 
Digital Professional (AC-3) Encoder pane of the Inspector window. 

You make your Dolby Digital Professional settings using the tabs described below, by 
either modifying an existing setting or creating a new setting in the Settings tab. The 
Dolby Digital Professional pane opens with the default Audio tab on top and contains 
the following items:
Â File Extension:  This field displays the Dolby Digital Professional file extension (ac3) 

automatically after the Dolby Digital Professional output format is selected from the 
File Format pop-up menu or the ( + ) pop-up menu in the Settings tab.

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. Since 
job segmenting is not used for audio-only encodes, this checkbox is not active with 
the Dolby Digital Professional file format. For more information, see “Job Segmenting 
and Two-Pass (or Multi-Pass) Encoding” on page 61.

Â Audio, Bitstream, and Preprocessing:  These buttons open the Audio, Bitstream, and 
Preprocessing tabs described next.
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Audio Tab Settings
All the most important Dolby Digital Professional settings are accessible in the Audio Tab.

Â Target System:  Compressor limits available settings to those appropriate for the 
target system. If you’re encoding for use with DVD Studio Pro, choose DVD Video. 
Choose DVD Audio only if you are encoding for use in a DVD Audio authoring 
application. Choose Generic AC-3 to remove the setting limits. 

Â Audio Coding Mode:  Specifies the audio channels of the encoded stream. This setting 
also has an Automatic button.

The audio coding mode 
Automatic button
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For example, “3/2 (L, C, R, Ls, Rs)” means three front channels (left, center, right), and 
two rear channels (surround). “2/0 (L, R)” is essentially a standard stereo file. The 
audio coding mode affects settings such as the available bandwidth and surround 
channel preprocessing. If you click the Automatic button (next to the Audio Coding 
Mode pop-up menu), Compressor makes its best guess at the intended Audio 
Coding Mode, based on available source audio files.

Note:  In the Audio Coding Mode pop-up menu, “S” stands for a single rear 
“Surround” channel, and in this illustration, “LFE” stands for Low Frequency Effects 
(also known as “subwoofer”). For more information, see “Assigning Files to Surround 
Sound Channels (Manual Method)” on page 139 and “Assigning Files to Surround 
Sound Channels (Automatic Methods)” on page 141.

Â Enable Low Frequency Effects:  Select this checkbox to include the LFE channel in the 
encoded stream (not available for 1/0 mono or 2/0 stereo). 

Â Sample Rate:  Specifies the sample rate. All files intended for video and audio DVD 
authoring must have a 48 kHz sample rate as per the DVD specification. The 32 kHz 
and 44.1 kHz sample rates are available only when Generic AC-3 is the target system.

Â Data Rate:  The choices depend on the coding mode and target system. The higher 
the rate, the better the quality. AC-3 streams have a constant data rate. At 448 kbps, 
which is the default for 5.1 encoding, one minute of AC-3 audio takes about 3.3 MB of 
storage space. For stereo encoding, rates of 192 kbps and 224 kbps are typical and 
will produce good results.

Â Bit Stream Mode:  Defines the purpose of the encoded audio material. The information 
is included in the finished stream and can be read by some decoding systems.

3/1 channels 3/0 channels 

2/2 channels 1/0 channels 2/1 channels 2/0 channels 
(LFE option not available) (LFE option not available) 

3/2 channels 

L C 

LFE 

LFE LFE LFE LFE 

R 

Ls Rs 

L R 
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L R L R 

S 
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Â Dialog Normalization:  Specifies the average volume of the dialogue, using decibels of 
full scale (dBFS), in your sound files relative to full modulation. The playback device 
uses this information to maintain similar volume among different AC-3 streams. The 
goal is to make all AC-3 encoded audio files have the same listening level, regardless 
of the source file. 
It is especially important to properly use the Dialog Normalization feature if you have 
different audio files (with different volume levels) going on to a DVD. If you know the 
average level for each file, enter that number in the Dialog Normalization field for 
each file. For example, if the dialogue in your Final Cut Pro sequence averages 
around –12 dB on the audio meter, enter –12 in the Dialog Normalization field. 

Note:  This normalization is between the audio streams on the DVD, not within an 
individual audio stream itself. For that type of normalization, use an audio editing 
tool like Soundtrack Pro.

You can enter values from –1 dBFS to –31 dBFS. The difference between the value 
you enter and 31 dBFS (which represents the normal dialogue listening level) is the 
amount that the source audio will be attenuated. 

Â If you enter –31 dBFS, the attenuation is 0 dB (31 dBFS–31 dBFS), and the source 
audio levels are not affected at all.

Â If you enter –27 dBFS, the attenuation will be 4 dB (31 dBFS–27 dBFS).
Â If you enter –12 dBFS, the attenuation is 19 dB (31 dBFS–12 dBFS). 
The louder the source file, the smaller the value you enter, and the more the audio in 
the encoded file is attenuated during playback.

Important:  It is critical that you set the Dialog Normalization setting correctly if you 
intend to use any of the Compression Preset settings. The Compression Preset 
settings assume that the audio, after the dialogue has been normalized, is at the 
normal listening level of 31 dBFS. Levels that are consistently louder than that result 
in distorted sound and erratic levels.

If you do not know the sound level of the source file or for some other reason want 
to ensure the Dolby Digital Professional encoder does not affect your sound levels, 
enter –31 for the Dialog Normalization and choose None in the Compression Preset 
pop-up menu (located in the Preprocessing tab).
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Bitstream Tab Settings
These settings are stored in the finished stream for use by the playback device. Leave 
them at their default values unless you have a specific technical reason for changing them.

Â Center Downmix, Surround Downmix:  If your encoded audio has these channels, but the 
player does not, the channels are mixed into the stereo output at the specified level.

Â Dolby Surround Mode:  When encoding in 2/0 (stereo) mode, specifies whether the 
signal uses Dolby Surround (Pro Logic).

Â Copyright Exists:  Select this checkbox to specify that a copyright exists for this audio.
Â Content is Original:  Select this checkbox to specify that this audio is from the original 

source and not a copy.
Â Audio Production Information:  Select this checkbox and fill in the fields below to 

specify how the encoded audio content was mixed. Playback devices may use this 
information to adjust output settings.
Â Peak Mixing Level:  Specifies peak sound pressure level (SPL) (between 80 dB and 

111 dB) in the production environment when this mix was mastered.
Â Room Type:  Specifies information about the mixing studio.
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Preprocessing Tab Settings
Preprocessing options are applied to the audio data before encoding. With the 
exception of the Compression Preset setting, leave these settings at their default values 
unless you have a specific technical reason for changing them.

Â Compression Preset:  Specifies one of the dynamic range processing modes built in to 
the AC-3 format. The default of Film Standard Compression should only be used 
when you are encoding an original mix intended for cinema. In almost all cases, you 
should choose None.

Important:  It is critical that you set the Audio tab’s Dialog Normalization setting 
correctly if you intend to use any of these Compression Preset settings. The 
Compression Preset settings assume that the audio, after the dialogue has been 
normalized, is at the normal listening level of 31 dBFS. Levels that are consistently 
louder than that result in distorted sound and erratic levels.

Note:  If you are building a Dolby Digital Professional 5.1-channel surround sound 
DVD, then you will use Film Standard Compression.
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General
Â Apply Digital Deemphasis:  Specifies whether input audio data is pre emphasized and 

needs to be de-emphasized before encoding.

LFE Channel
Â Apply Low-Pass Filter:  Select this checkbox to apply a 120 Hz low-pass filter to the 

Low Frequency Effects (LFE) channel. Turn off this filter if the digital signal fed to the 
LFE’s input does not contain information above 120 Hz.

Full Bandwidth Channels
Â Apply Low-Pass Filter:  Select this checkbox to turn on a low-pass filter with a cutoff 

near the available audio bandwidth that is applied to the main input channels. If the 
digital signal fed to the main input channels does not contain information above the 
available audio bandwidth, you can turn off this filter. Compressor will automatically 
determine the available bandwidth.

Â Apply DC Filter:  Select this checkbox to turn on a DC high-pass filter for all input 
channels as a simple way to remove DC offsets. Most mixed audio material is already 
free of DC offsets.

Surround Channels
Â Apply 90° Phase-Shift:  Select this checkbox to generate multichannel AC-3 streams 

that can be downmixed in an external 2-channel decoder to create true Dolby 
Surround–compatible output.

Â Apply 3 dB Attenuation:  Select this checkbox to apply a 3 dB cut to the surround 
channels of a multichannel film soundtrack being transferred to a consumer home 
theater format. Cinema surround channels are mixed 3 dB “hot” (higher) relative to 
the front channels to account for cinema amplifier gains.

General Information About Creating Dolby Digital 
Professional Files
Following are some things to keep in mind as you configure and encode Dolby Digital 
Professional AC-3 files.

About the Source Media Files
There are a few guidelines to be aware of when encoding Dolby Digital Professional 
output files from your source media files.

Depending on the format, a file can contain a single channel (mono), dual channels 
(stereo), or multiple channels. Compressor supports Dolby Digital Professional in all 
these configurations.
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Sound files intended for Dolby Digital Professional encoding must conform to the 
following rules:
Â All source files should be the same length. (If they are not, Compressor sets the 

length of the AC-3 stream to match the length of the longest file.)
Â All files must have a 48 kHz sample rate (as required for DVD).
Â AC-3 streams must have a multiple of 1536 samples. If the selected input files do not, 

Compressor adds digital silence to the end of the files.

Note:  Compressor can support any kind of source files that contain surround sound 
and high resolution audio up to 64 bits per sample (floating point) and sample rates up 
to192 kHz.

About Previewing the Encoder Settings
The settings made in the Dolby Digital Professional encoder pane cannot be 
previewed. If you have an external surround sound device connected to the USB, 
FireWire, or other output from the computer, you will be able to hear the audio 
assigned to the different channels, but it will not include any settings, such as the 
Dialog Normalization or Compression Preset settings.

Important:  Since the audio output is not Dolby Digital, the optical output cannot be 
used to verify the audio assigned to each channel.

The only way to verify the settings is to submit the batch and listen to the results. If you 
are unsure of the settings, use the Preview window to encode a short portion of the 
source as a test.

You can import an AC-3 file as a source media file into a Compressor batch. Compressor 
includes a built-in Dolby Digital decoder that it uses to decode the AC-3 files. This decoder 
will properly apply any settings you made in the Dolby Digital Professional encoder pane, 
allowing you to hear their effects without requiring you to have an external Dolby Digital 
decoder. You can also transcode the AC-3 files to a different format.

Note:  Surround sound AC-3 files are downmixed to stereo if you do not have an 
external surround sound system connected to the computer.
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Converting Stereo Audio Files to Dolby Digital 
Professional Format 
Follow these steps to encode a stereo (2/0 L,R) Dolby Digital Professional (AC-3) stream 
from a stereo source media file.

To encode an AC-3 stream:
1 Add source audio files to the Batch window. (See Chapter 4, “Importing Source Media 

Files,” on page 73, for details.)

2 Save the batch by choosing File > Save As (or pressing Command-Shift-S), then 
entering a name for the batch, selecting a location, and clicking Save.

3 Do one of the following to apply the appropriate Apple setting from the Dolby Digital 
Professional category to the source audio file:

Â Choose Target > New Target With Setting, choose a setting, and click Add. 
Â In the Batch window, control-click in an empty part of the job, choose New Target 

With Setting from the pop-up menu, choose a setting, and click Add.
Â Drag a setting from the Settings tab to the source audio file’s job in the Batch window.

4 Optionally, make any adjustments to the setting in the Encoding pane of the Inspector 
window. See “About the Dolby Digital Professional Encoder Pane” on page 130 for 
more information.

Note:  Compressor will map channels intelligently. Here are some examples:

Â If you import a stereo source file and apply a mono 1/0 (C) audio coding mode to it, 
the file will be down-mixed. 

Â If you apply a surround audio coding mode to the stereo file, the left and right 
channels will be mapped to the left front (L) and right front (R) channels, leaving the 
other channels of the coding mode silent. 

Â If you assign a stereo file to the left front or left (rear) surround channel, Compressor 
will pick the left channel and ignore the right channel.

5 Click Submit.

For information about encoding surround sound files, see “Assigning Files to Surround 
Sound Channels (Manual Method),” next, and “Assigning Files to Surround Sound 
Channels (Automatic Methods)” on page 141. Also see “About Previewing the Encoder 
Settings” on page 137 for information on playing your AC-3 audio files with Compressor.
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Assigning Files to Surround Sound Channels 
(Manual Method)
Follow these steps to use the manual method for assigning individual audio files to 
surround sound channels. 

To manually assign source audio files to channels of a surround sound stream:
1 Do one of the following to import the source audio files:

Â Click the Add Surround Sound button in the Batch window.
Â Choose Job > New Job With Surround Group (or press Command-Shift-I).
Â Control-click in the batch and choose New Job With Surround Group from the 

shortcut menu. 
The channel assignment interface opens.

2 Do one of the following to assign a source audio file to a particular channel. 

Â Drag the source audio file from the Finder to the icon for a specific channel (for 
example, “L”).

Â Click the icon for a specific channel (for example, “L”) and use the Open dialog to 
locate the source audio file intended for that channel. 

The file is now assigned to the “L” (Left Front) Channel.

3 Repeat Step 2 for each of the source audio files that you intend to include in the 
surround stream.

Note:  If you are creating Dolby Digital Professional (AC-3) surround sound streams, you 
will not use all the channels listed in the table at once. See “Audio Tab Settings” on 
page 131 for a diagram of the Dolby audio coding modes.

4 When you have finished adding source audio files to the channel assignment interface, 
click OK.
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The group of surround files appears as a single surround source media file job in the 
Batch window and are also shown in the Inspector window.

Note:  You can click a channel icon in the Inspector window to change the file assigned 
to it.

5 Do one of the following to apply the appropriate Apple setting from the Dolby Digital 
Professional category to the source audio file:

Â Choose Target > New Target With Setting, choose a setting, and click Add. 
Â In the Batch window, control-click in an empty part of the job, choose New Target 

with Setting from the pop-up menu, choose a setting, and click Add.
Â Drag a setting from the Settings tab to the source audio file’s job in the Batch window.

6 Make any necessary adjustments in the Inspector window and click Submit.

Compressor creates an AC-3 surround audio stream. See “About Previewing the Encoder 
Settings” on page 137 for information on playing your AC-3 audio files with Compressor.
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Assigning Files to Surround Sound Channels 
(Automatic Methods) 
Compressor offers some streamlined channel assignment techniques that can save 
you time.

To assign files to surround channels with channel identifier codes:
1 Append the channel identifier code of the target surround channel to the filename of 

each source audio file. (See the table below for a list of the appropriate channel 
identifier codes.)

For example, to assign an AIFF file to the left surround channel, rename the file as 
filename-Ls.aiff (where filename is the name of your file).

Note:  Mac OS X may add a file extension like .aiff. This will not interfere with this 
channel assignment method. 

This procedure only works when you drag and drop files into the Batch window. If you 
drag the files onto the Compressor application icon, they will appear as separate source 
files, each in its own job.

Note:  If you are creating Dolby Digital Professional (AC-3) surround sound streams, you 
will not use all the channels listed in the table at once. See “Audio Tab Settings” on 
page 131 for a diagram of the Dolby audio coding modes.

2 Drag the renamed source audio files to the Batch window.

If the following conditions are met, Compressor automatically collapses the entire group 
of files into what appears as a single surround source media file in the Batch window:

Â The files in the group must be named correctly. (See table above.)
Â The total number of files in the group must be fewer than seven.

Channel assignment Channel identifier code

Left front channel -L

Right front channel -R

Center front channel -C

Left surround channel -Ls

Right surround channel -Rs

Center surround channel -S

Low frequency channel 
(Subwoofer, LFE)

-LFE
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The Inspector window shows the audio files assigned to each channel.

Note:  You can click a channel icon in the Inspector window to change the file assigned 
to it.

3 Do one of the following to apply the appropriate Apple setting from the Dolby Digital 
Professional category to the source audio file’s job:

Â Choose Target > New Target With Setting, choose a setting, and click Add. 
Â In the Batch window, control-click in an empty part of the job, choose New Target 

with Setting from the pop-up menu, choose a setting, and click Add.
Â Drag a setting from the Settings tab to the source audio file’s job in the Batch window.

4 Make any necessary adjustments in the Inspector window and click Submit.

Compressor creates an AC-3 surround audio stream. See “About Previewing the Encoder 
Settings” on page 137 for information on playing your AC-3 audio files with Compressor.
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Assigning Files to Surround Sound Channels with Droplets
You can further streamline the channel assignment process by encapsulating the 
“automatic” method described above in a Droplet. 

For more information about Droplets, see “Using Droplets” on page 315.

Options for Spatial Mixing
This section offers additional insights and suggestions for using the channels in a Dolby 
Digital Professional program.

Using the Center Channel
In a multichannel system, there are three ways to achieve a centrally placed sound image:
Â Create a “phantom center” (mix sound to the left and right equally, as with stereo). 

Commonly used, but assumes the listener is seated exactly between the speakers 
(which is not possible in automobiles and not always the case in homes). The timbre of 
sound is not the same as from a direct speaker because of cross-cancellation effects.

Â Use the center channel alone. This creates a stable center image for listeners in any 
location. (To prevent the audio from sounding too focused or narrow, its reverb can 
be spread to the left and right channels.)

Â Use all three front channels equally or in various proportions. This method allows for 
greater control of the range of spatial depth and width. The phantom center can be 
reinforced by additional signals in the center channel, which can be enhanced by 
signal spread into the left/right pair. The disadvantage is that sound from all three 
speakers may not blend well or may not arrive at the listener at the same time, 
causing side effects such as comb filtering, shifts in tone color, or smearing. To 
counteract these side effects, you can first process the additional signals to change 
their spatial character, timbre, or prominence relative to the main center signal.

Using Surround Channels
Subtle surround effects can greatly enhance the listener’s sense of depth compared to 
conventional stereo. Popular music often benefits from creative use of surround. But 
don’t overdo it. The film industry guideline—don’t use surround effects to distract the 
listeners from the story—also works well for music.
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Limitations of the LFE Channel
The Low Frequency Effects (LFE) channel is a separate signal with a limited frequency 
range, and is created by the mixing engineer and delivered alongside the main 
channels in the mix. A “brick wall” filter at 120 Hz in the Dolby Digital Professional 
encoder limits use of the LFE channel to the bottom two audible octaves. Dolby 
recommends limiting the signal to 80 Hz when mixing your sound.

In most music productions (with such exceptions as the famous cannon shots in 
Tchaikovsky’s “1812 Overture”), the LFE channel is not necessary. The LFE signal is also 
discarded in the Dolby Digital Professional downmix process, so intense bass signals do 
not stress small stereo systems. Be sure not to include vital information in the LFE 
channel that would be missed in mono, stereo, or Pro Logic playback.

Because LFE is separate from other channels, its ability to blend with higher 
frequencies can be affected by filters used to generate the LFE signal. To ensure a 
cohesive audio signal, keep the entire signal together in the main channel or channels.

Avoid creating an LFE channel for material originally produced without one. Dolby 
Digital Professional’s five main channels are all full-range, and the LFE channel does not 
increase the frequency response. Dolby Digital Professional decoders offer bass 
management, directing low frequencies to a subwoofer or other suitable speakers. An 
LFE track may interfere with bass management.

Accommodating Stereo Playback
Even with the popularity of 5.1 systems, you should always address stereo reproduction. 
There are three basic ways to do this:
Â Prepare a new stereo mix from the original multitrack elements (using conventional 

stereo-mixing sessions).
Â Prepare a studio-adjusted downmix from the multichannel mix. This method takes 

advantage of the work that has gone into mixing the 5.1 version. It retains flexibility 
in the exact proportions of each channel represented in the final stereo mix.

Â Let the decoder derive a stereo downmix, based on preset formulas in the decoder. 
Downmix options and dynamic range control effects can be previewed and adjusted 
in the production studio, and a range of adjustments are possible.

Always check the mix on an inexpensive surround system to evaluate how well it 
sounds on modest playback systems.

Note:  For more information about Dolby Digital Professional, see “Frequently Asked 
Questions about Dolby Digital Professional,” available at the Dolby Laboratories Inc. 
website:  http://www.dolby.com 

http://www.dolby.com
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9 Creating DV Stream Output Files

Compressor provides the tools you need to create DV files.

Due to its low cost and wide availability, the DV video format is extremely popular for 
standard definition (SD) video capture and delivery. 

This chapter covers the following:

Â About the DV Stream Encoder Pane (p. 145)
Â DV Transcoding Workflow (p. 146)

About the DV Stream Encoder Pane
This section contains detailed information about the various settings within the DV 
Stream Encoder pane of the Inspector window. You make your DV settings by either 
modifying an existing setting or creating a new setting in the Settings tab. 

The Automatic buttons 
for the Format, Aspect 
Ratio, and Field Order 
values
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The DV Stream Encoder pane contains the following settings:
Â Extension:  This field displays the DV file extension dv automatically after the DV 

Stream output format is selected from the File Format pop-up menu, or the ( + ) 
pop-up menu in the Settings tab. 

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. For 
more information, see “Job Segmenting and Two-Pass (or Multi-Pass) Encoding” on 
page 61.

Â Format:  Choose either NTSC or PAL as the output video format. 
Â Aspect Ratio:  Choose either 16:9 or 4:3 as the output video aspect ratio.

Note:  The 16:9 aspect ratio uses anamorphic video.

Â Field Order:  Choose Bottom field first (required for interlaced DV video) with 
interlaced sources or Progressive with progressive sources.

DV Transcoding Workflow
How you use Compressor to transcode your video into DV Stream format files depends 
on how you intend them to be used. The basic steps are: 

Step 1:  Create a batch 
As with any transcode, you need to start by creating a batch.

Step 2:  Create jobs with the source audio files 
Import the source video files either by dragging them from Finder to the batch or by 
using the Job > New Job With File command.

Step 3:  Add targets with a DV setting to each of the jobs 
Each of the jobs requires at least one target—in this case the jobs need targets with a 
DV Stream setting. If there is more than one job, it is easiest to select all the jobs by 
choosing Edit > Select All, and then choosing Target > New Target With Setting, to 
apply the same setting to all the jobs.

Step 4:  Submit the batch for transcoding 
Click the Submit button to start the transcode process.
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10 Creating H.264 for 
Apple Devices Output Files

Using Compressor, you can create iTunes-compliant 
H.264 files. These can be played in iTunes, on a video iPod, 
or with Apple TV.

The efficiency of the H.264 encoder makes it well suited to create media to use with 
iTunes and its related iPod and Apple TV devices. Compressor includes preconfigured 
settings that use the H.264 for Apple Devices Encoder pane to make it easy for you to 
create suitable media files.

This chapter contains the following:
Â About the H.264 for Apple Devices Encoder Pane (p. 148)
Â H.264 Workflows for iPod and Apple TV (p. 152)

For information on creating H.264 files for DVD authoring, see Chapter 11, “Creating 
H.264 for DVD Studio Pro Output Files,” on page 153. For information on creating H.264 
files for uses other than DVD authoring (such as web video), see Chapter 17, “Creating 
QuickTime Movie Output Files,” on page 223. 



148 Chapter 10    Creating H.264 for Apple Devices Output Files

 

About the H.264 for Apple Devices Encoder Pane
This section contains detailed information about the elements of the H.264 for Apple 
Devices Encoder pane in the Inspector window. You make your H.264 settings using 
this pane, by either modifying an existing setting or creating a new setting in the 
Settings tab. 

 

You make your H.264 for Apple Devices settings using the controls described below, 
either by duplicating an existing setting and modifying it or by creating a new setting 
in the Settings tab of the Settings window. The H.264 for Apple Devices Encoder pane 
contains the following items:
Â Extension:  This field displays the H.264 for Apple Devices file extension (.m4v) 

automatically after the H.264 for Apple Devices output format is chosen from the 
File Format pop-up menu or the ( + ) pop-up menu in the Settings tab of the 
Settings window.

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. It is 
relevant only if you are using Compressor with distributed processing and with 
multi-pass encoding. (The distributed processing feature is limited to computers that 
have Final Cut Studio installed.) For more information, see “Job Segmenting and 
Two-Pass (or Multi-Pass) Encoding” on page 61.

Â Size:  Select one of the following size options from the pop-up menu:
Â iPod 640 (VGA):  This option creates video output files with a frame width of 640 pixels.
Â iPod 320 (QVGA):  This option creates video output files with a frame width of 

320 pixels.
Â Apple TV SD:  This option creates video output files with a frame width of 640 pixels 

with a higher bit rate range than the iPod 640 (VGA) size.
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Â Apple TV HD:  This option creates video output files with a frame width of 1280 pixels.

Â Aspect Ratio:  Use the Aspect Ratio pop-up menu to choose the exact pixel 
dimensions of the output media file. The available options depend on which size 
option (VGA, QVGA, or 720p) you selected. See “About the Aspect Ratios” on 
page 151 for more information.
The Aspect Ratio setting also has an Automatic button. Clicking the Automatic button 
causes the encoder to choose the aspect ratio that matches the source video file. 

Important:  The automatic mode for the Aspect Ratio setting is able to choose from a 
wider variety of values to better match the source video (with the values determined and 
displayed when this output format is applied to a source media file). For the best results, 
it is recommended that you use the automatic mode for the Aspect Ratio setting. 

Note:  By default, the Frame Controls feature is set to Automatic. As in the H.264 for 
DVD Studio Pro setting, the Frame Controls Retiming Control will be engaged only if 
the source file is interlaced.

Â Frame Rate:  Use this pop-up menu to choose from the following six options:
Â 29.97:  Used for NTSC-based video
Â 25:  Used for PAL-based video
Â 24:  Used for PAL-based video
Â 23.98:  Used for NTSC-based video
Â 15:  Used for web-based video
The Frame Rate setting also has an Automatic button. Clicking the Automatic button 
causes the encoder to choose the frame rate that matches the source video file. 

The aspect ratio Automatic 
button

The frame rate Automatic 
button
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Â Bit Rate:  Use this slider to choose the bit rate to use for the output video, or enter a 
number in the text field. The available ranges depend on the Size setting. The setting 
you should choose depends on how the output is to be used. Higher bit rates 
produce better picture quality, but they also produce larger output files. 

Â Frame Sync:  Also known as the key frame interval, the Frame Sync value represents how 
often a key frame is inserted in the H.264 stream. The lower the number, the more 
smoothly the video can be manipulated (scrubbed) during playback (more frequent 
key frames). The higher the number, the more efficient the compression (less frequent 
key frames). The available range is from 2 to 10 seconds; the default is 5 seconds. 
The Frame Sync setting also has an Automatic button. Clicking the Automatic button 
causes the encoder to choose a frame sync rate that matches the source video file. 

Â Multi-pass:  Similar to two-pass MPEG-2 encoding, multi-pass offers the best 
possible quality. For faster (single-pass) encoding, turn this feature off by deselecting 
the checkbox. 

Note:  If you are also using distributed processing, you may want to turn off job 
segmenting. (See “Allow Job Segmenting” on page 148.) For more information, see 
“Job Segmenting and Two-Pass (or Multi-Pass) Encoding” on page 61.

Â Include AAC Audio:  Use this checkbox to include a stereo AAC audio track in the 
output movie. The audio track will have a bit rate of 128 kbps. The sample rate will 
be either 44.1 kHz or 48 kHz, depending on the input audio.
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Chapter and Podcast Markers for iPod Output
Chapter markers created in Final Cut Pro are passed through (transferred) to other 
output files that can be recognized by QuickTime Player, iTunes (.m4v files), 
Final Cut Pro, and DVD Studio Pro. 

You can also add podcast markers to the output file. Podcast markers are similar to 
chapter markers (they can have a URL and artwork assigned to them); however, they 
cannot be navigated to directly by the viewer. They are intended to provide a 
slideshow function to audio podcasts. For information about adding chapter and 
podcast markers, see “Adding Markers to a Clip” on page 297.

About the Aspect Ratios
The choice you make with the Size pop-up menu defines the width of the encoded file. 
The choice you make in the Aspect Ratio pop-up menu defines the height of the encoded 
file. Compressor scales the source video vertically to make it fit the height. This means that 
the source video must be anamorphic (things look tall and skinny) in anticipation of being 
scaled to fit the intended aspect ratio. Non-anamorphic video set to an aspect ratio other 
than its native aspect ratio will appear distorted in the encoded file.

Important:  If your source video is letterboxed, use the aspect ratio that matches the 
whole video frame, including the black bars, or else you will end up with distorted 
output files. You can use the automatic crop feature to crop off the letterbox bars. See 
Chapter 21, “Adding Geometry Settings,” on page 267, for more information.

The following choices are available in the Aspect Ratio pop-up menu:

If the source media file is either DV NTSC or HDV, but you are unsure of your source 
media file’s aspect ratio, click the Automatic button. This option analyzes the source 
media file’s aspect ratio to determine the appropriate pixel dimensions.

iPod 640 (VGA) iPod 320 (QVGA) Apple TV SD Apple TV HD

4:3 (640 x 480) 4:3 (320 x 240) 4:3 (640 x 480) NA

16:9 (640 x 360) 16:9 (320 x 180) 16:9 (640 x 360) 16:9 (1280 x 720)

1.85:1 (640 x 346) 1.85:1 (320 x 173) 1.85:1 (640 x 346) 1.85:1 (1280 x 692)

2.35:1 (640 x 272) 2.35:1 (320 x 136) 2.35:1 (640 x 272) 2.35:1 (1280 x 544)
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H.264 Workflows for iPod and Apple TV
The efficiency and quality of H.264 creates a number of options for iPod and Apple TV 
video producers:
Â Compressor includes two video sizes specifically designed for playback on an iPod: iPod 

320 (QVGA) and iPod 640 (VGA). Both sizes create output media files that are 
compatible for playing on an iPod, and both will look good on the display of the iPod. 
Â As long as you intend the output media files to be viewed on the iPod itself, you 

can use the iPod 320 encoder size, which produces files that are about one half the 
size of the iPod 640 encoder size.

Â If you expect the output media files to be played on larger displays, whether in 
iTunes or on a monitor connected to an iPod, you should use the iPod 640 encoder 
size with its higher quality.

Â If you have assigned chapter markers to the video using the Preview window, iTunes 
will automatically use the first marker as the poster frame. If you assigned an image 
to any markers in Compressor, the first marker with an image becomes the poster 
frame in iTunes. You can change the poster frame in iTunes if necessary. See the 
iTunes help for more information. See “Adding Chapter or Podcast Markers to a Clip” 
on page 300 for more information about adding chapter markers in Compressor.

Â The Apple TV HD encoder size produces video files that are about four times the size 
of the iPod 640 encoder size. These are not compatible with iPod playback and may 
not play smoothly on older Macintosh computers.



11

     153

11 Creating H.264 for 
DVD Studio Pro Output Files

Compressor includes the ability to easily create H.264 settings 
specifically configured for high definition DVD authoring. 

High definition DVDs have the option of using HD MPEG-2 encoded files or H.264 
encoded files as sources. At DVD data rates, H.264 is generally twice as efficient as 
MPEG-2. That means you can use a lower H.264 bit rate to get the same quality (and 
smaller files) as with an MPEG-2 encoder, or higher quality (and similar file sizes) when 
using the same bit rate for H.264 as you would use for MPEG-2.

This chapter covers the following:
Â About the H.264 for DVD Studio Pro Encoder Pane (p. 153)
Â H.264 Workflows for DVD (p. 158)

About the H.264 for DVD Studio Pro Encoder Pane
This section contains detailed information about the elements of the H.264 for 
DVD Studio Pro Encoder pane in the Inspector window. You make your H.264 settings 
using this pane, by either modifying an existing setting or creating a new setting in the 
Settings tab. 

Note:  This particular Encoder pane is devoted to encoding H.264 files intended for 
authoring high definition (HD) format video DVDs. For information on creating H.264 
files for use with Apple devices such as iTunes, an iPod, or with Apple TV, see 
Chapter 10, “Creating H.264 for Apple Devices Output Files,” on page 147. For 
information about using H.264 for other purposes, see Chapter 17, “Creating QuickTime 
Movie Output Files,” on page 223.
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The H.264 for DVD Studio Pro pane contains the following items:
Â File Extension field:  Displays the QuickTime file extension (mov) automatically after the 

H.264 for DVD Studio Pro output format is selected from the File Format pop-up menu.
Â Allow Job segmenting:  This checkbox allows you to turn off job segmenting. It is only 

relevant if you are using Compressor with distributed processing and with two-pass 
or multi-pass encoding. (The distributed processing feature is limited to computers 
that have Final Cut Studio installed.) For more information, see “Job Segmenting and 
Two-Pass (or Multi-Pass) Encoding” on page 61.

Â Video Format:  Use the Video Format pop-up menu to choose from the following four 
options. All of them are HD progressive formats:
Â NTSC:  This format is referred to as 480p. It uses a 720 x 480 frame size with an 

anamorphic 16x9 format at 59.94 fps.
Â PAL:  This format is referred to as 576p. It uses a 720 x 576 frame size with an 

anamorphic 16x9 format at 50 fps.
Â 720p:  This format uses a 1280 x 720 frame size with a 16x9 format at either 59.94 

fps for NTSC or 50 fps for PAL. 
Â 1920x1080:  This format is referred to as 1080p. It uses a 1920 x 1080 frame size with 

a 16x9 format at either 59.94 fps for NTSC or 50 fps for PAL. 
The Video Format setting also has an Automatic button. Clicking the Automatic 
button causes the encoder to choose the video format that matches the source 
video file. 

The video format 
Automatic button
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Â Frame Rate:  Use the Frame Rate pop-up menu to choose from the following options:
Â 23.98:  Used for NTSC-based video
Â 25:  Used for PAL-based video
Â 29.97:  Used for NTSC-based video
Â 50:  Used for PAL-based video
Â 50.94:  Used for NTSC-based video
The Frame Rate setting also has an Automatic button. Clicking the Automatic button 
causes the encoder to choose the frame rate that matches the source video file. 

Note:  If you choose a format in the Video Format menu, the Frame Rate menu will be 
filled in automatically.

Â Average Bit Rate slider and field:  Choose an average bit rate to use for the output 
video with the slider, or enter a value directly. While the available range is between 
0.5 Mbps and 24.99 Mbps, typical HD-based DVD video bit rates with H.264 might 
range from 7 Mbps to 15 Mbps, depending on your DVD bit budget and the nature 
of your source media files. The H.264 file format is twice as efficient as the standard 
MPEG-2 format. This means you can count on a lower bit rate to get the same quality, 
or higher quality at the same bit rate. See “About the Bit Rate Settings” on page 157 
for more information.

Â Maximum Bit Rate slider and field:  Choose a maximum bit rate between 0.59 Mbps and 
29.4 Mbps. You can also enter any number within these ranges into the accompanying 
field. The Maximum Bit Rate cannot be set lower than the Average Bit Rate. As a 
general rule, set your maximum bit rate at least 1 Mbps higher than your average bit 
rate, to allow for bit rate variability in achieving the goal of constant quality.

Important:  For maximum compatibility with HD DVD players, avoid setting the 
maximum bit rate above 18 Mbps.

The frame rate Automatic 
button
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Â Frame Sync:  Use the slider or enter a value directly to choose the Frame Sync rate for 
the output video. The default setting is 2 seconds. See “About the Frame Sync 
Setting” on page 156 for more information.

Â Multi-pass:  Use this checkbox to turn on multi-pass encoding. Similar to two-pass 
MPEG-2 encoding, multi-pass offers the best possible quality. For faster (single-pass) 
encodes, turn this feature off by deselecting the checkbox. See “Using Multi-Pass for 
DVD Authoring” on page 157 and “Job Segmenting and Two-Pass (or Multi-Pass) 
Encoding” on page 61 for more information.

Â Include PCM Audio:  Use this checkbox to include a 16-bit, 48 kHz stereo PCM audio 
track in the output QuickTime movie. Most DVD producers will use a Dolby Digital 
Professional (AC-3) setting for the audio with its much higher efficiency. In that case, 
you can deselect this checkbox and make sure that a Dolby 2.0 setting is applied to 
the job in the Batch window. If you select the checkbox, encode the H.264 movie, 
and then import the movie into DVD Studio Pro, the video track and the audio track 
will appear as two separate items in the Assets tab, as if you had imported one video 
asset and one audio asset. 

About the Frame Sync Setting
The Frame Sync setting defines an H.264 group of pictures (GOP). One difference 
between MPEG-2 and H.264 encoding is that a frame within a GOP can reference 
frames other than those that it is closest to, which means the decoder must store all 
potential reference frames in order to be able to access them. The first frame of an 
H.264 GOP is a special I-frame known as an instantaneous decoder refresh (IDR) frame 
that also flushes the decoder’s reference frame buffers.

FS PS

GOP
Two seconds default

GOVU
0.5 seconds default

Partial Sync
key frame

PS PS

Frame Sync
key frame
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This means that frames within the GOP defined by the Frame Sync setting can 
reference any other frames in that GOP, but not those outside the GOP. The result is that 
a longer frame sync setting creates a larger GOP, with more frames available for 
referencing, while a shorter setting results in a smaller GOP and fewer frames that can 
be referenced. 

Additional I-frames, referred to as partial sync key frames, are added to the GOP. These 
standard I-frames define a group of video access unit (GOVU).

Important:  To conform to the HD DVD specification and its requirements for maximum 
GOVU length, Compressor inserts a partial sync key frame every 0.5 seconds.

Using Multi-Pass for DVD Authoring
To ensure that any H.264 files you create with Compressor will compile properly into 
HD DVD–compliant files in DVD Studio Pro, make sure that multi-pass encoding is 
turned on. 

To turn on H.264 multi-pass encoding:
1 Open the Settings tab.

2 Select the setting in the Settings tab that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Open the H.264 Encoder pane in the Inspector window.

4 Select the Multi-pass checkbox.

About the Bit Rate Settings
When determining average and maximum bit rates for DVD playback, remember to 
consider the bit rate of your audio tracks as well as the H.264 bit rate. 

Important:  For maximum compatibility with HD DVD players, avoid setting the 
maximum bit rate above 18 Mbps.

You must keep the total of both average and maximum audio and video bit rates 
under 30 Mbps, the maximum guaranteed transfer rate from high definition DVD 
players. Because DVD-compatible audio formats are constant bit rate (CBR), there is no 
maximum audio bit rate to worry about. 

For example, if you are using AIFF audio at 1.5 Mbps, you should keep both the average 
and maximum video bit rates for high definition DVDs under 28.5 Mbps. Typically, your 
average bit rate will be lower than this (from 7 Mbps to 15 Mbps). However, your 
maximum bit rate must also stay under this number. The 28.0 Mbps maximum bit rate 
is recommended to provide an extra margin for error (for example, to accommodate 
subtitle streams). 
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If you are using one of the DVD-compatible compressed audio formats such as Dolby 
Digital or MPEG-1/Layer-2, your audio bit rate may be as low as 0.2 Mbps to 0.4 Mbps, 
in which case you can set your maximum bit rate about 1 Mbps higher. As a general 
rule, set your maximum bit rate at least 1 Mbps higher than your average bit rate, to 
allow for bit rate variability in achieving the goal of constant quality.

H.264 Workflows for DVD
The efficiency and quality of H.264 creates a number of options for DVD producers:
Â Since H.264 can deliver high definition (HD) video at standard definition (SD) bit 

rates, you can get 90 minutes of HD content on a regular DVD-5 disc, which is 
playable on the new HD DVD players.

Â Video resolutions supported by SD DVDs are also supported by HD DVDs. This means 
that a high definition DVD can use an HD video resolution file for its main content, 
such as a feature film, and then use SD video resolution files for additional features 
like trailers and a “making-of” documentary. 

Â H.264 assets must be progressive, so interlaced SD video files must be converted to 
progressive. Alternatively, you can encode MPEG-2 files from the interlaced SD video 
files and add those to your DVD project.
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12 Creating Image Sequence Files

You can use Compressor to output an image sequence 
for use by compositing applications. 

This chapter discusses the image sequences that Compressor can output from your 
source media files:
Â Creating Image Sequence Output Files (p. 159)
Â About the Image Sequence Encoder Pane (p. 160)
Â Configuring Image Sequence Settings (p. 161)

Creating Image Sequence Output Files
The Image Sequence output format creates a set of still-image files representing the 
source video frames. Use this encoder to convert a video clip to an image sequence for 
use with compositing applications that aren’t compatible with QuickTime.

The Image Sequence output format supports two still image formats:

Â TIFF (Tagged Image File Format):  TIFF is one of the most common and flexible still-
image formats, and was developed to create a standard file format for storing and 
exchanging digital graphics used in desktop publishing. It is compatible with a wide 
range of compositing and image processing applications. 

Â TARGA (Truevision Advanced Raster Graphics Adapter):  TARGA, also commonly referred to 
as TGA, is a raster graphics format commonly used by animation and video applications.
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About the Image Sequence Encoder Pane

The Image Sequence Encoder pane contains the following items to help you create 
your TIFF or TARGA output files:
Â File Extension:  This field displays the TIFF file extension tiff automatically after TIFF 

output format is selected from the File Format pop-up menu or the ( + ) pop-up 
menu in the Settings tab. Don’t alter this field.

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. It is only 
relevant if you are using Compressor with distributed processing and with two-pass 
or multi-pass encoding. (The distributed processing feature is limited to computers 
that have Final Cut Studio installed.) For more information, see “Job Segmenting and 
Two-Pass (or Multi-Pass) Encoding” on page 61.

Â Image Type:  Choose either TIFF or TARGA from the pop-up menu.
Â Frame Rate (fps):  Use this field and pop-up menu to enter the frame rate at which you 

want the still images to be created. The higher the frame rate, the greater the number 
of still images created and the larger the output file. For example, if you choose 30 fps, 
Compressor creates 30 still images for every second of the video clip you are 
transcoding. If you choose 8 fps, Compressor only creates 8 still images per second.

Â Create unique output directory:  Select this checkbox to create a folder for the 
resulting output files. The folder is given the same name as that of the media file, and 
the files are stored inside the folder and named frame-nnn. For example, if the output 
filename is test, the directory path is destination/test/frame-nnn.
If you don’t select this box, the output files are stored at the top level of your destination 
folder and named filename-nnn rather than frame-nnn. Be aware that even at the slow 
rate of 8 fps, a large number of files are created when you transcode to this output 
format, so creating an output directory is a good way to keep your files organized.

Choose Image Sequence.

Choose either the TIFF 
or TARGA image type.

Choose a frame rate from 
the Frame Rate pop-up. 
menu or click the 
Automatic button.
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Â Add leading zeros to frame numbers:  Select this checkbox to add leading zeros to the 
frame number. When choosing this method, all the output files consist of multidigit 
filenames, such as frame-000001 (or filename-000001 if these files aren’t being saved 
in a unique output directory). If you don’t select this checkbox, each file uses a 
regular filename, such as frame-1 (or filename-1 if these files aren’t being saved in a 
unique output directory).

Configuring Image Sequence Settings
You use the Image Sequence output format if you want to transcode a video clip into a 
series of still images. 

To create an Image Sequence setting:
1 In the Settings tab, do one of the following:

Â Make sure that the correct setting is selected.
Â Create a new setting by choosing Image Sequence from the “Create a new setting” 

( + ) pop-up menu.

2 Click the Encoder tab, then choose Image Sequence from the File Format pop-up menu.

The Image Sequence Encoder pane appears.

3 Choose either the TIFF or TARGA image type.

4 Enter a number in the Frame Rate (fps) field or choose a frame rate from the pop-up menu.

5 Select the “Create unique output directory” checkbox if you want your image sequence 
files stored in their own folder in the destination folder. 

6 Select the “Add leading zeros to frame numbers” checkbox if you want your output 
image sequence files numbered with the format 0000nn.

Important:  The Compressor Remote Destination feature does not support uploading 
image sequences to a remote destination (FTP server). Instead, use FTP software to 
upload the image sequence to remote servers.

See “About the Image Sequence Encoder Pane” on page 160 for more information 
about the Image Sequence Encoder pane.

Note:  You can see the current contents of your setting by viewing the Summary pane 
of the Inspector window.
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13 Creating MP3 Output Files

Compressor provides the tools you need to create 
exceptional MP3 files.

MP3 is a specific type of MPEG encoding known formally as MPEG audio layer 3. MP3 
uses perceptual audio coding and psychoacoustic compression to remove all 
superfluous information (specifically the redundant and irrelevant parts of a sound 
signal that the human ear doesn't hear anyway). The result is that MP3 encoding 
shrinks the original sound data from a CD (with a data rate of 1411.2 kilobits per one 
second of stereo music) by a factor of 12 (down to 112–128kbps) without sacrificing very 
much sound quality. Proponents of MP3 actually claim there is no sacrifice in sound 
quality, but audio professionals can usually hear the difference on good equipment. 

This chapter covers the following:
Â Common Uses for MP3 (p. 163)
Â About the MP3 Encoder Pane (p. 164)
Â MP3 Transcoding Workflow (p. 166)

Common Uses for MP3
MP3 is a widely adopted standard for compressed audio files, so it can be used in many 
different ways. Here are a few:

Music
Almost every portable digital music player supports the MP3 audio format. By using 
the higher bit rates, for example 256 kbps, you can create an excellent quality audio file 
using a much smaller file size than with uncompressed audio. 

You can also add metadata to the file so that when the output media file opens in 
many players (including iTunes) the common information, such as artist, album, and so 
on, appear.
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Podcasts
The MP3 format’s wide range of supported bit rates makes it ideal for delivering 
podcasts at a variety of quality levels, making it possible for users to choose a file size 
and quality level they are comfortable with.

Note:  For the most options when creating enhanced audio podcasts, use the MPEG-4 
output format. You are able to add chapter and podcast markers with URLs and 
artwork to the output file. See Chapter 16, “Creating MPEG-4 Output Files,” on page 211, 
for more information.

About the MP3 Encoder Pane
This section contains detailed information about the various settings within the MP3 
Encoder pane of the Inspector window. You make your MP3 settings by either 
modifying an existing setting or creating a new setting in the Settings tab. 

The MP3 Encoder pane contains the following settings:
Â Extension:  This field displays the MP3 file extension mp3 automatically after the MP3 

output format is selected from the File Format pop-up menu, or the ( + ) pop-up 
menu in the Settings tab. 

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. Since 
job segmenting is not used for audio-only encodes, this checkbox is not active with 
the MP3 file format. For more information, see “Job Segmenting and Two-Pass (or 
Multi-Pass) Encoding” on page 61.
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Â Stereo Bit Rate pop-up menu:  The higher the Mono or Stereo kilobits per second 
(Kbps), the higher the audio quality and the larger the file size. The most common bit 
rate for stereo MP3 files is between 128 Kbps and 192 Kbps. Lower bit rates are more 
appropriate for sound files containing voice recordings (as opposed to music).
Some example settings and uses include:

Â 32 kbps:  AM radio quality, suitable for medium quality speech
Â 96 kbps:  FM radio quality, suitable for high quality speech or medium quality music
Â 128 kbps:  Suitable for good quality music
Â 256 kbps and 320 kbps:  Suitable for near-audio CD quality music

Â Use Variable Bit Rate Encoding (VBR):  This setting varies the number of bits used to 
store the music depending on the complexity of the music. This can help keep file 
size to a minimum.

Â Sample rate pop-up menu:  The number of times per second that the music 
waveforms are captured digitally. The higher the sample rate, the higher the quality 
and the larger the file size. Don't choose a sample rate higher than the rate used 
originally to store the music or you'll waste space. CD quality, for example, is 44.100 
kHz, so choosing a higher rate when you're encoding from a CD is unnecessary. 

Â Channels pop-up menu:  If you don't have stereo speakers or if your audio files are 
monaural, choose Mono (mono files are about half the size of stereo files). If you'll be 
listening to your MP3 files using your stereo system, choose Stereo. 

Â Joint Stereo:  When deselected, your MP3 files contain one track for the right stereo 
channel and one track for the left. In many cases, the two channels contain related 
information. When the Joint Stereo checkbox is selected, one channel carries the 
information that's identical on both channels, and the other channel carries the 
unique information. At bit rates of 160 Kbps and below, this can improve the sound 
quality of your converted audio.

Â Smart Encoding Adjustments:  Select this to have Compressor analyze your encoding 
settings and music source, and then adjust settings to maximize quality.

Â Filter Frequencies Below 10 Hz:  Filtering inaudible frequencies results in smaller, more 
efficient files without perceptible loss of quality. 
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MP3 Transcoding Workflow
How you use Compressor to transcode your audio into MP3 format files depends on 
how you intend them to be used. The basic steps are:

Step 1:  Create a batch 
As with any transcode, you need to start by creating a batch.

Step 2:  Create jobs with the source audio files 
Import the source audio files either by dragging them from Finder to the batch or by 
using the Job > New Job With File command.

Step 3:  Add annotations (if needed) 
If you intend to play the MP3 files with a device or application, such as iTunes, you can 
add a variety of annotations, such as Artist, Album, Title, and so on, that can be read 
and displayed.

Step 4:  Add targets with an MP3 setting to each of the jobs 
Each of the jobs requires at least one target—in this case the jobs need targets with an 
MP3 setting. If there is more than one job, it is easiest to select all the jobs by choosing 
Edit > Select All, and then choosing Target > New Target With Setting, to apply the 
same setting to all the jobs.

Step 5:  Submit the batch for transcoding 
Click the Submit button to start the transcode process.
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14 Creating MPEG-1 Output Files

Compressor provides the tools you need to create 
exceptional MPEG-1 transcoded files.

MPEG-1 is an internationally accepted compression standard developed by the Motion 
Picture Experts Group (MPEG). MPEG-1 allows you to create VHS-quality video files and 
was designed to support SIF (Standard Interface Format) resolution noninterlaced 
(progressive) video using relatively low bit rates (Compressor supports 0.5 Mbps to 
2 Mbps). It also allows you to create compressed 1-channel and 2-channel audio. 

This chapter covers the following:
Â Common Uses for MPEG-1 (p. 167)
Â MPEG-1 Specifications (p. 168)
Â About the MPEG-1 Encoder Pane (p. 169)
Â About System and Elementary Streams (p. 172)
Â MPEG-1 Transcoding Workflow (p. 172)
Â Configuring the MPEG-1 File Format for Web Use (p. 174)
Â Configuring the MPEG-1 File Format for DVD Use (p. 175)

Common Uses for MPEG-1
MPEG-1 is a widely adopted standard, so it can be used in many different ways. Here 
are a few:

DVD, VCD, and CD ROM
MPEG-1 is the video compression format used for video CD (VCD) titles and is 
compatible for use on DVD titles since all DVD players contain the hardware required 
for MPEG-1 playback. MPEG-1 is commonly used in videos distributed on CD ROM. Its 
low bit rate and small file sizes are useful when you must fit multiple hours of video 
onto a DVD and do not require the broadcast quality of MPEG-2 encoding. A DVD can 
contain a mix of MPEG-2 and MPEG-1 video.
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On the Web
Since MPEG-1 was one of the first widely adopted compression standards, it has an 
advantage of being compatible with most media players. This makes MPEG-1 attractive 
for use on the web when you need maximum compatibility with relatively high quality.

Audio-Only
You can use MPEG-1 Layer 2 audio compression as an alternative to Dolby Digital 
Professional or DTS compression. While there is no Apple setting for MPEG-1 audio-only 
files in this release of Compressor, you can easily create a setting yourself. See 
“Configuring the MPEG-1 File Format for DVD Use” on page 175 for details.

MPEG-1 Specifications
Compressor supports all the MPEG-1 specifications for frame sizes, frame rates, video 
encoding, and audio encoding. 

MPEG-1 Frame Sizes and Frame Rates
Compressor can produce full frame rate video (25 fps and 29.97 fps for DVD and 23.976 
fps, 25 fps, and 29.97 fps for the web) with SIF resolutions dependent on the use:
Â Web:  320 x 240
Â NTSC:  352 x 240
Â PAL:  352 x 288

While the NTSC and PAL resolutions are roughly half the full resolution of MPEG-2 
video, when played on a DVD player they automatically expand to fill the entire screen.

MPEG-1 File Format Specifications
MPEG-1 video encoding uses a process very similar to that used in MPEG-2 encoding—
many of the same terms and settings apply. In Compressor, the encoding settings are 
set as follows:
Â Encoding mode:  One pass
Â GOP structure:  Open
Â GOP pattern:  BBIBBP
Â GOP length:  15 frames for NTSC; 12 frames for PAL

These settings are fixed and apply to all Compressor MPEG-1 video output files. 
See “GOP Tab” on page 195 for information about Group of Pictures (GOP) settings. 
See “Quality Tab” on page 190 for information on the encoding mode.
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The MPEG-1 output files can have I-frames forced on specific frames by placing 
compression markers on them. These markers can be added to the source media file 
using Final Cut Pro or can be added manually in the Preview window. See “Adding 
Markers to a Clip” on page 297 for more information.

The MPEG-1 format does not support named chapter markers.

About the MPEG-1 Encoder Pane
This section contains detailed information about the various tabs within the MPEG-1 
Encoder pane of the Inspector window. You make your MPEG-1 settings using these tabs, 
by either modifying an existing setting or creating a new setting in the Settings tab. 

The MPEG-1 Encoder pane opens with the default Video tab on top and contains the 
following items:
Â Extension:  This field displays the MPEG-1 file extension mpg automatically after the 

MPEG-1 output format is selected from the File Format pop-up menu, or the ( + ) 
pop-up menu in the Settings tab. Changes to m1v if the Audio tab is disabled, or 
m1a if the Video tab is disabled.

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. It is 
relevant only if you are using distributed processing. (The distributed processing 
feature is limited to computers that have Final Cut Studio installed.) For more 
information, see “Job Segmenting and Two-Pass (or Multi-Pass) Encoding” on 
page 61.

Â Video and Audio tabs:  These buttons open the Video and Audio tabs described next.
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Video Tab
You use the Video tab to make settings related to the video format.

Â Enabled checkbox:  Make sure this box is selected if you want the MPEG-1 output 
format to include the Video tab settings.

Â Frame Rate pop-up menu:  Choose the frame rate of the video you are encoding. 
Â With Purpose set to Web, the choices are 23.976, 25 (PAL frame rate), 29.97 (NTSC 

frame rate), and Automatic. 
Â With Purpose set to DVD, the choices are 25 (PAL frame rate), 29.97 (NTSC frame 

rate), and Automatic. 
Clicking the Automatic button forces the encoder to determine the proper frame rate 
by choosing the rate that most closely matches the source frame rate.

Note:  Using the Automatic setting with nonstandard source frame rates may result in 
output frame rates that do not match the intended video frame rate. For example, a 
source frame rate of 15 fps with the Purpose set to DVD results in an automatic 
selection of 25 (PAL). If you are intending to use the output on an NTSC DVD, you 
must choose 29.97 as the frame rate.

Â Purpose buttons:  Choose the intended purpose for the output files. 
Â Web:  Forces the resolution to 320 x 240 regardless of the Frame Rate selection.
Â DVD:  Allows the Frame Rate selection to set the resolution. With the 29.97 frame 

rate, the resolution is 352 x 240. With the 25 frame rate, the resolution is 352 x 288.

The Automatic button
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Â Bit rate:  Use this slider to choose the bit rate to use for the output video, or enter a 
number directly into the text field. While the available range is from 0.5 Mbps to 2.0 
Mbps, the actual setting you should use depends on how the output is to be used. 
Higher bit rates produce better picture quality, but they also produce larger output files.
Â For web projects, choose a bit rate that best balances the picture quality with file 

size and download expectations.
Â For VCD projects, the recommended video bit rate is 1.15 Mbps, with a system stream 

(multiplexed video and audio in the same file) bit rate of under 1.3944 Mbps.
Â For DVD projects, the typical video bit rate is 1.15 Mbps with 1.856 Mbps being the 

maximum allowed.

Audio Tab
You use the Audio tab to make settings related to the audio format.

Â Enabled checkbox:  Make sure this box is selected if you want the MPEG-1 output 
format to include the Audio tab settings.

Â Sample Rate pop-up menu:  Choose the sample rate of the output audio.
Â 48 kHz:  Required for use on DVDs.
Â 44.1 kHz:  Used on audio CDs. This is the most commonly supported sample rate. 

Â Channels buttons:  Choose whether to create a stereo or mono output audio.
Â Bit Rate pop-up menu:  Choose the bit rate to use for the output audio. Choices are 64 

Kbps, 128 Kbps, 192 Kbps, 224 Kbps, and 384 Kbps. While higher bit rates produce 
higher quality audio, they also produce larger output files.

Note:  The 224 Kbps and 384 Kbps settings are not available when Channels is 
set to Mono.
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About System and Elementary Streams
You can use Compressor to create system or elementary MPEG-1 streams. 

System Streams
System streams, also known as multiplexed streams, combine the video and audio 
components into the same file. This type of stream is most often used in web applications.

Compressor automatically creates a system stream when you enable both the Video 
and Audio tabs in the same setting.

Elementary Streams
With elementary streams, there are separate files for the video and audio components. 
Elementary streams are required by some applications, such as DVD Studio Pro.

Compressor automatically creates an elementary stream when only the Video or Audio tab 
is enabled, but not both. To create elementary streams of both the video and the audio, 
you must use two settings—one with the Video tab enabled using the file extension of 
.m1v, and a second with the Audio tab enabled using the file extension of .m1a.

MPEG-1 Transcoding Workflow
This section gives step-by-step instructions for setting your MPEG-1 attributes prior to 
creating MPEG-1 output files with Compressor. Make your MPEG-1 settings from the 
MPEG-1 Encoder pane by either modifying an existing setting or creating a new 
setting. See the following steps for working with the MPEG-1 output file format.
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Example MPEG-1 Settings
The settings you use depend on whether you are encoding for use on the web or in a 
DVD project.

Encoding for the Web
Use the following settings when encoding MPEG-1 system streams for the web.

Video tab
Â Frame rate:  Automatic
Â Purpose:  Web
Â Bit rate:  As low as you can set it and get acceptable picture quality

Audio tab
Â Sample rate:  44.1 kHz
Â Channels:  Stereo with two-channel sources; Mono with one-channel sources
Â Bit rate:  As low as you can set it and get acceptable audio quality; use higher bit 

rates when encoding stereo audio

Encoding for DVD
Use the following settings to configure two settings when encoding MPEG-1 
elementary streams for DVD authoring. 

Video elementary stream setting—Video tab 
Â Frame rate:  29.97 for NTSC or 25 for PAL
Â Purpose:  DVD
Â Bit rate:  1.15 Mbps

Video elementary stream setting—Audio tab
Â Enabled box deselected

Audio elementary stream setting—Video tab
Â Enabled box deselected

Audio elementary stream setting—Audio tab
Â Sample rate:  48 kHz
Â Channels:  Stereo with two-channel sources; Mono with one-channel sources
Â Bit rate:  192 Kbps or 224 Kbps
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Configuring the MPEG-1 File Format for Web Use
The following steps guide you through configuring the MPEG-1 output file format for 
web use. This process creates a single MPEG-1 system stream.

Step 1:  Open the MPEG-1 Encoder pane and choose Video settings
1 Open the Settings tab, then choose MPEG-1 from the “Create a New Setting” ( + ) 

pop-up menu.

The MPEG-1 Encoder pane opens in the Inspector with the default Video tab displayed.

2 Name the new setting “MPEG-1 for Web. “

3 Select the Enabled box.

4 Click the Automatic button next to the Frame Rate pop-up menu. 

You can also choose 23.976, 29.97, or 25 from the Frame Rate pop-up menu if you know 
the frame rate of the source video.

5 Select the Web button. 

This sets the resolution of the output to 320 x 240.

6 Choose the bit rate to use from the Bit Rate slider, or enter a value directly.

Select to enable the
Video tab.

Click the Automatic 
button or choose a 
frame rate.

Select Web to set the
resolution to 320 x 240.

Choose the bit rate.
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Step 2:  Choose Audio settings
1 Click the Audio button in the MPEG-1 Encoder pane to open the Audio tab.

2 Select the Enabled box.

3 Choose 44.1 kHz from the Sample Rate pop-up menu.

4 Select Stereo when using two-channel audio sources, or Mono when using one-channel 
audio sources.

5 Choose the bit rate to use from the Bit Rate pop-up menu.

6 Click the Save button (in the lower-right corner of the Inspector) to save this setting.

Configuring the MPEG-1 File Format for DVD Use
The following steps guide you through configuring the MPEG-1 output file format for 
DVD use. This process creates two settings, one for video and another for audio, 
creating elementary streams.

Creating the MPEG-1 Video for DVD Setting
The following steps create the setting for an MPEG-1 elementary video output file.

Step 1:  Create the MPEG-1 Video for DVD setting
1 Open the Settings tab, and choose MPEG-1 from the “Create a New Setting” ( + ) 

pop-up menu.

This adds a new setting to the existing list.

2 Name the new setting “MPEG-1 Video for DVD. “

See “Creating a Setting from Scratch” on page 94 for more information.

Select to enable the
Audio tab. Choose the 44.1 kHz 

sample rate.
Select the number of

audio channels. Choose the bit rate.
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Step 2:  Open the MPEG-1 Encoder pane and configure the Video settings
1 Click the Encoder tab and choose MPEG-1 from the File Format pop-up menu. 

2 Click the Video button in the MPEG-1 Encoder pane to open the Video tab.

3 Select the Enabled box.

4 Choose the frame rate that matches your source video, either 29.97 or 25, from the 
Frame Rate pop-up menu.

5 Select the DVD button. 

This sets the resolution of the output to match the selected frame rate.

6 Choose the bit rate to use with the Bit Rate slider, or enter a value directly.

The typical value used for DVD projects is 1.15 Mbps, with 1.856 Mbps being the 
maximum allowed.

Select to enable the
Video tab.

Choose the frame rate.

Select DVD to set the
resolution to match the

frame rate.

Choose the bit rate.

The file extension changes 
to m1v once the Audio tab 
is disabled.
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Step 3:  Turn off audio for the video setting
1 Click the Audio button in the MPEG-1 Encoder pane to open the Audio tab.

2 Deselect the Enabled box.

This ensures that this setting (preset) will only create an elementary video stream and 
sets the file extension to m1v.

3 Click the Save button (in the lower-right corner of the Inspector) to save this setting.

This saves the “MPEG-1 Video for DVD “ setting.

Creating the MPEG-1 Audio for DVD Setting
The following steps create the setting for an MPEG-1 elementary audio output file.

Step 1:  Create the MPEG-1 Audio for DVD setting
1 Open the Settings tab and click the Add Preset ( + ) button.

This adds a new setting to the existing list.

2 Name the new setting “MPEG-1 Audio for DVD.” 

See “Creating a Setting from Scratch” on page 94 for more information.

Deselect to disable the
Audio tab.
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Step 2:  Turn off the video for the audio setting
1 Click the Encoder tab and choose MPEG-1 from the File Format pop-up menu. 

2 Click the Video button in the MPEG-1 Encoder pane to open the Video tab.

3 Deselect the Enabled box.

This ensures that this preset will only create an elementary video stream and sets the 
file extension to m1a.

Step 3:  Configure the Audio settings
1 Click the Audio button in the MPEG-1 Encoder pane to open the Audio tab.

2 Select the Enabled box.

3 Choose 48 kHz from the Sample Rate pop-up menu.

4 Select Stereo when using two-channel audio sources, or Mono when using one-
channel audio sources.

5 Choose the bit rate to use from the Bit Rate pop-up menu.

The typical values used for DVD projects are 192 Kbps and 224 Kbps.

6 Click the Save button (in the lower-right corner of the Inspector) to save this setting.

This saves the “MPEG-1 Audio for DVD” preset.

Deselect to disable the
Video tab.

The file extension changes 
to m1a once the Video tab 
is disabled.

Select to enable the
Audio tab. Choose the 48 kHz 

sample rate.
Select either

Stereo or Mono. Choose the bit rate.
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Creating a Group and Destination
To make it easy to use these two MPEG-1 presets with a source, you can create a preset 
group using them. See “Creating Groups of Settings” on page 98 for more information.

Also, to make it easier to use the output files created by these presets in 
DVD Studio Pro, create a destination that ensures the video and audio output files have 
the same name, only with different file extensions. See “Creating Destinations for Use 
with DVD Studio Pro” on page 314 for more information.





15

     181

15 Creating MPEG-2 Output Files

Compressor provides the tools you need to create 
exceptional MPEG-2 transcoded files.

MPEG-2 is an internationally accepted compression standard developed by the Motion 
Picture Experts Group (MPEG). MPEG-2 allows you to create broadcast-quality video files 
and was designed to support high-resolution, high bit-rate video. It is the video 
compression format used for high-quality video titles on DVD, HD broadcast, and home 
satellite dish systems. All DVD players contain the hardware required for MPEG-2 playback. 

This chapter covers the following:
Â About Standard Definition MPEG-2 (p. 181)
Â About High Definition Sources and MPEG-2 (p. 182)
Â About Elementary, Transport, and Program Streams (p. 183)
Â About the MPEG-2 Encoder Pane (p. 184)
Â MPEG-2 Transcoding Workflow (p. 202)

About Standard Definition MPEG-2
Standard MPEG-2 is full frame rate (23.98–29.97 fps) and full-screen resolution (720 x 
480 for NTSC and 720 x 576 for PAL). MPEG-2 has the following characteristics:
Â Support for interlaced video:  MPEG-2 can support either interlaced or progressive 

video. Because MPEG-2 streams are generally played from a local DVD drive, rather 
than over a network with variable bandwidth, video frame rate usually stays 
constant, and the video normally looks completely smooth. 

Â No streaming support:  MPEG-2 is not suitable for streaming video files over the web 
because it requires a high bit rate (2 to 9 Mbps) to maintain acceptable image quality. 

Note:  The Compressor MPEG-2 encoder can create MPEG-2 video streams for the 
DVD-Video format. To create DVD-Video discs, you must use a DVD authoring 
application, such as DVD Studio Pro, in conjunction with Compressor.
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About High Definition Sources and MPEG-2
Compressor has several different options and workflows for transcoding high definition 
(HD) video source files into MPEG-2 files.

HD on DVD
Compressor can output MPEG-2 files for creating HD-resolution DVDs from either HD or 
standard definition (SD) source media. Compressor can retain the various frame sizes 
and frame rates of high definition video when transcoding to MPEG-2. And Compressor 
supports the higher bit rates required by HD-based DVD formats. For more information 
on creating output for HD-based DVDs, see “About the MPEG-2 Encoder Pane” on 
page 184 and the DVD Studio Pro User Manual.

Note:  The other output file format option for HD-based DVDs is H.264, also known as 
MPEG-4 Part 10. H.264 is currently mandatory in both new high definition DVD 
specifications (HD DVD and Blu-ray). For more information about creating H.264 files for 
HD on DVD, see “Creating H.264 for DVD Studio Pro Output Files” on page 153. 

HD to SD Downconversion
For those situations in which you are editing high definition (HD) sources in 
Final Cut Pro and want to create a standard definition (SD) DVD from them, Compressor 
provides high-quality downconversion. Compressor retains as much detail as possible 
during scaling and correctly preserves progressive or interlaced formats when 
encoding to MPEG-2 for DVD. 

To see the source media resolution and frame rate:
1 Import the source media file into the Batch window.

2 Click the source’s name in the Batch window.

The source media file’s resolution and frame rate, along with its duration, appear in the 
lower-left corner of the Preview window.
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About Elementary, Transport, and Program Streams
There are three common MPEG-2 stream types that are used to deliver MPEG-2 
encoded video:
Â Elementary streams:  These streams contain only one MPEG-2 content channel and no 

audio. Elementary streams are required if you intend to use your MPEG-2 encoded 
video as a DVD Studio Pro asset.

Â Transport streams:  These streams can contain several MPEG-2 content channels and 
associated audio. All the channels are multiplexed together, allowing the receiver to 
choose which to play back. Compressor supports creating single-channel transport 
streams that can optionally include associated audio. 
Transport streams can also recover from interruptions during playback, making them 
ideally suited for broadcast and streaming applications where noise or network 
congestion can lead to interruptions.

Â Program streams:  These streams contain only one MPEG-2 content channel and its 
associated audio. Program streams require an error-free delivery method and are 
primarily used for storage or processing within a computer. 

By default, the Compressor MPEG-2 encoder creates elementary MPEG-2 steams. You 
can configure the MPEG-2 encoder to create transport or program streams and choose 
whether they should include audio in the Extras tab. See “Extras Tab” on page 197 for 
more information.

Note:  All the Stream Usage settings except Generic output elementary streams. If you 
select any of the other Stream Usage settings and then configure the output to be 
either a transport or program stream, the Stream Usage changes to Generic. See 
“Stream Usage” on page 185 for more information.
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About the MPEG-2 Encoder Pane
This section contains detailed information about the various tabs within the MPEG-2 
Encoder pane in the Inspector window. You make your MPEG-2 settings using these tabs, 
by either modifying an existing setting or creating a new setting in the Settings tab. 

The MPEG-2 pane opens with the default Video Format tab on top and contains the 
following items:
Â Extension field:  Displays the MPEG-2 file extension m2v automatically after the MPEG-

2 output format is selected from the File Format pop-up menu.
Â Allow Job segmenting:  This checkbox allows you to turn off job segmenting. It is only 

relevant if you are using Compressor with distributed processing and with two-pass 
or multi-pass encoding. (The distributed processing feature is limited to computers 
that have Final Cut Studio installed.) For more information, see “Job Segmenting and 
Two-Pass (or Multi-Pass) Encoding” on page 61.

Â Stream Usage:  This pop-up menu allows you to choose how you intend to use the 
MPEG-2 stream. Compressor modifies the options available and bit rate ranges based 
on the usage you choose with this pop-up menu. See “Stream Usage,” next, for 
more information.

Â Video Format, Quality, GOP, and Extras:  These buttons open the Video Format, Quality, 
GOP, and Extras tabs. Their settings are explained in the following sections.
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Stream Usage
Choosing a setting from the Stream Usage pop-up menu ensures the encoded MPEG-2 
stream will be suitable for how you intend to use it. The options in the Stream Usage 
pop-up menu include:

Â Generic:  The Generic option allows you complete access to all the MPEG-2 settings. 
This is the only option that supports the MPEG-2 640 x 480 video format in addition 
to the SD and HD video formats. It is also the only option that supports creating 
transport and program streams. It supports the complete bit rate range of 2.0 Mbps 
to 40.0 Mbps.

Â SD DVD:  The SD DVD option restricts the encoding options to those allowed by the 
SD DVD specification. These include the NTSC and PAL video formats and a bit rate 
range of 2.0 Mbps to 9.0 Mbps.

Â Blu-ray:  The Blu-ray option restricts the encoding options to those allowed by Blu-ray 
video discs. These include the SD and HD video formats and a bit rate range of 10.0 
Mbps to 40.0 Mbps.

Â HD DVD:  The HD DVD option restricts the encoding options to those allowed by the 
HD DVD specification. These include the SD and HD video formats and a bit rate 
range that changes depending on the selected video format. 
Â For HD video formats the bit rate range is from 10.0 Mbps to 29.4 Mbps. 
Â For SD video formats the bit rate range is from 2.0 Mbps to 15.0 Mbps.

Video Format Tab
You use the Video Format tab to make settings related to video formats, frame rates, 
aspect ratio, field dominance, and timecode. All of these, except the timecode setting, 
can be set to automatically configure themselves based on the video being encoded. 
The Video Format tab contains the following controls:
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Â Video Format pop-up menu:  Choose your output video file format as either NTSC, PAL, 
720p, HD 1440x1080, HD 1920x1080, or a variety of versions of 640 width formats. The 
Stream Usage setting determines which of these formats are actually available. When 
you choose a Video Format setting, the other settings in this tab will be filled in with 
default values, or they will be dimmed, indicating that there are no options for that 
setting. The NTSC and PAL items refer to standard definition settings for the NTSC 
and PAL TV standards. Of the major-market DVD regions, NTSC is used in North 
America and Japan, and PAL is used throughout Europe.
Generally, the output video format should match the source video format. For 
interlaced video originating from traditional NTSC or PAL camcorders, choose NTSC 
or PAL from this pop-up menu. If you are unsure of what your source media file’s 
video format is, you can choose Automatic. This setting analyzes your source media 
clip’s frame rate to determine the correct video format. 

If you click the video format Automatic button, the GOP size is limited to 12 or 15 
(based on whether the video is PAL or NTSC), with a closed IBBP pattern. With 
Automatic selected, you cannot change the frame rate setting in this tab, or the GOP 
settings in the GOP tab. See “Understanding GOPs and Frame Types” on page 197 for 
more information about GOPs.

Note:  Since MPEG-2 uses fixed video frame sizes (shown in the table below), 
Compressor enters the output frame size in the fields in the Geometry pane based 
on your video format selection.

The video format you choose determines the options for the associated 
characteristics such as frame size and rate, aspect ratio, and field dominance.

Video format Automatic 
button
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Note:  The normal frame dimensions of standard definition (SD) NTSC digital video are 
720 x 486. If you want to transcode a source file using the NTSC setting, Compressor 
crops the file to achieve the required MPEG-2 frame size of 720 x 480, unless you have 
already specified cropping attributes for your setting. If not, Compressor crops two 
rows of pixels from the top and four from the bottom. This crop attribute is only 
temporary and is not saved in the setting. You can see the effects of the crop by 
double-clicking the setting in the job to open the Preview window.

Video format
Frame size 
(pixels) Frame rate (fps) Aspect ratio Scanning method

NTSC 720 x 480 23.98 (progressive 
only), 29.97

4:3 or 16:9 Interlaced, 
progressive

PAL 720 x 576 25 4:3 or 16:9 Interlaced, 
progressive

720p 1280 x 720 23.98, 25, 29.97, 50, 
59.94

16:9 Progressive

HD 1440x1080 1440 x 1080 23.98 (progressive 
only), 25, 29.97

16:9 Interlaced, 
progressive

HD 1920x1080 1920 x 1080 23.98 (progressive 
only), 25, 29.97

16:9 Interlaced, 
progressive

640x480 (1.33) 640 x 480 23.98, 25, 29.97 4:3 or 16:9 Interlaced, 
progressive

640x360 (1.78) 640 x 360 23.98, 25, 29.97 4:3 or 16:9 Interlaced, 
progressive

640x352 (1.82) 640 x 352 23.98, 25, 29.97 4:3 or 16:9 Interlaced, 
progressive

640x384 (1.67) 640 x 384 23.98, 25, 29.97 4:3 or 16:9 Interlaced, 
progressive

640x320 (2.00) 640 x 320 23.98, 25, 29.97 4:3 or 16:9 Interlaced, 
progressive
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Â Frame Rate pop-up menu:  Choose the intended frame rate for the MPEG-2 output file. 
Film and some new camcorders create progressive material at 24 fps (or the NTSC 
variant 23.98 fps). Although the term “24p” implies video with a frame rate of 24 fps, 
the frame rate is usually 23.976 fps (rounded to 23.98) fps. To transcode these sources 
for DVD playback on NTSC-related TVs, choose the 23.98 setting. See “About 24p 
(23.98p)” on page 190 for more information.

Â Aspect Ratio pop-up menu:  Choose the aspect ratio of your video file. The default is 4:3. 
The other option of 16:9 is used for anamorphic DVD. The aspect ratio determines how 
the picture fills the television screen. A 16:9 (widescreen) DVD viewed on a typical 4:3 
television displays in letterbox format (black bars at the top and bottom of the screen). 
However, a widescreen DVD displayed on a 16:9 (widescreen) TV fills the screen.

About NTSC Frame Rates
The NTSC frame rate is frequently mentioned as 29.97 fps. Similarly, the “NTSC version” 
of 24 fps is mentioned as 23.98 fps. Both these numbers are actually approximations 
to the true values 30/1.001 and 24/1.001, or 29.97003 and 23.97602 shown to more 
decimal places. These numbers show that 29.97 is a pretty good approximation to 30/
1.001 (only 3 frames drift in 100,000 seconds), but that 23.976 would be much better 
than 23.98. In fact, even though 23.98 is used as shorthand in the Compressor Help 
and in the Compressor user interface, accuracy of 23.976 or better is maintained 
internally in Compressor, and generally within QuickTime as well.
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Â Field Dominance pop-up menu:  Choose whether the top field or the bottom field of 
your interlaced source media file will be the dominant (first) field in the output 
MPEG-2 video file. If you choose Automatic (the default), Compressor analyzes the 
source video and attempts to determine field dominance automatically. Bottom field 
is dominant for DV source video. This setting does not pertain to the 720p video 
format, since that format must be progressive.

Note:  For interlaced video, the top field is also known as the upper or odd field, and 
the bottom field is also known as the lower or even field.

Â “Choose start timecode” checkbox and field:  If you leave the checkbox deselected (the 
default), Compressor embeds the source media file’s existing timecode into the 
output media file. Selecting this box allows you to override the source media file’s 
existing timecode and enter a new timecode in the timecode field. This field remains 
dimmed unless the checkbox is selected, and if it is left blank, the output media file 
uses the default timecode of 00:00:00:00.

Â “Drop frame” checkbox:  If you have already selected the “Choose start timecode” 
checkbox, and you want your timecode to be drop frame (rather than non-drop 
frame), you must also select this checkbox.
Timecode is a numbering system for labeling the frames in a video sequence. The 
type of timecode designed for 30 fps video has a frame counter which counts from 0 
to 29, and then increments the seconds counter and returns to 0. This type of 
timecode, also known as non-drop frame timecode, maintains an accurate measure of 
elapsed time for true 30 fps video. However, the NTSC frame rate is 29.97 fps, and so 
drop frame timecode was defined to provide a more accurate measure of elapsed 
time for NTSC. Drop frame timecode skips frame numbers 0 and 1 once a minute on 
the minute, except for every 10 minutes. For example, drop frame timecode 
01:08:59;29 is followed by 01:09:00;02, skipping timecodes 01:09:00;00 and 01:09:00;01.

Note:  Drop frame timecode only applies if you are using interlaced NTSC video.
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Quality Tab
The Quality tab allows you to set the bit rate for your video so that it can be transcoded 
to a suitable data size and quality. 

In addition to the controls, the lower-right corner shows an estimate of how many 
minutes of video would fit on a 4.7 GB DVD using the current settings. This time 
assumes a single AIFF audio stream to be used with the MPEG-2 stream. 

About 24p (23.98p) 
For DVD authoring and encoding, 24p refers to a video sequence that contains 24 
progressive (non-interlaced) frames per second, with NTSC-related standard definition 
frame dimensions (720 x 480 for MPEG-2). Film-based movies have a native frame rate 
of 24 fps, and because the MPEG-2 format is able to represent 24 fps video internally, 
many commercial movie DVDs are encoded in this way. But any time you use NTSC 
video in your project, the frame rate of film-transferred material will be slowed down 
from 24 fps to 23.976 fps (rounded to 23.98) and a 2:3:2:3. pull-down is added. So, the 
more accurate term is actually “23.98p.”

Compressor can also do this for 24p source video files. For such material, the 23.98 
frame rate option (in the Video Format tab) compresses each source frame one-for-one, 
without compressing repeated frames or fields in order to achieve a 29.97 fps display 
rate. This results in higher quality at a lower compressed bit rate than would be 
possible if the 24p material were converted to 29.97 fps prior to transcoding. 
Compressor also sets internal MPEG-2 frame flags correctly, so DVD players will properly 
apply the 3:2 pull-down process for display on 29.97 fps interlaced NTSC TV sets.

Note:  If your source video has a frame rate of 24.00 fps rather than 23.98 fps, 
Compressor skips one out of every 1000 source frames. If the 24p source video is 
23.98 fps, Compressor transcodes all source frames, without skipping (or repeating) 
any of them.
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The Quality tab contains the following controls:

Â Mode pop-up menu:  Allows you to choose one of the following MPEG-2 
encoding modes. High Definition (HD) quality modes will be One pass VBR Best or 
Two pass VBR Best.

Â “One pass CBR”:  Using this mode, the output MPEG-2 video stream’s bit rate is held 
approximately constant from one GOP to the next. This is the fastest Compressor 
MPEG-2 encoding mode, and it provides good to very good quality, especially at 
bit rates between 5 and 9 Mbps.

Â “One pass VBR”:  This VBR (variable bit rate) encoding mode aims to maintain 
constant quality (at the expense of constant bit rate) for the transcoded video file. 
This means that in scenes with much detail or fast motion, Compressor allows a 
higher bit rate than it allows in less detailed or still parts of the stream. In spite of 
this bit rate variability, Compressor ensures your specified average bit rate is 
achieved accurately and that the maximum bit rate is not exceeded. Unlike the 
two-pass modes, one-pass VBR doesn’t have a “bird’s eye” view of the source media 
prior to encoding, so its bit allocation is less optimized than two-pass VBR. 
Nonetheless, for most Standard Definition (SD) media files at bit rates of 3.5 Mbps 
and above, this mode provides good to excellent quality and transcodes quickly. 

Mode pop-up menu

Time estimate for a 4.7 GB disc 
with a stereo AIFF audio stream

Motion Estimation 
pop-up menu
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Â “One pass VBR Best”:  This is similar to one-pass VBR, but with this mode, 
Compressor applies greater effort to its internal decision-making processes. 
Although one-pass VBR Best transcodes slower than one-pass VBR, it provides 
excellent to outstanding SD video quality at bit rates of 3 to 3.5 Mbps and above. 
Bit rates for HD MPEG-2 can range from 10–29Mbps average, 12–29Mbps 
maximum. Compared to one-pass VBR, one-pass VBR Best provides higher quality, 
especially for difficult material at low bit rates.

Note:  For short streams of 1 to 2 minutes or less, if you are using one-pass VBR or 
one-pass VBR Best, the average bit rate accuracy may be compromised by as much as 
10 to 30 percent.

Â “Two pass VBR”:  In this mode, Compressor reads through the entire source video file 
twice. In the first of these passes, Compressor analyzes the entire source video 
stream prior to transcoding it to determine the degree of encoding difficulty of each 
scene. It then creates a bit rate allocation plan that gives the higher bit rate to 
complex scenes and a lower bit rate to easy scenes, so as to average out to the 
specified average bit rate while ensuring that the specified maximum bit rate is not 
exceeded. In the second pass, Compressor does the actual compression, creating 
the MPEG-2 output video file according to its bit rate allocation plan. As with 
one-pass VBR, the goal of two-pass VBR is constant quality rather than constant bit 
rate. Unlike one-pass VBR, two-pass VBR is able to establish an overview of where 
best to spend its bits across the entire source media file, before beginning the actual 
encoding. The result of this process is that transcoding time is almost twice that of 
one-pass VBR. Although the benefit is not twice the quality, two-pass VBR provides 
more consistent overall quality than one-pass VBR, especially in source media files 
where the difference between the most and the least complex scenes is substantial.

Â “Two pass VBR Best”:  This mode devotes more effort to its internal decision-making 
process than does two-pass VBR. Encoding time for Two pass VBR Best is slower 
than it is for Two pass VBR, but it provides the best possible quality that the 
Compressor MPEG-2 encoder has to offer. This mode provides outstanding quality 
at bit rates of 3–3.5 Mbps and above for standard definition (SD) video. 

Note:  See “Job Segmenting and Two-Pass (or Multi-Pass) Encoding” on page 61 for 
information about using the two-pass modes with job segmenting.
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Â Average Bit Rate slider and field:  Choose the average bit rate by dragging the slider or 
entering a number into the accompanying field. The range available to you depends 
on the Stream Usage setting. See “Stream Usage” on page 185 for more information. 

Note:  The average bit rate setting directly controls the size of the encoded file. The 
maximum bit rate setting does not affect the encoded file’s size.

Â Maximum Bit Rate slider and field:  Choose the maximum bit rate by dragging the slider 
or entering a number into the accompanying field. The range available to you depends 
on the Stream Usage setting. See “Stream Usage” on page 185 for more information. 

Note:  This slider is only available with the VBR modes and cannot be set lower than 
the average bit rate.

About Choosing the Bit Rates
When determining average and maximum bit rates for standard DVD playback, 
remember to consider the bit rate of your audio track as well as the MPEG-2 bit rate.

You must keep the total of both average and maximum audio and video bit rates 
under 10.08 Mbps, the maximum guaranteed transfer rate from standard DVD players. 
Because DVD-compatible audio formats are constant bit rate (CBR), there is no 
maximum audio bit rate to worry about. 

For example, if you are using AIFF audio at 1.5 Mbps, you should keep both the 
average and maximum video bit rates under 8.5 Mbps. Typically, your average bit rate 
will be lower than this (for example, 3.5 Mbps for 2 hours of footage on your DVD). 
However, your maximum bit rate must also stay under this number. 8.0 Mbps 
maximum bit rate is recommended to provide an extra margin for error (for example, 
to accommodate subtitle streams). If you are using one of the DVD-compatible 
compressed audio formats such as Dolby Digital or MPEG-1/Layer-2, your audio bit 
rate may be as low as 0.2 to 0.4 Mbps, in which case you can set your maximum bit 
rate about 1 Mbps higher.

Also, as a general rule, set your maximum bit rate at least 1 Mbps higher than your 
average bit rate, to allow for bit rate variability in achieving the goal of constant quality.
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Â Motion Estimation pop-up menu:  This menu is another trade-off between image 
quality and processing time, especially if there is a lot of motion in the source file. 
Choose one of the following settings:
Â Good:  The fastest motion estimation setting. This mode does well even with 

significant amounts of motion between frames, if the motion has minimal 
interfield motion within frames. For example, footage that has been exposed to 
frame-rate conversion or other effects processes tends to have little interfield 
motion. In general, use Good with the one-pass encoding mode.

Â Better:  A good general-purpose motion estimation setting. The Better mode 
provides good results even with complex interlaced motion. Better works well for 
almost all types of interlaced video sources, even shaky footage from hand-held 
consumer camcorders. In general, use Better with One pass VBR and Two pass VBR.

Note:  If you are using a progressive video format, the Better mode will do only 
frame-based motion estimation, and not field-based motion-vector searching, which 
is not relevant for progressive source. In this case the Better mode will run 
somewhat faster.

Â Best:  This is the highest quality motion estimation setting and should be used for 
the most demanding and complex motion for interlaced sources. It is slower than 
the Better mode. In general, use the Best mode to maximize quality when using 
One pass VBR Best or Two pass VBR Best.

Note:  Choose a motion estimation mode from the Motion Estimation pop-up menu 
that is appropriate for the encoding mode you have selected from the five 
possibilities above. Use the Good motion estimation mode for one pass, the Better 
mode for the One pass VBR and Two pass VBR modes, and the Best mode for one 
pass VBR Best and Two pass VBR Best. Any of the motion estimation modes work with 
any of the encoding modes but these combinations are most suitable. 
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GOP Tab
You use the GOP (group of pictures) tab to select a GOP format, structure, and size. It 
contains the following controls. See “Understanding GOPs and Frame Types” on 
page 197 for more information. 

Note:  If you choose any of the HD video formats in the Video Format tab, the settings 
in the GOP tab cannot be changed and default to a closed IBBP GOP structure with a 
size of 12 (for PAL) or 15 (for NTSC). 

Â GOP Structure pop-up menu:  This setting specifies whether there will be two, one, or 
no B-frames between the reference frames within a GOP. GOP structure, along with 
GOP size, determines the number of I-frames, P-frames, and B-frames that are used 
within a GOP during encoding. Choose from one of the following:

Â IP:  No B-frames are used with this setting. Choose IP only if your media contains fast 
motion that does not encode with sufficient quality using an IBBP or IBP structure. 

Â IBP:  One B-frame is used between reference frames (I-frames and P-frames) with 
IBP. Choose this setting only if your media contains fast motion that does not 
encode with sufficient quality using an IBBP structure. 

Â IBBP:  Use IBBP for the majority of MPEG-2 encoding situations, along with a GOP 
size of 15 for NTSC, or 12 for PAL. Two B-frames are used between reference frames 
with this setting. 

Note:  For most MPEG-2 encoding situations intended for use on a DVD, choose IBBP 
as the GOP structure setting, and GOP size 15 for NTSC, or GOP size 12 for PAL. These 
selections will give the best results in most situations. 

See “GOP Structure” on page 199 for more information.
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Â Open and Closed buttons:  Closed GOPs do not contain any frame that refers to a 
frame in the previous or next GOP, while open GOPs begin with one or more B-
frames that reference the last P-frame of the previous GOP. Closed GOPs created by 
the Compressor MPEG-2 encoder begin with an I-frame. Choose your GOP type 
(open or closed) based on whether and how you create chapter markers for DVD 
authoring with DVD Studio Pro, and whether you intend to use multiple video angles 
in your title. See “Open and Closed GOPs” on page 200 for more information.

Â GOP Size pop-up menu:  Choose how many frames are contained within your GOP, 
following the format of the chosen GOP structure. The maximum GOP size you can 
choose within Compressor is 15 frames (NTSC) or 12 frames (PAL and 720p). The 
minimum GOP size for all video formats is 6 frames (closed GOP) or 7 frames (open 
GOP). The relationship between GOP structure and GOP size gives you GOP patterns. 
See “Understanding GOPs and Frame Types” on page 197 and “GOP Size” on 
page 199 for more information.

Â Pattern field:  This field cannot be edited but displays the actual GOP pattern based 
on your chosen GOP structure and size.



Chapter 15    Creating MPEG-2 Output Files 197

 

.

Extras Tab
You use the Extras tab to control the inclusion or exclusion of specific MPEG-2 
authoring information. The Extras tab contains the following controls:

Understanding GOPs and Frame Types
A major feature of MPEG-2 encoding is its ability to remove redundancy, not only 
within a frame, but also among a group of frames. MPEG-2 uses three frame types 
(I, P, and B) to represent the video. A group of pictures (GOP) setting defines the 
pattern of the three frame types used. These three picture types are defined in the 
following way:
Â Intra (I):  Also known as the key frame. Every GOP contains one I-frame. The I-frame 

is the only MPEG-2 frame type which can be fully decompressed without any 
reference to frames that precede or follow it. It is also the most data-heavy, 
requiring the most disk space. If you want to place an I-frame at a scene change or 
some other specific frame location, you need to manually set it using the Preview 
window. This is known as a forced I-frame. See “Adding Markers to a Clip” on 
page 297 for more information.

Â Predicted (P):  Encoded from a “predicted” picture based on the closest preceding 
I- or P-frame. P-frames typically require much less disk space than do I-frames 
because they reference a preceding I- or P- frame in the GOP.

Note:  Both I-frames and P-frames are also known as reference frames, because a 
B-frame may refer to either one or both frame types.

Â Bi-directional (B):  Encoded from an interpolation of succeeding and preceding 
reference frames, either I-frame or P-frame. B-frames are the most storage-efficient 
MPEG-2 frame type, requiring the least amount of disk space.

The use of B- and P-frames is what allows MPEG-2 to remove temporal redundancy, 
contributing to its ability to compress video efficiently.
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Â Add DVD Studio Pro metadata:  Selecting this checkbox allows Compressor to parse 
specific MPEG-2 authoring information during the transcoding process to accelerate 
the import process into DVD Studio Pro. However, these MPEG-2 files will be 
incompatible with versions of DVD Studio Pro 1.5 or earlier. Leaving the checkbox 
unselected means the information will be parsed later in DVD Studio Pro. 

Note:  MPEG-2 streams with additional DVD Studio Pro metadata are only compatible 
with DVD Studio Pro 2 (or later) versions. MPEG-2 streams with this checkbox 
selected will not be compatible with versions prior to DVD Studio Pro 2, or with other 
DVD authoring tools. All Apple settings have this box checked by default. To make 
your MPEG-2 files compatible with other DVD authoring tools, uncheck this box, and 
then save the setting.

Â Include chapter markers only:  Selecting this checkbox excludes unnamed 
compression markers from the stream but still retains the chapter markers. Leaving 
the checkbox unselected allows all markers to be recognized in the output media 
file. See “About MPEG-2 Markers and DVD Studio Pro” on page 201 and “Adding 
Chapter or Podcast Markers to a Clip” on page 300 for more information about 
chapter markers.

Â Multiplexed MPEG-1/Layer 2 Audio:  Use this checkbox to create a multiplexed stream 
(rather than an elementary stream). You can make the output file either a transport 
stream or a program stream. See “About Elementary, Transport, and Program 
Streams” on page 183 for information on the differences between the different 
stream types. 
The audio in this stream is MPEG-1 Layer 2, with a sample rate of 44.1 kHz or 48 kHz 
(depending on the source) and a bit rate of 384 kbps. To create an audio-only 
(MPEG-1/Layer 2 Audio) elementary stream, see “Creating the MPEG-1 Audio for DVD 
Setting” on page 177.

Important:  Generic is the only Stream Usage setting that supports transport and 
program streams. Selecting the Multiplexed MPEG-1/Layer 2 Audio checkbox sets 
your stream usage to Generic if it is currently anything else.
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More About GOPs and Markers
Following is some additional information you may find useful when deciding how to 
configure your GOP settings and how the GOP settings affect DVD Studio Pro markers.

Things to Consider When Choosing a GOP Setting
You need to consider the following aspects when choosing a GOP setting:

GOP Structure
This setting specifies whether there will be two, one, or no B-frames between the 
reference frames within a GOP. GOP structure, along with GOP size, determines the 
number of I-, P-, and B-frames that will be used during transcoding.

The GOP structure you choose depends on how far apart P-frames should be spaced. 
Since a P-frame is predicted from the previous reference frame (either an I-frame or a 
P-frame), if there are one or two B-frames in between, the prediction must cover the 
distance objects can move over the duration of two to three frames. 

In principle, the less average motion there is from one frame to the next, the farther apart 
P-frames can be spaced, and the greater the compression can be. For most video 
material, the IBBP structure is a good choice. Material with unusually fast motion 
throughout the entire sequence may benefit from an IBP or IP structure, but in such cases 
a relatively high bit rate (6 to 8 Mbps for SD video) may be required for good quality.

GOP Size
This setting specifies the number of frames within a GOP. Because exactly one I-frame 
exists per GOP, longer GOP sizes generally provide greater compression, because B- and 
P-frames are smaller than I-frames.

For most media, spacing I-frames about 1/2 second apart gives good results. This 
equates to a GOP size of 15 frames for NTSC and 12 frames for PAL. The DVD-Video 
specification prohibits GOP lengths from being much longer than this. Generally, only 
material with scene changes occurring less than 1/2 second apart frequently 
throughout the video will benefit from shorter GOP sizes.
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Open and Closed GOPs
Open GOPs are most efficient because they allow an extra B-frame in the GOP pattern. 
Open GOPs start with a B-frame that is able to look at the last P-frame from the 
preceding GOP as well as the first I-frame of its own GOP. 

By definition, closed GOPs cannot contain any frame that refers to a frame in the 
previous or next GOP. In contrast, open GOPs begin with one or more B-frames that 
reference the last P-frame of the previous GOP. Closed GOPs created by Compressor 
always begin with an I-frame.

Open GOPs generally provide slightly better compression than do closed GOPs of the 
same structure and size. The illustration above shows that a closed GOP contains one 
more P-frame than does an open GOP of the same length. Since P-frames generally 
require more bits than do B-frames, the open GOP achieves slightly better compression.

There are limitations to using open GOPs for DVD-Video discs that are created using a 
DVD authoring application such as DVD Studio Pro. One limitation is that only closed 
GOPs are permitted within MPEG-2 streams that will be used for mixed-angle or 
multi-angle DVDs.
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The other limitation is that DVD chapter markers can only be set at the beginning of a 
closed GOP. The best time to define chapter markers is before doing MPEG-2 
transcoding. For example, if you specify your chapter markers in Final Cut Pro, you can 
set Compressor to do MPEG-2 transcoding with open GOPs. Compressor will then force 
a closed GOP to begin only at the specified chapter markers, and will make all other 
GOPs open. You can also accomplish this by specifying “forced I-frames” in the 
Compressor Preview window, and giving them a chapter name to be used by 
DVD Studio Pro.

However, if you want to specify chapter markers at any GOP boundary after your video 
has been transcoded in the MPEG-2 format, you should only use closed GOPs. This 
freedom is limited, as it allows you to set chapter markers only at GOP boundaries, 
rather than at any video frame. 

About MPEG-2 Markers and DVD Studio Pro
The following MPEG-2 markers can be found in a source media file:
Â Chapter markers:  These identify frames that should be encoded as I-frames and are 

recognized as chapter markers when imported into DVD Studio Pro. 
Â Forced compression markers:  These are added by an editor during editing, and 

identify frames in the video that should be forced to I-frames for better quality 
encoding, such as the first frame of a new scene. Forced compression markers are 
not recognized as chapter markers by DVD Studio Pro.

Â Automatic compression markers:  These are inserted by Final Cut Pro at all edit points, 
forcing I-frames where scene changes are likely to occur. Automatic compression 
markers are not recognized as chapter markers by DVD Studio Pro. These will not be 
included if you select the “Include chapter markers only” checkbox.

If the “Include chapter markers only” checkbox is not selected, Compressor 
automatically places I-frames at all three kinds of markers. In most cases, this produces 
the best results. However, if you intend to use the media files as part of a mixed-angle 
or multi-angle DVD title, all media files must have identical I-frame patterns.

Chapter markers set in Final Cut Pro and transcoded in Compressor, or set directly in 
Compressor, will not be present in the imported MPEG-2 data in versions earlier than 
DVD Studio Pro 2. However, I-frames will be set where chapter markers were named. If 
you are using a version earlier than DVD Studio Pro 2, you have the following options:
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Final Cut Pro Native Projects
You have the following two options for Final Cut Pro native projects:
Â Export using Compressor:  If quality and transcoding controls are important to your 

project, use Compressor to export your MPEG-2 media file. You will save time and 
avoid generation loss. The disadvantage of using this mode is that you cannot use 
Final Cut Pro during the export process.

Â Export a QuickTime Reference Movie and encode in standalone Compressor:  You will not 
get quite the high quality that exporting directly to Compressor provides, but you 
will be able to continue editing in your Final Cut Pro timeline while Compressor 
works in the background.

Compressor Native Projects
You can set chapter markers using the Compressor Preview window, but they will not 
be preserved when exported to versions earlier than DVD Studio Pro 2. I-frames will be 
preserved. If you are using a version prior to DVD Studio Pro 2, you can manually set 
the chapter markers directly in DVD Studio Pro.

MPEG-2 Transcoding Workflow 
This section gives examples and step-by-step instructions for setting your MPEG-2 
attributes prior to creating MPEG-2 output files with Compressor. Make your MPEG-2 
settings from the MPEG-2 Encoder pane by either modifying an existing setting or 
creating a new one in the Settings tab.
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Example MPEG-2 Settings
The following MPEG-2 settings can be used for most general MPEG-2 encoding 
situations. Open the MPEG-2 Encoder pane and click the appropriate buttons to 
access these tabs.

Note:  Be aware that many of the settings shown in this example are not suitable for 
all video input formats, nor for all encoding situations. Some alternative settings are 
shown in parentheses where appropriate. See the sections at the beginning of this 
chapter for details on how and when to use other settings.

Video Format tab
Â Video Format:  NTSC (PAL, 720p, HD 1440x1080, HD 1920x1080, or one of the 640 

width options)
Â Aspect Ratio:  4:3 (16:9 for anamorphic or HD widescreen)
Â Field Dominance:  Automatic (not available for 720p)

Quality tab
Â Mode:  One pass VBR Best (Other one-pass and two-pass settings)
Â Average Bit Rate:  5 Mbps (2 to 9 Mbps) for standard DVD or 18 Mbps for HD video 

formats (range varies)

Note:  Your choice of bit rate may be influenced by several factors, including the 
complexity of your source video, the format and number of your audio streams, 
and the total duration of all video clips to fit on your DVD.

Â Maximum Bit Rate:  8.0 Mbps for standard DVD or 27 Mbps for HD video formats
Â Motion Estimation:  Best

GOP tab
Â GOP Structure:  IBBP
Â GOP Size:  15 (12 for PAL and 50i, 50p, and 24p HD formats)
Â GOP Type:  Open (Closed)

Note:  Your choice of GOP type (Open or Closed) may be influenced by whether 
and how you create chapter markers for DVD authoring with DVD Studio Pro and 
whether you intend to use multiple video angles in your title. See “About MPEG-2 
Markers and DVD Studio Pro” on page 201 and “Adding Chapter or Podcast Markers 
to a Clip” on page 300 for more information.
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See the following steps for working with the MPEG-2 output file format.

Step 1:  Open the MPEG-2 Encoder pane and choose Video Format
It’s important to match the video format, aspect ratio, and field dominance to those of 
your source media file. See “Video Format Tab” on page 185 for a more detailed 
description of each of these settings.

Note:  The easiest way to make sure you are matching the source media file is to 
activate the Automatic buttons. See “About the Automatic Settings” on page 55 for 
more information.

1 Open the Settings tab, then choose MPEG-2 from the Add Preset ( + ) pop-up 
menu button. 

The MPEG-2 Encoder pane opens in the Inspector window with the default Video 
Format tab displayed. 

2 Choose the setting from the Stream Usage pop-up menu that matches how you intend 
to use the encoded video. This ensures that the MPEG-2 encoding options are 
restricted to those that are supported by your intended usage. The options include:

Â Generic
Â SD DVD
Â Blu-ray
Â HD DVD

Manually configure these
settings if you do not

intend to match the
source media file.

Select the Automatic 
buttons to have the 
encoder match the 
source media file.

Choose the type 
of MPEG-2 stream 
to create.
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3 Choose a format from the Video Format pop-up menu or select its Automatic button:

Â NTSC (default)
Â PAL
Â 720p
Â HD 1440x1080
Â HD 1920x1080
Â 640x480
Â 640x360
Â 640x352
Â 640x384
Â 640x320

4 Choose an aspect ratio from the Aspect Ratio pop-up menu or select its Automatic button.

You must determine whether the intended shape of your source video is 4:3 (normal) 
or 16:9 (widescreen) before you can choose your aspect ratio.

5 Choose a field dominance setting based on your source media type from the Field 
Dominance pop-up menu. For example, for DV choose Bottom First. Or choose the 
Field Dominance Automatic button to let Compressor determine the correct setting.

6 If you want to use the timecode from your source video, leave the “Choose start 
timecode” checkbox unselected. Otherwise, select this box and enter a new timecode. 

7 If you have checked the “Choose start timecode” checkbox, and if your video format is 
NTSC, select the “drop frame” checkbox if you want to use drop frame (rather than 
non-drop frame) timecode.

See “Video Format Tab” on page 185 for more information.

Step 2:  Choose Quality settings
In the Quality tab, you set the MPEG-2 encoding attributes that have the greatest 
influence on the resulting quality of your MPEG-2 video output file: encoding mode, 
average and maximum bit rate, and type of motion estimation.

1 Click the Quality button in the MPEG-2 Encoder pane to open the Quality tab.

Choose a mode that 
fits your time and 
quality requirements.

Choose a Motion 
Estimation setting.

Choose bit rates that fit
your file size and quality

requirements.
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2 Make a selection from the Mode pop-up menu.

For best image quality, choose One pass VBR Best or Two pass VBR Best. For faster 
encoding, with excellent image quality, choose One pass VBR or Two pass VBR. For HD 
sources, choose either One pass VBR Best or Two pass VBR Best.

With two-pass modes, the source media file is examined on the first pass and 
transcoded on the second pass, with bit rates tailored to the video content. 
Alternatively, one-pass modes transcode the material more quickly, but allocate bits 
less optimally than do the corresponding two-pass modes. 

Note:  If you are using two-pass VBR with distributed processing enabled, you may want 
to uncheck the “Allow Job Segmenting” checkbox in the Encoder pane. See “Job 
Segmenting and Two-Pass (or Multi-Pass) Encoding” on page 61 for more information.

3 Choose an average bit rate using the Average Bit Rate slider or field. 

Choose an appropriate bit rate based on the content and length of your source video 
and the intended size (in bytes) of your output file. In DVD authoring, the entire video 
must fit on the DVD disc—the lower the bit rate, the more data you can store. 
However, the higher the bit rate, the better the image quality will be. 

As you change the Average Bit Rate value (with the slider or the field), the bit rate 
calculator at the bottom of the Quality tab dynamically shows the maximum number 
of minutes of video on a DVD-5. The calculator assumes 1.5 Mbps for audio (two-
channel AIFF).

See the following table for some average bit rates and corresponding footage times for 
a 4.7 GB DVD:

Note:  When One pass VBR or One Pass VBR Best is chosen for very short clips (less than 
a minute or two in length), the resulting MPEG-2 output file size may not accurately 
reflect the average bit rate you specified. If the MPEG-2 output media file is larger than 
you want, you can try transcoding it again at a lower average bit rate.

Average bit rate1 Approximate duration for 4.7 GB DVD

3.5 Mbps 121 minutes

5.0 Mbps 94 minutes

6.0 Mbps 82 minutes

7.5 Mbps 68 minutes

8.0 Mbps 65 minutes

1 For DVD clip with video, audio, and subpictures: assumes 1.5 Mbps for audio (two-channel AIFF).
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4 If available, use the Maximum Bit Rate slider or field to set a maximum bit rate.

Because SD DVD players support peak bit rates of up to 10.08 Mbps for video plus 
audio, you should set the maximum video bit rate between 8.0 and 8.5 Mbps if you are 
using a 1.5 Mbps (two-channel AIFF) audio track.

Note:  For best results, make sure the maximum bit rate is at least 1 Mbps higher than 
the average setting. Larger differences can produce better results.

5 Choose one of the following settings from the Motion Estimation pop-up menu:

Â Good:  The fastest motion estimation setting—sufficient when there is relatively low 
motion between frames

Â Better:  A good general-purpose motion estimation setting—provides very good 
results even in the presence of complex interlaced motion

Â Best:  The highest quality setting to handle the most demanding and complex 
motion for interlaced sources—somewhat slower than the Better mode

See “Quality Tab” on page 190 for more information.

Step 3:  Choose GOP settings
Select a suitable GOP structure and size, and decide whether you want the GOPs to be 
open or closed. 

Note:  These settings are not adjustable if you chose an HD video format in the Video 
Format tab.

1 Click the GOP button in the MPEG-2 Encoder pane to open the GOP tab.

Choose a GOP structure
to control how many

B-frames are used.

Choose open or 
closed GOPs.

Choose a GOP size.



208 Chapter 15    Creating MPEG-2 Output Files

 

2 Choose a GOP structure from the GOP Structure pop-up menu. 

For the majority of MPEG-2 encoding jobs for DVD authoring, choose the IBBP 
GOP structure.

3 Choose a GOP size from the GOP Size pop-up menu.

For the majority of MPEG-2 encoding jobs for DVD authoring, choose GOP size 15 for 
NTSC and GOP size 12 for PAL and 24p.

The options available in this menu are determined by the GOP structure you choose, 
and whether or not the GOP is open or closed.

4 Decide whether you want the GOP pattern to be open or closed and click the 
appropriate button.

See “Understanding GOPs and Frame Types” on page 197, “Things to Consider When 
Choosing a GOP Setting” on page 199, and “GOP Tab” on page 195 for more 
information about GOPs. 

Working with MPEG-2 I-Frames
The Compressor Preview window offers additional MPEG-2 transcoding flexibility by 
allowing you to manually insert I-frames into your output MPEG-2 file at any frame 
location, regardless of your chosen GOP pattern and size. These are known as forced 
I-frames, and may be useful for improving the quality of the MPEG-2 file in the vicinity 
of the scene change. See “Understanding GOPs and Frame Types” on page 197 for 
more information on I-frames. 

In addition, adding I-frames to your clip allows you to create chapter markers that 
DVD Studio Pro can understand and use. See “Adding Markers to a Clip” on page 297 
and “Adding Chapter or Podcast Markers to a Clip” on page 300 for more information.
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Step 4:  Choose Extras settings
You can control the inclusion or exclusion of specific MPEG-2 authoring information in 
the Extras tab.

1 Click the Extras button in the MPEG-2 Encoder pane to open the Extras tab.

2 Select the “Add DVD Studio Pro metadata” checkbox if you want Compressor to parse 
specific MPEG-2 authoring information rather than parse the information later in 
DVD Studio Pro.

3 Select the “Include chapter markers only” checkbox if you want to exclude automatic 
compression markers from the stream but still retain the chapter markers. 

4 Select the Multiplexed MPEG-1/layer 2 Audio checkbox only if you need to create 
transport or program streams. See “About Elementary, Transport, and Program Streams” 
on page 183 for more information.

See “Extras Tab” on page 197 and “About MPEG-2 Markers and DVD Studio Pro” on 
page 201 for more information about settings in the Extras tab.

Also, to make it easier to use the output files created by these presets in 
DVD Studio Pro, create a destination that ensures the video and audio output files have 
the same name, only with different file extensions. See “Creating Destinations for Use 
with DVD Studio Pro” on page 314 for more information.

Warning:  Checking this box may make your MPEG-2 files incompatible with any DVD 
authoring tools other than DVD Studio Pro 2 (or later).
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16 Creating MPEG-4 Output Files

Compressor provides the tools you need to create 
exceptional MPEG-4 transcoded files.

MPEG-4 Part 2 (known as MPEG-4 video in QuickTime 6) plays an important role in the 
evolution of standards for the Internet and wireless multimedia industries, where it has 
been widely adopted. 

Use MPEG-4 Part 2 anywhere you want to be compatible with MPEG-4 Part 2 devices or 
players, such as the millions of 3G mobile phones and digital still cameras that capture 
and play back MPEG-4 Part 2 video.

H.264, also known as MPEG-4 Part 10, is a newer technology than MPEG-4 Part 2, 
providing up to four times the frame size of video encoded with the MPEG-4 Part 2 
codec at a given data rate. But, just as MPEG-1 and MPEG-2 are still used in the industry 
today, MPEG-4 Part 2 will continue to be used.

Note:  MPEG-4 Part 2 is both a QuickTime codec (MPEG-4 Video) and an output format. 
This chapter discusses MPEG-4 Part 2 as an output format.

MPEG-4 Part 2 offers the following advantages:
Â Standards compliance:  Output is with MPEG-4 Part 2 devices and other standards-

based (ISMA) players, such as mobile phones. 
Â High-quality video:  A versatile transcoder that can be set to a target data rate and—

using one-pass variable bit rate (VBR)—can maximize the highest quality output or 
speed for the fastest possible transcode.

Â Advanced Audio Coding (AAC):  MPEG-4 audio accommodates a wide variety of source 
audio, and brings true variable bit rate (VBR) audio transcoding to QuickTime. It uses 
the Advanced Audio Coding (AAC) codec, which provides more clarity than MP3 
audio at the same bit rate with smaller file sizes, or files of the same size at higher 
quality. You can also include podcasting information, such as chapter and podcast 
markers with artwork and URLs, as well as a variety of text annotations.
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Â Hinting for streaming:  Hinting refers to how a video stream is divided into streamable 
pieces. To create streaming video, the streaming server needs some hints about what 
data to send out and when. These hints consist of defining a maximum packet size 
and maximum packet duration. A hint track contains information needed to stream 
your output file. A hint track is created for every streamable media track in the 
output file (video and audio), and the streaming server uses the hint track to turn the 
media into real-time streams.

About the MPEG-4 Encoder Pane
The MPEG-4 Part 2 Encoder pane allows you to select a variety of streaming types 
and options.

The MPEG-4 Part 2 pane contains the following items:
Â File Extension field:  Displays the MPEG-4 Part 2 file extension mp4 as soon as the 

MPEG-4 output format is selected from the File Format pop-up menu, or the ( + ) 
pop-up menu in the Settings tab.

Â Video, Audio, and Streaming buttons:  These buttons open the Video, Audio, and 
Streaming panes, described next.

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. It is only 
relevant if you are using Compressor with distributed processing and with two-pass 
or multi-pass encoding. (The distributed processing feature is limited to computers 
that have Final Cut Studio installed.) Since the MPEG-4 Part 2 format uses single-pass 
VBR, you can leave this box checked in all cases for added speed gains with 
distributed processing. For more information, see “Job Segmenting and Two-Pass (or 
Multi-Pass) Encoding” on page 61.
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Â Allow Podcasting information:  Select this checkbox to ensure that podcasting 
annotations and metadata are written to the output media file. This is available for 
audio files only. To make this option available, deselect the Video Enabled checkbox 
at the top of the Video pane.

Video Pane
The Video pane allows you to make settings for the quality (ISMA profile), frames per 
second (fps) rate, key frame interval, and bit rate of your MPEG-4 Part 2 output file. The 
pane contains the following controls:

Â Video Enabled checkbox:  Make sure that this box is selected if you want the MPEG-4 
Part 2 output format video settings to be applied.

Â ISMA Profile buttons:  Choose from one of the following MPEG-4 Part 2 quality settings:
Â Basic (0):  Ensures playback on all MPEG-4 Part 2 devices.
Â Improved (1):  Gives better output quality, but this setting is not compatible with 

older MPEG-4 Part 2 devices.
Â Frame Rate (fps) pop-up menu and field:  Choose or enter a number to set the overall 

frame rate of your output media file.
Â Key frame interval field:  Enter a value to designate how often (number of frames) you 

want key frames created in your output media file.
Â Bit Rate pop-up menu:  Choose from one of the following bit rate settings. Whatever 

setting you choose, quality will vary from frame to frame to maintain the selected 
bit rate.
Â Constant at:  Sets a manually specified bit rate based on your slider setting.
Â Low VBR:  Sets an overall low quality for all frames.
Â Medium VBR:  Sets an overall medium quality for all frames.
Â High VBR:  Sets an overall high quality for all frames.

Â Bit rate slider and field:  (Only available with the “Constant at” setting.) Move the slider 
to set the overall video bit rate for your output media file between the range of 
32 Kbps and 2048 Kbps, or enter a specific number in the accompanying field.

Either enter a number in the Bit 
Rate field or use the slider to set 
the bit rate (only available with 
“Constant at” setting).
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Audio Pane
You use the Audio pane to set the audio track quality, sample rate, quality, and bit 
rate of the MPEG-4 output file. Use the following buttons and slider to make more 
detailed adjustments:

Â Audio Enabled checkbox:  Make sure that this box is checked if you want the MPEG-4 
Part 2 output format audio settings to be applied.

Â Channels buttons:  Choose the audio channel for your output media file to be either 
mono or stereo.

Â Sample Rate pop-up menu:  Choose from one of the following sample rates:  
8, 11.025, 12, 16, 22.05, 24, 32, 44.1, or 48 kHz. You can also choose Recommended 
to have Compressor choose a sample rate that is suitable for the Channels and Bit 
Rate settings.

Note:  If you choose Recommended, the sample rate is not determined until the 
transcode actually starts.

Â Quality pop-up menu:  Choose one of the following for the audio quality of your 
output media file:
Â Low:  This allows for fast transcoding, but it is at the expense of output file quality.
Â Medium:  The audio quality is better than Low, but this takes longer to transcode.
Â High:  This is the best audio quality setting available. Use this setting when the 

audio quality is important for the output media file and you don’t mind how long 
it takes to transcode.

Â Bit Rate slider and field:  Move the slider to set the overall audio bit rate for your 
output media file between the range of 16 Kbps (2 KB/sec.) and 256 Kbps (32 KB/
sec.), or enter a specific number into the accompanying field.

“Sample rate” 
pop-up menu

Bit Rate slider
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Streaming Pane
You use the Streaming pane to set hints for your output file, as well as set the 
maximum packet size and packet duration limits of the MPEG-4 Part 2 output file. You 
can also set your output media file to work with an older version of QuickTime 
Streaming Server (version 4.1 or earlier).

The Streaming pane contains the following controls:
Â “Streaming hints enabled” checkbox:  Make sure that this box is selected if you want 

the MPEG-4 Part 2 output format streaming settings to be applied.
Â “QuickTime Streaming Server Compatibility (pre v4.1)” checkbox:  Select this checkbox if 

you want your output media file to work with an older QuickTime Streaming Server 
(version 4.1 or earlier). You don’t need to select this box if you are using a newer version 
of QuickTime, because any streaming compatibility issues are automatically resolved.

Â Packet Maximums Size field:  Enter a number to specify the largest file size allowable 
(in bytes) for a streaming packet in your output media file. The packet size you 
choose should be no larger than the largest packet used on any network between 
the streaming server and the viewer. 

Â Packet Maximums Duration field:  Enter a number to specify the longest duration 
allowable (in milliseconds) for a streaming packet in your output media file. The 
duration affects MPEG-4 Part 2 audio only. It limits the maximum amount of audio 
(in milliseconds) in any packet, which limits the audio dropout created by the loss of 
a packet.
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MPEG-4 Part 2 Transcoding Workflow
This section contains information on a standard MPEG-4 Part 2 workflow as well as 
information on creating an audio podcast.

Standard MPEG-4 Part 2 Workflow
If you don’t need to customize the video and audio settings of your MPEG-4 Part 2 file, 
you can use the “quick-and-easy” method to transcode your source media files. This 
consists of accepting the following default MPEG-4 Part 2 output format settings:

Video pane
Â Video Enabled checkbox:  Selected
Â ISMA Profile:  Basic
Â Frame Rate:  15 fps
Â Key frame interval:  15 frames
Â Bit Rate:  368 Kbps

See “Video Pane” on page 213 for more information.
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Audio pane
Â Audio Enabled checkbox:  Selected
Â Channels:  Stereo
Â Sample Rate:  44.1 kHz
Â Quality:  High
Â Bit Rate:  64 Kbps

See “Audio Pane” on page 214 for more information.

Streaming pane
Â “Streaming hints enabled” checkbox:  Selected
Â Packet Maximums Size:  1,450 bytes
Â Packet Maximums Duration:  100 milliseconds

See “Streaming Pane” on page 215 for more information.

If these settings are acceptable to you, there is nothing further that you need to do, 
and you can begin transcoding source media files immediately.

If you want to customize your MPEG-4 Part 2 file format settings, you need to perform a 
more detailed transcoding workflow than the one described above, that involves the 
following steps:
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Step 1:  Customize MPEG-4 video settings
1 In the Inspector window, click the Encoder pane and choose MPEG-4 from the File 

Format pop-up menu.

The MPEG-4 Encoder pane opens, displaying mp4 in the File Extension field, and the 
default Video pane.

2 Adjust the MPEG-4 video settings using the available controls.

Note:  Make sure the Video Enabled checkbox is selected. 

See “Video Pane” on page 213 for details about MPEG-4 Part 2 video settings.

If you don’t want to edit any other attributes, your MPEG-4 setting can be assigned to 
any source media file in the usual way. See “Preparing Compressor for Transcoding” on 
page 32 for more information. Otherwise, go to the next step to edit MPEG-4 
audio settings.

Either enter a number in the 
Bit Rate field or use the slider 
to set the bit rate.
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Step 2:  Customize MPEG-4 audio settings
1 Click the Audio button to open the Audio pane.

2 Adjust the MPEG-4 audio settings using the available controls.

Note:  Make sure that the Audio Enabled box is selected.

See “Audio Pane” on page 214 for details about MPEG-4 Part 2 audio settings.

If you don’t want to edit any other attributes, your MPEG-4 setting can be assigned to 
any source media file in the usual way. See “Preparing Compressor for Transcoding” on 
page 32 for more information. Otherwise, go to the next step to edit streaming settings.

Step 3:  Edit MPEG-4 streaming settings
1 Click the Streaming button to open the Streaming pane.

2 Select the “QuickTime Streaming Server Compatibility (pre v4.1)” checkbox if your 
intended distribution method is via a QuickTime Streaming Server earlier than version 4.1.

3 Enter new numbers into the Size and Duration fields for Packet Maximums, and make 
sure that the “Streaming hints enabled” checkbox is selected.

4 See “Streaming Pane” on page 215 for details about MPEG-4 Part 2 streaming settings.

Either enter a number in the 
Bit Rate field or use the slider 
to set the bit rate.
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Audio Podcasting Workflow
Compressor makes it easy to create an enhanced audio podcast based on the MPEG-4 
output format. An enhanced audio podcast includes podcasting information such as 
chapter and podcast markers with artwork and URLs, as well as a variety of 
text annotations.

Step 1:  Configure the MPEG-4 output for audio-only output
1 In the Inspector window, click the Encoder pane and choose MPEG-4 from the File 

Format pop-up menu.

2 Click the Video button to open the Video pane.

3 Deselect the Video Enabled checkbox.

4 Click the Audio button to open the Audio pane.

5 Select the Audio Enabled checkbox.

This configures the MPEG-4 output to be audio-only. You can also configure the other 
settings in the Audio pane as needed.

Step 2:  Configure the MPEG-4 output to include podcasting information
1 Select the “Allow Podcasting information” checkbox at the bottom of the 

Inspector window. 

This checkbox is only available when you have deselected Video Enabled in the Video 
pane. Selecting this checkbox ensures that any annotations you add as well as any 
chapter and podcast markers with their artwork and URLs are embedded with the 
output media file.

2 Save the setting so that you can apply it to a source media file’s target.

Deselect this checkbox to
activate the “Allow

Podcasting information”
checkbox.

Select this checkbox to
include podcasting

information in the output
media file.
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Step 3:  Apply the setting to a source media file’s target
You must apply the setting to a source media file’s target to be able to configure the 
podcasting information that this setting allows you to add to the output media file. See 
“Assigning Settings to Source Media Files” on page 102 for more information.

Step 4:  Enter the annotations for the output media file
1 Click a non-target area of the job created by the source media file.

The Inspector window shows the A/V Attributes and Additional Information tabs.

2 Click the Additional Information tab.

3 The Additional Information tab is where you can add annotations, such as a title and 
artist, to the output media file.

4 Choose an item from the Add Annotation pop-up menu to add it to the output 
media file.

The item appears in the Annotation column.

5 Double-click the item’s Value column to type in the text annotation.

6 Repeat this for each annotation item you want to add to the output media file. 

7 Click Save.

See “Using the Inspector with Source Media Files” on page 82 for more information.

Choose items from this
pop-up menu to include

them as annotations in
the output media file.

Click Save once you have 
added the annotations.
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Step 5:  Create and configure the markers for the output media file
You can use the Preview window to add and configure chapter and podcast markers 
for the output media file. You can manually add the markers or import a chapter 
marker list. Each chapter and podcast marker can be named, have a URL added to it, 
and have a still image added as its artwork.

When played, the artwork displays along with the URL (which the viewer can click to 
open a web browser to show).

See “Adding Markers to a Clip” on page 297 for details on adding and configuring 
markers in the Preview window.

Step 6:  Submit the job and verify the output media file
Once you have added the annotations and markers to the job, you can submit it to 
create the output media file.

After the encoding process finishes, you can open the output media file in 
QuickTime Player to verify that the markers, URLs, and artwork appear as intended.

Adding Additional Settings and Presets
Although the output format setting is the most important component of the 
Compressor workflow, you can also add other settings and presets, such as filters, 
cropping, frame sizing, actions, and destinations. For further instructions on how to 
add these settings, see the following:
Â Chapter 19, “Adding Filters to a Setting,” on page 241
Â Chapter 20, “Adding Frame Controls to a Setting,” on page 255
Â Chapter 21, “Adding Geometry Settings,” on page 267
Â Chapter 22, “Adding Actions to a Setting,” on page 277
Â Chapter 24, “Creating and Changing Destinations,” on page 305



17

     223

17 Creating QuickTime Movie 
Output Files

Compressor provides the tools you need to create 
QuickTime media files.

QuickTime is cross-platform multimedia technology, and allows Mac OS applications to 
capture and play back video, audio, and still-image files. QuickTime supports a wide 
variety of codecs and can also be extended to accommodate additional codec options 
and third-party codecs. See “Creating QuickTime Export Component Output Files” on 
page 237 for more information about additional QuickTime export options.

This chapter contains the following:
Â Creating QuickTime Output Files (p. 223)
Â About the QuickTime Movie Encoder Pane (p. 224)
Â QuickTime Transcoding Workflow (p. 230)
Â Understanding Codecs (p. 234)
Â QuickTime Video Codecs (p. 234)
Â QuickTime Audio Codecs (p. 235)

Creating QuickTime Output Files
QuickTime is an open standard with many built-in codecs, and is both a multimedia 
and streaming media architecture. It is widely used for both authoring and delivery. For 
example, many video editing and compositing applications use QuickTime as their 
base format, and most title developers author their CD-ROM content using the 
QuickTime format. QuickTime contains a wide range of video and audio codecs suitable 
for everything from streaming video to DVD. The QuickTime architecture can also 
handle file formats other than QuickTime movies, such as AVI files and 3G streams. For 
more information on creating those kinds of formats, see Chapter 18, “Creating 
QuickTime Export Component Files,” on page 237.
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About the QuickTime Movie Encoder Pane
The following options appear when you choose QuickTime Movie from the File Format 
pop-up menu:

Â File Extension field:  Indicates the file extension for this output file format. The file 
extension .mov represents QuickTime. It is recommended that you don’t alter this field.

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. It is only 
relevant if you are using Compressor with distributed processing and with two-pass 
or multi-pass encoding. (The distributed processing feature is limited to computers 
that have Final Cut Studio installed.) For more information, see “Job Segmenting and 
Two-Pass (or Multi-Pass) Encoding” on page 61.

Â Video Settings and Audio Settings:  These buttons open the QuickTime Compression 
Settings and Sound Settings dialogs. Use these dialogs to select suitable codecs and 
change other video or audio compression settings. See “About the Sound Settings 
Dialog” on page 229 and “About the Compression Settings Dialog” on page 227 for 
more information on these dialogs. 

QuickTime Media Files for the Web
You can play your output media files over the web with QuickTime, once they are 
compressed to a data rate appropriate for the bandwidth you expect the users to have. 
You can do this by making your output media files either QuickTime Fast Start movies 
(pre-buffered download) or QuickTime Streaming movies (complete download).

Compressor allows you to choose different streaming options via the Streaming 
pop-up menu in the QuickTime Encoder pane. See the Streaming pop-up menu item 
for more information about streaming QuickTime media files over the web.

Summary table

File Extension field

Options button (dimmed)
Streaming 
pop-up menu
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Â Enabled/Disabled/Pass-through:  Use these pop-up menus to enable or disable Video 
and Audio settings. Enabled means the video or audio track will be included in the 
output movie. Disabled means the video or audio track will be excluded from the 
output movie. Pass-through (audio only) means Compressor will copy the audio into 
the output movie without modifying it. An example of this might involve HD (high 
definition) files with multi-track audio that you want to convert to SD (standard 
definition) files without disturbing the audio tracks.

Note:  If you export a sequence from Final Cut Pro to Compressor (File > Export > 
Using Compressor) and apply a setting with “Pass-through” selected, the audio 
portion of the setting will change to a PCM setting with the sequence’s setting and 
channel count, but with only a single track created on output. If you require audio 
passthrough for a Final Cut Pro sequence, export a QuickTime movie (File > Export > 
QuickTime Movie) and then import the movie into Compressor.

Important:  If a setting has “Pass-through” selected, the Filter pane audio filters are 
not available. Additionally, the Frame Controls pane retiming controls will not correct 
the audio, potentially causing synchronization errors with the video.

Â Streaming:  Choose one of the following QuickTime streaming options from this 
pop-up menu:
Â None:  If you choose this setting (the default), your output media file will not 

stream over the Internet.
Â Fast Start:  This option allows your output media file to be viewed even before it is 

fully downloaded from its server.
Â Fast Start–Compressed Header:  This setting achieves the same results as Fast Start 

(allowing your output media file to be viewed before it is fully downloaded from 
the server), but the output media files are smaller. 

Â Hinted Streaming:  This setting allows hint tracks to be added to the output media 
file so that it can be used with a QuickTime Streaming Server. 

Â Options button:  This button remains dimmed unless Hinted Streaming is selected from 
the Streaming pop-up menu. Clicking this button opens the QuickTime Hint Exporter 
Settings dialog, which allows you to choose extra hinting settings for your stream.

Â Summary table:  Displays full details for this setting.

Chapter and Podcast Markers for QuickTime Output 
Chapter markers created in Final Cut Pro are passed through (transferred) to other 
output files that can be recognized by QuickTime Player, iTunes (.m4v files), 
Final Cut Pro, and DVD Studio Pro. For information about adding chapter and podcast 
markers, see “Adding Markers to a Clip” on page 297.
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QuickTime Video and Audio Settings
The QuickTime Video and Audio Settings buttons appear in the Encoder pane if you 
selected QuickTime Movie as the output file format. (The Audio Settings button also 
appears if you choose AIFF from the File Format pop-up menu.) You use these 
buttons to open the Compression Settings and Sound Settings dialogs, where you 
can modify whichever video or audio codec you want to add to the selected setting 
in the Settings tab. 

By default, both the Video and Audio Settings buttons are enabled, but you can 
disable one or the other by deselecting the appropriate checkbox.

Video codec settings
Â For information on how to customize video codec settings, see Step 2:  “Add a 

QuickTime video codec to a setting” on page 231.
Â All codecs are compatible with QuickTime, but if you intend to play back the 

output file using QuickTime Player, the following delivery codecs are 
recommended:
Â H.264
Â Photo-JPEG

Audio codec settings
Â For information on how to customize audio codec settings, see Step 3:  “Add a 

QuickTime audio codec to a setting” on page 232. 
Â All codecs are compatible with QuickTime, but if you intend to play back the 

output media file using QuickTime Player, the following delivery codecs are 
recommended:
Â AAC
Â IMA 4:1

See “QuickTime Audio Codecs” on page 235 for more information about audio codecs.
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About the Compression Settings Dialog
You use the Compression Settings dialog to change your video codec settings for the 
QuickTime output format. To open the Compression Settings dialog, click the Video 
Settings button in the QuickTime Encoder pane. 

If a particular setting can’t be changed, it remains dimmed. Some video codecs—such 
as Sorenson Video 3 and Photo-JPEG—allow you to make additional settings. If this is 
the case, the Options button becomes available. Click it to make additional settings. 

The Compression Settings dialog contains the following items, depending on which 
codec you choose in the Compression Type pop-up menu:
Â Compression Type:   Use this pop-up menu to choose the video codec you want to add 

to your preset. 
Â Frame Rate:  With this pop-up menu, you can reduce the frame rate of your original 

file to reduce the size of the compressed file. Higher frame rates make for smoother 
motion but require more bandwidth. You use the Frame Rate pop-up menu to 
choose a different frame rate, but for best results you should change it to a number 
that the original file can be easily divided by. For example, if your original file had a 
frame rate of 30 fps, you should use a frame rate of 10 fps or 15 fps. Choosing a frame 
rate of something like 24 fps would result in uneven motion and even dropped 
frames, because 30 is not evenly divisible by 24. Choose from the following 
settings:  8, 10, 12, 15, 23.98, 24, 25, 29.97, 30, 59.94, 60 fps, or choose Custom to enter 
a number manually.

 Choose a frame rate
from this pop-up menu.

Click the Options button
for more configuration

settings.

Select a compression 
type from this 
pop-up menu.
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Â Key Frames:  If your selected codec allows it, use the Key Frames Every field to enter 
the number of frames you want between your key frames. Codecs based on the 
temporal compression method use key frames. These act as a reference frame for the 
next sequence of frames, so that any data redundancy between the key frame and 
the ensuing frames can be removed. In between key frames are the less detailed 
delta frames. You need to insert key frames throughout your media file because 
content changes. Some video codecs allow you to insert a key frame every certain 
number of frames, while other video codecs use natural key frames by scanning the 
whole file to detect where the major similarities and differences occur and inserting 
the key frames accordingly. 

If there’s a lot of motion in your media file, you need key frames more often than you 
do with something more static, such as a talking head sequence. 

Â Depth pop-up menu:  You use the Depth pop-up menu to define the color setting. For 
example, if a QuickTime movie were composed of millions or thousands of colors 
and the playback computer only showed 256 colors, you would use this setting to 
resolve this color depth discrepancy. 
The contents of this pop-up menu change depending on the video codec selected in 
the Compression type pop-up menu. For example, if you choose the PNG codec, you 
can make a selection ranging from Grays to Millions of Colors+, while the Photo-JPEG 
codec only allows you to choose between Color and Grayscale.

Â Quality slider:  Use this slider to make general setting changes to the overall image 
quality of your processed file. Quality is a subjective setting that trades image quality 
for bandwidth and gives the entire media file the same quality. Lower quality means 
that the finished file requires less bandwidth and streams faster. Available settings 
are Least, Low, Medium, High, and Best. You can also drag the slider between any of 
these settings to obtain a more specific rate (displayed numerically).

Key frame

Delta frames 

Key frame
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Â Options button:  This button remains dimmed unless the codec you selected from the 
Compression type pop-up menu offers options. It is recommended that you contact 
the manufacturers of these codecs directly for more information about the additional 
options they offer.

Â Data Rate:  Use this field to set the number of kilobytes per second 
(KB/sec.) required to deliver your media file. This setting is useful if you have a 
specific bit rate (such as a DSL connection) or amount of space (on a DVD or CD 
ROM). You should choose a data rate that is appropriate for your delivery medium 
and set it as high as possible within your data limitations. When you set a data rate, 
you override other codec quality settings because the codec compresses the file as 
much as it needs to based on its data rate limit. 
Remember that the data rate is only for the video track of a media file. If your media 
file also contains audio, you must allow some space for that too.

About the Sound Settings Dialog
You use the Sound Settings dialog to change your audio compression settings for 
either the QuickTime or AIFF output format. To open this dialog, click the Audio 
Settings button in the QuickTime Movie or AIFF Encoder pane.

If a particular audio setting cannot be changed, it remains dimmed. Some audio 
codecs—such as Qualcomm PureVoice and QDesign Music 2—allow you to make 
additional settings. If this is the case, the Options button becomes available. Click it to 
make additional settings.

The Sound Settings dialog contains the following items, with various choices for each, 
depending on the audio codec you choose in the Format pop-up menu.
Â Format:  Choose the audio codec you want to add to your setting.
Â Channels:  Choose the type of channel output, such as mono, stereo, or some type of 

multi-channel output, depending on the codec.

Format 
pop-up menu

Rate field and 
pop-up menu

Options button (dimmed)



230 Chapter 17    Creating QuickTime Movie Output Files

 

Â Rate:  Choose the sample rate you want to use for your media file. The higher the 
sample rate, the higher the audio quality, but the larger the file. Downloading a 
larger file takes longer and requires more bandwidth. 

Â Options:  This button remains dimmed unless the codec you selected from the 
Format pop-up menu offers options. It is recommended that you contact the 
manufacturers of these codecs directly for more information about the additional 
options they offer.

QuickTime Audio Sample Sizes and Rates
If you have the disk space and bandwidth, it is best to leave your audio uncompressed. 
Uncompressed audio normally uses 8-bit (phone quality) or 16-bit (CD quality) samples. 
Compressor supports up to 64 bits per sample floating point and a maximum sample 
rate of 192 kHz. 

Choosing an Audio Codec
AAC is a good general purpose audio delivery codec and it is compatible with a wide 
variety of playback devices. For low-bandwidth audio on faster computers, the 
QDesign Music codec (QDMC) is good for most material, while Qualcomm PureVoice is 
the best choice for speech-only material. For slower computers, CD-ROM, and kiosk 
situations, IMA is a better choice, because it is less computer intensive, thus allowing 
the computer to focus on the more challenging video stream. See “QuickTime Audio 
Codecs” on page 235 for more information about audio codecs.

QuickTime Transcoding Workflow
The following steps outline the transcoding process required to create QuickTime 
output media files:

Step 1:  Open the QuickTime Encoder pane
There are a multitude of QuickTime video and audio codecs that you can choose from 
in Compressor. You access all codecs via the Compression Settings and Sound Settings 
dialogs, opened from the QuickTime Encoder pane by clicking the Video Settings and 
Audio Settings buttons.

1 In the Settings tab, do one of the following:

Â Make sure that the correct setting is selected.
Â Create a new setting by choosing QuickTime Movie from the “Create a new setting” 

( + ) pop-up menu.
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2 Open the Encoder pane in the Inspector window.

The default QuickTime Encoder pane appears, containing the Video and Audio Settings 
buttons, Enable pop-up menus, the Streaming pop-up menu, the Options button 
(dimmed), and the Summary table. See “About the QuickTime Movie Encoder Pane” on 
page 224 for more information.

Note:  Make sure that the Enable pop-up menus next to the Settings buttons are set to 
Enable if you want those settings included in the transcoding.

Step 2:  Add a QuickTime video codec to a setting
To add a QuickTime video codec to your setting, you need to open the Compression 
Settings dialog and choose a video codec from the Compression Type pop-up menu. 

Note:  If you don’t intend to use any video settings, deselect the Enable checkbox next 
to the Video Settings button.
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1 Click the Video Settings button in the QuickTime Encoder pane.

The Compression Settings dialog opens.

2 Choose a video codec from the Compression Type pop-up menu and either accept its 
defaults or customize the other settings (Motion, Encoding Mode, Quality, Depth, and 
Options, if available). See any of the following for more information about video codecs:

Â “Video codec settings” on page 226
Â “About the Compression Settings Dialog” on page 227 
Â “QuickTime Video Codecs” on page 234

Note:  You can see the current contents of your setting by viewing the Summary table.

3 Click OK to save changes and close this dialog.

Step 3:  Add a QuickTime audio codec to a setting
If you want to add an audio codec to your setting, you need to open the Sound 
Settings dialog and choose your audio codec settings from there. 

Note:  If you don’t intend to use any audio settings, deselect the Enable checkbox next 
to the Audio Settings button.

Choose a video codec 
from the Compression 
Type pop-up menu.
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1 Click the Audio Settings button in the QuickTime Encoder pane. 

The Sound Settings dialog opens.

2 Choose an audio codec from the Format pop-up menu and either accept its defaults 
or customize the other audio codec settings (Format, Channels, Rate, and Options, 
if available). 

See any of the following for more information about audio codecs:

Â “Audio codec settings” on page 226
Â “About the Sound Settings Dialog” on page 229 
Â “QuickTime Audio Codecs” on page 235

Note:  You can see full details of the current contents of your setting by viewing the 
Summary table.

3 Click OK to save your settings and close this dialog.

Choose an audio codec from 
the Format pop-up menu.
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Understanding Codecs
Codec stands for compressor (CO)/decompressor (DEC) pairs. You use different codecs for 
different playback methods (such as the web or CD-ROM). Once you know the playback 
method of your target audience, you can pick a suitable codec. To decide which codec 
is right for your needs, you must choose the necessary level of compression to meet 
your data rate limits and the level of quality you want. 

The following sections discuss issues to be aware of when selecting a video or 
audio codec.

QuickTime Video Codecs
Each codec offers advantages and disadvantages. Some are more appropriate for 
storing certain types of media; others introduce more artifacts. Some compress slowly 
and decompress quickly, while others compress and decompress at the same speed. 
Some codecs can compress a file to 1/100th of its original size, while others decrease 
the file size very little. Some codecs are only available on specific operating system 
platforms, some require a particular processor, and some require a minimum version of 
QuickTime for playback. 

When choosing a codec you should consider the following:
Â Minimum system requirements of your target audience
Â Source material
Â Quality of the compressed media file
Â Size of the compressed media file
Â Compression/decompression time for the media file
Â If the media file will be streamed

Adding Additional Settings and Presets
Although the output format setting is the most important component of the 
Compressor workflow, you can also add other settings and presets, such as filters, 
cropping, frame sizing, actions, and destinations. For further instructions on how to 
add these settings, see the following:
Â Chapter 19, “Adding Filters to a Setting,” on page 241
Â Chapter 20, “Adding Frame Controls to a Setting,” on page 255
Â Chapter 21, “Adding Geometry Settings,” on page 267
Â Chapter 22, “Adding Actions to a Setting,” on page 277
Â Chapter 24, “Creating and Changing Destinations,” on page 305
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Compressor comes equipped with the standard video codecs that QuickTime offers 
and the additional codec options that come with QuickTime Pro. Unless you know your 
target audience has a particular codec installed on their computers, you should use 
one of the standard QuickTime codecs to ensure universal conformity. 

Note:  See the relevant QuickTime documentation for more information about choosing 
video codecs and how to get the best out of the video codec settings.

Video codecs can be divided into the following two types:
Â Lossless codecs:  Lossless codecs completely preserve the data they compress, and are 

usually used to transfer footage from one editing suite to another. Lossless codecs can 
require high data rates and high-end computers with specialized hardware. Examples 
of lossless codecs are the Animation, 8-bit, and 10-bit uncompressed 4:2:2 codecs.

Â Lossy codecs:  In comparison to lossless codecs, lossy codecs only return an 
approximation of the data and are usually used to deliver finalized video to an end 
user. The level of approximation is determined by the quality of the codec. Typically 
there is a tradeoff between the output quality of the codec and its achievable level of 
compression. With some codecs, a compression ratio of at least 5:1 can be reached 
without visible degradation. An example of a lossy codec is the Photo-JPEG codec. 
Low-quality lossy compression introduces unnatural visual artifacts which may 
become noticeable to the human eye. Using a lossy codec, you should only compress 
your media file once, because compressing a file multiple times adds more artifacts.

QuickTime Audio Codecs
If you have the disk space and bandwidth, the best thing you can do is leave your 
audio uncompressed. Uncompressed audio normally uses 8-bit (phone quality) or 
16-bit (CD quality) samples. (Compressor supports up to 64 bits per sample floating 
point and a maximum sample rate of 192 kHz.) If you have disk space and bandwidth 
limitations, you must compress your audio. However, audio takes up less disk space 
than video, so it doesn’t need to be compressed as much as video.

The two most important components of audio codecs are sampling rates and size. 
Sampling rate sets the sound quality, and sampling size sets the dynamic range of the 
sound. QuickTime audio codecs allow you to set both the sampling rate and size of 
your source media file. 
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Sound Sampling Rates
Digitized sound consists of sound samples captured at different frequency rates. The 
more sound samples per second, the higher the sound quality. For example, audio CDs 
use a 44.1 kHz sampling rate, DVDs sample at 48 kHz, and telephone networks sample 
voices at 8 kHz. The sample rate you choose depends on the nature of the sound. Music 
requires a higher sampling rate than voice, because music contains a wider range of 
frequencies. Spoken voice has a more limited range of frequencies, so you can choose a 
lower sampling rate and still maintain acceptable audio quality. In most cases, you 
should choose the highest sampling rate available. 

Reducing the sampling rate can shrink a media file by as much as 5:1. The audio quality 
will be affected, but not as much as it would be if you used 8-bit sampling. The 
following table shows common sampling rates and the audio device quality to expect 
at each rate:

Sound Sampling Size
The sound sampling size determines the dynamic range of the sound. 8-bit sound 
provides for 256 possible values, whereas 16-bit sound allows for more than 65,000 
possible values. 

Choose 16 bit for music that has both soft and loud sections, such as orchestral music. 
For spoken voice or music that has a more or less constant volume level, choosing 8 bit 
can still yield good results.

If you need to shrink your media file, you can reduce the sample size from 16 bit to 
8 bit. This cuts the file size in half but also degrades the audio quality.

Sample rate Audio device quality

48 kHz DAT/DV/DVD

44 kHz CD

22 kHz FM radio

8 kHz Telephone
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18 Creating QuickTime 
Export Component Files

You can use Compressor to output a variety of additional 
formats using the QuickTime component plug-in feature. 

This chapter discusses how to take advantage of the QuickTime component plug-in 
feature, which opens up a wide variety of additional file formats that Compressor can 
output from your source media files:
Â Creating QuickTime Export Component Output Files (p. 237)
Â Installing QuickTime Export Component Plug-Ins (p. 238)
Â About the iPod Plug-In (p. 238)
Â About the QuickTime Export Components Encoder Pane (p. 239)
Â Configuring Export Components Settings (p. 240)

Creating QuickTime Export Component Output Files
Compressor and QuickTime can be extended to support additional codec options and 
third-party formats. This section focuses on the QuickTime component plug-in feature, 
which allows you to export exotic file formats that can play on third-party devices and 
operating systems, such as cell phones. Unlike standard QuickTime movies, these 
exported files cannot be played back with QuickTime Player or other QuickTime-based 
applications. (For information on the native QuickTime movie file format, see “Creating 
QuickTime Movie Output Files” on page 223.)

In the past, creating these kinds of files required multiple steps and multiple operating 
systems:  exporting the file, moving it to a computer on another platform, and then 
encoding using another software application. The QuickTime Export Components 
feature allows you to control the third-party encoding engine without having to open 
another application. This streamlines your workflow and saves you the time and hassle 
of working with multiple operating systems and software packages.
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Installing QuickTime Export Component Plug-Ins
With no additional third-party software, Compressor currently supports transcoding to 
3G, AVI and iPod. The export component feature in Compressor was developed to 
make it possible to add additional export plug-ins in the future. You would simply 
install the third-party software and then choose the corresponding output file format 
from the Encoder Type pop-up menu in the QuickTime Export Components Encoder 
pane of the Inspector window. 

To find out more about the currently available plug-ins and updates, check the 
Compressor support web site:
Â http://www.apple.com/support/compressor

About the iPod Plug-In
The QuickTime Export Components output format includes an iPod encoder type. This 
encoder creates an output file suitable for playing on an iPod, using an H.264 encoder 
for the video and an AAC encoder for the audio. All settings (frame size, frame rate, and 
so on) are automatically set.

Drawbacks of using this plug-in (as opposed to using the H.264 for Apple Devices 
output format) include not being able to take advantage of distributed processing, 
include chapter markers, or use the Frame Controls pane.

See Chapter 10, “Creating H.264 for Apple Devices Output Files,” on page 147, for more 
information on creating iPod output media files.

http://www.apple.com/support/compressor
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About the QuickTime Export Components Encoder Pane
The following options appear when you choose the QuickTime Export Components 
output format from the File Format pop-up menu in the Encoder pane of the 
Inspector window:

Â File Extension:  This field indicates the file extension for the output format selected 
from the Encoder Type menu.

Â Allow Job Segmenting:  This checkbox allows you to turn off job segmenting. Since 
job segmenting is not used for the Export Components format, this checkbox is not 
active. For more information, see “Job Segmenting and Two-Pass (or Multi-Pass) 
Encoding” on page 61.

Â Encoder Type:  Use this pop-up menu to choose from the available export component 
output formats (plug-ins).

Â Options:  Click this button to open the Settings window for the output file format 
selected in the Encoder Type pop-up menu.

File Extension field

Choose QuickTime 
Export Components

Click to see the options
for the encoder plug-in

Choose an encoder 
plug-in
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Configuring Export Components Settings
When you choose QuickTime Export Components as your output format, you can only 
create settings for export plug-ins that are already installed. 

To create QuickTime Export Components settings:
1 In the Settings tab, do one of the following:

Â Make sure that the correct setting is selected.
Â Create a new setting by choosing QuickTime Export Components from the “Create a 

new setting” ( + ) pop-up menu.

2 Choose an output file format from the Encoder Type pop-up menu.

3 Click the Options button in the Encoder pane.

The Settings window for that particular output file format opens.

Important:  Use the third-party export module user interface to explicitly enter the 
width, height, and frame rate for the output file. Do not leave the width, height, and 
frame rate fields in the third-party user interface at their default (“current”) values.

4 Click OK to save your settings and close this dialog.

Note:  The Compressor Frame Controls feature is not available when using the 
QuickTime Export Component Output feature.

Configure settings 
for the QuickTime 
export component.
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19 Adding Filters to a Setting

Compressor comes with a variety of filters (such as 
color correction and noise removal filters) that you can 
use to adjust the details of your transcoding projects. 

This chapter contains the following:
Â Working with Filters (p. 241)
Â About the Filters Pane (p. 244)
Â Available Filters (p. 245)
Â Adding Filters to a Setting (p. 253)

Working with Filters
You can treat your source media file with a variety of filters before you transcode it to 
help improve the output quality of your video and audio. The best way to assign these 
filter settings is to look at, and listen to, your source media file and choose the most 
suitable one based on its content.

Previewing Filters
You can preview a clip containing your current filter settings by clicking the target in 
the Batch window to open it in the Preview window. The Preview screen is split into 
original and transcoded versions of your media file so that you can see or hear the 
effects of your filter settings before processing the batch (as long as the checkbox for 
that particular filter is selected). 

This can be helpful when you are applying multiple filters since it can be difficult to 
anticipate how the filters will interact with each other.

Important:  The order of the filters in the filter list defines the order in which they are 
applied to the video or audio. Try changing the order of the filters if you are seeing 
unexpected results in the Preview window.
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Once you are reasonably happy with your settings, it’s a good idea to scan through the 
whole movie to ensure that your changes are not too extreme for some scenes. 

Note:  Depending on your system, the source media file type, and the number of filters 
applied, the Preview window showing the filter settings may update at a lower frame 
rate than the source frame rate.

See Chapter 23, “Using the Preview Window,” on page 283, for more information.

Deinterlacing
NTSC and PAL video is interlaced. This means that each frame of video consists of two 
fields (1/60th of a second apart), one with the odd broadcast lines and one with the 
even lines of the image. The differences between these two fields create the impression 
of motion. Our eyes combine these two images into one whole frame of smooth, 
realistic motion at 30 fps in standard definition television, and because of the high 
field-refresh speeds (1/60th of a second), the interlacing is invisible.

Adjustments you make
can be viewed in the

Preview window.
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Because interlacing creates two fields for each frame, areas with fast movement within 
the field become separated into alternating jagged lines. You can view your source 
media one frame at a time and check for horizontal stripes along the leading and 
trailing edges of moving objects. If you find these, you need to deinterlace your source 
media to convert it to a frame-based format. 

Note:  For deinterlacing, the Frame Controls feature is recommended over the 
Deinterlacing filter (a legacy filter) as it will always provide much higher quality. See 
Chapter 20, “Adding Frame Controls to a Setting,” on page 255, for more information.

Color Spaces
Compressor supports the following color spaces—YUV (R408), 2VUY, RGBA, ARGB, and 
YUV (v210). Some filters require a color space conversion and some filters can handle 
various color spaces. For each media file, Compressor chooses the most suitable color 
space to provide the best output and performance results based on the color space of 
three attributes: the source media format, the output file format, and chosen filters. 

Interlacing creates  
a “comb” effect that  
should be removed. 
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About the Filters Pane
Use the following features in the Filters pane of the Inspector to select and adjust filters 
that you want to assign to your settings.
Â Filters list:  Select the checkbox next to the filters you want to add to your presets. 

Filter settings you select appear in the Summary table in the Summary pane. You can 
reorder filters by dragging them up or down in the Filters list. Because these filters 
are processed one by one during transcoding—starting with the first entry in the 
list—it is important that your filters are organized correctly. For example, it is sensible 
to place your text overlay filter last, so that the text color you selected doesn’t get 
modified by some other filter. 

Â Filter controls:  The controls available depend on the filter selected in the Filters list. 
The slider allows you to make large numerical changes to your setting, while the 
arrow control lets you make single incremental number changes. The setting number 
appears in the field located between the slider and arrow control.

Note:  Once you make any adjustment to a filter, its checkbox is automatically selected. 
If you decide that you no longer want to use that filter, be sure to deselect that 
particular filter’s checkbox before transcoding. 

Filters list

Filter controls

Choose video or audio
filters
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Available Filters
The Filters pane contains two tabs: one for video and one for audio. 

Video Filters
Â BlackWhite Restore:  Restores nearly black colors to pure black and nearly white colors 

to pure white without affecting colors in the rest of the image. Use this filter to better 
compress the solid black and white areas (the luminance) in the image, such as 
backgrounds. The two sliders allow you to separately set values between 0 and 100 
for black and white. See “Color Spaces” on page 243 for information on how color 
spaces relate to this filter.

Â Brightness and Contrast:  Alters the overall color and luminance values of your output 
media file to a brighter or darker level. Some QuickTime codecs darken your video 
file, so you can use this filter to compensate for that. Choose any number between 
–100 and 100, but avoid the extreme settings as they give a very washed-out quality.

Â Color Correct Highlights, Midtones, or Shadows:  Depending on which of these you 
choose, this corrects white balance inaccuracies and creates color effects on the 
bright, midtone, or dark areas of your clip. Adjust red, green, and blue values 
independently between –100 and 100. 
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Â Deinterlacing:  Removes the effects of interlacing. If your source media file needs to 
be converted to a frame-based format, you must deinterlace it to remove the effects 
of interlacing. Interlacing on computer displays can cause high-motion parts of your 
video to look fuzzy, so this is especially important if you’re outputting a QuickTime 
movie for desktop playback, or for streaming over the web. You can remove the 
upper (odd) or lower (even) field from an interlaced video file, although smooth 
motion may be compromised within the clip. This filter can also be used to eliminate 
flickering caused by interlacing in still frames that have thin vertical lines, such as title 
pages with small text. The remaining fields are interpolated to create a whole image, 
resulting in an overall softening of the image. 
See “Deinterlacing” on page 242 for more information.

Note:  The Frame Controls feature is recommended over the Deinterlacing filter (a 
legacy filter) as it will always provide much higher quality. See Chapter 20, “Adding 
Frame Controls to a Setting,” on page 255, for more information.

Experiment with one of the following deinterlacing methods in the pop-up menu to 
see which one works best with your footage:

Â Blur:  Blends the odd and even fields together. This setting gives more importance 
to temporal data and preserves motion better, but because individual frames 
consist of a composite of both frames, they don’t look good when you pause 
playback.

Â Even:  Keeps the even fields and ignores the odd fields, avoiding motion blur.
Â Odd:  Keeps the odd fields and ignores the even fields, avoiding motion blur.
Â Sharp:  Looks at both fields to make all edges sharper. This setting gives more 

importance to spatial data. 
Â Fade In/Out:  Adds a dissolve from and to a matte color at the beginning and end of 

the clip.
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Â Fade In and Fade Out Duration:   Sets the duration of the dissolve. 
Â Fade In and Fade Out Opacity:   Sets the opacity of the clip’s video at the first 

(Fade In) or last (Fade Out) frame. A value of 0.0 sets the clip video to be 
completely covered by the matte color. A value of 0.5 sets the clip to be 50 percent 
covered by the matte color.

Â Fade Color:   Sets the matte color. When clicked, the color picker appears where you 
can choose the color to fade to and from. (The Fade In and Fade Out colors must 
be the same.)

Â Gamma Correction:  Controls the overall brightness of an image as displayed on a 
monitor by changing the gamma amount of the media file. This filter can be used to 
remove detail from an underexposed clip or reduce an overexposed clip’s saturation 
to an acceptable level without washing out the image too much. Computers using 
different operating systems have different monitor settings. For cross-platform 
viewing, correcting the gamma will improve the image for all platforms. Choose a 
gamma setting between 0.1 and 4.0.

Â Letterbox:  Scales and positions the image in the frame within horizontal letterbox bars.

Â Type:  This pop-up menu allows you to choose the type of letterboxing to use. 
Scale vertically compresses the video to fit within the letterbox bars. Matte crops 
off the video where the letterbox bars are placed.

Â Position:  This pop-up menu allows you to choose the position of the video. Center 
places letterbox bars above and below the video, keeping the video centered. 
Bottom positions the video at the bottom of the screen with a single letterbox bar 
above it. Top positions the video at the top of the screen with a single letterbox 
bar below it.
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Â Output:  This pop-up menu allows you to choose the specific aspect ratio to use for 
the letterbox. Each setting is followed by a value that shows the ratio of the width 
to the height for that setting. For example, the Academy setting shows its aspect 
ratio as 1.85:1, indicating that the image’s width is 1.85 times the size of its height. 
The Manual setting enables the Manual slider which you can use to manually set 
the letterbox aspect ratio. 

Â Manual slider:  Used when Manual is selected in the Output pop-up menu. Allows 
you to manually set the letterbox aspect ratio. The Manual slider has no effect 
when Manual is not selected in the Output pop-up menu.

Â Background color box:  Sets the letterbox color. Click this box to choose a 
background color from the color picker.

Â Noise Removal:  Reduces random flecks of noise from the image. Some codecs 
introduce noise into the video file, which can be softened with the Noise Removal 
filter. You can improve image quality and spatially compress your material more 
efficiently by reducing its fine detail. 
The noise reduction filter allows you to blur areas of low contrast while leaving high-
contrast edges sharp. This is known as adaptive noise reduction. The results are 
imperceptible to the human eye, but improve the final compression of the source 
media. It is especially important to use this filter with live video.

Â Apply To:  This pop-up menu allows you to choose which channels you want to 
filter the noise from. The default is All Channels, which filters out noise from all 
channels including the alpha channel. The other option is Chroma Channels, which 
filters out noise only from the two chroma channels—U and V—in the AYUV color 
space (or R408 in Final Cut Pro terminology).

Â Iterations:  This pop-up menu smooths out image noise. Choose how many times 
(between 1 and 4) you want the selected algorithm applied to the source media 
file. The modified image is used each time as a starting point for the algorithm. The 
more iterations used, the fuzzier the image becomes.

Â Algorithm:  Select one of the following algorithms from the Algorithm pop-up 
menu: Average (each pixel’s color is modified by taking an average color of pixels 
around it, including its own color value); Replace (each pixel’s color is modified by 
taking an average of pixels around it, while ignoring its own color value); and 
Merge (each pixel’s color is modified by taking a weighted average of surrounding 
pixels and itself; the pixel’s own color value is given greater weight).
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Â Sharpen Edge:  Enhances the image contrast around object edges. Some codecs blur 
the video image, so this filter can counteract the softening effect of noise removal or 
blurred source material and increase the perception of sharpness in the image. When 
used to an extreme, the output media file can look grainy. Choose any number 
between 0 and 100.

Â Text Overlay:  Superimposes text onto the image. This is a useful tool for stamping 
other relevant text information onto your output media file. Use the following 
controls to position text, select color and font, and set its opacity:

Â Position pop-up menu:  Positions text in the image clip. Choose from 1 of 13 
positions such as Center, Lower Left, Lower Left - Title Safe, and so on.

Â Alpha:  This slider sets the text opacity. Choose between 0 and 1. A value of 0 makes 
the text completely transparent, while a value of 1 makes it completely opaque.

Â Overlay Text:  Type your text here.
Â Text Color:  Click this box to choose a text color from the color picker.
Â Select Font:  Click this button to open a font palette for selecting font, style, and size.

Â Timecode Generator:  Superimposes the clip’s timecode text onto the image. You can 
also add a label to the timecode text.
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Â Position pop-up menu:  Positions timecode text in the image clip. Choose from 1 of 
13 positions such as Center, Lower Left, Lower Left - Title Safe, and so on.

Â Alpha:  This slider sets the timecode text opacity. Choose between 0 and 1. A 
value of 0 makes the text completely transparent, while a value of 1 makes it 
completely opaque.

Â Label:  Type any text that you want to appear to the left of the timecode number here.
Â Start Timecode at 00:00:00:00 checkbox:  Select this checkbox to have the timecode 

start at 00:00:00:00. When this is not selected, the clip’s timecode is used.
Â Text Color:  Click this box to choose a timecode text color from the color picker.
Â Select Font:  Click this button to open a font palette for selecting font, style, and size.

Â Watermark:  Superimposes a watermark onto the image. This is a useful tool for 
stamping a suitable logo onto your output media file. The watermark filter can apply 
either still images or movies as watermarks on your output media file. Use the 
following pop-up menus, fields, and sliders to position and size the watermark and 
set its opacity:

Â Position pop-up menu:  This pop-up menu positions the watermark image in the 
image clip. Choose from one of 13 positions such as Center, Lower Left, Lower Left - 
Title Safe, and so on.

Â Scale By:  This slider sets the size of the watermark image size. 
Â Alpha:   This slider sets the watermark image opacity. Choose between 0 and 1. A 

value of 0 makes the watermark image completely transparent, while a value of 1 
makes it completely opaque.

Â Repeat checkbox:  Used when you choose a clip as the watermark, this checkbox 
allows you to have the watermark clip loop its playback. If you don’t select this 
checkbox, the watermark clip plays until its end and then disappears.

Â Choose button:  Click this button to open the file selection dialog and select a 
stored watermark movie or still image.
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Audio Filters
Important:  The audio filters are not available when audio is set to “Pass-through” in 
QuickTime settings. See “About the QuickTime Movie Encoder Pane” on page 224 for 
more information.

Â Dynamic Range:  Allows you to dynamically control a clip’s audio levels by enhancing 
the quieter parts and lowering the louder parts. This is also referred to as audio 
level compression. 

Â Soften Above:  Audio above this level is reduced to the level set by the Master Gain. 
Â Noise Threshold:  Sets the level of what is considered noise. Audio at this level and 

above is dynamically boosted to the level set by the Master Gain. Audio below this 
level is left as is.

Â Master Gain:  Sets the average level of the dynamically compressed audio.
Â Peak Limiter:  Sets the level of the loudest audio allowed in the clip. 

Â Gain (dB):  Sets the level above which louder peaks are reduced.
Â Apple AU Graphic EQ:  Allows you to use the Apple AUGraphicEQ to shape a wide 

variety of frequencies throughout the audible frequency range. You have the choice 
of a 31-band or a 10-band version.
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Â Options pop-up menu:  Opens the Apple AUGraphicEQ interface. You can use the 
“number of bands” pop-up menu in the equalizer’s interface to choose to use the 
31-band or 10-band versions of the equalizer.

Â Fade In/Out:  Adds a mix from and to a silence (or a gain level you set) at the 
beginning and end of the clip. 

Â Fade In and Fade Out Durations:  Sets the durations of the mix from the gain value 
to the clip’s normal audio level at the start (Fade In) and end (Fade Out) of the clip.

Â Fade In and Fade Out Gains:  Sets the level that the mix starts with (Fade In) or ends 
with (Fade Out). A value of –100.0 is silence while 0.0 leaves the audio as it is.

Note:  When using the Fade In/Out and Dynamic Range filters at the same time, be 
sure to have the Dynamic Range filter ahead of the Fade In/Out filter in the filter list.
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Adding Filters to a Setting
You use the Filters pane in the Inspector window to add filters to your settings. 

To add filters to a setting:
1 Open the Settings tab.

2 Select the setting in the Settings tab that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window. This way, you can open the 
Preview window and see the effects of your filter adjustments.)

3 Click the Filters pane in the Inspector.

4 Make adjustments to any filters that you want added to the setting.

Note:  A checkmark appears automatically as soon as you make adjustments to any filter. 

The filter is automatically
selected if you make any

adjustments to it. Any changes you make to a 
filter’s settings apply to the 
currently selected filter.
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5 Drag the filters up or down within the Filters list to set the order in which you want 
them applied to the source media file during transcoding.

Because these filters are processed one by one during transcoding—starting with the 
first item in the list—it is important that your filters be organized in the order you want 
them. For example, it is sensible to place your text overlay filter last, so that the text 
color you selected doesn’t get modified by some other filter. 

If you move a filter, be sure to select the checkbox so that Compressor knows to apply 
the filter to that setting. As an additional reminder, once you select the moved filter and 
then try to select another setting, the Save dialog appears, requiring you to save or revert 
the changes to that setting. By default, all selected filters are displayed first in the list.

Note:  You can see setting details in the Summary pane of the Inspector window.

See “About the Filters Pane” on page 244 for more details.

Drag filters up or down to set 
the order in which you want 
them to be applied to the 
source media file.
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20 Adding Frame Controls 
to a Setting

Frame controls use advanced image analysis for retiming, 
resizing, and other sophisticated video effects. 

This chapter contains the following sections:

Â Working with Frame Controls (p. 255)
Â About the Frame Controls Pane (p. 256)
Â Adding Frame Controls to a Setting (p. 260)
Â Using Reverse Telecine (p. 262)
Â Using the Retiming Controls (p. 264)

Working with Frame Controls
Through frame controls, Compressor offers high-quality transcoding from many 
different source formats to many different target formats using advanced image 
analysis. That means you can now do any of the following at levels of quality that were 
previously only available through expensive hardware solutions:
Â Convert video files between international television standards such as PAL to NTSC, 

or NTSC to PAL. 
Â Downconvert high definition (HD) video sources to standard definition (SD), or 

upconvert SD to HD. 
Â Convert a progressive stream to an interlaced one, or interlaced to progressive. 
Â High-quality frame rate adjustments, including high-quality slow-motion effects.
Â Automatically remove telecine pull-down (reverse telecine).

Note:  The Advanced Format Conversions settings group in the Settings tab has 
particular relevance to working with frame controls.

Important:  Frame Controls settings cannot be previewed in the Preview window. To 
preview Frame Controls settings, do a test transcode of a small section of your source 
media file. (See “Transcoding a Portion of the Clip with the Preview Window” on 
page 295 for more information.)
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About the Frame Controls Pane
Use the following features in the Frame Controls pane of the Inspector to select and 
adjust frame controls attributes that you want to assign to your settings.

Frame Controls Status
Use this pop-up menu to choose from the following Frame Controls options:

Â Off:  The default setting for most Apple presets. Choose Off if your Compressor 
project does not involve changes to the frame size, frame rate, or field dominance.

Â On:  Allows you to manually adjust all the attributes in the Frame Controls pane.
Â Automatic selected:  Compressor analyzes the transcoding job (the source media file 

and the applied setting), and then automatically determines the appropriate Frame 
Controls attributes.
In Automatic mode, Frame Controls technology is engaged in the following two 
types of transcodes only:

Â Transcoding from high definition (HD) sources to standard definition (SD) MPEG-2 
output files

Â Transcoding from interlaced sources to H.264 for DVD Studio Pro and H.264 for 
Apple Devices (progressive) output files

Resizing controls

Retiming controls

Frame Controls status

Frame Controls 
Automatic button
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Resizing Controls

 

Use the controls in this section to choose the algorithm with which frames are resized. 
Â

 

Resize Filter:  

 

Use this pop-up menu to choose from the following resizing options. 
This decision is a trade-off between faster processing time and higher output quality 
in projects that involve a change in resolution.

Â

 

Fast (Nearest pixel)
Â

 

Better (Linear filter)
Â

 

Best (Statistical prediction)
Â

 

Output Fields: 

 

 Use this pop-up menu to choose the output scanning method (either 
the field dominance or a conversion to progressive scanning). 

Â

 

Same as source: 

 

 No change to the scanning method.
Â

 

Progressive: 

 

 Scanning method where each frame is complete (not divided into 
fields). Use this setting in place of the Compressor Deinterlacing filter (a legacy 
filter in the Filters pane) as it will always provide much higher quality. 

Â

 

Top first: 

 

 Interlaced field dominance (field order), also known as 

 

field two, the upper 
field,

 

 or 

 

the odd field.
Â

 

Bottom first:  

 

Interlaced field dominance (field order), also known as 

 

field one, the 
lower field,

 

 or 

 

the even field.
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Â Deinterlace:  Use this pop-up menu to choose from different techniques for 
deinterlacing. This decision is a trade-off between faster processing and 
higher-quality deinterlacing of motion areas within the frame. In all cases, each 
higher-quality deinterlacing option yields the same or better results than the next 
lower quality option. However, if downward resizing is also applied to the frame, 
improvements in quality may not be noticeable. Under these circumstances, Fast or 
Better will likely provide sufficiently high quality, depending on the amount of 
downward resizing.

Â Fast (Line averaging):  This option averages adjacent lines in a frame.
Â Better (Motion adaptive):  This option offers good-quality deinterlacing for areas of 

the image that are in motion.
Â Best (Motion compensated):  This option offers higher-quality deinterlacing for areas 

of the image that are in motion.

Â Reverse Telecine:  This option removes the extra fields added during the telecine 
process to convert the film’s 24 fps to NTSC’s 29.97 fps. Selecting this item disables 
all other items in the Frame Controls pane. 

Note:  See “Using Reverse Telecine” on page 262 for more information on 3:2 pull-
down and using the Reverse Telecine feature.

While the Deinterlace pop-up menu is always active, Compressor only deinterlaces 
jobs that need it. (For example, if the source is interlaced and the Output Fields pop-
up menu is set to Progressive, Compressor will deinterlace. If the source media file is 
progressive, Compressor will not deinterlace.) 

Â Adaptive Details:  Select this checkbox to use advanced image analysis to distinguish 
between noise and edge areas. 

Warning:  Using all Best settings may result in unexpectedly long processing times. If 
you are reducing the frame size in addition to deinterlacing the frame, Fast or Better will 
likely provide sufficiently high quality, depending on the amount of downward resizing.
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Â Anti-alias:  Use this slider to set a softness level from 0 to 100. This parameter 
improves the quality of conversions when you’re scaling media up. For example, 
when transcoding standard definition video to high definition, Anti-alias smooths 
out jagged edges that might appear in the image. 

Â Details Level:  Use this slider to set a level (from 0 to 100) to preserve sharp edges. 
This is a sharpening control that lets you add detail back to an image being enlarged. 
Unlike other sharpening operations, the Details Level setting is able to distinguish 
between noise and feature details, and generally doesn’t increase unwanted grain. 
Increasing this parameter may introduce jagged edges, however, which can be 
eliminated by increasing the Anti-alias level. 

Note:  Adaptive Details, Anti-alias, and Details Level pertain only to frame resizing 
(scaling), not deinterlacing.

Retiming Controls
Use the controls in this section to choose the algorithm with which frame rates 
are adjusted. 
Â Rate Conversion:  Use this pop-up menu to choose from the following techniques for 

retiming frames (changing the frame rate). This decision is a trade-off between faster 
processing time and higher output quality. In many cases, the Better setting will 
provide sufficiently high-quality conversion at a substantial savings in processing 
time over the Best setting.

Â Fast (Nearest frame):  No frame blending is applied; Compressor simply uses a copy 
of the nearest available frame to fill the new in-between frames.

Â Good (Frame blending):  Averages neighboring frames together to create new 
in-between frames.

Â Better (Motion compensated):  Uses optical flow to interpolate frames, with 
good-quality results.

Â Best (High quality motion compensated):  Uses optical flow to interpolate frames, 
with higher-quality results; this option is particularly useful for transcodes that 
involve increases in frame rates (for example, 23.98 fps to 59.94 fps).

Warning:  Using all Best settings may result in unexpectedly long processing times. 
The Better setting for rate conversion will provide sufficiently high-quality conversion 
at a substantial savings in processing time over the Best setting.
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Â Set Duration to:  Use this to choose one of three methods to convert the clip’s 
duration to a new duration.

Â Percent of source:  Use this to enter a percentage value to modify the clip’s speed or 
choose a specific situation from the pop-up menu.

Â Total duration:  Use this to choose a duration for the clip. 
Â So source frames play at [frame rate] fps:  Use this when the source media file’s 

frame rate does not match the Encoder pane frame rate (shown as the frame rate 
for this item). 

Note:  When you use the retiming controls to change the video speed, Compressor 
will also adjust the audio portion of the output media file so that it stays in sync with 
the video. The retiming controls will not affect the audio pitch.

See “Using the Retiming Controls” on page 264 for more information about using 
these options.

Adding Frame Controls to a Setting
You use the Frame Controls pane in the Inspector window to add frame resizing and 
retiming adjustments to your settings. 

To add automatic Frame Controls adjustments to a setting:
1 Open the Settings tab.

2 Select the setting in the Settings tab that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Click the Frame Controls tab in the Inspector window.

Selection pop-up menu
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4 Click the Automatic button next to the Frame Controls pop-up menu.

Compressor analyzes the transcoding job (the source media file and the applied 
setting), and then automatically determines the appropriate Frame Controls attributes.

In Automatic mode, Frame Controls technology is engaged in the following two types 
of transcodes only:
Â Transcoding from high definition (HD) sources to standard definition (SD) MPEG-2 

output files
Â Transcoding from interlaced sources to H.264 for DVD Studio Pro and H.264 for Apple 

Devices (progressive) output files

To add custom Frame Controls adjustments to a setting:
1 Open the Settings tab.

2 Select the setting in the Settings tab that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Click the Frame Controls tab in the Inspector window.

4 Choose On from the Frame Controls pop-up menu.

Choosing On allows you to manually adjust all the attributes in the Frame Controls pane.

5 Make changes to any of the following controls in the Frame Controls pane. (See “About 
the Frame Controls Pane” on page 256 for details on each of the controls.)

Â Resize Filter
Â Output Fields
Â Deinterlace
Â Adaptive Details
Â Anti-alias
Â Details Level
Â Rate Conversion
Â Duration settings

6 Click Save to save the changes.
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Using Reverse Telecine
The Deinterlace pop-up menu includes a setting for reversing the telecine.

About Reverse Telecine
The most common approach to distributing film’s 24 fps among NTSC video’s 29.97 fps 
is to perform a 3:2 pull-down (also known as a 2:3:2:3 pull-down). If you alternate 
recording two fields of one film frame and then three fields of the next, the 24 frames 
in 1 second of film end up filling the 30 frames in 1 second of video.

As shown above, the 3:2 pattern (actually a 2:3:2:3 pattern since frame A is recorded to 
two fields followed by frame B recorded to three fields) repeats after four film frames. 
Virtually all high-end commercials, movies, and non-live television shows use this 
process prior to being broadcast.

For editing and effects purposes, it is often desirable to remove the extra fields and 
restore the video to its original 23.98 fps rate. An additional benefit of restoring the 
original 23.98 fps rate is that it is easier to convert this to the PAL 25 fps rate. 
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The lower frame rate also has the advantage of requiring fewer frames per second of 
video, leading to smaller file sizes. The reverse telecine feature makes it easy to do this.

About the Cadence
When film is telecined to NTSC video, it has a constant cadence. This means that the 3:2 
pattern is consistent and uninterrupted. It is relatively easy to remove the telecine from 
a constant cadence clip since you only have to determine the pattern once.

If you take these telecined clips and edit them as NTSC video, the result will be a final 
video file that has a broken cadence with an inconsistent 3:2 pattern. It is much more 
difficult to remove the telecine from this clip since you have to constantly verify the 
cadence to make sure you don’t inadvertently choose incorrect fields when creating 
the 23.98 fps video.

The Reverse Telecine feature included with Compressor automatically detects broken 
cadences and adjusts its processing as needed.

Other Reverse Telecine Issues
There are a few other issues to be aware of when you use the Reverse Telecine feature.

All Other Frame Controls Settings Are Disabled
Since the goal of the Reverse Telecine feature is progressive 23.98 fps video, all of the 
other options of the Frame Controls pane are disabled when Reverse Telecine is selected.

About Reverse Telecine and Segmented Encoding
Because of the unpredictable nature of the processing when reversing the telecine, 
segmented encoding does not work as efficiently as it does when reverse telecine is 
not being used. 
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About Pausing the Transcode Process
If you pause the transcode process, the transcode must start from the beginning when 
you restart it.

Creating PAL Video During the Reverse Telecine Process
It is a common practice to convert 23.98 fps or 24 fps video to PAL’s 25 fps rate by 
speeding up the playback by 4 percent. If you are starting with NTSC 29.97 fps video 
from a telecine, you can convert it to PAL video using two jobs.
Â First job:  Apply a setting to the job that performs the reverse telecine process and 

results in an NTSC frame size at 23.98 fps.

Note:  You could apply a setting that also converts the video to PAL; however, the 
format conversion will not be done using Frame Controls, and may not be of suitable 
quality.

Â Second job:  Create the second job by having the first job selected and choosing 
Job > New Job With Target Output. This creates a job that is chained to the output of 
the first job. You can now apply a setting that sets the output format to PAL and use 
the Frame Controls feature to ensure a high-quality output file.

See “About Adding and Copying Jobs” on page 110 for more information about 
chaining jobs.

Using the Retiming Controls
The retiming controls have two common usages:
Â Converting video from one frame rate to another:  This typically involves converting 

NTSC to PAL frame rates or PAL to NTSC frame rates. This function uses only the setting 
of the Rate Conversion pop-up menu and is automatically configured when necessary.

Â Converting video to a new speed:  This can be a matter of playing the existing frames 
at a different rate or, in the case of slow-motion effects, it can require generating 
intermediate frames.

In all cases, if the source media file contains audio, the audio also has its speed changed, 
with the audio pitch corrected so that it sounds the same as the original, just at a 
different speed. This ensures that you will maintain sync between the video and audio.

Note:  If you preview a setting that uses retiming controls, the video will play at its new 
frame rate or speed, but it will not have been processed by Frame Controls and will be 
of a lower quality than the actual transcoded output file will be. The audio is pitch 
corrected when previewing the setting.

Important:  If you are using retiming controls on a setting using the QuickTime Movie 
output format and choose Pass-through for the audio setting, the audio does not have 
its speed changed and will not maintain sync with the video. See “About the QuickTime 
Movie Encoder Pane” on page 224 for more information.
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Converting Video to a New Speed
The retiming controls give you three options for determining the playback speed.

Â Entering a percentage
Â Entering a duration
Â Forcing the frames to play at the Encoder pane’s Frame Rate setting

Entering a Percentage
You have two options when using the percentage method to determine the clip’s duration:
Â Entering a percentage value
Â Choosing a preset value

The presets that you choose from are intended to be used for specific situations.

Â 24 @ 25:  Use this setting when you have 24 fps video that you want to convert to 25 
fps for PAL distribution.

Â 23.98 @ 24:  Use this setting when you have 23.98 fps video and want to convert it to 
24 fps.

Â 23.98 @ 25:  Use this setting when you have 23.98 fps video and want to convert it to 
25 fps for PAL distribution.

Â 30 @ 29.97:  Use this setting when you have 30 fps video and want to convert it to 
29.97 fps.

Â 29.97 @ 30:  Use this setting when you have 29.97 fps video and want to convert it to 
30 fps.

Â 24 @ 23.98:  Use this setting when you have 24 fps video and want to convert it to 
23.98 fps for NTSC DVD distribution.

With all these options, no intermediate video frames are required—the existing frames 
are just set to play back faster or slower.
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Entering a Duration
The duration field shows the clip’s current duration. As you change the duration, the 
percentage value changes to reflect that change. 

This option is most useful when you have a source media file whose duration is a bit 
longer or shorter than it needs to be, and you’d rather change its playback speed than 
add or remove video frames.

With this method, intermediate video frames are created as needed.

Forcing Frames to Play at the Encoder Pane’s Frame Rate Setting
This option is used when your source media file uses a frame rate different from the 
Encoder pane’s Frame Rate setting.
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21 Adding Geometry Settings

You can make advanced adjustments to your settings with 
the Geometry pane of the Inspector window. 

This chapter contains the following sections:

Â Working with Cropping, Scaling, and Padding (p. 267)
Â About the Geometry Pane (p. 269)
Â Making Geometry Adjustments to a Setting (p. 274)

Working with Cropping, Scaling, and Padding
The Geometry pane provides three different methods you can use to affect the 
output image.

Cropping
When you crop an image, you are removing video content. Often that content is 
unnecessary image area (such as the overscan area, which is necessary for television, 
but not for computers) to make what’s left seem bigger in the same frame size.

Cropping also includes an automatic setting that detects image edges and 
automatically enters crop values to match them. This is especially useful if you want to 
crop out the letterbox area of a source media file. 
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When you adjust the crop settings, one of two things happens to the output video file’s 
frame size:
Â The frame size remains the same if you have chosen anything other than the 100% of 

source, 50% of source, and 25% of source settings in the Frame Size pop-up menu of 
the Dimensions section of the Geometry pane. This means that the source video 
image is scaled larger to fill the output video file’s frame size, which results in larger 
pixels and overall image degradation. 

Â The frame size reduces by the crop amounts if you have chosen the 100% of source, 
50% of source, or 25% of source settings in the Frame Size pop-up menu of the 
Dimensions section of the Geometry pane. This can result in nonstandard frame sizes.

The cropping settings are in the “Source inset (Cropping)” section of the Geometry pane.

Scaling
Scaling provides a way to alter the output video file’s frame size without removing any 
of the source image. Most often, scaling involves shrinking your output media image 
size to save storage space or reduce the bit rate. 

There are three basic methods you can use to scale your output image size:
Â Choose a percentage of the source size:  There are three settings that scale the source 

image based on a percentage (100% of source, 50% of source, and 25% of source). In 
addition to the source image frame size, crop values will affect the actual frame size 
of the output video.

Â Choose a specific frame size:  There are several standard frame size settings you can 
choose from, such as 720x486, 720x576, and so on. When you choose any of these, 
the output video file’s frame size will match this setting. 

Â Enter a custom value:  You can enter a custom frame size. Additionally, you can have the 
custom frame size constrained to a common aspect ratio such as 4:3 or 16:9. When you 
enter a custom frame size, the output video file’s frame size will match this setting.

You are also able to define the output image’s pixel aspect ratio by choosing from a 
pop-up menu with the common settings. 

Note:  The scaling settings are only active when using the MPEG-4, QuickTime Movie, 
and Image Sequence output encoding formats.

The scaling settings are in the “Dimensions (encoded pixels)” section of the Geometry pane.
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Padding
Padding provides a method to scale the image to a smaller size while retaining the 
output image’s frame size by filling the padded areas with black. Unlike cropping, 
padding does not remove any of the source image—the image is reduced by scaling 
by the padding amounts.

Padding is useful when the source image frame size is smaller than the output image 
frame size and you want to prevent the source image from being scaled to the output 
image size. By adding the correct amount of padding, the source image will remain the 
same size in the output image, with black filling the rest of the image frame.

Padding is automatically applied when the source video image is uncompressed NTSC 
720x486 and the output image is 720x480.

There are also several common padding settings you can choose from, such as 16x9 
and Panavision. These make it easy to have Compressor automatically enter padding 
values to ensure the source image retains its original aspect ratio.

The padding settings are in the “Output image inset (padding)” section of the 
Geometry pane. 

About the Geometry Pane
You use the Geometry pane to choose cropping and sizing settings, output media file 
sizes, and the aspect ratio (the ratio between image frame width and height):

Scaling

Cropping

Padding
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Source Inset (Cropping) Settings
Â Left, Right, Top, and Bottom:  The four cropping fields (Left, Top, Right, and Bottom) 

allow you to crop the frame of your source media file in pixel increments. Most 
broadcast video files have overscan areas. If the output file will be shown exclusively 
on a computer screen rather than on a television screen, you can safely remove some 
edging from your file without impacting the picture area. The numbers give the 
distance (in pixels) between the edge of the original frame and the resulting cropped 
frame. All fields default to 0.

Note:  The regular (“action safe”) overscan area is the outer 5 percent of the image on 
all four sides. Cut in an additional 5 percent and you have the more conservative 
“title safe” area. So you can safely crop anywhere between 5 and 10 percent of your 
outer frame area and still preserve the essential material.

Â Automatically detect crop settings for letterbox checkbox:  This checkbox allows 
Compressor to detect whether the source media file has been letterboxed, and if it 
has, to enter crop values to remove the letterbox.

Note:  If you want to transcode a normal size standard definition (SD) source media 
file (720 x 486) using an MPEG-2 NTSC setting, your output media file will be 
automatically cropped (two pixels from the top and four from the bottom) to achieve 
the MPEG-2 required dimensions of 720 x 480, unless you already specified cropping 
attributes. This crop attribute is only temporary and is not saved in the setting. You 
can see the automatic crop in the usual way, by double-clicking the setting in the job 
to open the Preview window.

See “About the MPEG-2 Encoder Pane” on page 184 for more information about the 
Video Format pop-up menu.
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Dimensions (Encoded Pixels) Settings
The settings in the Dimensions section are only active when using the MPEG- 4, QuickTime 
Movie, and Image Sequence output encoding formats. For other formats, the settings are 
dimmed but show the settings that will be used when the batch is submitted.
Â Frame Size:  These text fields and associated pop-up menus allow you to customize 

the frame size and aspect ratio of your output media file. Choose from one of the 
following:100% of source, 50% of source, 25% of source, 320 x 240, 640 x 480, 720 x 
480, 720 x 486, 1280 x 720, 1920 x 1080, or Custom (a manually created setting). Three 
custom settings constrained to particular aspect ratios are also available: Custom 
(4:3), Custom (16:9), and Custom (2.35:1). With the custom options, you enter 
whichever dimensions suit your needs in the Width and Height fields. In the 
constrained custom cases, you enter a value in either the Width or the Height field, 
and the other value is entered automatically.

The relevant output size dimensions are automatically entered in the Width and 
Height fields based on the choices you make in the pop-up menus. 



272 Chapter 21    Adding Geometry Settings

 

Â Pixel Aspect pop-up menu:  Use this pop-up menu to set the pixel aspect ratio of the 
output media file. This forces the pixel aspect ratios to conform to specific formats. 
This is especially important when using some filters. For example, if the graphic you 
use for the Watermark filter uses a circle and you want to be sure it still looks like a 
circle when finished (as opposed to an oval), you must choose the “Pixel aspect” 
setting that matches your output format. Options include:

Â Default:  The pixel aspect ratio is set to the commonly assumed value for the 
setting’s width and height. For example, the default for 720 x 480 or 720 x 486 is 
NTSC CCIR 601/DV NTSC.

Â Square:  Use this when the output is to be displayed on computers.
Â NTSC CCIR 601/DV:  Forces the pixel aspect ratio to 4:3 using 720 x 480 pixels.
Â NTSC CCIR 601/DV (Anamorphic):  Forces the pixel aspect ratio to 16:9 using 

720 x 480 pixels. 
Â PAL CCIR 601:  Forces the pixel aspect ratio to 4:3 using 720 x 576 pixels.
Â PAL CCIR 601 (Anamorphic):  Forces the pixel aspect ratio to 16:9 using 720 x 576 pixels.
Â DVCPRO HD 720p60 (16:9):  Forces the pixel aspect ratio to 16:9 using 1280 x 720 pixels.
Â DVCPRO HD 1080i60 (16:9):  Forces the pixel aspect ratio to 16:9 using 

1920 x 1080 pixels.
Â HDV 1080i (16:9):  Forces the pixel aspect ratio to 16:9 using 1440 x 1080 pixels.
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Output Image Inset (Padding)
Â Padding:  Use this pop-up menu to choose a preset padding configuration or the 

Custom setting, which allows you to manually enter values in the Left, Right, Top, and 
Bottom fields. The preset configurations include 4x3 1.33:1, 16x9 1.78:1, Panavision 
2.35:1, Europe Standard 1.66:1, UK Standard 1.75:1, and Academy 1.85:1.

Â Left, Right, Top, and Bottom:  Use these fields to add pixels of image “padding” around 
the sides of a frame. This is the opposite of cropping. In cases where the frame size of 
the output media file differ from those of the source media file, you may wish to pad 
an image rather than scale it. 



Making Geometry Adjustments to a Setting
You use the Geometry pane in the Inspector window to crop, scale, and change the 
frame aspect ratio in a setting.

To add cropping, frame sizing, and aspect ratio settings to your setting:
1 Open the Settings tab.

2 Select the setting in the Settings tab that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Click the Geometry tab in the Inspector.



Chapter 21    Adding Geometry Settings 275

 

4 Enter your source inset (cropping) settings, choose output size dimensions from the Frame 
Size pop-up menu, and choose padding settings from the output image inset section.

You can see all changes you make to your setting by viewing the Summary table in the 
Summary pane.

Note:  There are two ways to adjust frame size. You can either enter numbers in the 
cropping fields or drag the red frame bars in the Preview window. Using the latter 
method, the resulting numbers dynamically appear in the cropping fields so that you can 
see a numerical representation of your frame cropping. Hold down the Shift key to 
constrain the crop to either the source aspect ratio, the source height, or the source width.

See “About the Geometry Pane” on page 269 or “Previewing a Clip” on page 289 for 
more details.

If you select a batch’s target, 
any resizing in the Preview 
window is reflected in the 
Geometry pane. You can also 
directly enter numbers into 
these cropping fields.

Drag the red frame bars
(by the handles) to adjust
the output file frame size.
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22 Adding Actions to a Setting

You can make advanced adjustments to your settings 
with the Actions pane of the Inspector window. 

This chapter contains the following sections:

Â Working with Post-Transcoding Actions (p. 277)
Â Adding Actions (p. 279)
Â Triggering AppleScript Droplets (p. 280)

Working with Post-Transcoding Actions
Compressor can send an email to one recipient per preset, giving notice of when a 
transcode is complete. You can also add one AppleScript script per preset. This gives 
you some post-transcoding options for your output media file, such as creating a script 
in AppleScript for adding metadata to a QuickTime file, or automatically transferring 
the transcoded file to a streaming web server, or creating a watched folder and having 
the transcoding process start automatically whenever new source media files are 
dropped into the folder. 

Note:  You need to have your Internet preferences set up with an outgoing mail 
server for email notification. This option is not available for mail services that require 
SMTP authentication.
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About the Actions Pane
You use the Actions pane in the Inspector to set options related to transcode 
completion notification emails and post-transcoding AppleScript options. 

The Actions pane contains the following items:
Â Email Notification to:  If you want to be notified when a particular transcoding job has 

been completed, select this box and enter the appropriate email address in the text 
field. (You can only enter one email address.) This is useful if you are transcoding an 
especially large source media file that may take many hours to complete. Rather than 
continuously checking to see if the transcoding is finished, you just wait until you 
receive an email.

Note:  To enable this email feature, you must first enter an email address and 
outgoing mail server in Compressor Preferences. (Choose Compressor > Preferences.)

Â Execute AppleScript on output:  Select this box to activate a chosen script. Even if you 
have chosen a script, it will not run unless you have selected this box.

Â Choose button:  Click this button to select an existing script that you want to assign to 
the output file. Adding a script is a useful way of applying post-transcoding actions 
to your job, such as adding metadata to QuickTime files or adding interactive 
QuickTime elements. 

Choose button

Email notification
checkbox
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Adding Actions
You use the Actions pane in the Inspector window to set post-transcoding options for 
your output media file, such as sending an email, adding metadata to QuickTime files, 
or transferring the transcoded file to a streaming web server or to DVD Studio Pro. 

To add an email notification to your setting:
1 Open the Settings tab.

2 Select the setting in the Settings tab that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Click the Actions tab in the Inspector.

4 Select the “Email Notification to” checkbox and enter the relevant email address in the 
accompanying field.

Note:  To enable this email feature, you must first enter an email address and outgoing 
mail server in Compressor Preferences. (Choose Compressor > Preferences.)

To add a script to your setting:
1 Open the Settings tab.

2 Select the setting in the Settings tab that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Click the Actions tab in the Inspector.

4 Click the Choose button.

The File Selection dialog appears.



280 Chapter 22    Adding Actions to a Setting

 

5 Navigate to the relevant AppleScript file and click Open.

The path to the AppleScript file appears below the Choose button. Make sure the 
checkbox is selected; otherwise, the script won’t be applied to the setting.

See “About the Actions Pane” on page 278 for more details.

Triggering AppleScript Droplets
Follow these steps to ensure that your script will successfully process Compressor 
output media files.

To create an AppleScript Droplet application to process files created by Compressor:
1 In Script Editor, Choose File > Save As.

2 In the Save Dialog:

a Choose Application from the File Format pop-up menu.
b Disable the Run Only, Startup Screen, and Stay Open options.
c Click Save.

The script is saved as a script application. Because the script contains an “on open” 
handler, the script application is saved as an application Droplet, indicated by the arrow 
in the script application's icon.
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To automatically trigger an AppleScript Droplet after compressing files:
1

 

In Compressor, assign a preset to an Imported file in the Batch window.

 

2

 

In the Batch window, select the preset, then choose Window > Show Inspector (or 
press Command-Option-I).

 

3

 

In the Inspector window, click the Actions tab.

 

4

 

Enable the “Execute AppleScript on output” option, then choose an AppleScript 
Droplet application.

 

More AppleScript Information

 

You can find more information about writing scripts to use with Compressor at the 
following websites:
Â

 

Apple Developers:

 

  http://developer.apple.com/applescript
Â

 

General Apple Customers:

 

  http://macscripter.net

http://developer.apple.com/applescript
http://macscripter.net
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23 Using the Preview Window

The Preview window has two main roles. You can use it to 
play your source media file in its original format, or you can 
preview your source media file with whichever settings have 
been assigned to it.

This chapter contains the following:
Â About the Preview Window (p. 284)
Â Previewing a Clip (p. 289)
Â Transcoding a Portion of the Clip with the Preview Window (p. 295)
Â Adding Markers to a Clip (p. 297)
Â Preview Window Keyboard Shortcuts (p. 303)

When you use the Preview window to compare the original version of the clip with the 
version that will be output, you can make and view real-time changes. This comparison 
lets you check the effects of settings on your file before spending time and resources 
transcoding it. Do this to check the quality of the output media file.

Scaled, cropped, and 
filtered version of the clipOriginal version

of the clip
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You can also use the Preview window to enlarge the Preview screen size, manually add 
I-frames (MPEG-1 and MPEG-2 only), and designate a portion of your media file for 
transcoding using the In and Out markers. 

About the Preview Window
The Preview window allows you to play batch items before submitting them for 
transcoding, and allows you to compare versions of your clip to ensure that the quality 
of the output media file is acceptable. 

The Preview window contains the following items:

Â Preview scale selection:  Adjusts the Preview screen size. The three settings are 100%, 
75%, and 50%, but you can also drag the Preview window handle to any size you like.

Â Source/Setting selection:  Use these buttons to preview the selected batch item using 
either the source’s aspect and size or the output’s aspect and size. The Source View 
button also provides a cropping boundary that you can use to define one or more 
edges to be cropped. The Output View button shows the cropped version of the 
media scaled to its aspect and size setting. 

Â Source/Output information:  The clip’s frame size and frame rate are shown in the 
lower-left corner of the Preview window. The clip’s duration (from the In point to the 
Out point) is shown in the lower-right corner. With the Source View button selected, 
the frame size and frame rate represent the source media clip. With the Output View 
button selected, the frame size and frame rate represent the setting for this batch item.

Note:  To see the total duration of the clip (without In and Out points), select the source 
file in the Batch window and open the Inspector window (Window > Show Inspector).

In and Out controls

Preview scale selection

Source/Setting selection

Preview screen area

Batch item
selection controls

Timeline controls Marker pop-up menu

Source/Output 
information

Transport controls
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Batch item selection control area
You can use the batch item selection area to choose specific items from the Batch 
window to show in the Preview window.

Â Batch item selection buttons:  Use these buttons to click backward or forward through 
the list of source media files and clips with settings available for previewing. As you 
click through the list, the selected batch item appears in the batch item pop-up menu.

Â Batch item pop-up menu:  Choose the source media file you want to preview from this 
pop-up menu, with or without its assigned settings.

In and Out controls
Once you have selected the batch item, the In and Out controls can be used to see and 
adjust the In and Out point timecode information.

Â In and Out timecode fields:  The exact locations of the In and Out points are displayed 
here using the standard timecode format of hh:mm:ss:ff. You can manually edit these 
fields by selecting the field and entering new values. If a new value is entered, the 
timeline’s relevant In or Out point moves to the specified point in the current batch item.

Note:  If your source media file has a timecode track with a specific timecode, the 
Start and End timecode of the clip will appear in both the In and Out timecode fields. 
For everything else, the timecode will start with 00:00:00:00.

Â In and Out point buttons:  Drag the In point (right-pointing arrow) or Out point (left-
pointing arrow) buttons in the timeline to set a new In or Out point. You can also use 
the Set In and Set Out buttons (next to the timecode fields) to set In and Out points.

Batch Item
selection buttons

Batch Item 
pop-up menu

Sets In point to current
playhead position.

Sets Out point to current 
playhead position.

In point timecode Out point timecode
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Preview screen area
The Preview screen area displays the currently selected batch item. The Preview screen 
also contains the following items:

Â Split screen slider:  Drag the split screen slider any distance across the top of the 
Preview screen to get a comparison view between the source media file (left side) 
and output media file (right side). In addition to the location of the slider at the top, 
the screen division is indicated by a vertical white line bisecting the image.

Â Cropping boundary:  The cropping boundary is only available in Source view. Use the 
handles to drag the red boundary edges and corners in the direction you want to 
crop your output media file. Use the center handle to drag the entire frame in any 
direction while still maintaining its dimensions. The new values (for left, top, right, 
and bottom) appear dynamically in the Preview screen as you crop the frame. If you 
also have the Inspector window open with the batch’s target selected, you can see 
the same values changing in the cropping fields of the Geometry pane. Select the 
Output view to show the results of the crop boundary settings.

Cropping boundary

Cropping dimensions (also 
seen in Source Inset fields 
in the Geometry pane)

Cropping handle for the 
lower-right corner

Split screen slider
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Timeline controls
The timeline controls provide information about the clip, including any markers it has 
and the current In and Out point settings. You can also use the timeline to position the 
playhead to a specific frame and set the In and Out points.

Â Playhead timecode:  Shows the timecode of the playhead’s position in the timeline 
using the standard timecode format of hh:mm:ss:ff. You can enter a new value to 
precisely position the playhead along the timeline.

Note:  If your source media file has a timecode track with a specific timecode, the 
timecode of the clip will appear in the playback timecode field. For everything else, 
the timecode will start with 00:00:00:00.

Â In and Out points:  Use these if you want to transcode only a section of your source 
media file, rather than the whole thing. Drag the points to indicate the Start and End 
points within the source media file that you want to transcode. The In and Out 
timecode fields at the bottom of the Preview window update as you drag these 
points. (You can also click the Set In Point or Set Out Point buttons to set the points 
to wherever the playhead is currently positioned.)
In and Out points are not preserved after a transcode has been completed, so if you 
want to resubmit a batch from the History table, you need to reapply these points to 
your clip. In and Out points are assigned to the source media file rather than the 
setting, so whatever In and Out points you create will be the same for all other 
settings related to that source media file in the current batch.

Â Playhead:  Gives you a visual indication of where the displayed frame is located 
within the clip. You can drag the playhead to navigate quickly to a specific location 
within the clip.

Â Marker:  Gives you a visual indication of where a marker has been placed in the clip. 
The color of the marker indicates its type:
Â Blue:  Compression markers (These are compression markers that you add manually.)
Â Purple:  Chapter or Podcast markers (These are named markers that are intended to 

be navigational chapter stops or visual artwork in the output media file.)
Â Green:  Edit/cut markers (These are compression markers that are added 

automatically at edit points in the Final Cut Pro sequence.)
See “Adding Markers to a Clip” on page 297 for more information.

Playhead timecode

Playhead

Marker

In point Out point
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Transport controls
These move the playhead backward or forward to the exact position of the next marker 
or In and Out point, making it easy to navigate quickly between existing markers. You 
can also use these buttons to quickly move the playhead to the start or end of the clip.

Â Play/Pause button:  Starts or stops playback of the clip. If you stop playback, the playhead 
remains at its current position. To return to the start of the clip, you need to drag the 
playhead back to the beginning or click the “move to previous marker” control.

Â Move to previous or next marker button:  Moves the playhead to the previous or next 
marker, or to the start or end of the clip if no more markers are present.

Â Fast Backward and Fast Forward buttons:  Allow you to play your clip in either 
direction at twice the normal speed. Hold down a button to continue scanning in 
either direction.

Â Playback Loop button:  Click to play the media in a continuous loop.

Marker pop-up menu
Use the Marker pop-up menu to manage the clip’s markers. While you can use markers 
with all settings, they actually only affect the output file when the setting uses the 
MPEG-1, MPEG-2, MPEG-4 when configured for podcasting, H.264 for DVD Studio Pro, 
H.264 for Apple Devices, or QuickTime Movie output file formats. See “Adding Markers 
to a Clip” on page 297 for more information.

Move to
previous marker

Play/Pause

Fast Backward

Move to 
next marker

Fast Forward

Playback Loop button
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Â Import Chapter List:  Opens a file import dialog that allows you to import a file 
containing a list of chapter marker times for the source media file. See “Adding 
Chapter or Podcast Markers to a Clip” on page 300 for more information.

Â Add/Remove marker:  Actual state depends on whether the playhead is positioned on 
a marker or not. 
Â When not positioned on a marker, says “Add marker.” Choosing “Add marker” places 

a new marker on the timeline at the playhead’s current position.
Â When positioned on a marker, says “Remove marker.” Choosing “Remove marker” 

deletes the current marker.
Â Edit:  Only available when the playhead is positioned on a marker. Choosing Edit 

opens a dialog for configuring the marker. The dialog allows you to set the marker 
type and assign a URL and an image to it. See “Adding Chapter or Podcast Markers to 
a Clip” on page 300 for more information.

Â Show Chapter/Podcast Markers:  Controls whether chapter and podcast markers (those 
with names) are shown in the timeline. A checkmark indicates they are shown.

Â Show Compression Markers:  Controls whether compression markers (those without 
names) are shown in the timeline. A checkmark indicates they are shown.

Â Show Edit/Cut Markers:  Controls whether markers automatically placed at each edit 
point by another application, such as Final Cut Pro, are shown in the timeline. A 
checkmark indicates they are shown. 

Previewing a Clip
You can preview either the original source media file or the file with a setting applied 
to it. Source media files appear in the list as their filenames. Any settings that have 
been applied to the source media file are listed immediately below the file’s name, and 
are indented to make it easier to identify them. Whether you choose to view the 
original source media file or the source media file with a setting determines which 
options you see in the Preview window.

Important:  Settings you make in the Encoder pane and the Frame Controls pane 
cannot be previewed. Only the settings made in the Filters pane and Geometry pane 
can be previewed. See “Transcoding a Portion of the Clip with the Preview Window” on 
page 295 for an alternative method to “preview” Encoder pane and Frame Controls 
pane settings.
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To preview a source media file:
1 Open the Preview window.

Note:  You can open your file into the Preview window in one step, by double-clicking 
the source media file in its job in the Batch window. 

2 Do one of the following:

Â Choose a source media file from the Batch Item pop-up menu (identified by its filename).

Â Click the Batch Item selection buttons until the source media file appears in the 
pop-up menu.

Â Select the source media file in its job in the Batch window.
Only the Source View button is active (and the Output View button is dimmed). This is 
because you selected a regular source media file, so you can only see the 
unadulterated clip—without the split screen divider or cropping bars.

3 Choose a Preview screen size from the Preview Scale pop-up menu, or drag the 
Preview window handle to a size you like. 

This does not affect the display frame size of the actual output media file. That can only 
be set from the Geometry pane in the Inspector window.

4 Click the Play button to preview the selected source media file.

Source media files with markers already added, such as files from Final Cut Pro, will 
show the markers in the timeline. You can manage the markers if needed. See “Adding 
Markers to a Clip” on page 297 for more information.

A setting applied to 
the source media file 
“Nancy at table CU 5.” 
The checkmark indicates 
that this is currently 
being viewed in the 
Preview window.

The original
source media file

“Nancy at table CU 5.”

Selects the default
color bars image.
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To preview a clip with an assigned setting:
1 Open the Preview window.

Note:  You can open the clip into the Preview window in one step, by double-clicking 
the target (that contains the setting) of a job in Batch window. 

2 Do one of the following:

Â Choose a setting from the Batch Item pop-up menu (the indented setting names, not 
the source filenames).

Â Click the Batch Item selection buttons until the clip with a setting appears in the 
pop-up menu.

Â Select the clip’s setting in its job in the Batch window.
Both Source and Setting (Output) View buttons are active so you can switch between 
these two views. Because you selected a setting, you can use the split screen slider and 
cropping boundary in the Preview window. 

3 Click the Setting view button in the upper-right corner of the Preview window.

4 Choose a Preview screen size from the Preview Scale pop-up menu, or drag the 
Preview window handle to a size you like.

This does not affect the display frame size of the actual output media file. That can only 
be set from the Geometry pane in the Inspector window.

Note:  When you adjust the frame size of a setting (in the Geometry pane) while you 
are viewing it in the Preview window, the frame size may not resize accordingly. If this 
occurs, select Sample Movie or a different target from the batch item pop-up menu 
and then select this target again and it will display the correct frame size.

5 Drag the split screen slider left or right across the top of the screen to move the split 
screen divider over more or less of the transcoded portion of the clip. 
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6 Use the cropping boundary to adjust the display frame size of your output media file. 

7 Check the results of your cropping by clicking the Source and Setting View buttons. 

Note:  The more you reduce the clip image by cropping it, the larger the scale factor of 
the output image will be (as the framing geometry conforms to the settings of the 
output size ratio rather than to the source file settings). This effect is similar to zooming 
in on an image, which results in larger pixels and overall image degradation. So make 
sure that you don’t crop in so far that the image is enlarged past its original size relative 
to the original size of the frame.

 

Cropping boundary 
and handles

Split screen slider

Split screen divider

Cropping dimensions (also 
seen in Source Inset fields 
in the Geometry pane)

Source and Setting 
View buttons

Batch item 
pop-up menu

Source and Setting 
View buttons
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8 Select the filter that you want to adjust and make changes as necessary. 

Note:  The filter you select must have a checkmark next to it in the Filters list. 
Otherwise, the filter won’t be applied to the setting.

 

Setting selection

Selected filter
settings seen in the

Preview window
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9 If you want to make the display frame size of your output media file different from that 
of your source media file, open the Geometry pane in the Inspector window and 
choose a pre-existing value from the “Frame size” pop-up menu or enter different 
output size values in the relevant fields. 

Note:  MPEG-2 is limited to preestablished display frame sizes based on MPEG-2 
specifications. In this instance, all output size items are unavailable.

 

10 Click the Play button in the Preview window to view the clip.

See “About the Preview Window” on page 284 for more information about these settings.

Cropping 
dimensions (also 
displayed in the 
Inspector window 
when cropping 
bars are dragged)
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Transcoding a Portion of the Clip with the Preview Window
Although Geometry (cropping and scaling) and Filters adjustments are displayed 
instantly in the Preview window, Encoding pane and Frame Controls pane settings are 
not. To preview Encoder pane and Frame Controls pane settings, do a test transcode of 
a small section of your source media file.

You can use the Preview window to set In and Out points to transcode only a portion 
of your media file rather than transcoding the whole thing. 

Playing Dolby Digital Professional (AC-3) Files in the Preview Window
You can use the Preview window to play back Dolby Digital Professional (AC-3) files. 
Compressor includes a Dolby Digital decoder so that when you add an AC-3 source 
media file to a batch and play it, you are able to hear it using your computer’s current 
speakers. This includes everything from the built-in stereo speakers, which play a 
mixed-down version of the AC-3 file if it contains more than two channels, to a set of 
external surround speakers connected to a USB or FireWire output.

Important:  Since Compressor is decoding the Dolby Digital audio file, you cannot use 
the your computer’s optical output to preview Dolby Digital audio.

This feature is important if you are using the Dolby Digital Professional encoder since 
you cannot preview the encoder’s settings in real time in the Preview window. 
Instead, you can add the encoded AC-3 files to a batch and play them to verify that 
the encoder’s settings produced good results. See “Transcoding a Portion of the Clip 
with the Preview Window” on page 295 for information on creating a short test clip 
for this purpose.
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To designate a portion of your media file for transcoding:
1 Open the Preview window.

2 Choose a clip from the Batch Item pop-up menu or click the Batch Item selection 
buttons until the clip appears in the pop-up menu.

3 Do one of the following:

Â Drag the In point to the appropriate location. 
Â Drag the playhead to where you want transcoding to begin and click the 

Set In Point button.

4 Do one of the following:

Â Drag the Out point to the appropriate location. 
Â Drag the playhead to where you want transcoding to end and click the 

Set Out Point button.

The only segment of the media file that will be transcoded is between the two points 
that you set. The rest of the clip will not be transcoded.

Important:  When you use the markers to specify a segment of the source media file to 
transcode, they apply to all targets assigned to the file’s job. You can add a source 
media file multiple times to a batch, creating multiple jobs, and set the In and Out 
points differently in each job.

Playhead

Out pointIn point

Set In Point button Set Out Point button
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Adding Markers to a Clip
Compressor can import and create several different kinds of markers. In addition, 
Compressor can import entire lists of chapter markers.

Output File Formats That Support Markers
Not all output file formats support markers. Following is a list of those that do 
support them.
Â MPEG-2
Â MPEG-4 when configured for podcasting (audio-only with the “Allow Podcasting 

information” checkbox selected)
Â QuickTime Movies
Â H.264 for DVD Studio Pro
Â H.264 for Apple Devices

You can set and configure markers for other output file formats, but they will not be 
included in the encoded output file.

Types of Markers
Compressor can import and create the following types of markers:
Â Chapter markers:  Chapter markers allow easy access to index points throughout a 

DVD, QuickTime movie, or podcast. Compressor and DVD Studio Pro can both read 
chapter markers exported from Final Cut Pro. QuickTime Player can interpret any text 
track containing time stamps as a chapter track. Chapter markers can also have 
artwork and a URL assigned to them that appear when playing a podcast.
These markers appear as purple in the Preview window timeline.

Â Podcast markers:  Like chapter markers, podcast markers can have artwork and a URL 
assigned to them. Podcast markers cannot be used to access frames within the clip 
though, and they do not appear as chapter markers in DVD Studio Pro or QuickTime.
You can use podcast markers to provide a slideshow (with URLs) for users to view 
when playing audio podcasts.

Â Compression markers:  Also known as manual compression markers—these are 
markers you can add to a Final Cut Pro sequence (or in the Compressor Preview 
window) to indicate when Compressor should generate an MPEG I-frame during 
compression. See “Understanding GOPs and Frame Types” on page 197 for more 
information on I-frames.
These markers appear as blue in the Preview window timeline, and are the type created 
when you manually add markers using Compressor. You can convert compression 
markers into chapter markers using the Edit item of the Markers pop-up menu.
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Â Edit/Cut markers:  Also known as automatic compression markers—these markers are 
automatically generated by Final Cut Pro at each cut or transition point in a 
sequence. During transcoding, Compressor uses Edit/Cut markers to generate MPEG 
I-frames at these points, improving compression quality.
These markers appear as green in the Preview window timeline. 

Note:  DVD Studio Pro ignores Edit/Cut markers because they can interfere with GOP 
alignment for multi-angle DVD video. For more information, see the documentation 
included with DVD Studio Pro.

Manually Adding and Removing Markers
The Preview window includes comprehensive marker support, including the ability to 
manage markers already added to the source media file, manually add or remove 
markers, and import chapter marker lists (described in “Adding Chapter or Podcast 
Markers to a Clip” on page 300).

To add a compression marker to your clip:
1 Open the Preview window.

2 Select the “Show Chapter/Podcast Markers” and “Show Compression Markers” items 
from the Marker pop-up menu.

3 Choose a clip from the Batch Item pop-up menu or click the Batch Item selection 
button until the clip you want appears in the pop-up menu.

Note:  Clips that already contain markers, such as those from Final Cut Pro, will show 
those markers in the timeline. You can edit those markers the same way you would if 
you had manually entered them.

4 Do one of the following to determine where the marker is to be placed:

Â Drag the playhead where you want to add a marker.
Â Enter a timecode value in the playhead timecode field.
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5 Do one of the following to add a marker:

Â Click the Marker button and choose “Add marker” from the pop-up menu.
Â Press M.
A blue marker appears in the timeline. 

 

Compression markers can be converted to chapter or podcast markers by using the 
Edit option of the Marker pop-up menu. See “Adding Chapter or Podcast Markers to a 
Clip” on page 300 for more information.

To remove a marker from your clip:
1 Click either the Move to Previous Marker or Move to Next Marker controls to move the 

playhead to the marker you want to remove. 

2 Do one of the following to remove the marker:

Â Click the Marker button and choose “Remove marker” from the pop-up menu.
Â Press M.

The marker disappears. 

A blue marker appears
under the playhead after

the marker is added.
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Adding Chapter or Podcast Markers to a Clip
To manually add a chapter or podcast marker to a clip, you first add a compression 
marker (as described in the previous section) and then you edit the marker.

Note:  A podcast can have both chapter and podcast markers. The only difference is 
that the viewer can navigate directly to a chapter marker but cannot navigate to a 
podcast marker. See “Types of Markers” on page 297 for more information.

To manually add a chapter or podcast marker to a clip:
1 Do one of the following to determine where the marker is to be placed:

Â Drag the playhead where you want to add a marker.
Â Enter a timecode value in the playhead timecode field.

2 Do one of the following to add a marker:

Â Click the Marker button and choose “Add marker” from the pop-up menu.
Â Press M.
A blue compression marker appears in the timeline.

3 Open the Markers pop-up menu and choose Edit (or press Command-E).

A dialog for editing the marker appears.

4 Choose Chapter or Podcast from the Type pop-up menu.

5 Enter a name for the marker in the Name field.

For chapter markers, this name appears in the output media file where it can be seen 
with QuickTime Player, in DVD Studio Pro (where it can be edited), and in playback 
devices. For podcast markers, this name does not appear to the viewer.
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6 Optionally, enter a URL in the URL field. 

This URL applies only to podcasts. The marker’s name appears over the artwork where 
the viewer can click it to open a web browser to the URL’s website.

7 Optionally, you can assign an image to the marker by choosing one of the following 
from the Image pop-up menu:

Â None:  No image is associated with the marker.
Â Frame in source:  You choose a frame from the source media file. The default image is 

the frame two seconds further than the frame the marker is at.
Â From File:  This opens a file selection dialog that you use to select a still image file to 

assign to the marker.

Note:  Images assigned to chapter markers are ignored by DVD Studio Pro.

8 Click OK to close the dialog.

The marker in the timeline changes to purple to indicate it is now a chapter or podcast 
marker. You can use the Previous Marker and Next Marker buttons to select other 
markers in the timeline to edit.

You also have the option of importing a chapter marker list. These lists can use either 
the QuickTime TeXML format (an XML-based format for constructing 3GPP-compliant 
timed text tracks in a QuickTime movie file), or the plain text chapter list files supported 
by DVD Studio Pro. See “Creating Plain Text Chapter Marker Lists,” next, for information.

To import a chapter marker list:
1 Open the Preview window.

2 Choose a clip from the Batch Item pop-up menu or click the Batch Item selection 
button until the clip you want appears in the pop-up menu.

3 Choose Import Chapter List from the Markers pop-up menu.

A file selection dialog opens so that you can locate and select the chapter marker file 
for that source media file. 

4 Select the chapter marker file and click Open.

The markers are imported and added to the Preview window timeline.

Note:  While all markers imported by using a chapter marker list are configured as 
chapter markers, you can use the marker edit dialog to change them to podcast or 
compression markers. Additionally, you can add URLs and artwork to them as needed.

Important:  The timecode values in the list must be based on the source media 
file’s timecode.



302 Chapter 23    Using the Preview Window

 

Creating Plain Text Chapter Marker Lists
You can create a list of timecode points that Compressor can import to create markers. 
The timecode values need to match the timecode of the track’s video clip. The list of 
timecode values must be a plain text file; you can create it with TextEdit (as long as you 
save the file as plain text). If you create the list with a more advanced word-processing 
application, be sure to save the file as a plain ASCII text file with no formatting. The file 
must follow these rules:

Â Each marker must be on a new line that starts with a timecode value in the 
“00:00:00:00” format. These values identify the marker positions.

Â After the timecode value, you can include a name for the marker. You can use a 
comma, space, or tab character to separate the timecode value from the marker name.

Â Any lines that do not begin with a timecode value are ignored. This makes it easy for 
you to add comments to the list.

Â The timecode values do not have to be listed in chronological order.
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Preview Window Keyboard Shortcuts

Key command Function

 
Starts fast reverse motion.

Starts fast forward motion.

Moves clip backward frame by frame.

Moves clip forward frame by frame.

Starts or stops clip playback.

Adds or removes a marker.

When the playhead is positioned on a marker, opens the Edit 
Marker dialog.

Sets an In point for the clip.

Sets an Out point for the clip.

J 

L 

space 

M 

E

l 

O 
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24 Creating and Changing 
Destinations

Compressor allows you to choose where to save your 
transcoded files.

This chapter contains the following:
Â About the Destinations Tab (p. 306)
Â Using the Inspector with Destinations (p. 307)
Â Creating a Destination (p. 308)
Â Warning Triangles (p. 311)
Â Deleting and Duplicating a Destination (p. 312)
Â Creating Destinations for Use with DVD Studio Pro (p. 314)

Without a selected destination, the output file is saved to the same folder as the source 
media file. This may be satisfactory for your needs, but if there are various remote 
uploading servers, or if you just want a specific type of output file to end up in a 
specific location, you must assign that destination. 

If you have a volume open on your desktop, it is treated the same as a local destination 
and allows you to save output media files directly, without the extra steps needed for 
remote destinations, such as specifying the host name and entering the user name and 
password. When you use the remote option for your destination, you can save to any 
folder under the User directory of that remote computer.

Once you have created all your necessary destinations, you won’t have to open the 
Destinations tab again, because you can select all destinations directly from the Batch 
window once they have been created.

Note:  Make sure that your output files have access and appropriate privileges to any 
remote destination you assign. 
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About the Destinations Tab
You use the Destinations tab together with the Inspector window to create, modify, or 
remove your destination settings and add file identifiers to your output media 
filename. The Destinations tab contains the following items:

Â Destinations list:  This lists destination names and pathnames.
There are four default destinations in the Apple folder:  Source is the same folder 
from which the source media file originated; Desktop is the user’s Desktop folder; 
User’s Movies Folder is the user’s Movies folder; Cluster Storage is a cluster’s scratch 
storage location.

Note:  Cluster Storage applies only to installations of Compressor that have 
distributed processing enabled. The distributed processing feature is limited to 
computers that have Final Cut Studio installed. 

Â Add ( + ):  To create a local or remote destination, click this button and choose either 
Local or Remote from the pop-up menu. 
Â If you choose Local, a file selection dialog appears in which you can select a 

destination folder. 
Â If you choose Remote, the Remote dialog appears. Enter FTP information concerning 

host name, file path, user, and password for accessing the remote location. You can 
also enter an iDisk location.

Â Duplicate button:  Makes a copy of the selected destination, placing it in the Custom 
folder. Using this option allows you to create a new destination from a pre-existing 
destination which you can then adjust according to your needs, rather than creating 
a new destination from scratch.

Default destinations

Custom destinations

Add button Remove button

Duplicate button
Filename Template 
pop-up menu

Sample filename line

Default filename 
identifiers
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Â Remove ( – ):  Removes a selected custom destination from the Destinations tab 
immediately. You are not asked for confirmation, so be sure you want to remove the 
destination before clicking this button.

Note:  You cannot remove the destinations from the Apple folder.

Using the Inspector with Destinations
When you double-click or select a destination in the Destinations tab, the Inspector 
window opens. It contains the following items:
Â Name:  Use this field to modify the name of the destination preset.
Â Template:  Use this pop-up menu to add file identifiers to your output media file. You 

can manually edit this field. Selecting any of the following file identifiers adds it to 
your output media filename:
Â Date:  Date the file was transcoded in the YYYY-MM-DD format
Â Setting Name:  Name of the setting used for the transcoding job
Â Source Media Name:  Source media filename without its extension
Â Source Media Extension:  Extension of the source media file

Â Sample From Defined Template:  Displays a sample of what the output filename will 
look like with any file identifiers you have added. You cannot edit the Sample line, 
but it changes dynamically based on the file identifiers you add or delete.

Â Path:  Displays the path to the destination folder.
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Creating a Destination
You use the Destinations tab with the Inspector window to create and assign a 
destination and to add file identifiers to your output file. If you want to save your 
output media files to a remote destination, you need to enter information into the 
Remote dialog so that Compressor can successfully access the remote server. 

You can create the following destinations:
Â Local:  Any directory on your own computer
Â Open Volume:  Any shared volume open on your desktop
Â Remote:  A directory in the default location of an FTP or iDisk server, if you have 

suitable access privileges and permissions

Note:  By default, the output media file destination is the same folder from which the 
source media files originated. You can change the default destination to any other 
Destination preset. Choose Compressor > Preferences and use the Default Destination 
pop-menu to choose from the list of Destination presets.

To create a local or open volume destination:
1 Open the Destinations tab.

2 Click the Add ( + ) button and choose Local from the pop-up menu.

The Destination Selection dialog appears.

3 Navigate to your chosen destination folder or open mounted volume, then click Open.

A new destination called Untitled Local-1 appears in the Custom folder of the 
Destinations tab along with the path to the folder you just assigned. 

4 Double-click the new destination in the Destinations tab.

The Inspector window opens, showing relevant information for the new destination.

5 Do either of the following in the Inspector:

Â Modify the name of the new destination in the Name field.
Â Modify the pathname of the new destination by clicking Choose to open the 

destination selection dialog and navigating to a new folder.

Choose Local from 
the pop-up menu.
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6 Add file identifiers to your output filename using the pop-up menu in the Template field. 

You can also manually edit this field by doing any of the following:
Â Drag the file identifiers to rearrange their order.
Â Click on either side of the file identifiers to type additional text.
Â Use the Delete key on your keyboard to remove any of the file identifiers.

The Sample From Defined Template field in the Inspector window shows a sample of 
the output filename with its chosen file identifiers. The default file identifier 
combination is “Source Media Name–Setting Name.”

Note:  Avoid customizing your filename templates with anything beginning with a 
period ( . ). The resulting file will only be visible via the command line and not visible 
using the Mac OS X Finder.

See “About the Destinations Tab” on page 306 for more details about these settings.

To create a remote destination:
1 Open the Destinations tab.

2 Click the Add ( + ) button and choose Remote from the pop-up menu.

The Remote dialog appears. It contains the following fields:

Filename Template 
pop-up menu

Host Name is required.

File Path is required.
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Â Name:  Use this field to modify the name of the destination preset.
Â Template:  Use this pop-up menu to add file identifiers to your output media file. You 

can manually edit this field. Selecting any of the following file identifiers adds it to 
your output media filename:
Â Date:  Date the file was transcoded in the YYYY-MM-DD format
Â Setting Name:  Name of the setting used for the transcoding job
Â Source Media Name:  Source media filename without its extension
Â Source Media Extension:  Extension of the source media file

Â Sample From Defined Template:  Displays a sample of what the output filename will 
look like with any file identifiers you have added. You cannot edit the Sample line, 
but it changes dynamically based on the file identifiers you add or delete.

Â ftp or iDisk:  Select the type of remote destination you want to create. 
Â Host Name:  (Required) Name of the host server. Compressor assumes that the URL 

scheme being used is ftp:, so you don’t need to enter this or any other URL scheme.
Â File Path:  (Required) Specifies the path on the host where the output media file will be 

stored. For example:  Volumes/Movies/OutputMedia. Only enter the path to the location 
where the output media file will be stored. You don’t need to include the filename.

Â User:  (Optional) This is only required if the host server has access restrictions 
requiring a user name and password. If anyone can access the host server, you can 
leave this field blank.

Â Password:  (Optional) This is only required if the host server has access restrictions 
requiring a user name and password. If anyone can access the host server, you can 
leave this field blank.

3 Enter information in the relevant fields, as necessary.

4 Click OK.

Once you have at least one destination in the Destinations tab other than Source, you 
can set a new default destination.

To change the default destination:
1 Choose Compressor > Preferences.

2 Use the Default Destination pop-up menu to choose from the list of existing 
destination presets.

The destination you choose appears as the default destination when you import a new 
source file in the Batch Window.
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Warning Triangles
When there is a problem with your destination, a yellow warning triangle appears. You 
must resolve this problem before you can successfully transcode. Warning triangles 
appear in the Destinations tab if the destination isn’t reachable or writable, and in the 
Batch window if:
Â There is already an identical file at that destination.
Â You have two destinations with the same name.
Â The destination isn’t reachable or writable.

The warning appears at whatever level the problem originated (preset, job, or batch), 
and propagates upward, so that if the problem occurs at the preset level, you see 
warning triangles next to the preset and job.

If you hold the pointer over the warning triangle for a few seconds, a tooltip displays 
information about the nature of the problem. As soon as you resolve the problem, the 
warning triangle disappears and you can continue to transcode. 

Click the warning 
triangle in the Batch 
window to see an 
explanation dialog.
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Deleting and Duplicating a Destination
You can manage destinations by deleting those you no longer need and creating new 
ones based on existing destinations.

To delete a destination:
1 Open the Destinations tab.

2 In the Destinations tab, select the destination you want to remove, then click the 
Remove ( – ) button, or press Delete.

Important:  There is no confirmation step in this process, so you need to be sure you 
want to remove the destination before clicking the button.

Remove button
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To duplicate a destination:
1 Open the Destinations tab.

2 In the Destinations tab, select the destination you want to copy, then click the 
Duplicate button. 

A new entry appears in the Destinations tab with Copy appended to its name. This 
destination is identical in all other ways. Rename the duplicate destination as appropriate.

Duplicate button

The duplicated
destination
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Creating Destinations for Use with DVD Studio Pro
When you are encoding video and audio files for use in DVD Studio Pro, you can make 
importing and using the files within DVD Studio Pro easier by creating a custom 
destination for them.

DVD Studio Pro includes the ability to automatically locate and, if applicable, import or 
use an audio file when you import or use a video file with the same root name. For 
example, if you assign a video file to a menu’s background, DVD Studio Pro looks for an 
audio file with the same name and automatically sets it as the menu’s audio.

The default Compressor destinations add the Setting name to the filename. Since 
different settings are required to output DVD compatible video and audio files, this 
results in the video and audio filenames never being the same—even if they are from 
the same source file.

When creating custom destinations in Compressor, you can choose to not include the 
preset name file identifier with the output filename.

To remove the setting name from a destination:
1 Double-click the destination.

The Template field in the Inspector window lists the file identifiers assigned to 
the destination.

2 If “Setting name” is listed in the Template field, delete it.

Template field
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25 Using Droplets

Compressor allows you to save one or more settings 
or groups of settings into a Droplet. A Droplet is a 
standalone preset created by Compressor, packaged 
into a drag-and-drop application and saved as an icon. 

When you drag source media files to a Droplet icon, they are automatically submitted 
for transcoding using the specified embedded settings. The transcoding process 
begins, whether or not Compressor is open.

You can drag any number of media files onto a Droplet. You can double-click a Droplet 
to open it and see the settings it contains.

Note:  Compressor must already be installed on any computer on which you intend to 
use Droplets.

This chapter contains the following:
Â About the Droplet Window (p. 316)
Â Creating a Droplet (p. 317)
Â Checking Droplet Settings and AppleScript Options (p. 319)
Â Using a Droplet to Transcode Source Media Files (p. 319)
Â Droplet Tips (p. 322)
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About the Droplet Window
You can open any Droplet to view its full details. You can also modify some settings 
such as the destination for the output media files and the output file identifiers.

The Droplet window contains the following items:
Â Cluster:  Use this pop-up menu to choose a cluster of computers on your network to 

which you can submit batches for distributed processing. (The distributed processing 
feature is limited to computers that have Final Cut Studio installed.) The menu will 
have only one available option (This Computer) unless all the following conditions 
are met:
Â Your copy of Compressor has distributed processing enabled.
Â There are other available clusters on the network. 

Â Destination:  This field displays the path to the destination folder for the output 
media file. You can modify this by clicking the Choose button to open the 
destination selection dialog and navigating to a new folder.

Â Template:  Use this pop-up menu to add file identifiers to your output media file. You 
can manually edit this field. Selecting any of the following file identifiers adds it to 
your output media filename:
Â Date:  Date the file was transcoded in the YYYY-MM-DD format
Â Setting Name:  Name of the setting used for the transcoding job
Â Source Media Name:  Source media filename without its extension
Â Source Media Extension:  Extension of the source media file

See “About the Destinations Tab” on page 306 for more information on using 
file identifiers.

Destination field

Source files table

Setting pop-up 
menu

Show at Launch box

Summary table

Template field

Submit button
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Â Source files:  Contains all jobs in the batch about to be submitted. If the Show at 
Launch box is checked, the Droplet window opens after you drag your source media 
files to the Droplet icon, and all the source media files appear in the Source Files 
table. You can drag one or more source media files into this table, and they will all be 
transcoded together when you submit the batch, just like a normal batch submission 
from the Batch window.

Â Setting:  This read-only pop-up menu displays the full list of settings associated with 
each Droplet. You can assign as many settings to a Droplet as you like by making a 
Droplet out of a setting group. (See “Creating a Droplet,” next, for details.) You can 
see the full details of each setting by choosing it from the pop-up menu and viewing 
the Summary table at the bottom of the window.

Â Summary:  This table lists every component of the setting selected in the Setting 
pop-up menu. 

Â Show at Launch:  When this checkbox is selected, the Droplet window opens when 
you drag source media files to the Droplet icon, before the batch is submitted. This 
allows you to verify the settings contained within the Droplet. If the box is not 
selected, the batch is submitted as soon as the batch is dragged to the Droplet icon 
(as long as there are no errors), and the Droplet window doesn’t open.

Â Submit:  Click this button to submit the batch. You only need to do this if the 
Show at Launch checkbox is selected; if this box is not selected, the batch is 
submitted automatically.

Creating a Droplet
Droplets are easy to create, and once created, allow you to quickly and easily submit 
source media files for transcoding.

To create a Droplet:
1 Open the Settings tab.

2 Select the setting or setting group you want to save as a Droplet and click the Save 
Droplet button.

Setting pop-up menu

Save Droplet button
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The Save dialog appears.

Note:  You cannot select multiple settings to add to a Droplet directly from the Settings 
tab. However, you can place the settings you want to use into a setting group, select 
that group, and click Save. In this situation, every source media file is transcoded by 
every setting in the Droplet. For example, if you submitted two source media files to a 
Droplet containing three settings, Compressor creates six different output media files. 
For information about creating groups of settings, see “Creating Groups of Settings” on 
page 98.

3 In the Save dialog, enter a name for the Droplet in the Save As field, use the Where 
pop-up menu to navigate to the Droplet location, then click Save.

You can save your Droplet anywhere on your computer, but it’s most convenient to 
save it on your desktop, so you can conveniently drag source media files to it.

You can choose a destination folder other than Source from the Save dialog, but you 
can only select destinations that have already been created using the Destinations tab. 
If no custom destinations have been created, only four default Apple destinations 
appear in the Choose Destination pop-up menu. See “Creating a Destination” on 
page 308 for more information about destinations.

To choose an alternate destination for a Droplet:
1 Choose a destination from the Choose Destination pop-up menu.

Note:  The Droplet displays a warning triangle if there is a problem with the chosen 
destination. If this occurs, change your chosen directory until the warning disappears. 
See “Warning Triangles” on page 311 for more information.

2 Click Save.

Your newly created Droplet appears as an icon at whatever location you selected. You 
are now ready to use it for transcoding.
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Checking Droplet Settings and AppleScript Options
The Show at Launch checkbox at the bottom of the Droplet window determines 
whether or not a Droplet window opens when a batch is dragged to a Droplet icon. If it 
is selected, the Droplet window opens when you drag a batch to the Droplet icon, and 
you can view the Droplet settings.

If this checkbox is not selected, double-click the Droplet icon to open its window and 
see the settings.

See “About the Droplet Window” on page 316 for more information about 
Droplet settings.

You can see a list of AppleScript dictionary options that can be used with a Droplet by 
dragging the Droplet icon over the Script Editor located in /Applications/AppleScript.

Using a Droplet to Transcode Source Media Files 
Once you have created a Droplet, you can transcode source media files by dragging 
them to the Droplet icon.

To transcode source media files using a Droplet:
1 Drag your selected source media files over the Droplet icon.

The Show at Launch checkbox at the bottom of the Droplet window determines what 
happens next:

Â If the Show at Launch checkbox is not selected:  The Droplet begins transcoding the 
source media files immediately.

Show at Launch
checkbox
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Â If the Show at Launch checkbox is selected:  The Droplet window opens with the source 
media files displayed in the Droplet Source Files table. Proceed to step 2 to submit 
your batch.

2 If the Droplet window opens, you can check and modify Droplet settings for such items 
as the destination folder and file identifiers. When you’re satisfied with the settings, 
click Submit.

Each source media file is processed according to the existing setting or group of 
settings contained within the Droplet. 

3 Open the Batch Monitor if you want to view the processing status of your source 
media files.

See the Batch Monitor User Manual for more information.

If a Droplet window is open, you can drag your source media files directly to the Source 
Files table and submit them for transcoding.
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To transcode source media files using an open Droplet:
1 Double-click the Droplet icon to open it.

2 Using the Finder, locate the source media files and drag them into the Droplet’s Source 
Files table.

3 Modify your Droplet settings as necessary, then click Submit.

Each source media file is processed according to the existing setting or group of 
settings contained within the Droplet. For example, if you submitted two source media 
files to a Droplet containing three settings, Compressor would create six different 
output media files. 

4 Open the Batch Monitor if you want to view the processing status of your source 
media files.
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Droplet Tips
Here are some additional tips on using Droplets to transcode source media files.

Droplets and Compressor Processing Services 
If you drag files to a Droplet icon without first opening the application or opening a 
Droplet, Compressor may display an alert message (“This computer is unavailable”), 
indicating that Compressor processing services have not yet started up in the 
background. Click Submit at the bottom of the Droplet window. Compressor 
processing services will start up and transcode the files.

Droplets and Large Numbers of Source Media Files
If you submit a large number of source media files (such as 200 or more) using a 
Droplet, there may be a delay of about 1 minute between the “Getting ready for 
processing” alert message and the dialog reporting that the job is being submitted. 
You can avoid this reporting delay by reducing the number of source files you submit 
at one time with a Droplet.
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Customer Support 
and Troubleshooting

 

If you run into problems while working with Compressor, there are several resources 
you can use to find a solution.
Â

 

Release Notes:

 

  A release notes page in the Compressor Help menu provides last-
minute information that didn’t make it into the 

 

Compressor User Manual

 

. Be sure to 
consult this release notes page as soon as you install or upgrade Compressor.

Â

 

Compressor Support web page: 

 

 Compressor has its own tech support page at 
http://www.apple.com/support/compressor and a related discussion page at 
http://discussions.info.apple.com.

Â

 

AppleCare Knowledge Base:

 

  AppleCare Support maintains a database of common 
support issues that is updated and expanded to include new issues as they arise. This is 
an excellent, free resource for Compressor users. To access the AppleCare Knowledge 
Base, go to the AppleCare support page at http://www.apple.com/support.

Â

 

AppleCare Support:

 

  There are a variety of support options available to Final Cut Pro 
customers. For more information, see the 

 

Apple Professional Software Service 
& Support Guide

 

 that came with your documentation.

 

Calling AppleCare Support

 

Included in your Compressor package is documentation about the support options 
available from Apple. Several levels of support are available, depending on your needs.

Whatever your issue, it’s a good idea to have the following information immediately 
available. The more of this information you have ready to give to the support agents, 
the faster they will be able to address your issue.
Â

 

The registration number that came with Compressor. This number is different from 
the software serial number that is used to activate your copy of Compressor.

Â

 

Which version of Mac OS X you have installed. This information is available by 
choosing About This Mac from the Apple menu. 

http://www.apple.com/support/compressor
http://discussions.info.apple.com/compressor
http://www.apple.com/support


 

324 Appendix A    Customer Support and Troubleshooting

Â The version of Compressor you have installed, including updates if applicable. The 
version number can be viewed by choosing Compressor > About Compressor.

Â The model of computer you are using.
Â How much RAM is installed in your computer, and how much is available to 

Compressor. You can find out how much RAM is installed by choosing About This 
Mac from the Apple menu in the Finder. 

Â What other third-party hardware is connected to or installed in the computer, and 
who are the manufacturers. Include hard disks, video cards, and so on. 

Â Any third-party plug-ins or other software installed along with Compressor.

Creating a Support Profile
In addition to accessing the Compressor User Manual, the Help menu also contains an 
item for creating a support profile. There are certain support situations in which 
AppleCare may require information about both your computer and how this particular 
application is configured. Choosing Help > Create Support Profile creates a file that 
contains the necessary information and can be emailed to AppleCare. You would not 
normally use this feature unless directed to by an AppleCare representative.

AppleCare Support can be reached online at http://www.apple.com/support/compressor

Troubleshooting Tips
If you are having trouble with Compressor, look here for answers to your questions.

Compressor Command-Line Usage Requires Login
While it is possible to use the command line to run an Apple Qmaster distributed 
processing network, each Compressor service node (each computer providing 
Compressor distributed processing services) must be logged in (with a Mac OS X 
user name and password) for full functionality.

http://www.apple.com/support/compressor
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Scaling (10-bit Color) Source Media Files
If you are using Compressor to transcode source media files that use 10 bits per color 
channel and you intend to scale (resize) the frame size, enable Frame Controls. If you 
do not enable Frame Controls in these cases, the transcoded output file will have 8-bit 
color rather than 10-bit color. 

To enable Frame Controls:
1 Open the Settings tab.

2 Select the setting in the Settings tab that you want to modify. (Or select a setting 
already applied to a source media file in the Batch window.)

3 Click the Frame Controls tab in the Inspector window.

4 Choose one of the following from the Frame Controls pop-up menu:

Â Automatic:  Compressor analyzes the transcoding job (the source media file and 
the applied setting), and then automatically determines the appropriate Frame 
Controls attributes.

Â Custom:  This option allows you to manually adjust all the attributes in the Frame 
Controls pane.
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Command-Line Usage

 

Using the Command Line

 

If you are accustomed to doing your work from Terminal shells, and need or prefer to 
run Compressor from the command line with minimal use of application interfaces, this 
appendix is for you. 

The appendix includes the following topics:
Â

 

Shell Commands for Configuring Service Nodes and Cluster Controllers (p. 327)
Â

 

Shell Commands for Submitting Compressor Jobs (p. 328)
Â

 

Shell Commands for Monitoring Batches (p. 330)

 

Shell Commands for Configuring Service Nodes 
and Cluster Controllers

 

As an alternative to using the Apple Qmaster pane in System Preferences, you can use 
the command 

 

qmasterprefs

 

, with command-line options for enabling and disabling 
service node and cluster-controlling services. 

In the command-line descriptions below, angle brackets < > indicate a mandatory 
argument in a command and brackets [ ] indicate an optional argument. 

 

Note:  

 

While it is possible to use the command line to run an Apple Qmaster distributed 
processing network, each Compressor service node (each computer providing 
Compressor distributed processing services) must be logged in (with a Mac OS X 
user name and password) for full functionality.

 

Synopsis

 

Below is a synopsis of the command for enabling and disabling cluster-controlling 
services on a computer. The 

 

qmasterprefs 

 

command is located in /usr/sbin.

 

qmasterprefs -cluster <on | off> [-timeout <minutes>] [-servername <name>] 

[-list] [-help] 
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Below is a synopsis of the command for enabling and disabling service-node 
processing on a computer.

qmasterprefs -service “Unix Processing” <on | off> [-instances <n>] [-timeout 

<minutes>] [-servername <name>] [-list] [-help] 

Command options
This table provides information about each of the enabling and disabling service-node 
and cluster-controlling services on a computer.

Shell Commands for Submitting Compressor Jobs
You can run the Compressor application from the command line using the Compressor 
command, with a number of command-line options for submitting jobs. 

In the command-line descriptions below, angle brackets < > indicate a mandatory 
argument in a command and brackets [ ] indicate an optional argument. 

Synopsis
Below is a synopsis of the command for submitting a job to a cluster. The Compressor 
command is located in /Applications/Compressor.app/Contents/MacOS.
Compressor [-clustername <name>]

[-clusterid <username:password@ipaddress:portNumber>] [-batchfilepath 

<path>] [-batchname <batchname>] [-priority <value>] [-jobpath <path>] 

[-settingpath <path>] [-destinationpath <path>] [-info <xml>] 

[-timeout <seconds>] [-help] [-show]

In this example, -jobpath, -settingpath, and -destinationpath can be repeated 
as many times as the number of jobs you want to submit.

Note:  Not all the options are necessary. For example, you can specify the cluster either 
by its -clustername or by its -clusterid. You do not need to specify both. If both are 
specified, only -clusterid is used.

Preference command option Description

[-cluster] <on | off> Turns cluster-controlling services on or off.
[timeout min] [servername name] [quickcluster on | off ] 
[unmanagedservices on | off ] [unmanagedmulticapturethreshold 
sec] [networkinterface allinterfaces | <bsd name>]

[-service Rendering] <on 

| off>

Turns UNIX Rendering services on or off.
[timeout min] [instances n] [autorestart on | off ] [unmanaged on | off ]

[-list] Lists the current qmasterprefs settings.

[-help] Displays information about supported options for qmasterprefs.

[-restart] Restarts Apple Qmaster services.

[-service name options] Sets service options.
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Additionally, if you specify -batchfilepath, then -jobpath, -settingpath, and 
-destinationpath are not necessary because the previously saved batch file already 
contains information about the job, settings, and destination.

Example of -batchfilepath:

Compressor -clustername "This Computer" -batchfilepath "/Volumes/Hermione/

SavedCompressorBatches/FreeChampagne.compressor"

Once the job is submitted successfully, this command displays the batch ID (identifier) 
and job ID (identifier) in the shell, and you can monitor the progress of a batch in the 
Batch Monitor.

Command options
This table provides information about each of the command options for submitting jobs.

Submission command option Description

[-clustername <name>] Use to specify the name of the cluster to which you want to send 
the job. Using the cluster name, Compressor looks for the cluster 
on the network in order to use it.

[-batchname <name>] Use to specify a name for the batch so that you can easily 
recognize it in the Batch Monitor.

[-clusterid 

<user name:password@IP 

address:port number>] 

Optionally, you can use -clusterid to enter the cluster ID and 
port number instead of using -clustername. (When you enter 
the cluster ID and port, less time is required to find the cluster on 
the network.)
Or, if you used -clustername and the cluster requires a password, 
use -clusterid to specify the user name and password. (You 
need to include the IP address: port number as well whenever you 
use -clusterid.)
Tip:  Use Compressor -show to see a cluster’s IP address and 
port number.

[-priority <value>] Specifies the priority level for a job.

[-jobpath <url>] Specifies the location of the source file.

[-settingpath <url>] Specifies the location of the settings for the job.

[-destinationpath <url>] Specifies the destination file URL for the job.

[-info <xml>] Gives detailed information for a batch or a job.

[-timeout <seconds>] Use to specify the number of seconds before Compressor can quit 
when looking for a cluster. The default value is 0, which puts no 
limit on the timeout and allows Compressor to browse the network 
for as long as it needs to find the cluster.

[-show] Shows the ID information for the cluster specified with 
-clustername or -clusterid, or for all clusters if no cluster 
is specified. 

[-help] Displays information regarding the required parameters for the 
Compressor command.
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Example of Compressor Command XML 

 

The code below is an example of XML code for submitting a Compressor command. 
Notice that because it needs to be entered as one command line, every character after 

 

-options

 

 that isn’t alphanumeric must be preceded with a backslash (\).

 

./Compressor -clusterid tcp://127.0.0.1:51737 -batchname myBatch -jobpath /

Volumes/Source/ShortClips/NTSC24p.mov -settingpath /Users/stomper10/Library/

Application\ Support/Compressor/PhotoJPEG.setting -destinationpath /Users/

machinename/Movies/myDestinationFilename.mov.

 

This command has the following elements:
Â

 

Cluster address is tcp://127.0.0.1:51737. 
Â

 

Batchname is myBatch. 
Â

 

Job path is /Volumes/Source/ShortClips/NTSC24p.mov. 
Â

 

Setting path is /Users/stomper10/Library/Application\ Support/Compressor/
PhotoJPEG.setting. 

Â

 

Destination path is /Users/machinename/Movies 

 

Shell Commands for Monitoring Batches

 

You can use the Batch Monitor command, 

 

Batch\ Monitor

 

, with a number of 
command-line options for monitoring jobs. 

In the command-line descriptions below, angle brackets < > indicate a mandatory 
argument in a command and brackets [ ] indicate an optional argument. 

 

Synopsis

 

Below is a synopsis of the command for monitoring batches. The 

 

Batch\ Monitor 

 

command is located in /Applications/Utilities/Batch Monitor.app/Contents/MacOS.

 

Batch\ Monitor [-clustername <name>] [-clusterid <user name:password@IP 

address:port number>] [-jobid <identifier> -batchid <identifier>] [-timeout 

<seconds>] [-query <seconds>] [-help]
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To cancel a job or batch:
Batch\ Monitor [-clustername <name>] [-clusterid <IP address> <port number> 

<user name> <password>] -kill -jobid <identifier> -batchid <identifier>

Command options
This table provides information about each of the command options for 
monitoring batches.

Monitoring command option Description

[-clustername <name>] Use to specify the name of the cluster to which the job was sent.

[-clusterid 

<user name:password@IP 

address:port number>]

Optionally, you can use -clusterid to enter the cluster ID and 
port number instead of using -clustername. 
Or, if you used -clustername and the cluster requires a password, 
use -clusterid to specify the user name and password. (You need 
to include the IP address: port number as well whenever you use 
-clusterid.)
Tip:  Use Apple\ Qmaster -show or Compressor -show to see a 
cluster’s IP address and port number.

[-jobid <identifier> -

batchid <identifier>] 
Use to specify the job you want to monitor. 
When you use the -jobid option, you must also specify the 
-batchid, in the form of the name that was given to the batch 
when it was submitted. (The batchid and jobid are displayed after a 
batch is submitted.)
If you do not use the -jobid option, all the jobs submitted to the 
specified cluster are listed. 

[-timeout <seconds>] Use to specify the number of seconds before Batch Monitor can 
quit when looking for a cluster. The default value is 0, which puts 
no limit on the timeout and allows Batch Monitor to browse the 
network for as long as it needs to find the cluster. 

 [-query <seconds>] Use to specify how frequently, in seconds, the job status should 
be updated.

[-kill -jobid <identifier> 

-batchid <identifier>] 
Cancels the specified job or batch. 

[-help] Displays information about supported options for Batch\ Monitor.
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3G formats  223, 238
5.1 surround sound  78–81, 129, 130, 132, 139–143
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16-bit audio  230, 236
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90° phase-shift options  136
720p format  154, 186, 272
1080i format  186, 272
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A
A/V Attributes tab  56, 82
AAC (Advanced Audio Coding) codec  127, 211
.ac3 extension  60, 130
AC-3 format

See also Dolby Digital Professional format
data rates  132
encoding  12, 60, 130
length of streams  137
sample rates  137

access privileges  308
actions

adding AppleScripts  279–280
adding email notification  279
post-transcoding  279–280
settings for  31, 64

"action safe" areas  270
Actions pane  64, 92, 93, 278–280
Adaptive Details setting  258
adaptive noise reduction  248
Add button  89
Additional Information tab  57, 83

annotations  84
closed caption file  83

Advanced Audio Coding (AAC) codec  127, 211
AIFF (Audio Interchange File Format)

audio settings  229–230
choosing output formats  34

described  125–128
encoder  14
QuickTime settings  226
settings  125–128

AIFF Encoder pane  125–126
.aiff extension  60
Algorithm pop-up menu  248
Allow Job Segmenting option  60
alpha channels  248
anamorphic video formats  272
annotations  84
Anti-alias setting  259
Apple AU Graphic EQ filter  251
AppleCare

Knowledge Base  323
support profiles  16

Apple Qmaster
alternatives to  327
distributed processing  61

Apple Qmaster pane  327
AppleScripts

actions and  31
activating  64
adding to settings  277, 279–280
choosing  64
dictionary options  319
executing  278
files  279
resources  281, 324
website for  281, 324

Apple settings  89
See also settings

Apple Store  17
Apple TV

aspect ratios  151
encoder size  152
H.264 video for  147

Apple websites  16–17
Apply 3 dB Attenuation option  136
Apply 90° Phase-Shift option  136
Apply DC Filter option  136
Apply Digital Deemphasis option  136
Apply Low-Pass Filter option  136
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artifacts in output files  85, 235
artwork

adding to chapter marker  301
aspect ratio

Apple devices  151
default  188
MPEG-2 options  205
pixel aspect ratio  272
settings  188, 274–275

Aspect Ratio pop-up menu  188
audio

8-bit  236
16-bit  236
channel identifier codes  79, 141
channels  131, 171
device quality  236
Dolby Digital AC-3 format  12, 129, 138
enabling tracks  225
filter list  251–252
maximum bit rates  157, 193
MPEG-1 settings  171
Pass-through setting  225, 264
PCM audio  156
rules for  132, 137
sample rates  137, 171, 236
sampling size  236
spatial mixing  143–144
stereo. See stereo audio
surround sound  78–81, 139–143
uncompressed  127, 230, 235

audio CDs  171, 236
audio codecs

See also codecs
AAC  211
AIFF  128
choosing  127, 230
MP3  163
QuickTime  235–236

Audio Coding Mode setting  131
Audio Interchange File Format. See AIFF
Audio pane  214, 217, 219
Audio Production Information setting  134
audio settings

AIFF  125–128
MP3  164
MPEG-2 files  193
MPEG-4 files  214, 214–219
QuickTime  126–127, 226, 229–230

Audio tab  131–133, 171
Auto Launch Batch Monitor option  38
automatic compression markers  201
automatic settings  55

non-standard QuickTime files  86
Average Bit Rate slider  193, 206
AVI format  223, 238

B
B-frames  199, 195, 197
background colors  248
bass management  144
batches  101–123

See also Batch Monitor
assigning destinations to  36, 107–108
canceling  331
changing source media file  78
command line options  328
copying jobs between  110
creating  34–36
described  19, 29, 31
destinations. See destinations
history of. See History drawer
importing source media files into  35, 75–78
jobs. See jobs
monitoring  330
monitoring with shell commands  330–331
names  77
opening batch files  117
optional tasks for  26–27
previewing  284–289
quitting after submission  39
resubmitting  115, 116, 118
saving  116
selections  91
settings. See settings
submitting  25–26, 36, 112–113, 317
submitting with shell commands  328–330
temporary destinations  108
transcoding different clips in  122–123
viewing status of  36

Batch Item pop-up menu  285
Batch Monitor

batch status  36
command line options  330
opening  67
opening automatically  38
overview  67
in workflow  25

Batch Monitor command  330–331
Batch window

destination warnings  311
Droplets and  317
importing source media files  75–81
overview  49–50, 74–75
tabs  74
toolbar  50–52
in workflow  35, 42

bi-directional frames  197
Bit Rate pop-up menu  213
bit rates

average  193, 206
constant  157, 193
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H.264 for DVD Studio Pro output  155
maximum  155, 193, 207
MPEG-1  171
MPEG-2  190–193
MPEG-4  213, 214
QuickTime  229
variable. See VBR

Bit Rate slider  213, 214
Bit Stream Mode setting  132
Bitstream tab  134
BlackWhite Restore filter  245
Blu-ray MPEG-2  185
blurring fields  246
Brightness Contrast filter  245
button toolbar  50

C
CBR (constant bit rates)  157, 193
CD audio  230
CD-ROMs

MPEG-1 output and  167
QuickTime content  223
sample rates  236

center channel  143
Center Downmix, Surround Downmix setting  134
chaining jobs  111
channels

AIFF output  127
alpha channels  248
applying filters to  248
assigning with identifier codes  79, 141
center  143
Dolby Digital  131
full-bandwidth  136
LFE  136, 144
MPEG-1 settings  171
MPEG-4 output  214
QuickTime settings  229
surround  136, 143
using in Dolby Digital programs  129, 143–144

chapter marker
adding image  301

chapter markers  297
adding  300–301
adding artwork  301
adding URL  301
creating plain text list  302
defining  201
described  201
displaying  289
importing marker list  289, 301
lack of support in MPEG-1  169
retaining  198, 209
visual indicators for  287

chroma channels  248

clips
adding I-frames to  208, 298–299
exporting  11
playing  287
previewing  289–295
removing I-frames from  299
transcoding from different media files  122–123
transcoding portions of  295–296

closed caption file  83
closed GOPs  196, 200, 208
cluster controllers

configuring with shell commands  327–328
enabling/disabling  327, 328

Cluster pop-up menu  316
clusters

choosing for distributed processing  316
copying options  39
selecting storage locations  306
submitting jobs to  328

codecs
See also audio codecs; video codecs
AAC  211
AIFF  128
audio  235–236
choosing  234
described  31
lossless  235
lossy  235
overview  234–236
QuickTime  226, 231–236

color
color spaces  243
filters  245
marker colors  287
settings  228
text overlays  249, 250

Color Correct Highlights filter  245
color spaces  243
command line  327–331

monitoring batches  330
shell commands  327
submitting jobs  328

compatibility of MPEG-2 output  198
compressed headers  225
compressed source files  85
compression

audio  135
uncompressed audio  127, 230, 235

compression markers  198, 287, 289, 297, 298
Compression Preset setting  135
Compression Settings dialog  227–229
Compression type pop-up menu  227
Compressor

features overview  12–14
getting started with  19–27
interface  41–72
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introduction to  9–15
layouts  43–45
memory allocated to  324
preferences  38–40
quitting after batch submission  39
scenarios  11
shortcuts  37
terminology  31
website  16
workflows. See workflows

.compressor extension  116
Compressor windows

about tabs  47–49
resizing  46
why covered  46
working with  46–49

configuration
cluster controllers  327–328
service nodes  327–328

constant bit rates  157, 193
constraining aspect ratio  63
Content Agent

described  39
preferences setting  38

Content is Original setting  134
converting video frame rates  264
converting video speed  264
copying items

destinations  306, 313
settings  89, 93

Copyright Exists setting  134
cropping boundary  286
Cropping fields  270
cropping items

frame sizes  187
images  63, 274–275, 292

customer support  323–324

D
data rates  132, 229
Data Rate setting  132
dates

transcodings  307
DAT sample rates  236
DC filters  136
decoders, stereo playback and  144
Default Destination pop-up menu  40, 310
Default Setting pop-up menu  40
Deinterlace pop-up menu  258
Deinterlacing filter  246
deinterlacing video  242–243, 246
deleting items

destinations  307, 312
I-frames  299
markers  289

names from destinations  314
settings  89, 97

delta frames  228
Depth pop-up menu  228
Description field  99
Desktop folder  306
Destination field  316
destinations  305–313

See also settings
assigning  22, 24, 36, 107–108
in batches  29
changing default  40, 310
compared to settings  87
creating  33, 308–310
deleting  307, 312
described  31
Droplets  318
duplicating  306, 313
DVD Studio Pro and  179, 314
file identifiers  307
image sequence output  160
local  306, 308, 308–309
open volume  308–309
remote  306, 308, 309–310
removing names from  314
temporary  108
types of  308
warnings  311

Destinations Inspector window  307
Destinations tab  42, 53, 306–307, 312–313

about  306–307
Details Level setting  259
Dialog Normalization setting  133
distributed processing

choosing clusters  316
cluster storage  306
Final Cut Pro  119–121
H.264 output and  154
job segmenting  60–61, 184, 212, 224
QuickTime reference movies  85
scratch storage settings  39

distributing settings  99
DNS Domain settings  40
Dolby Digital decoder  85, 295
Dolby Digital encoder  144
Dolby Digital Professional encoder  34
Dolby Digital Professional Encoder pane  130–136
Dolby Digital Professional format  129–130, 143–144

about  14
as sources  85
Audio tab settings  131–133
Bitstream tab settings  134
converting audio to  138
described  12
Preprocessing tab settings  135–136
previewing  85, 137, 295
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Dolby Laboratories website  144
Dolby Surround Mode setting  134
downconversions  182
downloading movies  224, 225
downmixes  134, 144
drop frame timecode  189
Droplets  315–322

adding file identifiers  316
creating  37, 89, 317–318
described  37
destinations  318
saving  89, 318
settings for  319, 320
surround sound settings  143
transcoding with  319–321
working with  37

Droplet window  68, 316–317
Duplicate button  89, 93
duplicating items

destinations  306, 313
settings  89, 93

DV sample rates  236
DVCPRO HD format  272
DVD-5 discs  158
DVD option  170
DVDs

bit rates  171
chapter markers  201
HD-resolution DVDs  182
minutes of video on  190
MPEG-1 output and  167
MPEG-1 settings  173, 175–179
sample rates  171, 236
SD video on  182

DVD Studio Pro
configuring MPEG-1  175–179
destinations for  179, 314
Dolby encoding options  131
meta-data  198, 209
MPEG-2 format and  12

DVD Video format
DVD Studio Pro and  131

DVD-Video format
MPEG-2 video streams and  181
open GOPs and  200

DVD Video setting  131
.dv extension  60
DV Stream format

about  145
settings  145–146
workflow  146

Dynamic Range filter  251

E
edit/cut markers  287, 289, 298
elementary streams  172, 183, 198
emailing settings  99
email notification

activating  64, 279
described  277
preference  38

Email Notification to option  278
Enable Low Frequency Effects setting  132
Encoder pane

See also names of specific Encoder panes
modifying settings in  93
overview  59, 92

encoding audio files  138
even fields  189, 246
Execute AppleScript on output option  278
exporting items

chapter markers  202
Final Cut Pro projects  117
media with I-frames  66
QuickTime Export Component plug-ins  238

extensions
See also names of specific file extensions
channel identifiers and  79, 141
Dolby Digital files  130
in File Extension field  60
in Summary table  58

Extras tab  197–202, 209

F
Fade In/Out filter (audio)  252
Fade In/Out filter (video)  246
Fast forward and backward buttons  288
Fast Start option  225
field dominance  189, 205
Field Dominance pop-up menu  189
fields, output

types of  189
File Extension field  60
file extensions. See extensions
file formats

See also names of specific formats
described  31
extensions  60

file identifiers  307, 316
files

AppleScript  279
media. See source media files
paths  310

File Selection dialog  279
Film Standard Compression setting  135
Filter controls  244
filters

adding to settings  253–254
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applying  63, 293
described  30
order of  241
previewing  97, 241, 293
reordering  63
settings  62, 97, 245–252
types of  245–252
uses for  241–243
working with  244–254

Filters list  244
Filters pane  62, 92, 93, 244–252

adding to setting  253
Final Cut Pro

chapter markers and  202
distributed processing  119–121
quitting Compressor after batches  39
resubmitting projects  118
transcoding projects  117–118

FireWire website  17
flickering, removal of  246
folders, transcoded files  33
fonts  249, 250
forced compression markers  201
forced I-frames  197, 201, 208
Format option  127, 229
formats. See specific formats
Frame Controls pane

adding custom settings  261
automatically adding settings  260
introduction  255
modifying settings in  93
overview  62, 256–260
previewing  255
retiming controls  264
reverse telecine  262

frame numbers  161
frame rates

displaying  182
frame retiming and  62
H.264 for DVD Studio Pro output  155
image sequences  160
MPEG-1  168, 170
MPEG-2  188
MPEG-4  213
NTSC  188
QuickTime  227
settings  259

frames
numbering  161
resizing  62
retiming  62
types of  197–201

frame size
cropping and  187, 270
MPEG-1  168
MPEG-2  294

scaling and  267, 271–272
settings  257

Frame size pop-up menu  271
Frame Sync rate  156
Full Bandwidth Channels settings  136

G
gamma correction  247
Gamma Correction filter  247
General settings, Preprocessing tab  136
geometry

settings  30, 63, 269–275
Geometry pane  63, 92, 93, 269–275
Geometry tab  274
GOPs (group of pictures)

adding I-frames to clips  208
closed  196, 200–201
H.264  156
MPEG-2 output files  207–208
open  196, 200–201
overview  197–201
settings  168, 195–197, 199–201
size  186, 196, 199
structure  195, 199

GOP Size pop-up menu  196, 208
GOP Structure pop-up menu  195, 208
GOP tab  195–197, 203, 207
GOVUs (group of video access units)  157
Group button  88, 98
group folders  90, 98
group of pictures. See GOPs
groups

described  31
settings  88, 98

H
H.264 for Apple Devices format

choosing output formats  34
Encoder pane  148–151
introduction  147
workflow  152

H.264 for DVD Studio Pro format
choosing output formats  34
Encoder pane  153–156
frame sync  156
GOVUs  157
partial sync  156
progressive video  158
using multi-pass  157
workflow  158

H.264 format
described  14

HD DVDs
SD and HD support  158
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HD video
downconverting  12, 182
DVD-5 discs and  158
frame resizing and  62
high definition source  182
MPEG-2 options  182, 186, 191

HDV res format  186
help

online  15
support profiles  16

high definition video. See HD video
high-pass filters  136
Hinted Streaming option  225
hinting  212, 215, 217, 219, 225
hint tracks  212, 225
History window  42

opening/closing  65
overview  65, 115
resubmitting batches  116
transcoding status  36

host servers  310

I
I-frames

adding to clips  298–299
adding to MPEG-2 files  208
described  197, 201
forced  201, 208
GOP structures and  195, 199
markers for  66
removing from clips  299

IBBP option  195, 199
IBBP patterns  186
IBP option  195
identifier codes for channels  79, 141
iDisk volumes  306
IMA codec  127
images

cropping  267, 270, 292
padding  269
quality of  228, 248
scaling  267, 271–272
sequence output  159
stills  30
TARGA output  159
TIFF output  159

Image Sequence Encoder pane  160–161
Image Sequence format

encoders  14, 34
outputs  159–161

image sequences  159
importing items

Final Cut Pro projects  117
source media files  35, 73–78

In and Out points  285, 287–288, 295–296
Include PCM Audio option  156
Inspector window

about automatic settings  55
described  42
overview  54–64, 92

installing QuickTime plug-ins  238
interlaced video

creating  181, 242–243
Internet. See web
intra frames. See I-frames
iPod

aspect ratios  151
chapter markers  151
encoder sizes  152
H.264 video for  147
podcast markers  151
QuickTime Export Components format  238

IP option  195
ISMA profile  213
Iterations pop-up menu  248
iTunes

aspect ratios  151
chapter markers  151
H.264 video for  147
podcast markers  151

J
jobs

See also batches
in batches  34
chaining  111
command line options  328
configuring  22
copying  110
described  19, 29, 31
destinations for  107–108
importing source media files into  75–78
segmenting  60–61

job segmenting
H.264 options  154
MPEG-2 options  184
MPEG-4 options  212
QuickTime Export Component output  239
QuickTime options  224

K
keyboard shortcuts

See also shortcuts
general controls  71
Preview window  72, 303

Key Frame Every option  228
key frame interval (Frame Sync rate)  156
Key frame interval field  213
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key frames
described  197
H.264  156
MPEG-4  213
QuickTime  228

L
layouts

about the files  45
batch  44
choosing  44
configuring  43–45
managing  44–45
saving  44
standard  43

leading zeros  161
letterbox filter  247
LFE (low frequency effects)

channel  136, 144
enabling  132
interference and  144
limitations  144

Linear filter option  257
Live averaging option  258
local destinations  308
looping playback  288
lossless codecs  235
lossy codecs  235
lower fields  189, 246
low frequency effects. See LFE
low-pass filters  136
luminance values  245

M
.m1a extension  60, 172
.m1v extension  60
.m2t extension  60
.m2v extension  60, 184
.m4v extension  60
Mac OS version  323
mail servers  277
Manual slider  248
Marker pop-up menu  288
markers

adding chapter markers  300–301
adding to output clip  297
automatic compression  201
chapter markers  198, 201, 209, 287, 289
chapter markers MPEG-1  169
compression markers  198, 287, 289, 298
edit/cut markers  287, 289
forced compression  201
formats that support them  297
I-frames  66
In and Out points  287

MPEG-2  201
naming  289
podcast markers  297
types of  287, 297
working with  288

matte letterboxing  247
Maximum Bit Rate slider  155, 193, 207
media files. See source media files
memory allocated to Compressor  324
menu bar  49
meta-data  198, 209
minutes of video, on DVDs  190
mixing audio  134, 143–144
Mode pop-up menu  191, 206
mono audio channels  214
Motion adaptive option  258
Motion compensated option  258
Motion Estimation mode  194
Motion Estimation pop-up menu  194, 207
Motion Estimation settings  194
motion in sequences  194
.mov extension  60, 154, 224
movies, described  30
Movies folder  306
moving playhead  288
MP3 format

choosing output formats  34
common uses for  163
encoder pane  164
introduction  163
podcasts  164
workflow  166

.mp4 extension  60, 212
MPEG-1/Layer 2 audio  198
MPEG-1 Encoder pane  169–171, 174
MPEG-1 format

adding I-frames to  298–299
choosing output formats  33
configuring for DVD  175–179
configuring for web  174–175
described  15
elementary and system streams  172
Encoder specifications  168
exporting  12
frame rates and sizes  168
introduction to  167–168
platforms for  167
sample settings  173
as source files  85
transcoding workflow  172–173

MPEG-2 Encoder pane  184–201
MPEG-2 format

adding I-frames to  208, 298–299
authoring settings  197–209
Blu-ray  185
choosing output formats  33
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described  15
DVD Studio Pro projects  12
extras settings  209
frame sizes  294
generic  185
GOP settings  195–201, 207–208
HD-based DVDs  182
HD DVD  185
markers  201
output files  181–201
parsing sources  85
quality settings  190–194, 203, 205–207
SD DVD  185
settings  203
as source files  85
streaming support  181
stream types  183
Stream Usage setting  185
transcoding workflow  202–209
video settings  185–205

MPEG-4 encoder  15
MPEG-4 Encoder pane  218
MPEG-4 format

advantages of  211
and podcasting  213
audio settings  214, 214–219
choosing output formats  33
output files  211–222
podcast workflow  220–222
as source files  85
streaming settings  215
transcoding workflow  216–222
video settings  213, 216, 218

MPEG-4 Part 10. See H.264 format
MPEG-4 Part 2 Encoder pane  212–215
.mpeg extension  60
MPEG format as source files  85
.mpg extension  60
multi-pass encoding  60–61, 156
multiplexed streams  172
multi-track pass-through  225
music  236

N
names in destinations  314
Nearest pixel option  257
networks, browsing for source files  40
noise removal  248
noise removal filter  248
non-drop frame timecode  189
noninterlaced video  167
NTSC format

cropping in  187
frame rate  168, 188
GOP size  196

MPEG-2 output  186
pixel aspect ratio  272
SIF frame size  168

numbering still frames  161

O
odd fields  189, 246
one-pass VBR best encoding  191
one-pass VBR encoding  211
online help  15
opacity of text  249, 250
open GOPs  196, 200, 208
opening batch files  117
Open Volume option  308
output files

See also names of specific formats
choosing format  30, 33
described  29, 31
destinations. See destinations
formats, described  31
naming  108
quality of  283
settings. See settings
transcoding  14

Output pop-up menu  248
Output view  96
Output View button  284
overexposed clips  247
overscan areas  270

P
P-frames  195, 197, 199
Packet Maximums Duration field  215
Packet Maximums Size field  215
padding

about  269
settings  273

PAL format
GOP size  196
MPEG-1 SIF output  168
MPEG-2 output  186
pixel aspect ratio  272

Partial sync  156
partial sync key frames  157
Pass-through

audio filters  251
setting  225

passwords  310
paths to destinations  307, 310
Pattern field  196
Pause button  288
PCM audio  156
Peak Limiter filter  251
Peak Mixing Level setting  134
performance, screen savers and  36, 113
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permissions  308
phantom centers  143
phones

audio quality  230
sample rates  236

Photo-JPEG codec  227, 228
Pixel Aspect pop-up menu  272
pixel aspect ratio  272
pixel color  248
platforms, playback  14
playback

looping  288
platforms  14
stereo  144
transport controls  288

Playback Loop button  288
Play button  288, 290
playhead  287
Playhead timecode field  287
plug-ins  238
PNG codec  228
podcast markers

defining  297
H.264 output  151

podcasts  211
MPEG-4  213, 220–222
URLs  301
using MP3  164
using QuickTime Export Components format  238
video using H.264  152

Position pop-up menu  247
pre-buffered downloading (QuickTime)  224
predicted frames  197
Preferences window  38–40
Preprocessing tab  135–136
presets

See destinations, Droplets, settings
previewing items

clips  289–295
filters  241
settings  32, 35, 42, 96–97
source media files  290

Preview screen area  286
Preview screen size  284
Preview window  283–303

adding I-frames to MPEG-2 files  208
controls  284–289
described  32, 42
Dolby Digital files  295
enlarging Preview screen size  284
keyboard shortcuts  72, 303
opening  66
overview  66, 284–289
previewing clips  289–295

previewing settings  32, 35, 42, 96–97
roles of  283
transcoding portions of clips  295–296

privileges  305
program stream  198
program streams  183
progressive video

motion in  194
MPEG-1  167
MPEG-2  181

projects, Final Cut Pro  117
Purpose buttons  170

Q
QDesign Music 2 codec  126, 229
QDesign Music codec  127
QDMC codec  127
qmaster prefs command  327
Qualcomm PureVoice codec  126, 127, 229
quality

job segmenting and  61
MPEG-2 files  205–207
previewing output  283
QuickTime settings  228

Quality pop-up menu  214
Quality slider  228
Quality tab  190–194, 203
QuickTime

encoder  33
website  17

QuickTime audio codecs
adding to presets  232–234
choosing  127, 230, 235–236
settings  226

QuickTime Encoder pane  224–226
QuickTime Export Components  15, 240
QuickTime Export Components Encoder pane  239
QuickTime Export option  202
QuickTime Hint Exported Settings dialog  225
QuickTime movie files

chapter markers  225
encoder for  15
Fast Start movies  224, 225
.mov extension  154
QuickTime Streaming movies  224
sound settings  226

QuickTime output files
creating  223–224
sound settings  126–127, 229–230
transcoding workflow  230–234
web-based files  224

QuickTime reference movies  85
QuickTime Sound Settings dialog  126
QuickTime Streaming Servers  215, 219
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QuickTime video codecs
adding to presets  231–232
choosing  234–235
settings  226

quitting Compressor
preferences setting  39

R
RAM  324
Rate Conversion pop-up  259
reference frames  197
remote destinations  308, 309–310
Remote dialog  309
Remove button  89, 97
rendering, transcoding process and  117
Resize filter pop-up menu  257
resizing frames. See frame size
resolution  182
resubmitting batches  115, 116, 118
retiming controls

converting video speed  265
usages  264

retiming frames  62
reverse telecine

about  262
cadence  263
issues with  263

Reverse Telecine setting  258
Room Type setting  134

S
Sample From Defined Template display  307
Sample Rate pop-up menu  214
sample rates

AC-3 streams  137
AIFF output  127
DVD format  132
MPEG-1 settings  171
MPEG-4 settings  214
overview  236
QuickTime audio  127, 230
surround sound  137

sampling size, sound  236
saturation  247
Save dialog  318
Save Droplet button  89, 317
saving items

batches  116
Droplets  317

scale letterboxing  247
scaling images  267, 271–272
Scan buttons  288
scratch storage settings

cluster options  39
locations  306

screen savers  36, 113
Script Editor  319
SD video

cropping output  270
downconverting HD video to  12, 182
frame size  187
setting MPEG-2 options  186

Selected Target setting name  285
sequences, exporting  11
service nodes

configuring with shell commands  327–328
enabling/disabling  328

Set Duration to setting  260
Set In Point button  296
Set Out Point button  296
.setting extension  99
settings

adding to Settings tab  89
AIFF codecs  128
AppleScripts in  279–280
aspect ratio  274–275
assigning  22–23, 35, 102–104
assigning destinations. See destinations
assigning to multiple groups  99
assigning to multiple jobs  35
compared to destinations  87
creating  32, 35, 94–95
cropping settings  274–275
customizing  32
deleting  89, 97
described  29, 30
Description value  99
destinations. See destinations
distributing  99
Droplets and  35, 143
duplicating  89, 93–94
emailing  99
email notification actions  279
file identifiers  307
filters  253–254
frame rates  259
frame size  257, 274–275
geometry  269–275
groups of  88, 98
image sequence codecs  161
location of  99
modifying  105–106
MPEG-1  177
MPEG-2  203
names  90, 95
numbers of in groups  99
organizing  90
output filename  108
pre-existing  35, 37
previewing  32, 35, 42, 96–97
previewing clips and  291–295
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QuickTime audio codecs  232–234
QuickTime Export Components  240
QuickTime video codecs  231–232
replacing in a job  105
setting default  40
sharing  99
storing  99
in Summary pane  58
working with  87–99

settings panes
about  58–64
Actions pane  64
Encoder pane  59
Filters pane  62
Frame Controls pane  62
Geometry pane  63
Summary pane  58

Settings tab  32, 42, 52, 88–91
about  88–91
creating settings  32

shared volumes  308
sharing presets  99
Sharpen Edge filter  249
sharpening fields  246
shell commands  327–331
shortcuts

See also keyboard shortcuts
transcoding with Droplets  315–322
workflow  37

Show at Launch checkbox  317, 319
SIF (Standard Interface Format)  167
single-pass encoding  156, 191
single pass VBR encoding  211
SMTP authentication  277
Sorenson Video 3 codec  227
sound. See audio
sound settings. See audio settings
Sound Settings dialog  126–127, 226, 229–234
Source inset fields  63, 270
source media files

adding to batches  20–21, 75–78
assigning destinations to  22, 24, 36, 107–108
assigning settings to  22–23, 35, 102–104
audio files  138
confirming transcode completion  37
conversion process  11
described  29, 30
in Droplet window  317
extensions for  58
frame rates  182
high definition  182
highly compressed files and  85
importing  35, 73–78, 182

in Inspector window  56
length of  137
previewing  66, 289–295
resizing  63
resolution  182
streaming over Internet  224
transcoding. See transcoding
transferring to processing clusters  39

Source view  96
Source View button  284
spatial mixing  143–144
split screen slider  286
square pixels  272
standard definition video. See SD video
Standard Interface Format (SIF)  167
starting timecodes  189
Statistical prediction option  257
status of submitted batches  36
stereo audio

channels  214
data rate  132
downmixing  138
stereo playback  144
surround sound and  130

stills  30
streaming hints  215, 217, 219, 225
streaming packets  215
Streaming pane  215, 217, 219
Streaming pop-up menu  225
streaming video  181, 212, 215
Stream Usage pop-up menu  185

Generic  198
Submit button  317
submitting batches  36, 112–114

command line options  328
process  25
resubmitting  115, 116
resubmitting Final Cut Pro projects  118

subnet settings  40
Summary pane  58, 92
Summary table  317
support profiles  16, 324
surround channels  136, 143
surround sound

assigning channels manually  80, 139
assigning identifier codes  79, 141
data rates  132
described  129
spatial mixing  143–144
stereo audio and  130
stereo playback  144

system streams  172
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T
Tagged Image File Format. See TIFF
TARGA (Truevision Advanced Raster Graphics 
Adapter)

described  159
encoder  14, 34
output files  159–161

targets
about  109
adding to job  110
copying  110
deleting  110
described  19, 31

Target System setting  131
Template field  307, 316
temporary destinations  108
Terminal shell commands  327–331
terminology  31
TeXML chapter marker list  301
text, superimposing  249, 250
TextOverlay filter  249
.tga extension  60
third-party plug-ins  324
TIFF (Tagged Image File Format)

described  159
encoder  14, 34
output files  159–161

.tiff extension  60
timecode

described  189
drop frame  189
In and Out controls  285
MPEG-2 options  189, 205
non-drop frame  189
playhead in  287

Timecode Generator filter  249
timeline controls  287
timing (retiming)  62
toolbar  49

configuring  50
items  51
overview  50–52

tracks
enabling audio or video tracks  225
hint tracks  212, 225
LFE tracks  144

transcoding
basic workflow  29–37
batches for. See batches
choosing output format  33
Compressor windows and workflow  42
confirming completion of  37
described  31
destinations  33
different clips from single media file  122–123

Droplets and  315–322
email notifications  277
Final Cut Pro projects  117–118
frame controls and  256–260
optional tasks for  26–27
output formats  14
portions of media files  295–296
post-transcoding actions  279–280
post-transcoding options  277–280
preparing Compressor for  32–33
previewing settings  32, 35
screen savers and  36, 113
settings  32
typical components of  30–31
viewing status  36

transport controls  288
transport stream  198
transport streams  183, 198
troubleshooting

artifacts in output files  85
deleting settings  97
destination warning triangles  311
resources for  323

two-pass encoding  60–61
two-pass VBR best encoding  191, 192
two-pass VBR encoding  192

U
uncompressed audio  127, 230, 235
upper fields  189, 246
URL chapter marker  301
user names  310

V
VBR (variable bit rate)

AAC and  211
job segmenting and  61
MPEG-2 options  191
one pass  191
settings  213
two pass  192–194

VCDs
bit rates  171
MPEG-1 output and  167

video
compression. See transcoding
deinterlacing  242–243
enabling tracks  225
filter list  245–250
interlacing  181, 242–243
minutes of, on DVDs  190
noise  248
noninterlaced  167
progressive  167, 181, 194
streaming  181, 212
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video CDs. See VCDs
video codecs

See also codecs, names of specific codecs
considerations  234
lossless  235
lossy  235

Video Format pop-up menu  154, 186
Video Format tab  185–190, 203
Video pane  213, 216, 218
video settings

MPEG-2 files  185–190, 204–205
MPEG-4 files  213, 216, 218
QuickTime  226

Video tab  170
voice levels  236
volume, normalizing  133

W
WANs (wide area networks)  40
warnings, destination  311
watermark filter  250
web

frame rates and sizes  168
MPEG-1 output on  168, 173, 174–175
resolution for  170
streaming media files over  224

Web option  170
websites

AppleCare Support  323, 324

AppleScripts  281, 324
Apple Service and Support  16
Apple Store  17
Apple websites  16–17
Compressor  16, 323
Compressor support  16
Dolby Laboratories  144
FireWire  17
QuickTime  17

white balance  245
wide area networks  40
windows. See Compressor windows
workflows

basic transcoding  29–37
Compressor windows and workflow  42
DV Stream format  146
H.264 for Apple Devices  152
H.264 for DVD Studio Pro format  158
MP3  166
MPEG-1  172–173
MPEG-2  202–209
MPEG-4  216–222
podcasting with MPEG-4  220–222
quick-and-easy  20–26
QuickTime  230–234

X
XML code  330
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